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FDOTConnect OpenBridge Modeler Training:
Introduction to Model-Centric Workflows

Bridge Design & Modeling

Description

The training course details 3D bridge modeling workflow using Bentley product OpenBridge Modeler
(OBM). To be in compliance with Florida Department of Transportation CADD standard (FDOT CADD),
this effort must also be accomplished within FDOTConnect workspace. Starting with laying out a 3D bridge
model, following up with plan development and quantity reports, and concluding with advanced topics,
the participant is walked through a typical workflow using the tools and features available. Interspersed

throughout are real-world detailing and design examples using the concepts in the course. Examples of
data migration among different engineering disciplines are represented in the form of hands-on exercises.

Objectives
This course includes but is not limited to:
*  OBM and OpenRoad Designer (ORD), Hierarchy and common tools
FDOTConnect Workspace and OBM Menu
»  Software Installation and Data Migration
*  WorkSets for Project Management and Discipline Connectivity
*  Design Files and Models
» 3D Bridge Modeling Tools and Workflow
* Plans Development
*  Quantity and Reporting Tools

Prerequisites

Recommended: Basic knowledge of drawing tools, levels, details skills in MicroStation and understanding
of the FDOT workspace for Open Roads Designer and OpenBridge Modeler. An overview of the essential
elements of the FDOT design environment (CADD ESSENTIALS-Course Guide) as a prerequisite for this
and other FDOT CADD training courses. Completing Bentley OpenBridge Modeler basic training courses
for familiarity with tools and interface is also recommended.

For information about this and other CADD training courses, publications, videos, and Frequently Asked
Questions, visit the Production Support CADD Office of the Florida Department of Transportation on the
world-wide web at http://www.fdot.gov/cadd/
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1 INTRODUCTION

Florida Department of Transportation (FDOT) 3D modeling initiative was developed in early 2016 and is
currently in the active implementation phase. Progress includes release of ORD FDOTConnect CADD
software for Roadway, Right of Way, Survey and Geotech in July 2019. The first production version of
FDOTConnect OBM was released in July 2020. Data connectivity among different disciplines has always
been an integral part of the effort.

Accordingly, this course was developed to introduce Bridge Designers to the OpenBridge Modeler
Connect Edition tools for modeling FDOT projects. The current curriculum was developed within the
FDOTConnect10.12 Workspace to introduce applicable content and provide sample exercises for this new
platform and workflow. This training is based on a sample project data set provided.

COURSE OBJECTIVES

Participants of this course will be introduced to the latest bridge modeling workflows in OpenBridge Modeler
for development of 3D BIM digital model, two dimensional (2D) graphic plans, quantity and report generation,
and other value-added features in design. At successful completion, users will learn how to:

¢ Create new files in the FDOTConnect Workspace

* Navigate the software interface

* Reference or import Civil Geometry and Terrain files into bridge model files

»  Set up a bridge model with FDOT bridge component templates

»  Create design plans directly from the OBM model

» Create a quantities report and other design data reports from the model

* Make modifications to the model to better represent FDOT-specific bridge geometry

EXPECTATIONS — WHAT THIS COURSE PROVIDES

This is an introductory course to get users familiar with the OBM software and creating a bridge model. The
user will see examples and techniques to use the model to create value-added content during the design
process for typical deliverables. The course provides background and detailed information for the key tools
and processes the user will likely use in the software, as well as exercises for practical applications. It is
developed primarily as an instructor-led course but can be used for self-paced learning. The manual will use
a typical FDOT prestressed girder superstructure bridge as the training model for exercises throughout. The
course briefly discusses and provides outside resources for advanced topics including reinforcement, steel
superstructure, and parametric cells. This course does not include workflows with OpenBridge Designer
which includes links to other Bentley products such as the LEAP structural analysis products and offers
additional potential for model-centric design applications.
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DOCUMENT STYLE

Style conventions used throughout the course guide are shown in the following table.

ltem

Convention

Example

Menu names and
commands

Bold
(Names separated

with > symbol)

General form is Workflow (when applicable) > Tab
> Group > Tool

File > Open
File > Settings > User > Preferences

OpenBridge Modeler (Workflow) > FDOT >
Actions > Create File

Window actions

Bold

Click the Apply button.

Click the Graphic Select button to the right of the
Horizontal Alignment Include box.

In the Segment Type list, click Lines.

Window field names

Italic

Key in Hemfield Road in the Alignment Name
field.

Click the Graphic Select button to the right of the
Horizontal Alignment Include field.

In the Segment Type list, click Lines.

Key-ins

Bold

Key in Hemfield Road in the Alignment Name
field.

File names

Italic

Open the file Working Graphics.dgn in the C:\
Bentley Training\GEOPAK 101\Project Setup\
Practice\ folder.

File paths

Underline

Open the file Working Graphics.dgn in the C:\
Bentley Training\GEOPAK 101\Project Setup\
Practice\ folder.

New terms or emphasis

Italic or Bold

The Template Library contains templates, which
represent typical sections of the proposed
roadway.

The user is not to utilize this tool.
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DEFINITIONS AND KEY TERMS

3D Design: The process of creating 3D Models for a project

3D Model: A digital graphical representation of proposed facility/site data consisting of X, Y, and Z
coordinates for producing objects in three dimensions to convey design intent useful for visualization, analysis,
animation, simulation, plans, specifications, estimates production, and life-cycle asset management. An
accurately designed 3D model is tied to a defined geographic coordinate system.

ByLevel: A setting that, when turned on, causes the element on a specific level to retrieve its definition
from the Level Symbology of that layer, such as Color, Line Style, and Line Weight .

CADD: (Acronym for: Computer Aided Design and Drafting) Software and methods used to design and
represent objects graphically on the computer. CADD facilitates the visual presentation of Engineering
Data.

Create File Application: FDOT application used to create new .dgn files per CADD Standards. Should
be used in place of the Bentley “New File” option.

Data Point: A graphic input (left-click on the mouse), depending on the context: designates a point in a
design, designates the view in which it is entered, or accepts an operation rather than rejecting it.

Design File: An electronic CADD file that conforms to MicroStation® (DGN) or AutoCAD® (DWG)
graphics formats.

Digital Terrain Model (DTM): ADTM is a digital topographic model of the earth’s surface minus objects
such as trees, vegetation, and structures that can be manipulated through computer-aided design programs.
All elements of the DTM are spatially related to one another in three dimensions.

Explorer: An expandable menu with items including File, Items, Resources, Sheet Index, links,
OpenBridge Model and OpenBridge Standards. It may be docked for consistent access or floatable based
on user preference.

Feature Definition: The OBM Feature Definition Library refers to a component of a DGN Library that
contains a level, element, feature symbology and feature definition structure.

Level: A category that data (linework, etc.) in the design file may be segregated into.

Line Style: Part of the symbology of an element: for example, whether a line is represented a solid,
composed of dashes, dots and dashes, and so on. Each element has its own line style.

Master Units: The largest unitin common use in a design file, usually represented in US Survey Feet for
most of the Department’s seed files.

New File: Standard Bentley file creation function that should not be used in the FDOT workspace

Project Root Folder: The file system folder that contains all projects’ files and folders. The project root
folder should not contain files that do not pertain to the project, nor should files that are part of the project
reside outside of the project root folder, or one of its sub-folders.

Properties Window: The window for a bridge component that allows the user to see the information
about the component and make modifications. This window can be found by clicking the Properties tool
in the Primary group of the Home tab. Or, it can be found by selecting an object in the view window and
clicking the Properties tool.

Reference Files: A design file or other file type that is attached to and viewed simultaneously with the
active design file.

Reset: A placement action (right-click on the mouse) that, with most tools, backs up one step. In some
cases a Reset operation completes an action; in other cases, it cancels an action or rejects an identified
element.

Save Settings: Saves settings in the active design file. This option is enabled only if the Save Settings
on Exit preference is set to off in the Preferences dialog Operation category. This allows the user to save
settings (including level and reference visibility, viewport settings, etc.), as they are not automatically saved
when you exit the file.

Search: The user can use this tool to find the location of a command or tool. It can be found in the upper
right-hand corner of the OBM window or by hitting F4.
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Seed File: A predefined settings file used to create a new design files or cell libraries.

SupportLine: Term used in OpenBridge Modeler (OBM) to describe the abutment and pier locations in
plan view. The placement of these lines are usually at the centerline of piers and at the front face of backwall
for abutments and are also used to determine extents of the deck and beams.

Symbology: The settings applied to an element for visualization/printing purposes, such as Color, Line
Style, Line Weight, Transparency, etcetera.

Workflow: Drop-down list that controls which tabs are displayed on the ribbon.
Working Area: Size, in working units square, of design plane.

Working Units: The real-world units in MicroStation (or OBM) that the design plane is configured to, such
as US Survey Feet.

WorkSet: Collection of files for a certain project.

Workspace: Container for organizational standards.

COURSE SUPPORTING FILES AND ADDITIONAL RESOURCES

The exercises for each chapter are independent of one another and can be used without having to complete
the exercises in previous modules. All files used in this course are located at this link, along with MSE
Retaining Wall and Florida Slab Beam Modeling workflow documents:

https://www.fdot.gov/cadd/downloads/documentation/fdotconnecttraining/fdotobm

Download the Dataset before beginning this course. For a Workstation installation, copy the dataset
(12345678901 folder, 12345678901.cfg, and 12345678901.dgnws) to: C:\Worksets\FDOT folder. For other
installations or different drive names, adjust the file path as necessary.

There are additional training resources in the link below to provide supplemental learning opportunities:
https://www.fdot.gov/cadd/main/fdotcaddtraining.shtm
Alink to the ORD CADD Essentials training mentioned above is found here:

https://www.fdot.gov/cadd/downloads/documentation/fdotconnecttraining/fdotconnect-cadd-essentials

OBM AND FDOTCONNECT INSTALLATION

The FDOTConnect CADD Software Installation Guide PDF is available at this link:
https://www.fdot.gov/cadd/downloads/software/

Following the installation instruction is key for a successful installation. The reason is that the process is
atypical to common commercial software.

The following are a few items specific to FDOTConnect OBM workspace.

« Save all existing templates XML files, library files and cell files created in earlier version of OBM
and FDOTConnect in the customized directory and be prepared with future inclusion via importing
tools.

* Install OBM prior to FDOTConnect state kit, similar to ORD installation. Configuration customization
is required.

« FDOT OBM shortcut will be available in FDOTConnect folder instead of FDOT ORD shortcut. In
the case that both OBM and ORD are installed on a user’s computer, both FDOT shortcuts will be
available.

* In the case that Bentley products are updated after FDOTConnect installation, FDOTConnect
workspace will stay intact.

»  For users with OpenBridge Designer installed on their computer, FDOT OBD shortcuts will also be
provided.
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OBM HELP AND SUPPORT

OBM provides Help and product support through online services, documentation and Tool Tips that can be
accessed from the OBM menu bar once a session is opened.

OpenBridge Modeler @ & H lrf Ei * = (o §“f 104 3| |3 = Workset: 12345678901

Home Civil Utilities Reports and Drawings View Collaborate FDOT

@ © = oI

Help  Feedback Examples About
Contents ﬁ

Help Social Media

Help Contents

This is a link to online help documents and tutorials from Bentley.

Feedback

This opens a window in which feedback can be shared with Bentley. Sharing issues, bugs and
enhancement requests are encouraged to help improve the software.

EXAMPLES (BENTLEY LEARNING PATH)

This links to online trainings and references. This is a newly developed tool to provide internet support,
online help, training and updates. It is gradually becoming a regular supporting tool for development
and advancement.

ABoOUT

This opens a window that will show which version of the Bentley software is used, along with memory
statistics, current file information, and copyright/trademark information.

SEARCH RIBBON

The user can use this tool to find the location of a tool or command or search for help on a specific topic.
This is one of the most important tools in OBM. As MicroStation, ORD and OBM tools are developed, it may
get cumbersome to remember the locations of each of the tools. Especially since many users have recently
migrated to the CONNECT version with the new ribbon menu style and the same tools may be in three
different locations in each of the three programs. Many tools are accessible via multiple paths. This search
functionality will bring the user directly to the tool as needed. When searching, the user can find the path to
the desired tool by hovering over the search result in the ribbon. See the following figure.

N HFET = Workset 12345678901 add bridge 9

Ribbon (1)

Navigate to OpenBridge Modeler—Home—Bridge Setup

BENTLEY COMMUNITIES AND PRODUCT SUPPORT

There is a continuously growing community of OpenBridge users around the world. The Bentley Communities
site is helpful for troubleshooting issues and finding solutions. You may find help in categories including
OpenBridge, OpenRoads, MicroStation, ProStructures, and more.

https://communities.bentley.com/
If an issue requires escalation to Bentley, they offer Product Support through their website.
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FDOT HELP AND SUPPORT

The FDOT Production Support Office | CADD provides many venues of help and support whether one-on-
one; self-help; or group assistance. The FDOT Customer Support Guide is published on the CADD website
under the Publications link to explain how to get help, who to contact and what to expect.

From the FDOT Desktop folder, the user will find links to join a GoToMeeting for one-on-one support,
connect to FDOT’s forum on the Bentley Communities website, connect to the FDOT PSO|CADD’s website
for on-line support, and an option to submit their own Support Request via FDOT PSO|CADD’s online
support portal.

@ Q
Ao v
B 0 S

DﬂT 2024 MSCE Dl'lT 2024 OBD Dl'lT 2024 OBM FDOT 2024 BIM Crypter BIM Validator CADD Support

Pro-Structures Communities

-~
) ' - ﬁ !

CADD Website Clear Crash Designer LandXML Frn|:ct Validator Summary
Interface Visualizer Reports Builder
Quantities
Builder

For detailed instructions on CADD Support, CADD Website, Request CADD Support and FDOT Workspace
Doctor applications, see FDOTConnect related training menu. This training focuses solely on FDOT OBM
application.

From within an OBM session, the user will find many Help and Support links under the FDOT tab.

FDOT] Help |
. QQ ﬁ @ E [E) structures Report Raw g o QC Quick @ Reference Checker B Iﬂ ‘) /J m
E#\ — = =
. . Structures Report Final »| QC Project . GCS Reparter
FDOT Attach Geotech ~ GBOtECh | Standard Rebar  Steel antity _Explore FDOT  Web  CADD  Apout
SY Cells SurveyReference Data Manager 190IS™ | Packager T00IS™ Shapes i  Takeoff Manager Tools "j QcC sTOP Directories* Links ™ Links¥ | Links ™
ns Roadway Geotechnical Structures. Quantities Quality Assurance Resources Helj

The FDOT CADD Office has many links to contact Support staff for assistance or find resource material
within the CADD website.

e Thereis an FDOT CADD Support Forum for users to globally submit issues for any CADD user to
respond. This forum is maintained and monitored by the PSO|CADD staff, but also opens the door
to many other resources for assistance.

Through the CADD Office’s website, the user will have access to much more Help and Support assistance
through Publications, Downloads, Training Courses, FDOT Training Manuals, GoTo Webinars, Quick
Clips, Frequently Asked Questions (FAQ), Quick Links and links to other offices and outside professional
resources.
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2 FDOTConnect Workspace Elements and
Features

OVERVIEW

This chapter will discuss the different ways that the user can navigate the OBM workspace and organize
their model by using the Model Explorer, Levels, Feature Definitions, etc.

OBJECTIVES

This chapter discusses the design environment within OBM. Highlights of this chapter include:

 FDOTConnect Screen Layout
*  Workspace Preferences
OBM Explorer

*  Feature Definitions

FDOTCONNECT SCREEN LAYOUT

FDOTConnect OBM screen layout may be customized to open with components in the same position for
every editing session. It may also be reorganized or changed on the fly during an editing session. FDOT
has established a default layout that is delivered with FDOTConnect CADD software.

OBM tools are grouped into a family tree from the Workflow, ribbon tabs, groups and tools. If any tool
has a triangle next to it, it contains multiple versions of the same tool. Most of the 3D bridge modeling is
accessible from OpenBridge Modeler Workflow, while tools in Drawing and Modeling ribbons contain most
MicroStation tool to fine tune CADD production.

| Workflow I
OpenBridge Model v VT HE
Home Civil Utilities Reports an

<7 Add Bridge @§ Move

«m & ] _
Import  Bridge ﬁ: Add Unit &7/ Terrain
= Wizard ";ﬁ’ Alignment ﬁﬂq. Add Multi-Units

= (g "i_.;’f‘ﬂ * {E‘E} Y4
O\ E & '

Explorer Element ...
= & - Selection i..:

v

Primary Selection Bridge Setup

For detailed MicroStation tools and instructions, see FDOTConnect CADD Essentials training manual
for further information. The topics include workspace preferences, views, models, drawing, drawing
with precisions, level, changing elements, selecting and grouping, drawing annotation, cells and points,
patterning and hatching, placing dimensions, information and measuring tool, reference files, raster images
and point clouds. All these functions are still valid in OBM. This document is only covering what’s unique
to OBM.
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WORKSPACE PREFERENCES

The preferences window contains settings that customize the way OBM operates and looks. To access
the window, select the OBM menu option: (Any Workflow) > File > Settings > User > Preferences.

Preferences [FDOT] X
Category
Name for Preferences: | Default Preferences

Database
Descartes ot ik TR
Help Settings 2ingle Lhe ¢
Input Default Tool: | Selection
Language Layout: | Regular
LooidandjGec) Tool Box Tool Size: | Medium (24 x 24)
Mouse Wheel . .

. View Tool Size: | Small (16 x 16)
Operation =

Position Mapping
Raster Manager

Marker Size:

Default (Tool Size)

l:‘ Auto-focus Tool Settings

Reference

Rendering Borderless |cons

Ribbon I:‘ High-contrast icon edges
Spelling Use Windows file open
Tags Highlight file name
Text .
Update Settings l:‘ Restore undocked dialogs
View Options |:| Focused dialog is opaque

View Options - Civil |:| Modeless dialogs transparency

0 10 100
[ ] Hide Thumbnail View
[ ] Apply Dark Themed Ul

Focus Item Description:

For more options, click on the category list at left.

Defaults oK Cancel

The settings in this window work at the system level, which means that they are not specific to any design
file, but are active no matter which design file is being worked in. This window has many options which are
referred to throughout this course manual. See Bentley’s online Microstation help guide.

PROPERTIES

The Properties window is located in the Home tab of any Workflow and may be floatable or docked as
wished. It is used to review or modify the properties of any given selection. It can be used in conjunction
with the various other OBM tools such as the Element Selection, Explorer, Models, and more.
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EXPLORER

Explorer is one of the commonly used tools in Bentley products. OBM has its own version of the Explorer
tool that is used to manage and control project content. It is located in the Home tab of any Workflow and
may be floatable or docked as wished. It has expandable menu items including File, OpenBridge Model,
OpenBridge Standards, Items, Resources, Sheet Index, and Links. Files created per FDOT workspace and
Create File tool will have all delivered libraries listed under the OpenBridge Standards tab.

@, Explorer — X
& File
OpenBridge Model
OpenBridge Standards
@ Items

' Resources

"E'g Links

|| €[ €| €| <] ¢

OPENBRIDGE MODEL

The OpenBridge Model menu is used to view the civil and bridge data in hierarchal order. It can be used to
toggle on or off the display of various elements within the model. This functionality is helpful because unlike
Level Display, it can control individual elements rather than all elements of a given category. For instance,
a single pier could be toggled off while keeping the other piers on in the model. Individual elements can
also be renamed from their default names by right clicking an element and selecting Rename. This can
be helpful in organizing elements since they will be labeled as shown in the OpenBridge Model menu in
various model-generated reports.

LEVEL, ELEMENT TEMPLATE, FEATURE SYMBOLOGY, AND FEATURE DEFINITION

A MicroStation design is made with basic building blocks called elements that are placed in a design space
within each model. Each element placed in a model is on a drawing Level. Each Level can have its own
color, line style, and weight along with several other attributes. The next step up from Level is Element
Template. Each Element Template can be assigned a Level, color, line style, weight, class, transparency,
and priority. The color, line style, and weight can be set to ByLevel or can override the Level settings.

Similar to elements in MicroStation, Features were developed for the Connect Edition software, including
OBM. When creating an OBM design, the user can use features to intelligently organize model information.
Feature Symbology is overlaid on top of Element Templates with “shape” information such as point, line,
profile, surface and solid. Feature Definitions provide an additional overlayer on top of Feature Symbology
with “part” information, such as deck, beam, support, etc. The list of shapes and parts are predetermined
by OBM and may not be edited.

In addition to providing for the management and display options for levels through Level Manager, Level
Filters, and Level Display applications, OBM also provides a list of applicable Feature Definitions through
a flyout menu. FDOT Feature Definitions for bridge design projects are delivered with the FDOTConnect
workspace in a DGNLIB file. These FDOT Standard Libraries are locked and cannot be modified by the
user.

This manual focuses on Features Definitions in OBM, which is comprised of the following:

« Database intelligence developed from Level to Features
* Level Manager, Level Display, Element Templates, Features Symbology & Features
* FDOT delivered Feature Definition Standard
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FDOT FEATURE DEFINITIONS

The OBM Feature Definition Library refers to a component of a DGN Library that contains a level, element
template, feature symbology and feature definition structure. New libraries can be created; new and existing
level libraries can be attached, detached, imported, and exported using the Level Manager window. They
may also be delivered in the appropriate directory. A level or definition does not technically attach from the
Standard Library to a design file until it is used.

The FDOT Levels and attributes are grouped and translated into specific Rule Files which are associated
to each valid Standard Filename of each Discipline for the purpose of performing the Quality Control check
for FDOT Standard compliancy of design files. Complete specifications can be found in the CADD Menu
(CADD). FDOT QC check will not use Feature Definitions in the near future releases.

When using OBM to create an FDOT drawing, the color, line style and line weight attributes should be set
to “ByLevel”. This setting allows the level to control these active attributes. This ensures that the levels
comply with FDOT standards. FDOT levels are predefined and delivered in specific DGNLIB files. FDOT
does not recommend overriding the ByLevel settings. To do so would result in non-standard design files that
would not be acceptable in FDOT Project submittals.

Note that users should be using the Feature Definitions provided in the FDOTConnect workspace wherever
possible. If new Feature Definitions are desired, this should be requested through the FDOT > Help >
CADD Support > Email CADD Support.

NOTE New or modified Feature Definitions may be introduced into an existing DGN for an
updated DGNLIB by right clicking on the filename within the OpenBridge Standards
menu and selecting “Update Standards from dgnlib.” This can be useful when updating
an existing file to a new version of the program.

NOTE FDOTConnect OBM will be using the Features Definitions for alignments defined by
FDOTConnect for ORD. There will not be a different set of Features Definitions for
alignments for bridge modeling in OBM

&, Explorer - X
[T File v
OpenBridge Model v
OpenBridge Standards ~
* Q ,® M

4“9 Standards
- Libraries
4 Feature Definitions
> Feature Definition (FDOT_Standards_Features_Labels_Text_Din
> Feature Definition (FDOT_Drainage_And_Utilities.dgnlib (Defal
4 Feature Definition (FDOT_OBM_Standards_Features_Text Favo
e Alignment

&' Linear Template

€/ Linear

I+ Point

> \ SupportLine

> :;?3 Supports

> € Deck

> E Beam

rd @ Bearing

> [ Barrier v
| 4
¥ Items v
r,. Resources v
‘Eg Links L
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3 DESIGN FILES

OVERVIEW

This chapter will cover file creation process in OBM, file connectivity among disciplines and file management
in FDOTConnect workspace. FDOTConnect is a workspace developed by FDOT for Bentley Connect
Edition software. It includes all necessary resources, tools and customization that are required for FDOT
projects. It must be used for compliance with the FDOT Computer Aided Design and Drafting (CADD)
Standards. See FDOT CADD Manual for CADD Standard details.

OBJECTIVES

This chapter reviews the OBM design environment within the Florida Department of Transportation (FDOT)
FDOTConnect Workspace. Special consideration is given to:

*  OBM Structures Design Files

«  FDOT ORD and OBM Seed Files

* Launching OBM in FDOTConnect Workspace

*  Opening Files in FDOTConnect Workspace

+  FDOTConnect Discipline Configurations

* Creating Files in FDOTConnect Workspace

* Design File Settings

* FDOTConnect Preferences

OBM STRUCTURES DESIGN FILES

The OBM CONNECT format is a subset of .DGN and accepts .DWG file formats. This gives OBM native
support for both Bentley and Autodesk platform. For other applicable formats, see OBM user guide.

A design file (.DGN) is a container for the data of the project. Note that this term is generic in the Bentley
environments; a design file could be “Design File” or “Sheet File” as defined in the FDOT Create File tool in
the FDOT tab. The design file can be viewed as a “box” or “container,” which contains one or more models,
with the first one typically named “Default.” Each model is a unique component within the .DGN, which
allows multiple drawings to reside in the same design file. For example, design models, drawing models,
and sheet models can exist as separate models in a single design file. Note that “Design File” and “design
model” are different concepts, so are “Sheet File” vs sheet model. “Design File” and “Sheet File” are FDOT
introduced concepts while design models and sheet models are Bentley concepts.

NOTE Only one design file is opened at a time in OBM, but other design files may be viewed by
attaching them as References, along with their models, to the active model in the open
design file. All Dimensioning and annotation are typically done in a drawing model.

OBM Design File

Bridge Design
Model

Drawing Models Sheet Models
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In OBM, generally a design model is used when first creating a bridge model or drawing bridge elements,
either in 2D or 3D. See chapter 6 for a more detailed explanation of how design models, drawing models,
and sheet models work together in the plans production workflow.

When progressing to model-centric workflow, the goal is to generate a 3D design model. The option to
create a 2D design model is either as a starting point to aid in the creation of a 3D design or for those who
are not using a 3D workflow yet. Regardless of 2D or 3D design file, there should be one governing design
file used for the purpose of digital delivery.

FDOTCONNECT SEED FILES

Each OBM design file is created from a seed file. A seed file is a previously stored design file, with user
specified settings, used as a template to create a new DGN. FDOT has created seed files for use in
production that have standard settings stored within them. Available OBM seed files with FDOTConnect
are:

FDOT-OBM-KeySheetSeed.dgn Contains settings to create a Key Sheet design file in OBM.
FDOT-OBM-StructuresSeed2d.DGN Contains settings to create a 2D Bridge design file in OBM.
FDOT-OBM-StructuresSeed3d.DGN Contains settings to create a 3D Bridge design file in OBM.

FDOT-OBM-StructuresSheetSeed3d.dgn  Contains settings to create a 3D “Sheet File” in OBM.

A default seed file will be selected for each design file when using the FDOT Create File tool, but the user
can override the seed file if another is needed.
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LAUNCHING OBM IN FDOTCONNECT WORKSPACE

FDOT has created and provided a custom workspace FDOTConnect to standardize the OBM environment
for agency use. This workspace determines how OBM displays on the screen and sets up certain default
files and search paths. FDOT’s customized OBM workspace can be launched by the following common
avenues:

*  Double-click the FDOT-OBM icon from the FDOTConnect desktop folder.

FDOT 2024 MSCE ~ FDOT 2024 OBD FDOT 2024 OBM FDOT 2024 BIM Crypter BIM Validator )
Pro-Structures Communities

[
31 1Y
DepeEaln

CADD Website Clear Crash Designer ML Project Validator Summary pace
Interface Visualize Reports Builder or
Dhantitiac

FDOT Connect2024
FDOT 2024 MSCE
FDOT 2024 OBD
FDOT 2024 OBM

FDOT 2024 Pro-Structures

NOTE Opening an OBM session from the Bentley program group or by double clicking on a
DGN file will not guarantee opening of OBM in the FDOTConnect workspace.

Once the program is located, it can be pinned to Start or the Taskbar for easy access.

All the utilities presented in the above shown folder are created by FDOT. Workspace Doctor and Clear
Crash are two very useful tools. Workspace doctor is provided to fix configuration problems, i.e. remove
user preferences and return to program default. User may also manually remove user preferences by
removing the file personal.upf in the following directory [drive]\users\[username]\appData\local\Bentley\
OpenBridgeModeler\XX.X.X\prefs\. FDOT user preference and interface configuration (bar menu) are not
part of the OBM settings like how it was in the older versions of Bentley programs.

BENTLEY PRODUCT HIERARCHY

Bentley’'s CONNECT Edition software include MicroStation, ORD and OBM. OBM is built on top of ORD
and ORD on MicroStation. In general, functions and tools that are available in MicroStation are available in
ORD and those for ORD are also available in OBM, but not the other way around. That means functions and
tools available in OBM may not be used or available in ORD or MicroStation. With all that said, this does
not mean that ORD files can be opened in OBM. Neither MicroStation files in ORD nor OBM. Even files
created in a different version may not be recognized in the same program. This is true for new version to old
version or old version to new version. The next section will discuss further on file management regarding
this information.

FDOT OBM 22



OPENING FILES IN FDOT CONNECT WORKSPACE

FDOT OBM File Open tool launches the File Open window. File > Open is used to manage design files
and open existing drawings. Recent Files will appear when this is first opened. The user can also click on
Browse at the end of the Recent Files list to open the “File Open” window shown in the image below. If
using ProjectWise, you may see a window pop up from that that needs to be closed first.

Open
Recent Files for 12345678301

> ThisPC » OSDisk (C:) » Worksets » FDOT » 12345678901 v o O Search 12345678901

Export

Publish iModel

~ WorkSet | 12345678901 ~

File name: | IEERPEIES ~| | caD Files (dgnawgad)
[ I

The File Open window contains standard navigation tools such as a drive list and files list. Right clicking on
a file opens a dropdown menu with file options for use on the selected file.

The File name identifies a specific file selection and List Files of Type filters which type of files display in
the Files list box. For example, to view DGN files only, change the option to MicroStation DGN Files [*.dgn].

The Options button only displays when selecting DWG file formats. FDOT Software delivery provides preset
settings found within this option and does not recommend users to make any changes.

To navigate to a different directory, select the directory from the Directories list in the middle of the window.
To open a design file, select it from the Files list and click OK, <OR> double-click on the file name to open it.

All roadway features are expected to be created in FDOT ORD workspace. They are to be referenced into
OBM files. No ORD files should be opened in OBM, nor OBM files in ORD. LandXML or Alignment XML or
ConceptStation XML may be imported into OBM and saved as a DGN file. Bridge modeling is expected to
be completed within another file that references the above mentioned DGN file.

If any data created from ConceptStation is to be used in OBM, use only XML format exchange. Data
transfer from OBM to ConceptStation shall be DGN referenced in ConceptStation. Opening ConceptStation
file in OBM is not recommended.

It is clear now that no two DGN files are the same. Double clicking the DGN file in the file explorer
is not recommended, as DGN files are affiliated with ORD, OBM, and MicroStation programs. The only
recommended way to open a DGN file properly is to open it from the File > Open directory in the program
and version it was created, otherwise utilizing the reference tool is encouraged.

SWITCHING DESIGN FILES

Once a DGN file is open, users may switch to other DGN files by selecting the OBM menu option File >
Open <OR> hold the Control key down and select the letter ‘O’ (Ctrl+O). The Open window displays with
abbreviated options as in the File Open window.
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EDOT DISCIPLINE CONFIGURATIONS

FDOT discipline bar menus are no longer necessary. Instead, tools will be available under the FDOT tab as
shown. FDOT tools are strategically organized under multiple groups, such as the Resources group which
will include Website Links and Explore Directories tools, and the Create File tool (discussed in detail in the
next section) is under the Actions group. Other FDOT tools such as CADD Support and Workspace Doctor
tools are also included and discussed in previous chapters in this guide.

Structures specific groups/tools are available, such as a Structures Standards Packager, Rebar Tools (to
generate reinforcing bar lists), and the Steel Shapes section generator. Also included are QC checks,
Linked Data Manager (LDM), and Plan Set Manager.

£ o[68 @ B Workset: 12245678901 - _BlankFile.dgn (Default) - OpenBridge Modeler CE - 2022 Release 2

s View  Collsborate | FDOT | Help
@n ctures Report Raw + QCQuick @ Reference Checker =] a
= 3 o o EEe O

S 5#6 o
) i
=== o S e G

Can el rpor
T Lbrariess Webpages~ GAln | Suney fefere + Tools * Shapes | 5 Tekeoff Manager ool #gQcsToP
Structures Quantities Quality Assu

Cell Application: Roadway
—_ — — — - —

e Gl Utilti

CREATING FILES IN FDOTCONNECT WORKSPACE

To create a new file in the FDOT OBM WorkSets, the user should use the FDOT Create File tool in order
to be in compliance with the file name Quality Control requirements per FDOT CADD manual. The user
should not use the New File that comes with OBM by default. Instead, the user is encouraged to
create a new WorkSet and open the file BlankFile.dgn in the newly created WorkSet that comes with
FDOTConnect software. As mentioned, FDOT provides an application named Create File to create new
files with the correct seed file, file names and folder structure already in place. This FDOT utility may not be
accessible outside of an FDOT OBM session. The BlankFile.dgn is only needed the first time a file needs
to be created, afterward the user can access the tool from existing project DGNs.

To access this FDOT utility within an OBM session, select the FDOT > Actions > Create File.

OpenBridge Modeler v = H "_d Eb ; |.r='] ¢| ?3 :i |: (7] = Search Ribbon (F4)
Home Civil Utilities Reports and Drawings View Collaborate FDOT Help /

AP P @ O © 4+ - L 1@ O

Element ..., Create [filters Linked Misc. Plan Set | Cell Cell FDOT At T Web CADD About
Selection i T File ™  Data Manager Tools™ Manager~  Libraries~ Webpages~  (Cells | Survey R 7 Links~ - Links

Selection Actions Cell Applications Roadv. Help
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CREATE FILE TooL

The Create File tool is used to create FDOT OBM design files in accordance with the FDOT standard file
naming conventions. Create File uses an ASCII text file, called a Control File (*.ctl) to perform these task(s).

NOTE FDOT'’s Create File is a separate utility now delivered with FDOTConnect Software. This
application may no longer be accessible outside of OBM.

CreateFile (v2023.5.12.1) >

Workset:  C:\Worksets\FDOT\12345678901 v

Discipline: | STRUCTURES v

File Group: |3ﬂmﬁﬂﬂmﬁﬂ V|

File Type:

Base Filename Description

BHALGMER Alignment and Superelevation for Bridge Design
BHDSGMBR 2D Bridge Plan (Proposed)

BHMODLBR Bridge 30 Model

GOTMER Converted Temain for Bridge Design

Output File:

Bridge File

Seq #: Base Filename: Modifier (Optional) Seguence #: Extension:
B [ | mopLer | | [o1 | | .dan

Ciwlorksets\FDOT\12345678501 \structures\BMODLERD1 .dgn

Output Folder: structures |

ceegFile.  |cidotconnect10.12\organization-civilfdot \seed \FDOT-OBM-Struc|  Browse

County: Pasco | Coordinate System: | FLB3/2011-WF |

Action: | |

| Create—ﬂpenl-_lle| | Close |




A description of the Create File window is listed below:

Discipline

File Group

File Type

Output File
Output Folder

Seed File

Action

Create — Open File

Defines the control file, which sets all other information in Create
File window. Use the Discipline dropdown arrow to select
the appropriate control file. There are various available
disciplines: STRUCTURES, STRUCTURES - NON-
BRIDGE SPECIFIC, ROADWAY, UTILITIES, etc.

Upon selection of a Control File, all other fields automatically populate
with FDOT standard information.

Each control file has several File Groups to choose from. Each group
is a specific area of design and plans production, with
either “Design Files” or “Sheet Files.” Selecting a file group
automatically loads the file types related to that group into
the File Type list box.

Selecting a File Type automatically sets all the settings for the Output
File (Name), Output folder, and Seed File fields, of the file to
be created. If a file with the same name already exists, the
numbering is automatically incremented.

These settings are automatically set when the Discipline, File Group
and File Type are specified. Only the Output File or Seed
File may be modified directly. Browse buttons are provided
to change the Output Folder or the Seed Path, if needed.

When an OBM design file is created and opened, this text field can
be used to enter MicroStation/OBM commands, such as set
active scale to 10 (AS=10). Action functions similarly to the
MicroStation Key-in utility.

Selecting the Create — Open File button executes the creation of a
new DGN file as specified by the selections made and saves
the file to the Output File and Output Folder specified. Click
the button more than once to create multiple new DGN files
where needed. The application will automatically increment
the numbering of subsequent files with the same file name.
This is useful when more than one blank copy of a particular
type of DGN file is needed, such as Plan and Profile Sheets.

NOTE Ifany files created in OBM are roadway related features, such as turbidity walls, saving
to the \Roadway directory is required. This means there will be ORD and OBM files
mixed in the same directory. It may be helpful to organize these files into sub-folders.
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DESIGN (DGN) FILE SETTINGS

When a new design file is created, it is recommended to review the set-up of the design file parameters
that control how the drawing functions. The most common file settings are found in the Design File Settings
window which provides control over such settings as highlight colors, coordinate readout, working units,
and grid settings. To access Design File Settings, select the OBM menu option: File > Settings > File >
Design File Settings.

Design File Settings *
Category Linear Units

Active Angle Format: | MU:SU -

Active Scale Master Unit: |Survey Feet v | Label |

Angle Readout . B

e Sub Unit:  Survey Inches ¥ | Label

Civil Formatting Accuracy: | 1/16 -

Color
Fence

Custom

Grid Advanced Settings

Isometric Resolution: 304800 per Distance Survey Foot
Locks Working Area:  5.59683E+06 Miles

Snaps

Stream Solids Area: 10 Miles

Views Solids Accuracy:  5.27999E-07 Survey Feet
Working Units

Edit

Fecus ltem Description

Select category to view.

NOTE Itis important to note that, if the proper Seed File is used when the OBM file is created,
then there should be only limited reasons to change any of the design file settings.
One example may be updating Working Units based on Plans Development needs (see

section below).

WORKING UNITS

Working Units consists of controls that are used to set “real world” units of measurement for design models.
OBM recognizes Metric and English units, either of which may be selected. Additionally, users can create
their own custom units, by relating them to the standard units (Metric or English). Changing between the
units used in a model makes no difference to the size of geometry in the model; alternatively, changing
the Resolution setting in the Advanced Settings does change the size of existing geometry in the model. In
practice, the Resolution setting will rarely, if ever, have to be changed from the default.

The default Working Units in the FDOTConnect OBM seeds are Survey Feet and Inches with rounding to
the nearest 1/16" of an inch. In order to take advantage of some OBM plans development and reporting
tools, the user may want to change the Working Units. For example, changing the Working Units to decimal
survey feet for creating deck elevation reports so that the values are reported as typically provided in
drawings and calculations. Another instance is when the Structures Detailing Manual (SDM) precision
requirements vary from the default.

GLoBAL ORIGIN

The global origin for FDOT'’s standard seed files are set to an XY coordinate of 0, 0. The global origin can
be relocated to specific coordinate values to create a custom coordinate system.

When using Create File to create OBM files, a predefined seed file is used to create each design file
automatically and thus the global origin is set to FDOT standards.
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FDOT PREFERENCES

COMPRESSING DESIGN FILE

When elements are deleted from a OBM design file, the elements no longer display in the design, but a
record of the deleted elements remains in the design file. The Compress Design File command removes
the records, which reduces the file’s size.

The undo buffer is cleared when a design file is compressed, so after compressing, the user will no longer
be able to undo any previous operations.

It is best to use the Compress Design File command at the end of an editing session. This can also be set
to happen automatically upon exiting the design file. To enable this setting, select File > Settings > User
> Preferences from the OBM menu, select the Operation category and click the checkbox for Compress
File on Exit.

Preferences [FDOT] X
Catego
=y Name for Preferences: | Default Preferences
Database
Descart
H:;aSe:tsings [] Open Multiple Application Windows v
Input [ Save Settings on Exit
Language Auto-save Design Changes
k:Ok anvc:’:eell I Compress File On Exit
Os;sa:ion = [J Sync Symbology to BylLevel
Position Mappin Highlight Broken Associations
9
Raster Manager Display Active Level in All Views
Reference Viewing Tools Apply to Active View
Ribbon
Spelling [] Use Snap Mode from Preferences
Tags :| Fence Operations:
'Ll;ex; s Abort on Reset
t

View Options - Civil Optimized Fence Clipping

Resource Cache: | 4096

Focus Item Description:

For more options, click on the category list at left.

Defaults OK Cancel

By default, OBM saves drawing changes automatically. OBM design files are saved in DGN format.

The fact that the file is saved automatically is a very powerful feature of the software. This gives the user
security of knowing that in the event of a computer crash or power failure, the design changes for the last
completed command are saved.

Only changes to design elements are saved automatically. File settings (active color, view setup)
must be saved using the OBM menu option: File > Save Settings <OR> [Ctrl] + [F] on the keyboard.
This preserves all file settings to ensure reflection of current settings in future openings of the file.

To disable this feature, select the OBM menu option: File > Settings > User > Preferences and then select
the Operation category in the Preferences window. Uncheck the Auto-save Design Changes checkbox.
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E Preferences [FOOT) oy

Category
Mame for Preferences:  Default Preferences

Database

eseates Dpen Multiple Application Wind
Help Settings [] Open Mubiple Application Windows
nput [ ] Sawe Settings cn Exit

L2nquage [ Auto-save Design Changes

-aak dndll-ed -] Compress File On Exit
[/ouse Wheel [ Syne Symbalogy to ByLevel
peration Sync Symbalogy to Bylevel
Fosition Magping [#] Highlight Braken Assocstions
Faster Manager [ Display Sctive Level in All Views
::;:Irzm:: kA Viewing Tools Apphy to Active View
%ﬂrll:-nl:g [ Us= Sneg Mode from Preferences
T2 Fu'lr.e{:'peldhum;

fext ) B Abort on Reset

Jpdate Settings e e [l

fimw Dptions b4 Apply L =

Wiew O ptions - Civil kA Optirnized Fence Clipping

Fesource Cache: 4096

Focus lern Descriptson:
Far mare aptions, click on the categony list ot b=fe.

Defaults DK Cancel

If Automatically Save Design Changes is disabled, the user must manually save the file by clicking theOBM
menu option: File > Save. Selecting File > Save As allows the user to save the file as a V8, V7, DWG, or
DXF file format. The Save As command can also be used to create a backup of the design file.

NOTE Save Settings can be set to execute automatically from this Operation category of the
Preferences window, by checking the Save Settings on Exit checkbox.

To return to the File Open window during an editing session, select the OBM menu option: File > Close.
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EXERCISE OVERVIEW

BXIERCISES.T Review the Design Environment and Create a New File

This exercise covers opening the program, creating a WorkSet, and creating a new file. The WorkSet
created in the first part of this exercise is used only as an example for the purpose of demonstrating the
process. The WorkSet for the remaining exercises should be downloaded and copied into the WorkSets
folder prior to beginning the course; see link and instructions in Chapter 1 of this training guide.

REVIEW FDOTCONNECT WORKSPACE AND CREATE A WORKSET

1. Before we launch the program, locate the FDOTConnect and FDOT WorkSet Directories. The
FDOTConnect file directory should be in C:\FDOTConnect20XX and a separate directory used for
WorkSets, such as C:\Worksets\FDOT. The WorkSets directory is where the 12345678901 folder
downloaded from Chapter 1 should be located, along with the corresponding .CFG and .DGNWS files.

2. Next, launch OBM by double-clicking the FDOT-OBM shortcut from the FDOTConnect desktop folder
or from the Windows Start menu by select Start > FDOT Connect 20XX > FDOT 20XX OBM.

3. Under the WorkSet pulldown menu, select Create WorkSet...

OpenBridge Modeler CE

WorkSpace  WorkSet
FDOT - O_WORKSET_TEMPLATE ~

Recent Fi
:
You haven't' 456789 Training start by
123456739 _Training2
| 123456728901

Ny SN S YWY YY Y

4 LB, AU

-

F Create WorkSet.., I

™ Create new WorkSet
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4. Addthe WorkSet name 12345678901_TEST (also shown below), the Description FDOT OBM Training
Guide Bridge, select the 0_WORKSET_TEMPLATE as the template and select OK to create the new

WorkSet

Create WorkSet X

Name: = 123456789071_TEST
Desecription: | FDOT OBM Training Guide Bridge
Template: 0_WORKSET_TEMPLATE -

== Add a Custom Property ~

Folder locations

Root Folder:
Design Files:
Standard Files:

Standards Subfolders:

ProjectWise Projects

Create Folders Only

Browse...

QK Cancel

5. Change the active WorkSet from the 12345678901_TEST that was just created to the WorkSet

downloaded with the dataset, 12345678901.

OpenBridge Modeler CE

WorkSpace  WorkSet
FDOT - 12345678901 -
(@)
Recent Fi I o
O WORKSET_TEMPLATE -
You haven't

123456789 _Training
123456789 _Training2

E‘ 12345678901

12345678901 _TEST
Brows

NOTE See the Course Supporting Files and Additional Resources section on page 13
for instructions on how to download the dataset and where to copy the files.
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6. Click the Browse button and navigate to the _BlankFile.dgn in the 12345678901 WorkSet and select
Open.

. Open X
OpenBridge Modeler CE
4 <« FDOT » 12345678901 v O 2 Search 12343672901
WorkSpace WorkSet
0 ize ¥ New fold F= -
FDOT - 12345678901 - rgamize e folder o e
Name Date modified Type Size ()
X sy T RS
Recent Files Symbology 11/8/2023 11:49 AM File folder
You haven't opened any files recently. To browss TrafficOperations File folder
Utilities File folder
£ BlankFile.dgn <— Bentley MicroStati... 60 KB v
—/ a File - Directory  +
Browse New File
File name: |7E\ankFi|e‘dgn \/| CAD Files (".dgn;*.dwg;".dxf]
Options Cancel

To Create a new Design File

1. Open the Create File window by selecting FDOT > Actions > Create File. The Create File window
displays.

OpenBridge Modeler @ o-dEE e - 2 [as8 & 4 s
Home Civil Litilities Reports and Drawings View Collaborate

i L 00 O == x

Element ..., Create JFilters  Linked Misc.  Plan Set  Cell Cell FDOT
Selection L. 7 File N Data Manager Tools ~  Manager ~ Libraries ~  Webpages ™ Cells

Selection Actions Cell Applications

2. From the Create File window, click on the Discipline dropdown arrow to select STRUCTURES.

3. Click on the File Group dropdown arrow to select the applicable Structure Design Files. This will
populate the File Type window with the associated files for selection.
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4. Select the File Type of B#MODLBR: Bridge 3D Model and add the following information into the
Output File fields. Note that we are adding a TR as a modifier to the file name to designate this as the

training model.

CreateFile (v2023.3.12.1) *

Workset:  C:\Worksets\FDOT\12345678901 v]
Discipline: | STRUCTURES V |@

File Group: | Structure Design Files "|@

File Type:

Base Filename Description

BHALGMNER Alignment and Superelevation for Bridge Design
BHDSGNER 20 Bridge Plan (Proposed)

BH#MODLER Bridge 30 Model

GDTMBR Converted Temain for Bridge Design

Output File:

Bridge File
Seq#: Base Filename: Modifier (Optional] Sequence #: Extension:
B MODLBR [TR | o1 | |-dan

C:Wworksets\FDOTV1234567250 1structures\BO1MODLERTRO1 .dgn

Output Folder: |structures |

SeedFile:  |cdotconnect10.12\organization-civil\fdot\seed\FDOT-OBM-Stuc| | Browse

Cany Coirs Sy [FUBADITHE <

Action:

| Craa‘he—Openl-_lle| | Close |

5. Select the Create-Open File button to open the newly created design file in OBM. The new design
file is automatically created and opened as specified and saved under the corresponding Structures
discipline folder. The Create File window remains open to continue creating as many new design files
as needed. Since we do not need additional new files at this time, close the Create File window.




4 INCORPORATING CIVIL & OTHER DATA

OVERVIEW

Data connectivity among different disciplines has always been the integral part of the FDOT 3D initiative.
Specifically in bridge design and modeling workflows, it is important to be able to reference the applicable
information from various sources including Roadway, Survey, Geotech, and more. This chapter will
introduce the data commonly communicated through different disiplines and how to reference that data into
our bridge model file for use. The exercise will provide participants with practice using reference files and
managing changes during the course of the project.

Roadway data is especially important in OBM. Alignment and profile data must be created, imported, or
referenced first before starting any bridge modeling in OBM. A terrain file is also recommended for modeling
to allow for visual confirmation of elements, as well as the usage of additional OBM tools for substructure
unit placement.

OBJECTIVES

This chapter reviews how to acquire data from other disciplines inside the FDOTConnect environment or
outside. Topics include:

* Roadway alignment from GPK file from earlier versions of Bentley products

« Alignment in LandXML file

»  Superelevation in DGN file

*  Survey data in TIN file

e Survey data in LandXML

* Alignment and superelevation for Dual Bridges

*  GINT file for Geotech

DATA COMMUNICATED FROM OTHER DISCIPLINES

ROADWAY

In general, the necessary roadway data is provided in the \Roadway directory for bridge modeling. This
file typically follows the ALGNRDXX.dgn naming convention, is generated with the ORD FDOTConnect
workspace, and contains all necessary alignment, profile, and superelevation features that are necessary
to complete the project. Once the e is referenced, the user should set the annotation scale as desired and
annotate the alignment, if not already annotated directly in the alignment file: Reports and Drawings >
Drawing Scale > Annotation Scale and Reports and Drawings > Drawings > Element Annotation.

OpenBridge Modeler  + @~ 0 |k b [ 2598 0 I = workset 12345678001] Search Rif
Home Civil Utilities I Reports and Drawings I View Collaborate FDOT Help
tities Report | Deck  — Camb o, [ AL 1=30 v
= Quantities Repo k;ﬂ ec | Camber | i, B ) US Survey Faot - ,:,I I
=1 Input Report TlBeam & Pier o A~ A Custom ACS =
e B = B aBe US Survey Inch |8 . .
& XYZ (5] Bearing ] fgd X 1"=30 ~
Bridge Reeor‘ting Drawings Labels Drawing Sca_le
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Reports and Drawings I View Collaborate FDOT Help
H camber l}%.g - / I — A B
AN TIIT by AEC
| pier A . : T i LpBC B — —
Dynamic Settings Substructure Typical Place Named Adjust Element Drawing
View By Station Section Named Boundary Boundaries Profile Named Bo... [Annotation ¥ | Model Annotation ~

A
—

-«

Drawings

Annotate Element - —

Remove Element Annotations

If the alignment and profile are provided via GPK or LandXML file in the \Roadway directory, a file named
ALGNBRXX.dgn must be created in the \Structures directory. Create this file by using the Create File tool.
Once ALGNBRXX.dgn is created, use the Import Geometry tool to import data. The Home > Import >
Geometry tool in the Bridge Setup group is used to import GPK or LandXML geometry. Before annotating
the alignment as referenced above, define the Feature Definition as an alignment (right click on the
alignment: Properties > Feature Definition > Alignment > Baseline <OR> Centerline). If alignment data
is to be provided for dual bridges for the same centerline of construction, alignment and profile for each
bridge needs to be communicated.

Clarification of profile and alignment affiliations must be communicated if importing via GPK file. GPK files
generally store information for many alignment and profile chains. The user must ensure the profile(s)
and alignment(s) that correspond to one another are selected since the program will not indicate if non-
matching chains are selected. To avoid any issues, select the profile first and the corresponding alignment
will be automatically selected. If alignment and profile are provided in LandXML in the \Roadway directory,
affiliation does not need to be clarified and the files can be used as-is.

OpenBridge Modeler ~ hgl~ HE % L2 0ItE] -
File Civil  Utilities  Reporisand Drawings  View  Collaborate  FDOT

= [ v k OICY 4@8 A T Add Bridge T Move
Q @ o u €& T addUnit &7 Terrain

Explorer Element ... . Import) Bridge ,_, o

= & - Selection «: 7 B v  QwWizard wi Alignment ﬁﬂ.q.Add Multi-Units
Primary Selection m— Jﬁg Geometry  Bridge Setup
'_ m View 1, 3D Bridge Model -5? Terrain

NOTE If Alignment is imported from GPK or LandXML files, proper Feature Definition must be

assigned and the alignment must be annotated inside the DGN file.

The alignment associated with the active bridge unit can be updated or changed. Use the Home > Bridge
Setup > Alignment tool and click on the new alignment after it has been re-imported. See the following
image.

OpenBridge Modeler v v8lv HE % £ 2% 01t s
File Civil  Utilites  Reportsand Drawings ~ View  Collaborate  FDOT
= -8 k 2 @ @ %] Add Bridge % Move
O\ B & n m =2 T2 Add Unit &7 Terrain
Bl o e - o ns9h Aigmment] 5 Add Multi-Urit
Primary Selection Bridge Setup
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The remaining steps to utilize roadway information are similar for each of the approaches. First, reference
the alignment file DGN into the bridge model file. The referenced DGN will have one model with the
alignment and one with the profile, “Default” and “Default-3D” respectively in the image below.

i References (5 of 5 unique, 1 displayed) - X
Tools  Properties
.ET_ - ;'\ﬁ ’ ) [4 B 2 4 4 y Hilite Mode:  Boundaries ¥
= L= B¢ KT £ ! 7 D hi 2
Slot ™ ‘\D A File Name Maodel Description Logical Orientation Presentation | Oj k 1,5
1 ALGNﬁimﬂgn Default Master Model Coincident Wireframe ~ ¥ v
2 ALGNBRO1.dgn Default-3D Master Model Ref Coincident Wireframe
3 ALGNBRO1.dgn Superelevation Superelevation Ref-2 Coincident Wireframe
4 ALGNBRO1.dgn Superelevation-3D  Superelevation Ref-3 Coincident Wireframe
5 A\Survey\SURVRDO1.dgn GTDMRD Terrain Coincident Wireframe
Scale | 1.000000000 : | 1.000000000 Rotation | 00°00°00"
Offset X | 0:0 Y| 0:0 Z|0:0
I:‘ v D B D I D Z \lested Attachments: ¥ | Nesting Depth: | 1
Display Overrides: > New Level Display: ¥ Georeferenced: &

NOTE If an alignment or other reference file has been updated during a session, the user will
see an indication in the “Status” flag and can right click and select “Reload” to update
the reference. Depending on the nature and extent of the changes, any bridge elements
directly using elements from these reference files (alignment, surfaces for substructure
foundation placement, etc.) may update automatically or may need additional manual

updates.

If there is superelevation on the bridge portion of the project, superelevation should be included in the
superelevation model that comes with ALGNBRXX.dgn.

i References (5 of 5 unique, 1 displayed) - X
Tools  Properties
o ;'\ﬁ ¢ 12y ¢ o 0 D A + N ) =
E.: T B X = - o 7, | »<] Hilite Mode: Boundaries ¥
Slot ™ ‘\D 4 File Name Model Description Logical Orientation Presentation | cj k ‘lﬁ
1 ALGNBRO1.dgn Default Master Model Coincident Wireframe v v ¥
ALGNERDngn Defa_ult—SD Master Model Ref Coincident Wireframe
“ 3 ALGNBRO1.dgn Superelevation ISupereIevation Ref-2 Coincident Wireframe
4 ALGNBRO1.dgn Superelevation-3D  Superelevation Ref-3 Coincident Wireframe
5 ASurvey\SURVRDO1.dgn GTDMRD Terrain Coincident Wireframe
Scale | 1.000000000 ;| 1.000000000 Rotation | 00°00°00"
Offset X | 0:0 Y| 0:0 Z|00
l:" : VA D B D { DL_ \Jested Attachments: ¥ | Nesting Depth: | 1
Display Overrides: ¥ New Level Display: ¥ Georeferenced: &
NOTE The data needed for the OBM superelevation tools is in the Superelevation model. There

is no data in the Superelevation-3D model. It often becomes attached along with the
Superelevation model but can be ignored or detached.

If a superelevation DGN file is provided in the \Roadway directory, a direct reference is sufficient to use the
OBM superelevation tools.

Traditionally in design, all profile grade lines (PGL) are given in reference to the Centerline of Construction
and multiple profiles are given at a point left or right to the Centerline of Construction. Currently, OBM cannot
accommodate this versatility. A bridge must be created with a unique alignment and a unique profile. The
limitation is caused by the fact that alignment may not be paired with multiple profiles. If dual bridges are
intended, a separate alignment/profile must be referenced and the second structure created as a separate
bridge (see the Add Bridge section in Chapter 5). Alternatively, dual bridges can be modeled in two separate
files if referencing a single alignment.

FDOT OBM 36



SURVEY

Similarly, survey data from a TIN or LandXLM in the \Survey directory may be imported in a newly created
file using the naming convention GDTMBRXX.dgn within the \Structures directory. Be aware of the
Georeferenced Coordinated System for the project and the ability to add the Feature Definition as part of
the import process shown below.

Bl import Terrain Model(s - O b
Global Options
] x &l Terrain Models AN
a%%irlwd to existing Terrain 0
Tarrain Madal tn annand tn
Projection ~
Target FL83/2011-WF
TargetDescription NSRS11(NAD83/2011) Florida
TargetUnits US Survey Foot v
File Options
Feature Definition aA N
Feature Definition I|Terra\n\Existing\DtmEx\stin ™~ |i
Filter ~
Source File Units US Survey Feet
LandXML ~
Build Terrain From |Source And Definition ™ |
Triangulation Options ~
Import Cptions |Import Terrain Only ™ | 4
Import
C:\Worksets\FDOT\2204955 Design Review\Survey\Existing Ground.xml

If available, a DGN file can also be referenced (without importing) by the user for existing features. When
created as a Design Survey, the SURVRD (Survey Development Model) can serve as a complete survey
database, which contains or replaces various legacy files such as GDTMRD, TOPORD, UTEXRD, etc.
For more information, see the FDOT CADD Manual. Whether a full Design Survey or legacy files, the data
should be available in the \Survey directory.

L References (5 of 5 unique, 1 displayed) - X

Tools  Properties

. s td td S £y

E:E = E M .)2 .) (4 =l s B Ool 1 b g I > Hilite Mode: Boundaries ~

Slot ™ ‘\D ) File Name Madel Description Logical Orientation Presentation | oj k 15
1 ALGNBRO1.dgn Default Master Model Coincident Wireframe ¥ v ¥
2 ALGNBRO1.dgn Default-3D Master Model Ref Coincident Wireframe ¥ ¥
3 ALGNBRO1.dgn Superelevation Superelevation Ref-2 Coincident Wireframe v v
4 ALGNBROT.dan Superelevation-3D __Superelevation Ref-3 Coincident Wireframe ¥ v

“ 5 \Survey\SURVRDO1.dgn GTDMRD Terra_in I Coincident Wireframe v ¥

Scale | 1.000000000 :| 1.000000000 Rotation | 00°00°00"

Offset X | 0:0 Y| 00 Z|0:0
.| |I| e 3 M B D a D & \Jested Attachments: ¥ | Nesting Depth: | 1

Display Overrides: > New Level Display: > Georeferenced: &
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GEOTECH

FDOT has developed a group of Geotech tools within the FDOT tab that is included in both OBM and ORD.
These tools can be used to manage the boring data, plot them in 2D/3D, and generate the Report of Core
Borings. The workflow and spreadsheets are currently developed and documented in the Existing Feature
Modeling course guide.

FDOT | Help
%/ e i = —x @ E E
FDOT Attach Geotech ~ Geotech | Standard Rebar  steel
@Y (Cells Survey Reference |Data Manager Tools~ Packager T00IS™ Shapes %

ons Roadway Place Boreholes In 2D Plan

+ Place Boreholes In 3D Model

Adjust Geotech Named Boundaries

0 Geotech XSection Labeler

%y Report of Core Borings

Prior to their inclusion in the training guides, users can view the “New Geotech Tools for FDOTConnect”
webinar found on FDOT’s Posted Webinar Sessions site:

https://www.fdot.gov/cadd/main/webinars
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EXERCISE OVERVIEW
BERCISE 4.1 Data Communicated from other Disciplines

REFERENCE ROADWAY AND SURVEY DATA

1. Open the data set file: BOTMODLBRTRO01_4.1_Begin.dgn
2. Choose the Reference tool from Home > Primary > References

OpenBridge Modeler b T & H l'_::; Etlf: f |.E'.] E::: ‘@é ¢l :|313|: s
Ltilities Reports and Drawings View Collaborate FDOT

o a o ,& Import ~ @Add Unit &7 Terrain
n A, Bridge Wizard "l Alignment % Add Multi-Units
) - %3 AddBridge & Move

Primary Selection Bridge Setup

3. Attach the alignment file as a reference. First select the Attach Reference button within the References
window, then select the file(s) to be attached and click Open. The alignment file can be found in C:\
Worksets\FDOT\12345678901\Roadway.

E| References (0 of 0 unique, 0 displayed) — x

Tools  Properties

> i ;_‘ ni D5 1. 2 Hilite Mode: | Boundaries ~
Model Description Logical Orientation Presentation [ J k
< >
Scale | 1.0000000 Rotation
Offset X Y z
A k #=00 0 Ny wH® L @ & Mested Attachments: ¥ Mesting Depth:
Display Overrides: ¥ | Mew Level Display: ¥ | Georeferenced: A
E| Attach Reference - C\Worksets\FDOT\12345678501\Roadway' s
Look in: ‘ Roadway v| (€] ¥ 0 M~ EE 20 - V8 DGN
% Name . Date modified Type
. 3 117872003 11:43 AN Fi
Quick access f¥1 ) GNRDO1.dgn 8/15/2023 10:38 AM Bent]
N YV VYV VIV VYV,
Lit.. aries ‘
[! Attachment Method
This PC Interactive ~

Y Y Y Y Y YV Y .y Y.y,

< >
File rame: [ALGNRDO1.don “ [oeen |
Fils of type CAD Flles (“dgn;” cwg;"df) v Cancel
b [~] Save Relative Path Options
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4. Within the Reference Attachment Properties for... window, ensure that the Default model is selected,
the other settings match the image shown below, and click OK.

Reference Attachment Properties for ..\ALGMNRDO1.dgn s

File Name: ..\Roadway\ALGNRDO1.dgn
Full Path:  C\Waorksets\FDOT\ 12345678901\ Roadway ALGMNRDO1.dgn

i | Default d—— -
Logical Mame:

Description: | Master Model

Orientation:
View Description
Coincident Aligned with Master File
Coincident - World Glebal Origin aligned with Master File
Geographic - AEC Transform Calculated Transform, max error 7.589e-07 '
Geographic - Reprojected Reproject reference data to Master GCS

Standard Views
Saved Views (nong)
Mamed Boundaries (none)

Detail Scale: |Full Size 1= 1 -

Scale (Master:Ref): | 1.000000000 : | 1.000000000
Mamed Group: A
Revision: A
Level: -

Mested Attachments: | Live Mesting ¥ | MNesting Depth: | 0

Display Overrides: | Never 4
Mew Level Display: | Use MS_REF_MEWLEVELDISPLAY Cor
Global LineStyle Scale: | Master 4
Synchronize View: |VWolume Only 2

Toggles

EENEE s Do

5. Repeat Steps 3 and 4, but in Step 4 select Superelevation as the model.

NOTE The ALGNRDO1.dgn file generally has “...-3D” models for both the Default and
Superelevation models. However, for the purposes of bridge modeling, we do not need
those models since they do not contain the data we need to target. If they become
attached as references, their display should be toggled off by unchecking the
column within the References window.
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6. Attach the survey file as a reference. First select the Attach Reference button within the References
window, then select the file(s) to be attached and click Open. The survey file can be found in C:\
Worksets\FDOT\12345678901\Survey.

7. Within the Reference Attachment Properties for... window, ensure that the GTDMRD model is selected,
the other settings match the image shown below, and click OK.

Reference Attachment Properties for . ASURVRDO1.dgn et

File Name: .\Survey\SURVRDO1.dgn
Full Path: C:\Worksets\FDOT\12345678901\Survey\SURVRDO1.dgn

TDMRD _ -

Legical Mame:

Description: | Terrain

Orientation:
View Description
Coincident Aligned with Master File
Coincident - World Global Origin aligned with Master File
Geographic - AEC Transform Calculated Transform, max error 7.593e-07 "
Geographic - Reprojected Reproject reference data to Master GCS

Standard Views
Saved Views (none)
Mamed Boundaries (none)

Detail Scale: |Full Size 1= 1 -

Scale (Master:Ref): | 1.000000000 : | 1.0000D0D00
Marned Group: -
Revision: -
Level: A

Mested Attachments: | Live Mesting ¥ | MNesting Depth: | 0

Display Overrides: | Never 4
Mew Level Display: | Use MS_REF_MEWLEVELDISPLAY Cor
Global LineStyle Scale: | Master A
Synchronize View: |[Volume Only A

Toggles

EENE: 7 He B2HE
Cancel

NOTE The terrain model may be a model within an overall SURVRDO01.dgn file, or may exist in a
separate legacy GDTMRD.dgn file.
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8. Use the Fit View tool show the extents of these reference files. Change the Annotation Scale to 1"=30’

by going to Reports and Drawings > Drawing Scale > Annotation Scale. Annotation Scales can be
adjusted as required for viewing and/or plans production.

s View 1 - Top, Default

&g L 20U D G oREE[EYHBE

Reports and Drawings View Collaborate FDOT Help
2
o T L
T o A~ ik Custom ACS N
I Tt MBE . US Survey Inch L PEEETS -
=—— -REE & ™
Drawings Labels Drawing Scale

9. Test out different terrain file view options by clicking the outline of the terrain feature and opening the

Properties window (Home > Primary > Properties). Note that the Properties window may either be
docked or floating. Once there, change the Override Symbology field to Yes. This allows you to override
the symbology without changing the source file. Change the Calculated Features Display and Source
Features Display fields to see what switching between On and Off will do to the terrain model. A
common Calculated Feature is Triangles, which allows the users to visualize the variation of the terrain.

OpenBridge Modeler =
Home Civil Lti

Terrain Model: SURVRDO1
Boundary
Level: DTM_ex

lnnl,runluulun

Explorer _

Primary Sele
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@5 Properties - X
4 %y Elements (1)
> A Terrain Madel: SURVRDO1
General ~ N
Element Description  Terrain Model: SURVRDO1
Na Terrain Model: SURVRDO1
Point Locator_ep
BylLevel (2)
] Bylevel (2)
BylLevel (1)
Primary
(None)
Transparency 1}
Information v
Edge Method v
Calculated Features Display ~
Major Contours Off
Minor Contours Off
Triangles On <ff—
Spots Off
Flow Arrows Off
Low Points Off
High Paints Off
Source Features Display -~
Breaklines Off
Boundary On
Imported Contours Off
Islands Off
Holes Off
Voids Off
Feature Spots Off
Reference ~
el )
Override Symbolo;a; Yes |
v

10. Become familiar with these reference files and their content. Rotate and pan through the 3D Survey
data provided. It may be helpful to open View 2, which is the isometric view. The reference files can be
displayed (turned off or on) individually based on preference.

0 View?, Default [ @ ]
MmO~ 4 PP0adHoREE &Y Y
! View Rotation (left)
Pan View (right)
Open View 2
g.cel] |' Refengnces (3 of 3 unique, 3 displayed) |
| | feke 14151678 i X [s50s005 1116 || Y [1az12765 174 Z [am D AL OE @ X

11. When done reviewing the reference files, close View 2, and return to View 1. Select the terrain model
boundary, open the Properties window and Set Override Symbology to No.
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12. To better navigate the model, we will clip the references so that only the area of the bridge is visible.
Navigate to Home > Selection > Place Fence and draw a fence around the area shown below. The
precise area is not important since we are simply clipping the reference for easier viewing of the bridge

area.

|
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13. After the fence is placed, open the References window, select all of the references, click Clip Reference,
and select the fence. Now if you fit view, only the area of interest will be visible.

References (3 of 3 unique, 3 displayed) — x
Tools  Properties
.E_:E - Ai E‘_‘] v D ¢ Q )—1 3—‘ 3; e Fj g:j é ] Hilite Mode: | Boundaries ~
Slot © B3 FileMame Model Description Legical Orientation Presentation  [&] oj k &
1 JA\Roadway \ALGMRDO1.dgn Default Master Model Coincident Wireframe ¥ oY
2 \Roadway\ALGNRDO1.dgn Superelevation Superelevation Ref Coincident Wireframe YooY
| 3 ASurvey\SURVRDO1.dgn GTDMRD Terrain Coincident Wireframe L |
< >
Scale | 1.000000000 : | 1.000000000 Rotation | 00°00'00"
Offset X | 0:0 Y|oo Z|00
lI‘ !-; i ; "};_ B l;‘ 3] s Mested Attachments: | Mo Mesting ~ | Mesting Depth
Display Overrides: |Mever =  Mew Level Display: | Config Variable ~ | Georeferenced: | No i
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14. Before we begin modeling the bridge, we can turn off all reference displays except the Default model of
ALGNRDO1.dgn by unchecking the boxes shown in the figure below for the open views and save your
view settings by selecting File > Save Settings.

References (3 of 3 unique, 1 displayed) - X
Tools  Properties
EE - Ai o e > ¢ 2 50 2 AS z ; Hilite Mode: | Boundaries =
Slot ™ = 3 FileName Model Description Logical Orientation Presentation [+ J k __
1 .A\Roadway\ ALGNRDO1.dgn Default Master Model Coincident Wireframe L
2 .\Roadway\ ALGNRDO1.dgn Superelevation Superelevation Ref Coincident Wireframe VY
3 ASurvey\SURVRDO1.dgn GTDMRD Terrain Coincident Wireframe ¥ Y
£ >
Scale |1 00 Rotation | 00°00'00
Offset X | 0 ¥ Z|0:0
l:"z‘ : l:‘ l:‘ E l:‘ l:‘ E Mested Attachments ¥ Mesting Depth: | 1
Display Overrides * | MNew Level Display ¥ | Georeferenced g

s View 1 - Top, Default

LpepOdadfesea auy
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5 BRIDGE MODELING

OVERVIEW

All of the prior chapters prepare and build our knowledge for the essential effort of this course: 3D
bridge modeling. At the end of this chapter, the user will be able to create a 3D model of a typical
FDOT bridge structure. The modeling will be accomplished using the FDOTConnect OBM Workspace.

At the time of this training guide release, the following types of structures can be modeled in OBM: Beam-
Slab (P/S or Reinforced Concrete Girders), Beam-Slab (Steel Girders), Reinforced Concrete Slab, CIP
Concrete Box, and Segmental. This chapter covers how to model the common elements of an FDOT
Prestressed Beam-Slab bridge with Approach Slabs. The basics of model creation, as applicable to the
FDOTConnect Workspace, are detailed through the exercises. This chapter, and others throughout the
manual, also provides commentary and tool tips for additional situations that the user may encounter
beyond the scope of this training bridge model development including steel girder superstructures, rebar
non-standard bearings, and more.

There is also a Bridge Wizard tool in OBM added to quickly generate simple bridge components; however,
there are limitations how detailed the user can be in the creation of the model. For example, additional
settings and more detailed modeling options like deck breakbacks are not available requiring the user to
go back to each element for updates. This chapter follows the traditional OBM modeling workflow as this
is more suitable for most situations users are likely to encounter. The user should carefully consider the
limitations before proceeding with this approach.

OBJECTIVES

This chapter covers the steps to build a bridge 3D model built around key tools within OBM including:

* Add Bridge

* Place SupportLine

* Place Deck

* Place Barrier and Sidewalk

* Assign Superelevation

* Place Beam Layout and Beam
* Place Abutment

* Place Pier

* Place Bearing

*  Place Approach Slab

WORKFLOW INFORMATION

The model-centric approach in this training manual is a shift from traditional CADD and Plans Development
workflows. Instead of creating separate views in 2D space, a model is created, element by element, to
serve as the central repository of geometric and other data that is linked and referenced for activities and
deliverables. The steps to create the model build upon each other using the shared data to streamline the
process; therefore, the model progression becomes a critical aspect of the workflow. OBM is built on this
model progression and step-wise approach. This chapter outlines not only the tools, but also the order in
which to complete these steps for successful model development.
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ADD BRIDGE

A bridge model must have a file container. The recommended procedure for creating the active bridge
model file is with the FDOT > Create File tool as described in Chapter 2. Once created, an alignment file
needs to be referenced into the active bridge model dgn file prior to any bridge element modeling.

These reference files may be established by acquiring alignment files from Roadway or may be imported
and saved in OBM files. See Chapter 4 for more details. The alignment can be annotated with station
numbers for orientation with the overall project.

The first step in creating the actual 3D bridge model is to use the Add Bridge tool. The tool is accessed
from the Home > Bridge Setup > Add Bridge. This tool allows the user to add a description for a new
bridge as well as define the bridge type (Beam-Slab, Reinforced Concrete Slab, etc.). Multiple bridges can
be added in the same file, which may be used for certain situations. However, consideration should be
given when determining the number of bridges to add to one file, especially for large projects. The bridge
model files can be referenced and opened as read-only by other users, but only one user can be actively
working in a file at a time. This has implications for work-sharing and also to the extent of lost data if the file
becomes unstable during development.

A method for splitting up longer structures is to use the Add Unit tool. This will place another bridge “unit”
in the active bridge resulting in a similar workflow and procedure outlined in this section; however, all units
in a bridge must use the same alignment/profile.

OpenBridge Modeler v = H I'_::; E:Lf: f g E::: ‘fx; éf :|333|: =
Home Civil Utilities Reports and Drawings Wiew Collaborate FDOT Help
B @  NDI-@X | B impon - £ Terain 2 Place ~
s @ " £, Bridge Wizard %4 Alignment % Add Multi-Units 2 Move
2 & - B - g Move 25 Modify
Primary Selection Bridge Setup Supportline

The Bridge Type is also an important category in the Add Bridge window. The user can select from a
drop-down list of currently available bridge types in OBM. Note that the “Bridge Decorations” Feature
Definition is the default and should be utilized when adding any bridge model. This Feature Definition
is specifically created to take advantage of developments for enhancements in annotation scaling for plans
production.

4'%:—_':.‘:5 dge B

Feature Definition
Mame Prefix

IUse Road Alignment For Stationing [

Main -~
Description |FDOT Training Bridge |
Structure Mumber |123—45I3 |
Requires Foad Alignment ]

Unit -~
MName |L|n'rt'| |
Description | |
Eridge Type |E=eam Slab (P/5 or RC Concrete Girders) o |

Feature ~

| Bridge Decorations

|Eﬁdge
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Once the Add Bridge prompts are completed, the new bridge will appear in the Explorer > OpenBridge

Model window.

NOTE The Explorer window can be turned on and off through the Home > Primary > Explorer tool.

8, Explorer — >
) Resources E= Links

Fle - OpenBridge Model {-| OpenBridge Standards & lems

QS .; s

|5..=a'fre"? ,C‘| 2 ¥

4 @ Bridge Model
> < Civil Data
4 | Bridges
4 |« % Bridge( FDOT Training Bridge ) **
b Complex Element: CL_WB
> A% SURVRDO1

4 v '[Fj‘:‘ Units

B r Unit 1 :: Beam Slab Concrete-Girders Bridge **

PLACE SUPPORTLINE

SupportLines is the terminology used by OBM to describe the lines used to layout the spans of the bridge. At
a minimum, a SupportLine will be needed at every substructure location. For a typical bridge, a SupportLine
will be added at the front face of backwall for abutments (begin/end of bridge station) and the centerline of
piers. Other situations in which adding more SupportLines is beneficial in the creation of a bridge model
include changes in the deck’s width or thickness, changes in the beam/girder framing, or any other variation
in the cross-sectional properties. SupportLines are only linked to the bridge that is active at the time of
placement. If a new bridge is created in the model the user must create new SupportLines for that bridge.

OpenBridge Modeler - -=HE B £ 2(ada 2 s

Primary Selection Bridge Setup

Home Civil Ltilities Reports and Drawings View Collaborate FDOT Help
6 ~ & R v X £t Import = T2 Add Unit  £F Terrain 7 Place ~

@l | o e A, Bridge Wizard %4 Alignment % Add Multi-Units | ¢ Move

Explorer o _ ] . ]
= -~ B -~ %3 AddBridge % Move #7 Modify

SupportLine

SupportLines can be added by several methods: Place by Middle Point, | FpoT Help

Parallel, and Multi. These tools are located in the Home > SupportLine

group and can be accessed in the Place drop-down. The Middle Point 7 Place v <> Pla
tool creates a single SupportLine centered on the selected alignment of .

the activated Bridge Unit. The Parallel tool creates multiple SupportLines Units | %/ Middle Point |
along the alignment that are all parallel to each other. The Multi tool allows o~ 3
for the most control when adding multiple SupportLines and modifying » Parallel

them all at once. #~ Multi |

Once SupportLines are created they can be moved by selecting SupportLine >Move tool. Only SupportLines
created with the Multi SupportLine tool can be revised with the selecting SupportLine > Modify tool.
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PLACE DECK

Once SupportLines are defined, the deck can then be modeled. The deck must be present in the model
before beams and other elements can be modeled. To add a deck, select the Place Deck tool under the
Home > Superstructure group.

OpenBridge Modeler @ & H l'._t:; E:I‘:: * é E::: '495 14 :|333|: =
Home Civil Utilities Reports and Drawings View Collaborate FDOT Help
SRS T T 2% Import ~ T& Add Unit 57 Terrain /¢ Place = | <> Place Deck
— E @3 s g (Q) Bridge Wizard a;q' Alignment E@ Add Multi-Units },ﬂ Move Place Advanced Deck
orer
== N v ridge ove odi eam Layout
g 2 0 % Add Bridge g M > Modi Beam Lay
Primary Selection Bridge Setup Supportline

This brings up the Place Deck window which allows for the selection of the deck template, offset values,
material, Feature Definition, and other parameters. Below is a description of several fields and the OBM
Help Contents material can be consulted for additional information.

(;'%E?:-:e:e: - X

Deck »

Template Name E
Start Station Offset 00 |
End Station Offset 00 |
Horizontal Offset |D:D |
Vertical Offset 00 |
Add Constraints ]
Chord Tolerance |D_‘I 0000000000000 |
Max Dist Between Sections |'I:I3.I |
Analytical Deck ]

Deck Breakbacks -~

Left Start Breakback Distance  |0:0

Right Start Breakback Distance |'I:E
Left End Breakback Distance  |0:0
Right End Breakback Distance [1:6

Material ~
Deck Material 0400 4 4 Concl| ...
Build Order )
Build Order 1 |
Feature Y
Feature Definition |Cnnc:‘e‘te Deck [+ |
Name Frefix | DECK 1 |

NOTE The Feature Definition defines what an element is and controls the attributes of the model
linework for the bridge elements for plans production. The Material field will be directly
used and reported in the Quantities Report (see Chapter 7 for more details).
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The Start Station Offset and End Station Offset values allow the user to place deck segments that span
from points that are offset from the SupportLines, rather than aligned with them. The Horizontal Offset
value allows the user to shift the deck template’s working point to the left or right of the selected horizontal
alignment. The Vertical Offset value allows the user to have the top of the deck higher or lower than the
vertical profile control point.

The Max Distance Between Sections field can be reduced for more refined models with tighter curve radii
to increase model accuracy. However, the drawback of reducing this value is that it can slow down the
performance of the model. The Deck Breakbacks are squared off ends at skewed supports with the defined
distances being measured normal to the edge of the slab. Use of the deck breakbacks will be demonstrated
in deck placement exercise.

DECK TEMPLATES

Templates are used throughout the OBM elements to quickly generate bridge elements, especially
commonly used details. Deck templates are one of the most flexible modeling elements in OBM and many
variations can be accommodated. Below is the Template Selection window showing the provided deck
templates. This is where the FDOT-developed templates for typical decks and approach slabs as well as
Bentley-provided templates are available.

n Template Selection - templates.xml [ Decks\Standard Templates\FDOT Deck Slabs\Deck Slab w/' V-Groove ] - O X

= e e B SH Ttk 1
-----8 TRtpnSiet K)o e- QRS
O “TRDed

o Approach Slab

o Approach Slab-w-MSE-Coping

€ Deck Slab w/ V-Groove - Slope Break LT

€ Deck Slab w/ V-Groove - Slope Break LT/RT
o Deck Slab w/ V-Groove - Slope Break RT
) Deck Slab w/ V-Groove-NoChamfers
) Deck Slab w/o V-Groove-NoChamfers
o Deck Slab w/o V-Groove-NoChamfers_TOHL_L
o Deck Slab w/o V-Groove-NoChamfers_TOHL_R
o Deck Slab w/o V-Groove-NoChamfers_TOHLR
o Deck Slab w/o V-Groove-NoChamfers_TOHR_L
o Deck Slab w/o V-Groove-NoChamfers_TOHR_R
o FSB CIP Topping

) FSB End Closure

7 MuttiCellBox

(1 Parametric Segmental Boxes

™1 Seg Box - Balanced Cantilever

(™1 Seg Box - Span by Span

&
5
5
&

Select Cancel

C:\Worksets\FDOT, 12345678901\ Structures\Bridge Templates\templates.xml

A template provides a single working point used to associate it with the bridge alignment/profile. This
may be directly aligned or offset from the specified bridge alignment/profile. Additionally, the cross slope,
thickness, and geometric properties are controlled by variables and constraints in the template. The values
of these parameters for a anything different than the library template and variations along the length of the
bridge are input with the Variable Constraints window, discussed in the next section.

To access the deck template library, navigate to Utilities > Libraries > Decks. The Template Creation
window that opens allows the user to view, copy, and edit any of the existing templates. Templates are
stored in an xml file of the WorkSet project folder in ... > Structures > Bridge Templates > templates.xml.
If a template from one project needs to be used on another project, there are options to import and export
template libraries via the xml files, see image below. The easiest way to create a deck new template is to
make a copy of an existing template that is closest to the desired deck template. This can be done by right
clicking on an existing template and selecting Copy. The copied template can be renamed as needed, also
by right clicking. Alternatively, a new deck template can be created from scratch using Microstation drawing
tools. See the Place Barrier section for a discussion of using the Edit Geometry and temporary view feature
of the Template Creation window.
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Termnplate Creation - ternplates.xml [ Decks\Standard Templates\FD

¥ | =
[x ] ¢
=27 Standard Templates -~
=1-{Z] FDOT Deck Slabs
----- ) _TR-AppSlab
----- ) _TR-Deck

----- ) Approach Slab

----- Approach Slab-w-MSE-Coping
o

_____ P4 ] Dok Slabmmabhe e

1.."
..... ) Deck Slabl “! Rename
----- ) Deck Slab x Delete T
..... O Deck Sla & C
..... © Deck Siat il
..... O Deck Slab Mirror
----- ) Deck Slab Edit Descripticn LL
..... ©) Deck Siab . LR
..... o Deck Slab = Edit Geometry LR
..... € Deck Slab  Verify RL
..... ) Deck Slab wrervisroove-MoCHamrers~TOHR_R

----- {3} FSE CIP Topping
----- {3} FSB End Closure
ot W 1 1R 5T [ =10

Templates are made up of Points, with the relative location of each Point controlled by one or two Variables.
The Working Point (WP in the graphic) that follows along the profile and can either be a unique point or
coincide with another point on the template. The other points should be assigned working out from the
WP, by assigning the Mode of relative location assignment with the Points Constraints section. The Mode
Options are: Horizontal, Vertical, Slope, Offset, Angle, and Distance.

Pairt Constraints Comer Attributes
Mode Honzontal + Slope Mode Chart
Constrairt }
Type Horizontal
Mone Maone
Farent — ol Harizantal
Valie 134 | |vertical Vertical
Varisble [PGL_to_RT Coping +| |*'°P¢ Slope
Offset Offset
Angle Angle
|
Distance
QK Cancel
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Once the Mode is selected, the Parent point is chosen. This will be the point that will have the constraint
modes applied to determine the next point. Next the Value of the constraint is set. For example, if the
Working Point is chosen as the Parent for P_1 with a Horizontal constraint Value of 10:0 and a Slope
constraint Value of 0.02, P_1 will be placed 10ft to the right of the WP with a slope of 2% upward from the
WP. The Variable section is optional but can be used to name certain constraint/value relationships that can

then be edited using the Variable Constraints before or after placement of the deck.

Corner Attributes can be used to set a Fillet, Chamfer, or Asymmetrical Chamfer. Depending on the
Level of Detail required for the model, this can be used to modify the corners from being squared off.

Comer Attnbutes

Mode Chamfer W
Distance ;{}_D 374

Variable

The Superelevation Flag box should be checked for all top deck points, as those are what will be controlled
when a Roadway superelevation shape is applied to an OBM deck element.

Edit Details

Mame |P_1 | Superelevation Flag

The Key Points tab will display the corner points of the current deck template and are editable if needed.

Poirtt Details

TopLeft (TL) [P_5 - Top Right (TR) [P 1 -

Bottom Left (BL) |P_4 v Bottom Right (BR) |p_2 -

The green Verify checkbox at the top of the Template Creation window can be used to test the defined
Variables within the selected Deck Template. Various values can be entered and the graphical representation
of the deck template will adjust based on the input.

Template Creation - ternplatesxml [ Decks\5tandard Ternplates\FDOT Deck Slabs\Deck Slab w/ V-Groove |

B9 X T X 0 [H]v e

R]® 8- QRE B S

.9
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_TR-Deck — O >
]

ST SIS b G Ea [ 1 Name Value
o &-1g % & = 1% v [«

-~

RT_Slope 0.02000000...
Thickness 0:81/2

V Groove ... |0:01/2
LT_Slope 0.02000000...
PGL_to_LT_... |-40:5

Once the template is completed, it can be used with the Place Deck tool.
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V(
VARIABLE CONSTRAINTS

The variable constraints window can be accessed while creating a new deck or by selecting a current deck,
opening the properties window, and clicking the “...” beside the Variable Constraints field. See the following

figure.
@ Properties — =
4 % Elements (1) .
| General w [~
Deck N
MName DECK 1
Description
Template Mame _TR-Deck
Analytical Deck True
Start Station Offset 0" 0™
End Station Offset 0" 0"
Herizontal Offset oo
Wertical Offset o o"
Template SELECT to Edit
Chord Tolerance 0 3 15/16™
Wanable Constraint  SELECT to Edit
Point Cantrol SELECT to
Top Surface Ares 14497 9/16 5q.°
| Deck Breakbacks L4 |
| solid v,

The image below shows the variable constraints window with boxes calling out the different sections of the
window. Descriptions follow the image.

SingleDeckTemplateWindow — O X

A Variation

FFBW END BENT 3

FFBW END BENT 1

Value

r T T T T T T
2020+08.46 2020+58.46 2021+08.46 2021+58. 2022+08.46 2022+58.46 2023+08.46

Variable Constraints

= Variables =1 2020+08.46 - 2023+34.30 _TR-Deck PGL to_LT Coping Default = -40:5

o vart -
3 Variable Active Default Errors Expanded View @ Grid View
o

s T Slope ~ | 0.020000000000000 .

-—- AddSection  Mode: Supportline  + 00 * From  FFBW END BENT 1 MEE S X Delete Selected

% PGL_to_RT Cop v 40
FD Copy To Variable

:
.

2 Rotation By An 00°0000" :

F p

Rotation By S 0.000000000000000 i

- otatian By Sla 4 tocationtype [P from tart Distance End Distance **'  tart Value End Value  Transition

= RT_Slope ~ | 0.020000000000000 - Cecation engt

doess v 0812 4 station 2020+08.46 202040846 | 202147213 1638 -40:5 -255 Linear

E\ Groove Dept 100172 g L sl er2n (20303430 (122 55|

0K Cancel

FDOT OBM -



Solid Red Box — Selection between viewing windows. The “Variation” Window is shown in the screenshot
displaying the details of the selected variable. The “Template” Window shows the cross section of the
selected template.

Dashed Red Box — This Variable table has 4 columns. The Variable column lists the variable names as
defined by the selected template. The Active column contains check boxes for each variable, that can be
checked if the desired inputs for that variable are different than the values brought in by the template. The
Default column shows the values given by the template and will be used if the check box is not checked.

Solid Green Box — This window shows the change in the selected variable over the length of the active
bridge. Changes can be made only if the checkbox for the selected variable is checked. The screenshot
above shows the details for the PGL_to_LT_Coping variable, which has a changing deck width from
station 2020+08.46 to 2021+72.13. The width is then unchanged until 2023+34.30. The Mode controls
what method is used to determine the location of the transitions. The options are SupportLine, Ratio by
Span, and Station. There is an accompanying input for either the offset values, ratio, or station. Linear,
Parabolic, and Circular transitions are accommodated.

Dashed Green Box — This window shows a graphical representation of the information put in the Solid
Green Box. The y-axis represents the values for that variable, and the x-axis follows the stationing of the
selected deck.

The exercise at the end of this chapter shows the user how to use these features in practice.

Offsets are used to control the deck location, horizontally and vertically, from the bridge alignment and the
Work Point in the deck template. For example, a horizontal offset is required if using a Centerline Alignment
for a dual highway structure as the bridge alignment in order to keep the Work Point for the deck template
in the correct location for the left and right structures.

There are Feature Definitions provided for both Deck Slabs and Approach Slabs. Selecting the proper
Feature Definition will place the elements on the correct FDOT levels in the model space and also any
linework in views or sections for plans production purposes.

PLACE BARRIER

Barriers are placed directly onto the deck of the active bridge and are referenced either to an alignment or to
a point on the cross-section of the deck. The user should be able to add a barrier by selecting one of those
alignments or deck points, a barrier template (cross-section) and adding it to the bridge model.

To place a barrier on a deck, go to Home > Accessory > Place Barrier (see below)

g@ Place Pier (i, Place Custom Abutment rJi'ﬂ Place Excavation ET:F‘ Place Paint s

{:j Place Abutment Q Place Wingwall “\_ Place Path @

ﬁ Place Custom Pier €9 Place Bearing ,O Place Barrier &
Substructure Accessory Approach Slab
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Once the Place Barrier tool is selected, the Place Barrier window will open, shown below. This box is where
the user will choose their inputs for the placement of the barrier. Clicking the “...” beside the Template Name
field will open a window that will allow the user to choose which template they want. Each side barrier/railing
template typically has two versions, a left and a right. The user should be sure to select the correct one
for each respective side of the deck. Note that the templates cannot be modified without going back to the
Utilities ribbon and changing the template.

7 Place Barrier - x
Barrier ~
Template Name |521-427: 36" Single Slope ||| ..
Start Station Offset 00 |
End Station Offset 00 |
Horizontal Offset |-‘I 6172 |
Vertical Offset [0:0 |
Material )
Barrier Material |0521 5 13_Barrier - 36" Sir | .
Fay Unit |Unear Init W |
Solid Placement L]
Chord Tolerance |D_'I 00000000000000 |

Max Dist Between Sections [16:4 7/8 |

Template Orientation |‘-Iertica| w |
Start Cut Orientation |Fl:|||l:lw Skew o |
End Cut Orientation |Fl:|||l:lw Skew o |

Build Order .3
Barrier Build Order |‘I |

Feature ~
Feature Definition |Traﬁic Railing o |
Name Prefix [BARRIER 1 |

Many of the fields in the Place Barrier window are act in a similar fashion to those previously discussed in
the Place Deck window. Start Station Offset and End Station Offset values allow the user to place barrier
segments that span from points that are offset from the start/end of the selected deck, rather than align
with them. The Horizontal Offset is where horizontal adjustments should be made to accommodate for a
template that has a WP that is not on the coping. A negative offset will move the barrier to the left of the
guideline chosen, and a positive offset will move it right. Likewise, the Vertical Offset values allow the user
to shift the barrier template’s working point to the above or below the selected guideline.

The Orientation fields control how the templates are extruded along the bridge. The Template Orientation
field can be set to Vertical if the template faces should be vertical in the Z axis, or it can be Normal if the
template should be perpendicular to the deck template upon which it is placed. The Start Cut Orientation
and End Cut Orientation fields dictate if the ends of the barrier should be Normal to Path or Follow Skew.

FDOT OBM 56



I e _———ca——

Once the inputs are correct the user is prompted to select the deck(s) for which they would like to add
barriers. Multiple decks can be selected to place the barrier on at the same time.

B Defas e
[E-aln-d 2PROADHSREEEUXE:
/% Place Barrier - x
Barrier ~
Template Name 521427: 36" Sin .|
Start Station Offset 00
End Station Offset 00
Herizontal Offset 00
Vertical Offset
Select Candidate: Deta Point on
et gt Lot et o Materil =
ion Barrier Material 0521 513 Barie [ |
Unit 1 DECK 11DECK 1
Level: DeckConc_pm Pay Unit Linear Uit
Solid Placement ~
Chord Tolerance: 0.100000000000000
Max Dist Between Sections  16:4 7/8
Template Orisntation Vertical /
Start Cut Orientation Follow Skew
End Cut Orientation Follow Skew
Build Order -
Barrier Build Order 1
Feature ~
Fezture Definition Traffic Raiing
Name Prefix BARRIER 1
%r-

End the selection by right clicking in open space, and then data point in open space to open the Path
Selection window.

Ll Fath Selection - E

Candidate -

| Select Alignment |
Select Guideline from List

|4::h:||{:am||

To pick an alignment from the roadway geometry, click Select Alignment. The user can create auxiliary
alignments if needed for geometrically complex situations such as gore areas. To pick an alignment using
one of the control points from the deck template, click Select Guideline from List. Either method is valid
and will depend on individual situations; however, the Select Guideline from List method is more helpful
in most applications as it does not depend on individual alignment locations but rather on key points of the
deck template such as the top edges or the break points.




If using the Select Guideline from List option another Path Selection window will appear with an image
of the deck template cross section and a list of the Guideline Point Names. In the previous step the user
chose the right barrier template in the barrier template selection with a corresponding deck point at the top
right corner. In the figure below, this is P_1.

o7 Path Selection — O -
Guideline Point Name | Bl 2 k=4 | £- 3+ T $n Tn H 1
F0 x| o8- QR =%

P_1.comer.end

P_1.comer.star
P_10

F_1

P_2

P_2 comer.end
P_2 comer start
P_3

P_4

P_4 comer.end

P_4 comer start

F_5 b

Ok Cancel

Select OK in the second Path Selection window and make sure that there is a blue check mark where the
question mark used to be (see below)

Candidate —

= v

Select Alignment
Select Guideline from List

0K Cancel

Click OK again to place the barrier. In the image below, take note of the boxed offset.
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Another element that can be created with the Place Barrier tool is a sidewalk. Because they are similar
to barriers in that they are linear components that are extruded along a guideline, sidewalk templates are
set up with a WP in the same way as a barrier template. FDOT has developed sidewalk templates that
can be found in the barrier template library and will be discussed in the following section. Once a sidewalk
has been placed in a model with the Place Barrier tool, it is also eligible to be selected as a candidate for
barrier placement. This will be demonstrated in a later exercise but can also be seen in the following image.

é“@‘ Place Barrier

Barrier -~
Template Name l:l
Start Station Offset [11]

End Station Offset
Horizontal Offset 00
Vertical Offset

Material ~
Earrier Material 0521 5 14_Banie l:l
Pay Unit Linear Unit

Solid Placement -~

Chord Tolerance 0.100000000000000

Max Dist Between Sections  16:4 7/8

Template Orientation Vertical

Start Cut Orientation Follow Skew
Select Candidate: Data Point on . .
Candidate to add / Data Point on End Cut Orientation Normal to Path
| i Candidate to sut /Resetto

end selection

T SIDEWALK 2 \
Template : Left Sidewalk_Flex AP
Projected Length : 29:4 5/8

Level: SidewalkBrdg_pm

Build Order

Barrier Build Order

Feature

Feature Definition Traffic Railing
Name Prefix BARRIER 1




BARRIER TEMPLATES

Barrier templates have already been created and are available to all FDOTConnect users. These templates
can be found in Utilities > Libraries > Barriers.

OpenBridge Modeler @ oldEERE e > 2855 0 S Workset: 12345678001 - B
Home Civil Utilities Reports and Drawings View Collaborate FDOT Help
_—_: N * 0 Decks J]_ Columns @Abutments Q Material > Connection m Connector Angles
ﬁBamers D Footings QWlngwall xStif'feners # Shear Studs

. LEAP LEAP _RM ProStructures Templates Expor‘t
Bridge Concrete»  Bridge Steel = Bridge = v Terrain =~ J[ Beams @ Piers & SleeperSlab [)¢] Cross Frames ,}' Splices
Interoperability Import/Export Libraries

Clicking on this tool will open the barrier Template Creation window, showing the folders with the different
templates currently in the user’s library. The user should have access to current Standards Plans FDOT
barrier templates, Legacy FDOT barrier templates, and sidewalk templates. See below.

Template Creation - termnplates.cml

M| |e*

SR Bariers

. -] FDOT
-7 FDOT Legacy
-7 Sidewalks

Before adding a barrier to the model, it is important to know where the working point (WP) is located for the
template used in the model. The WP, as discussed in the deck creation section above, is the base point
used to orient the object on a certain alignment or control point. Adding a barrier to the model will have the
user select a point on the deck to align with the WP on the barrier. To place the barrier appropriately the
Horizontal Offset is used to offset the working point from the selected deck point (generally the coping).
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The below image shows an example of a template that needs an offset to fit properly on the deck for both
an FDOT Legacy and a typical current FDOT Standard Plans barrier. Because the working point is placed
on the curb side of these barriers (gutterline), the Horizontal Offset should be the total width of the barrier
plus any additional width to match with FDOT standards, or the distance from the gutterline to the coping.
Browse the barrier templates to see the various WP locations for each barrier.

Qutside
Edge
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The Template Creation window can be used to view and modify different templates in the user’s library.
There are very few occasions where the user will need a custom barrier since the FDOT barrier library
encompasses all the standard barriers. If there is a situation where a user needs a barrier outside of the
FDOT and OBM barrier library, a new template can be created from scratch or by copying and modifying
an existing template. If creating the template from scratch and the geometry of the barrier exists in a dgn at
the proper scale, the linework can be used.

Custom barriers should be added to their own folder in the WorkSet template library. This can be done by
right clicking the Barriers folder and selecting Add Category. With the new subfolder created, right clicking
on the subfolder and selecting Add Template will create a blank barrier template.

Template Creaticn - templates.cml [ Ba

= [ B <

ok

=1 Bamiers

: Ell:l Custom Bamiers
PGS TEST Barier
-9 FDOT

i l:l FDOT Legacy

{:l Sidewalks

Once the name and description are entered for the new template, the Template Creation window will go into
the background for a view selection. At this point, any view can be selected from the View Toggles at the
bottom of the program window to be used for the temporary view; selecting one will not affect the current
content.

5% - £ ~ &5 - [& pefauit vl f=li A EAHGE

» Template Designer > Select View For Template Design |Temp|ate Designer > Select View For Templ

A temporary view opens with nothing but a Working Point (WP). Often the temporary view windows will
need the Drawing Scale adjusted from the default. This can be adjusted as needed in the Reports and
Drawings > Drawing Scale > Annotation Scale.

The temporary view is where the custom barrier shape will either be drawn using the Microstation tools
within the Drawing workflow or referenced from an existing dgn. Generally, the WP would be the barrier
point that defines the gutterline. The order that the segments of the barrier are drawn will determine the
automatic sequence of numbering for the Points. If existing linework is referenced and merged from another
dgn, the Point numbering can be adjusted afterward if needed.

Once the linework for the barrier is completed in the temporary view, click the Import Template From
Model button on the right side of the view toolbar.

B View 1, OBM-TemnplateEditor-ternporary
mr-w- AR 0m A AY

With the barrier geometry defined, the Point Constraints can be used to set each point relative to each
other. The available constraints are the same as those for the deck templates, with an additional option of
Elevation Provider.
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Whenever a Mode is selected for the Point Constraint, the point relationship based on the current geometry
will be filled in. Since barrier points are generally rigid, the points can often be constrained based on their
default Parent/Value relationship once the Mode is selected. If desired, the Variable input can be filled in to
assign a given dimension to an editable variable.

Point Details  Key Points

Points

Edit Details
Name Typel Type2 WVariable1 Variable2
Name [P_0
Horizontal
P Horizontal | Vertical Curb_Height Point Constraints
P_2 Horizontal | Vertical Curb_Width Mode | Horizontal + Vertical |
P_3 Horizantal | Vertical Bamier_Height
Constrairt Constrairt
P_4 Horizontal | Vertical Barmier_Width
P_5 Horizontal | Vertical Type Horizantal Vertical
Parent Working Poirt i Working Poirt ~
Value
Varissle

Similar to deck templates, barrier templates are stored in an xml file of the WorkSet project folder in ... >
Structures > Bridge Templates > templates.xml. If a template from one project needs to be used on
another project, there are options to import and export template libraries via the xml files.

Ternplate Creation - templates.scm
El 2]

-] Barmiers
-0 Sidewalks

After the Point Constraints are set, the custom barrier can be used with the Place Barrier tool.

ASSIGN SUPERELEVATION

Superelevation can be assigned in several ways within OBM. The most direct method is to use the Assign
Superelevation tool found at Home > Superstructure > Assign Superelevation.

2 Place Deck I Place Beam ,22‘ Place Stiffeners % Place Shear Studs ?; Closure

'Iu;r Place Advanced Deck -@' Place Diaphragms I)(I Place Cross Frame _ﬁ Report

|E] Beamn Layout Place Steel Tubs @ Place Field Splices 37y Place Segmental ~ {47 Constraints
Superstructure

This tool utilizes a referenced roadway dgn file with the Superelevation information already included. In
order to use this approach, the correct roadway file must be attached and the reference turned on.
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The Assign Superelevation tool uses the points in the deck template to assign the cross slope along the
length of the deck. The points that should be tied to the Superelevation file need to have the Superelevation
Flag checked in the Template Creation Window (See below). These points are usually the points along the
top of the deck.

+ [ BSH 31 %R NE K 1
Koo a0 =S
A

=21 Standard Templates
{51 FDOT Deck Slabs
) _TR-AppSiab
O _TRDeck
© Approach Slab
) Approach Slab-w-MSE-Coping
€% Deck Slab w/ VGroove
) Deck Slab w/ VGroove - Slope Break LT
{3 Deck Slab w/ VGroove - Slope Break LT/RT
) Deck Slab w/ VGroove - Slope Break RT
) Deck Slab w/ VGroove-NoChamfers
O Deck Slab w/o V-Groove-NoChamfers
3 Deck Slab w/o V-Groove-NoChamfers_TOHL_L
) Deck Slab w/o V-Groove-NoChamfers_TOHL_R
{3 Deck Slab w/o V-Groove-NoChamfers_TOHLR v

Point Details  Kay Points

Points Edit Details
N Typel | Typsz | Varablel Variable2
i s bl bl bl Name [P_D [ Superelevation Flag || [ Elevation Report
T
P Horzotal | Slope  PGL_to_RT_Coping  RT_Slope FPoirt Constreints Comer Atibites
P2 Horzortal | Vertical Thickness Mode P — Mode  [Norm -
P3 Horzortal | Vertical Thickness

Constraint Constraint
P Horzortal | Vertical Thickness
P 5 Horzotal | Slope | PGL_to_LT Coping |LT_Slope Type  Horizontzl Vertical
P& Horizontal | Slope RT_Slope Farent  |Working Point el Working Point ~
P7 Horizontal | Vertical V_Groove_Depth valie | [00 | Joo |
s Horzortal | Slope RT_Slope varisie | <] ‘ 7
X Horzortal | Slope LT_Slope Retation
P10 |Honzontal | Verical V_Groove_Depth [ oot tate
P11 |Horzontdl | Siope LT_Slope

Save Cancel

Close

C:\Worksets\FDOT\1 23456?3901\Stru:tures\Br\dHe TEmEhtES\tEmE‘EtES‘Xm‘

After the prompts are followed and the Superelevation section and deck element are selected, the
Superelevation Assignment window is available.

Superelevation Assignment
La Lane Offset Pivot Start End Stati Start S End E}ation& Template
nes Detail 8 Pairt Station lon - Jlat slope Slope D;paﬁ Pairt
b |ishOuer [v|saion . [856172 [P0 |v|34240353. |13.5353. 00ss2as10.. [0.02000.. ERCCNEMF 5 |~
Leflner |~ | Station ... |-32:0 PO |v|342+0353.. | 343+5353.. |0.04424510.. |0.02000... |Station .. |P_1 v
oK Cancel

The current version of OBM makes the Superelevation Point selection process slightly cumbersome.
The Pivot Point and the Template Point cannot be the same value in the same row. For example, say
that the Pivot Point for the Leftlnner row is desired to be P_0. If the Superelevation Assignment window
automatically brings in P_0 for the Template Point field, the user should:

1. Change the Template Point to a value different than the desired Pivot Point, chosen from the dropdown
arrow.

2. The dropdown window for the Pivot Point should now display P_0 as an option.
3. Go back to the Template Point dropdown window and select the desired value.

Note that a positive slope in a Superelevation file from ORD: going from alignment outwards. Slanting
upward while looking down station is considered positive slope and slanting downward is negative slope.
OBM on the other hand, has positive and negative slope consistent with the slope of a line in a cartesian
coordinate. Additionally, in OBM, Superelevation grade and signs are in reference to the Superelevation
pivot point, not as assigned in the Superelevation definitions in ORD. Superelevation in OBM will not allow
pivoting points outside the deck template.

If the user wishes to modify the variable constraints of the deck (other than the cross slope), they must do
so after the Assign Superelevation tool is used. Using the Superelevation tool will effectively eliminate any
modifications to other variable constraints of the selected deck.
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Users can also manually assign Superelevation using the Variable Constraints window by accessing the
properties of a modeled deck component.

@1 Properties (OpenBridge Model) - *
4[] Selection {1)
3 DECK 1

Selection v |~
General v
Deck ~
MName DECK 1

Description

Template Name Deck Slab w/ V-Groove

Analytical Deck True

Start Station Offset o o”

End Station Offset oo

Horizontal Offset oo

Wertical Offset oo

Template SELECT to Edit

Chord Tolerance 0 3 15716™ \

A= [ Betpcen Cactin 1

Variable Constraint Ea!aiu:il
FRInT Lontro L T to Ea

Top Surface Area 8866 1/8 5q."

Deck Breakbadks v
Salid v
Feature -
Feature Definition Concrete Deck
Fuild Airdar - v

NOTE The properties.of any model element can be accessed by hovering over the element and
selecting the tool or by bringing up the Home > Properties under the Primary group.
The user may even want to dock the Properties tool for easy access while creating models.

From this window, you can select the Variables for deck slope and define the start/end stations and slope

values for the Superelevation transition. Additional transition points can be added by clicking the green + in
the Add Section area.
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SingleDeckTemplateWindow

m} X

u
E

Supportline2
Supportline3
Suppaortline4

r T T T T T T T
342+03.5300 342+23.5300 342+43.5300 342+63.5300 342+83.5300 343+03.5300 343+23.5300 343+43.5300

Station Distance

Variable Constraints

Variables 342+03.5300 - 343+53.5300 Slab w/ constraints LT _Slope_Lanel Default = 0.020000000000000

Variable Active Def  Errc Expanded View @ Grid View

LT_Width_Lanel ~ -20:0 Add Section  Mode: | Supportline = 0:0 ' From | Supportlinel =

Rotation By Angle* 007001
R X Delete Selected
Rotation By Slope* 0.0000
RT_Slope_Lanel v -0.0201 [0 Copy To Variable
RT_Width_Lane1 v 20:0 :
A | . Relative c 5 Interval Start End -
Thicknese = 0012 Location Type 1 ion From  Start Distance  End Distance Length Value Value Transition
NN 424035300 342.77.0000 73558 MG

Station 342+77.0000 342+ 77.0000 343+53.5300  76:6 3/8 0.020000001 0.02000000( Linear

0K Cancel

NOTE After the Assign Superelevation tool is used, the Variable Constraints window shows the
values used in the model.

If the Assign Superelevation tool is used, the parameters used for the cross-slope transitions can be viewed
in the Variable Constraints window, as well. However, these parameters cannot be deleted or modified in
this case. The only way to remove the superelevation values or modify the parameters after assigning is

to right click on the specific deck element in the Explorer window and select Remove SuperElevation as
shown on the following page.
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PLACE BEAM LAYOUT

The beam layout of a model acts as the framing plan for the bridge. To add a beam layout, select the Home
> Superstructure > Place Beam Layout tool.

3 Place Deck I Place Beamn Place Stiffeners Place Shear Studs 4 Closure
Place Advanced Deck -‘LJ Place Diaphragms || Place Cross Frames = Assign Superelevation B Report

H Bearn Layout Place Steel Tubs Place Field Splices Place Segmental Constraints

Superstructure

The resulting 2D linework in plan view generated by this tool is placed at elevation zero (Z=0) and are
placed on a “decoration” level. Note that the beam elements are not modeled in this step (that occurs
with the Place Beam tool described in the next section). Instead, the number of beams per span, beam
spacing, SupportLine offsets, and whether the beam has skewed ends are controlled in this tool. Below is
an example of the Beam Layout window.

The initial beam spacing can be set by modifying the Number Of Beams and the Edge Distance (overhang
width). Within the table, varying beam spacings or overhangs can be accommodated. The way that the
beam spacing is measured is set in the Method column of the table and chosen as Normal to the deck or
Along Skew. The SL Offset is the distance along the beam centerline from the controlling SupportLine to
the end of the beam. With the given options for beam layout, almost every framing plan can be modeled.
Clicking Validate will allow the user to temporarily view the placement within the model of the current beam
layout. Clicking Save will finalize the adjustments and close the window.

Beam Layout - u] X
Alignment | CLWB Select Aux Alignments v Add Delete
Placement Method Simple
Spans Details
Default Span | FFBW END BENT 1- CLPIER2 ~ Number Of Beams 52 Edge Distance () 0:0 Apply ¥ Equal Edge Distance
Set All To Default Same Beam Start/End Values Advanced Bearing Definition
Show Dverhang Lengths () BEAM START BEAM END REFERENCE
S Use
- Dtaic Spacing (') Method SL Offset () Spacing () Method SL Offset (")
acin etho acing o
CLPIER 2 - FFBW END BENT 3
> Nomal W fomal| W] longCrord [ENEE T |
Beam-2 | -27:10 Normal | 9 -27:10 Normal | -3 Long Chord v
Beam-3 | -185 Normal |9 -18:5 Normal | -3 Long Chord v
Beam-4 | -9:0 Normal |9 -90 Normal | -3 Long Chord v
Beam-R | 0:5 Normal | 9 05 Normal | -3 Long Chord v
Validate Save Cancel

NOTE Using the Set All To Default checkbox or the copy/paste (Ctrl+C & Ctrl+V) functionality can
be an efficient way to add the beam layout in multiple spans.
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PLACE BEAM

With a beam layout in place, the user is now ready to add 3D beam elements. To model the beams,
navigate to and select Home > Superstructure > Place Beam. A window will open with different beam
placement options.

Default Type ~
Custom
Orientation -~

llze Beam Rotation O

Build Order -~
Build Order 1

Feature Lad
Feature Definition Girder w
Mame Prefix GIRDER 1

Follow Deck Edges -~

Follow Left Deck Edge [
Follow Right Deck Edge [

By default, the Name Prefix will be set to GIRDER 1 and each additional beam group will increment up
by one number. However, different inputs can be used to describe the beam type based on the material,
for example “ConcBeam” or “SteelGirder.” This can be helpful if there are both concrete beams and steel
girders on a bridge. In this case, the user would need to use the Add Unit tool since different Bridge Types
would need to be selected.

A beam layout must be selected to open the Beam Definition window. This allows for defining minimum
haunch thicknesses, beam sections, and beam material. See the Beam Definition window and corresponding
information.

e
Beam Definition — o X

Beams Details
ETTETT RS = e S S R S M S S R R A S M S
Haunch Rotation Angle

Cm] IEEa'ﬂ Type | Custom = Haunch Start () Haunch End () ——
Beam-2 Min. Clearance ()| 0172 Camber ()| 2

Beam-3 7| Compute

Beam-5 Add || X Delete 5 Delete Al |, Sort Beam Copy

4 CLPIER 2- FFBW END BENT 3 Locat Rt Start Section Different
T o From T Length Start Template End End Template Material
e ocation 5] ) Template

Beam-3
Beam-4 w1 ] Drawing Enabled
u

Beam-5 = Cross Section Dist. () | 00

Beam-4 I

Beam-1

BX-0 T xa 08
.
IRJod- g RiE = e 4- g Rik

I Apply To All Beams oK Cancel
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Solid Red Box — This Beam List is determined by the Beam Layout created in the previous section. This
particular Beam List contains 2 spans of beams with 5 beams across the width of each span. Using the
Apply To All Beams check box called out by the Solid Green Box in the bottom left of the window allows
the user to make changes to one beam and apply it to all the beams in the Beam List. See the image below.

Beam Definition

Beamns

4 FFBW END BENT 1 - CLPIER 2
Beam-1
Beamn-2
Beam-3
Beam-4
Beamn-5
4 CLPIER 2 - FFBW END BENT 3
Beamn-1
Beam-2
Beamn-3
Beamn-4

Beamn-5

Ll N SN S N S N

Apply To All Beams

NOTE Using the Apply To All Beams checkbox functionality can be an efficient way to add the
beam sections and other parameters in multiple spans. The check can always be cleared
to make individual beam modification as needed.

Dashed Green Box — This Details section is where the user can modify the beam type, haunch, beam
dimensions, and the chosen template. The Beam Template Library can be found in Utilities > Libraries >
Beams. This is where the templates can be viewed and modified prior to selection.

Haunch Rotation Angle
Beam Type | Custom = Haunch Start (") rg Haunch End (7) 3 Calculated
Min. Clearance (') (172 Camber (%) | 2

v Compute

o= Add | X Delete | y® Delete All || Sot | [[] Beam Copy
N — Start Section Different
From T | ength Start Template End End Template Material

Type Location

NOTE The haunch thickness can be manually entered for both the start and end of the beams.
Also, the user can check the Compute box and provide the minimum haunch at the
edge of girder and the total net camber at midspan to allow the software to provide the
haunch thickness. Note that the camber is not modeled, only used to determine the
required haunch thickness.
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Dotted Red Line — This window contains drawing views of the selected beam. The left view window shows
the span of the beam, and the right view window shows the cross-section of the selected beam template.
Clicking the arrow next to Drawing Enabled will enable or disable these drawing views. See the red arrow

in the following figure.

4| Drawing Enabled fm—

Cross Section Dist. () | (:0

X131 X2
DR =% xos- g2 1%

After the information for the first beam is changed according to the desired inputs and the Apply To All
Beams is checked the user can select OK to create the beams in the model.

-8l A PPROAD HEEERGTXD

To return to the Beam Definition window for the beams just created, the user must select the Beam Group
for the active bridge in the model space and open the properties window. In the Beam Definition field select

the “...” to open the Beam Déefinition.
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PLACE ABUTMENT

After the beams are created, substructure units can be added to the model. To add an abutment, select the
Home > Substructure > Place Abutment tool.

5@ Place Pier (), Place Custom Abutment i) Place Excavation

c,r;j Place Abutment Q Place Wingwall

1l Place Custom Pier &3 Place Bearing

Substructure

Similar to deck elements, templates are used to generate abutment elements. However, the substructure
templates, especially for the abutments, are less flexible than the deck templates and the user may not be
able to model these elements to a high level of development with the provided tools in OBM. A higher level
of development can be accomplished with a Custom Abutment using a parametric cell, and/or using solids
modification tools. See the Chapter 5 abutment exercises for parametric cell use and see the Chapter 8
solids modification exercise (EXERCISE 8.1) for some solids modification use cases. FDOT has developed
a parametric cell for one of the standard FDOT end bents, but there are several limitations.

OBM provides templates for two categories of abutments: Pile Caps and Stem Walls. Users can utilize
these templates and add piles of different types including square prestressed and steel H-piles. These
templates can be edited and copied as needed. New templates can be created from scratch with the Add
button. The templates can be found in Utilities > Libraries > Abutments. Templates are stored in an
xml file of the project folder in ... > Structures > Bridge Templates > PierLib.xml. If a template from one
project needs to be used on another project, there are options to import and export template libraries via
the xml files.

Abutment Templates - O *
Selection f % ' k" . Pﬁ S 2 '
Pile Cap\Default\3 Lane - 40t lsometric Front/Rear Left/Right ~ Top/Bottom
Open Add Edit Copy Delete | Import = Export Maove +
4 7 Pile Cap -
4 {3 Default '
2% 1 Lane - 14it e
% 2 Lane - 2T#

(LXK

File_Cap_Batter_Piles
File_Cap_Slope
#% VDOT_Full_Integral_Abutment
4 {3 FDOT Templates
% FDOT End Bent_TRM Model1
B 7% Stem Wall

CA\Worksets\FDOT\ 1224567890 1\Structures\Bridge Templates\PierLib.xml
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Name: | FDOT End Bent_TRM Mods!1 |"’| f ? ] S by 16 4 <
»

Category: | FDOT Templates Display Mode lsometric Front/Rear Left/Right  Top/Bottom

Type: Pile Cap e
(.0 Cheek Walls  Piles ¥
| b
L
b Supportline Alignment | Front Face of Back Wall i -
=
Cap Length [ 578
Pile Cap Depth (%) 36
Pile Cap Width (") 45
Back Wall Depth (") 39 5/8
Back Wall Width (7) 15 .
Back Wall Horizontal Offset () 0
Corbel
0K Cancel

CAWorksets\FDOT\ 1234567890 1\Structures\Bridge Templates\PierLib.xm|

NOTE The Back Wall Depth entered can be an estimate. When the abutment is placed, there will
be options to conform the backwall with the top of deck and offset the backwall vertically

from the top of deck. These options override the value entered for Back Wall Depth from
the template.

The cap is to be stepped or sloped if pedestals are greater than 15” tall. A stepped cap can be created
during the bearing placement step (see Place Bearings section). To slope a pile cap, the user will need
to utilize the “Elevation Constraints” option and indicate that the top and bottom of the cap are to be
sloped.

@7 Properties - K
4 b Elements (1) =
4 &) Abutment Element: Unit 13 END BENT 1 = SR L ansrEne - - -~
Abutment v
Position: | Vertical Offset =
Feature ~»
Feature Definition Endbent with Coencrete Pile 00
Substructure Placement Rule ~

I Elevation Constraints SELECT to Edit I Top Slope: | Parallel to deck N
ubstructure | emplate o

Apply Skew To Solids False

Bottom Slope: | Parallel to cap top =
Conform Backwall With D True
Back\all Vertical Offset | -1" 1 3/4™
Integral False
Haorizontal Offset -19" 1 1/8™
Longitudingl Offset oo
Cap Length Adjustment  Aligned
Orientation Start
Build Order v
Material - OK Cancel

The abutments are placed on the SupportLines in the active bridge. After selecting the Place Abutment
tool, the Place Abutment window will open. The user will then have the opportunity to select the desired
SupportLine for the abutment location and modify the placement details of the abutment. These include
offsets, template selection, abutment materials, and feature definition. See the following image and field
descriptions for more details.
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o
Select SupportLine

SupportLine: FFBW END BENT 1
Sta: 2020+08.46

Herizontal Offset: -18:3 1/2
Skew: 17°36'40.4365

Direction: 71°54'01.8248" \ Line
Level: DecorSupportLines(20)

Pes

Template Name

Solid Placement

PileCap"FDOT End Bent_| ...

Integral O

Horizontal Offzet

191178

Langitudinal Offset 0:0

Lpply Skew To Solids O
Conform Backwall With Deck Top

Edit Elevation Constraints ]

Orientation

Cap Length Adjustment

Cap Matenial

Material

0400 4 5 Conc Class IV | ...

Column Material

Footing Material

Concrete Pad Matenial

Pile Material

045534 3_PSC Filing, 14| ...

Build Order

Pier Cap Build Order

Column Build Order

Footing Build Order

Concrete Pad Build Order

Pile Build Order

Feature Definition

Name Prefix

Feature ~

Endbent with Concrete Pile
END BENT 1

Template Name:

Selecting the “...” in this field will open up the
template library where any previously created
template will be opened.

Horizontal Offset and Longitudinal Offset:

These fields will move the abutment in plan view
relative to the selected SupportLine.

Apply Skew to Solids:

This field automatically adjusts the template solids
based on the SupportLine skew angle.

Conform BackWall with Deck Top:

If this checkbox is selected, the backwall will follow
the slope of the top of deck.

Edit Elevation Constraints:

This checkbox will open the Elevation Constraints
window after the substructure unit is placed to
allow the user to edit these fields.

Orientation:

Selecting Start or End will tell the program which
abutment this will be relative to the stationing of
the alignment curve.

Cap Length Adjustment:

There are five options for this field: None, Deck,
Skew, Aligned, and Deck and Aligned. These will
automatically modify the cap horizontal length in
the template to whatever is chosen.
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Material:

The materials for each component of the abutment
can be added by selecting the “...” next to the field.
Note that this is then tied to the bridge element
and is used in the Material Quantities Report (see
Chapter 7).

Build Order:

This refers to the order of construction (if desired).
This is only used for RM Bridge and can generally
be disregarded.

Feature Definition:

This field will determine the levels the model and
any section view linework will use for the individual
components, so the user should select the Feature
Definition that applies to the desired abutment.

If any part of the abutment must be modified after placement, the user can access the details of the
abutment by opening the abutment properties. The Elevation Constraints field allows the user to change the
top or bottom slope of the abutment cap and to set cap elevations as a hard-entered rather than internally
calculated value. The Substructure Template field allows the user to change the dimensions and layout of
the piles, cheekwalls, cap, etc.

Users can place the wingwalls as individual elements by selecting Home > Substructure > Place Wingwall.

o

Place
Pier

c{;j Place Abutment
ﬂ Place Custom Pier

(M| Place Custom Abutment i Place Excavation

Substructure

[;_? Place Wingwall
€3 Place Bearing
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The placement options for this tool can be tricky but can generally be used along with solids modification
tools to get the required geometry. Information on solids modification tools can be found in Chapter 8 and
the Bentley Help Contents for Microstation. Solids generated by OBM can be modified with the standard
Microstation solids modification tools found in the Modeling workflow. There are implications at this point in
time which need to be considered when modifying OBM solids. First, any modifications to the solids should
be reflected in the OBM quantity report tool. Second, the 2D decoration levels will not be updated to reflect
modifications to their parent solids. Modifying OBM solids is an advanced topic and may not be required on
every bridge model depending on the level of detail required.

ZF_;;" Place Wingwall — x
Left Wingwall Placement ~

Flace Left Wingwall

Template Name StandardWingWall\Re | ...

Orientation |N0rrna|f8kewed ~ |

Vertical Offset 0:0

Align With Abutment O

Transverse Offset 0:0

Align \wiith FFBEW O

Longitudinal Offset | 0:0

Parallel To Alignment O

Skew dngle 00°D0'D0"
Adjust Height to Backwall [
Computs Length O
Right Wingwall Placement ~
Flace Right \Wingwall O
Material ~
‘wingwall Material I:I
Footing Material
Build Order ~

‘Wwingwall Build Order 1

Footing Build Order 1
File Build Order 1

Feature -~
Feature Definition WingWall Concrete Piley ~
Mame Prefix Wingwall

The last tool used for the creation of abutments and its components is the Home > Substructure > Place
Custom Abutment tool.

5% Place Pier () Place Custom Abutrnent il Place Excavation

{D Place Abutment [ Place Wingwall
U Place Custom Pier €9 Place Bearing

Substructure

This tool allows the user to place abutment elements that have been previously generated in a parametric
cell on a model’s SupportLines. The Place Custom Abutment window can be seen below.
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@ Place Custorn Abutm... — *
Solid Placement ~

Cell |_TR-EndBent-FC ]

Tvpe Parametric

fictive Angle |193'52:33 478"

X-Scale |1.000000000000000

Jr-Scale (1.00000000D0DO000D

-Scale |1.000000000000000

Horizontal Offset 00

Vertical Offset [0:27/8

SupportLine Offset 00

[_ap Length Adjustment |None ]

gnore Support Line Skew [
Pinalytical Properties |

Material »
Cap Material [0400 4 5 Conc Class V] .|
Footing Material | -]
File Material [0455 34 5_PSC Piing, 2] .. |

Build Order v

Feature »
e ature Definition [Endbent with Conarete Piid~ ||
lame Prefix |END BENT 3

FDOT has developed a parametric cell for use in the FDOTConnect workspace and its usage will be
demonstrated in an upcoming exercise.




PLACE PIER

Modeling piers in OBM is very similar to abutments. To add pier, navigate to Home > Substructure > Place
Pier.

(I, Place Custom Abutment Féi!ﬂ Place Excavation
ace Abutment ace Wingwa
Place Ab Place Wingwall
ﬂ Place Custom Pier €9 Place Bearing

Substructure

Atfter filling in the input (see Place Abutment section for more information), simply select one or more
SupportLines to place the pier(s) as desired. The input is similar to the abutment input, but with less options.
The Cap Length Adjustment generally will not be used for pier caps since they often do not run the full width
of the deck.

&% Place Pier — *

Solid Placement ~
Template Name .F'lleBerrt'-,Q Lane-2
Integral |:|
Honzontal Offset -D:D
Cap Length Adjustment .Ncu ne el

Edit Elevation Constraints [_|

Material ~
Cap Material 0400 4 5_Conc Clz
Column Material 0400 4 5_Conc Clz
Foating Material 0400 4 5_Conc Clz

Concrete Pad Material .D-mﬂ14?_Neuprem

Pile Matenal (0455 34 5_PSC Pl
Build Oorder -~
Pier Cap Build Order (1
Column Build Order 1
Foating Build Order 1
Concrete Pad Build Order 1
Pile Build Ordes 1
Feature ~
Feature Definition Pierwith Concrete Pi |
KName Prefoc PIER 2

Piers are also template-based and there are additional options for cap shape, variations and tapers, column
shape, and footing shape which allows for more pier types to be accommodated. Although the pier templates
are extremely robust at this point, an even higher level of development can be accomplished with a Custom
Pier or parametric cell. Bentley has information and instructions on how to create and use parametric cells
available online.
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OBM provides templates for two categories of piers: Pile Bents and Multi Columns. Users can utilize these
templates and add piles of different types including square prestressed and steel H-piles. These templates
can be found in Utilities > Library > Piers. Templates are stored in an xml file of the project folder in ... >
Structures > Bridge Templates > PierLib.xml. If a template from one project needs to be used on another
project, there are options to import and export template libraries via the xml files. These template can be
edited and copied as needed. New templates can be created from scratch with the Add button.

Pier Ternplates - ] x

Multi Column\Default\2lane30ft Isometric Front/Rear Left/Right  Top/Bottom

Open Add Edit Copy  Delete | Import  Export
4 # Multi Column =
4 A Defautt 1
# 1Lane _14ft P //
Lt

+

LY
%

2% 2Lane_304t
# JLane_40ft

(s

P Dvop_Cap_1
& Dvap_Cap_2

# H_Pier .
# Hammer_Hesd1

-—*’ Hamrmer_Head?

# Hollow_Pier

#F lnvertedT_Cap_Pier

#F lnvertedT_Circular_Drill_Shaft

#F Pier_Rustification

#F Pier_Variable Cap_Rustification —

C\Werksets\FDOT\ 240835715201 Structures\Eridge Templates\PierLibooml

¥

Pier Templates = m} X
Name: = Variable_Cap_Parabolic_Cap |"’| % 8 é% g% % @ @ %
Category: | Default Display Mode Isometric Front/Rear  Left/Right  Top/Bottom

Type: Multi Column +

Analytical Type: Multi Column b -

¥

Cap CheekWalls Columns Struts Footings m "

Add Pattem == U

==

| et

Pattern Lavout

D°00'00"

16X121

Pile Width (%) 57/8

Pile Depth () 513/16 v

oK Cancel

C:\Worksets\FDOT\240835715201\Structures\Bridge Templates\PierLib.xml
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As with abutment pile caps, the pier caps are to be stepped or sloped if pedestals are greater than 15” tall
per the SDG. The cap can be stepped by selecting this option in the bearing window (See Place Bearings

section). To slope a pier cap, the user will need to utilize the “Elevation Constraints” option and indicate that
the top and bottom of the cap are to be sloped.

@1 Properties - X Elevation Constraints — O x
4 7h Elements (1) : Cap
Piar . Paosition: | Vertical Offset ¥
Feature » 0
| Feature Definition  Intermediate Bent with Cond
Tep Slope: | Parallel to deck ¥
Substructure Placement Rule -~ PP apte o
SELECT to Edit Bottom Slope: | Parallel to cap top L4
Substructure Template SELECT to Edit
Apply Skew To Solids  False
Integral Falze
Horizontal Offzet -28" 0"
Cap Length Adjustment None
Build Order W
Material w
OK Cancel

Note that different variables will be available to edit based on the Type of pier, cap, column, footing, and
piles that are selected.

Substructure Template - m] *

Name: Switch Template — -
"l @I DB @D DS

Category:
Display Mode Isometric Front/Rear Left/Right  Top/Bottom

Type: Pile Bent

+
(L Cheek Walls  Piles -

L ]
Type: Rectangle v ‘ 32
Cap Length ) 55:0 iﬁ
Cap Height (%) 36 ‘§
Cap Width (") 45
Edge None

Add To Library oK Cancel
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Pier Templates X
K e R e DD
Category: | Default Display Mode Isometric Front/Rear Left/Right  Top/Bottom
Type: Multi Column o
Analytical Type: | Multi Column v | —
L
(-0 CheekWalls Columns  Struts  Footings  Piles )
ey
| o
-
Cap Length () 36:0
Cap Height (7) 120
Cap Width (*) a7 -
Cap Min Height (") 43172
Left Taper Length () 11:6
Right Taper Length () 11:6
Edge None B
oK Cancel
CAWorksets\FDOT\240835715201\Structures\Bridge Templates\PierLib.acml
Pier Templates x
MName: | Pier_Variable Cap_Rustification |""'| @ @ ﬁh &B ﬁB ﬁB @ %
Category: | Default Display Mode Isometric Front/Rear Left/Right  Top/Bottom
Type: Multi Column o
Analytical Type: | Multi Column ~ —_
]
Cap  Cheek Walls Struts  Footings  Piles wr
£y
Add Column == 0
=
Variation
Length (unadjusted) (') 39:4 716
Auto Spacing Off =
Overhang From Left Edge () 236 1/4
+  Column 2 x
Adooiolel -
0K Cancel
C\Worksets\FDOT'\240835715201\5tructures\Bridge Templates\PierLibxml
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PLACE BEARING

Bearing elements and bearing assemblies are modeled after both beams and substructure units are added.
The bearings are inserted underneath the beams and will offset the substructure downwards. The user will
have options to create Bearing Seats, create Grout Pads/Bevel Plates, model stepped caps, change the
bearing materials, etc. To add a bearing, navigate to and select Home > Substructure > Place Bearing.

gé'}j Place Pier (@, Place Custom Abutment ré;ﬂ Place Excavation
c{; Place Abutment [ Place Wingwall

U Place Custom Piefd € Place Bearing

Substructure

The Place Bearing window will open, along with many placement options. From this point, a Bearing Type
must be selected out of the three available options: Cube, Cylinder, and Cell. The Cube and Cell options
are most commonly used on FDOT projects and will be the focus of this section. The preferred method for
bearing placement when working with FDOT standard bearing pads is to use the Cell option. The user must
click the “...” next to the Cell field.

4%' Place Bearing — x

Bearing -~
Bearing Type
T
Active Angle 00°00°00"
HA-Scale 1.000000000000000
Y-Scale 1.000000000000000
Z-5cale 1.000000000000000
Orientation

Grout Pad/Bevel Plate ~
Has Pad or Plate O

Bearing Seat -~
Has Bearing Seats O

Path -~

Material A~
Pad or Plate Material 0460 2 2_Stesl Gr|| ...
Bearing Material 0400147_Neoprer|| ...
Bearing Seat Material 0400 4 5 ConeCl|| ...

Build Order A~
Pad or Flate Build Order
Bearing Build Order
Beam Seat Build Order

Feature -~
Feature Definition
Mame Prefix BEARING 1
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This will open the bearing cell library that contains all of the FDOT standard bearings, as shown in the

«

image below.

Select Cell = |
Cell Name Type File Mame +
Default Standard  Bearinglib.cel =
Type A4 Standard Beaninglib.cel &
Type AB Standard BearingLib.cel e
Type D Standard | BearingLib.cel )

© [ipee ]swndard earingliocel -
TypeF  Standard Bearinglib.cel =
Type G Standard Beannglib.cel
Type H Standard BearingLib.cel
Type J Standard BearingLib.cel
Type K Standard  Bearinglib.cel

QK

Cancel

Once a bearing type is selected from the cells, the user does not need to do anything to change the
dimensions of the bearing. While this is the preferred option when placing FDOT-standard bearings, using
cells in the placement of bearings does have undesired implications when pulling quantities from the
model. When using the built-in Bentley quantities report generator, the bearings are pulled as an “each” or
“EA” quantity as opposed to a “cubic yard” or “CY” quantity. Additionally, when using the FDOT generated
quantities, the program will any bearing information. These issues will be discussed further in Chapter 7.

The other method that can be used if non-standard bearings are being used or if complicated geometry
makes it difficult to place the cells, is the Cube option. This option requires that the user input all bearing
dimensions before placing the bearings. Bearings are modeled from the centerline of the bearing. Cube
Depth, D is measured in the longitudinal direction and Cube Width, W is in the transverse direction.

ﬁ Place Bearing ...
Bearing

Bearing Type

Cube \whdth, W

Cube Depth, D

Cube Height

Orientation

— e
L)
|Cube w |
[2:10 |
0:10 |
0:29/16 |
|Girder v ||
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After the Bearing Type and Orientation have been set, the remaining input information is the same for all
options. Checking the box next to Has Pad or Plate or Has Bearing Seat will extend that portion of the
window with additional options for that component. The example below shows the fields that display once
Has Pad or Plate (left image) or Has Bearing Seats (right image) is selected. See figures for graphical
representations of variables used.

Bearing Seat Ll

Grout Pad /Bevel Plate L3 Has Bearing Seats

Has Pad or Plate Model Stepped Cap ]

Pad Thickness Definition At Center v Model As Sloped Bearing Seats [ ]
Pad Thickness at Center 0:57/3 Seat Min. Thickness |D:4 |
Pad D1 0:2 1516 Seat D1 |D:E |
Pad D2 0:2 15416 Seat D2 |D:E |
Pad W1 0:3 15/16 Seat W1 [1:6 |
Pad w2 0:3 1516 Seat W2 |1:E |
Pad Orientation Girder e Seat Orientation |F‘ier ~ |

The D dimensions determine the longitudinal distances of the Pad or Plate along the length of the bridge.
D1 is the distance ahead of the bearing centerline, and D2 is distance behind the bearing centerline.

The W dimensions determine the transverse dimensions of the Pad or Plate across the width of the support.
W1 is the Pad or Plate dimension left of the centerline of the girder (looking upstation). W2 is the dimension
to the right of the centerline of the girder (looking upstation).

Grout Pad/Bearing Seat Dimensions d Ahead

Station

w{p/x o~

From Bentley Help Contents
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The bearing line offsets are set in the Path group. There, the Back Offset and Ahead Offset from the selected
SupportLine can be set for the centerline of the bearings in the back and ahead spans, respectively. If the
substructure location has been offset from their respective SupportLines, the bearings must be offset to

match.

Path o
Back Offset BE |
Ahead Offset (15 |
Bearing/Beam Seat (Pedestal) 1
Dimensions and Orientations seameas Bmm Fah
3
E
UsingPier -1 Usirg Gader
O 2o i Oirie it afan
w1 o0 oWl A az
by
21 i T
Bearing Line - : - o7 —
22 i Ahead Offaet
BT — = = = = e e e e e e e —— = = = s

Back Ofest 2
D2 1 T

&.‘IfﬂﬁLﬂl‘—----—--—-‘-—--———--l——--—-—----—---‘-—--—-—-- =mmmsmssus s mne g = — -

D1 i
w2 Wl b wa
From Bentley Help Conients
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The last three groups of the Place Bearing window are to those seen in tools described in earlier sections
of this manual. In the Materials group, the materials for each component of the bearings can be defined
by selecting the “...” next to the field. Build Order group can be used to model construction sequencing, if
desired, and can be used in other Bentley software such as RM Bridge and Synchro. The Feature group
allows for the Feature Definition and Name Prefix to be defined. Feature Definitions determine the attributes
of the bearings and how the components look in the model.

Material ~
Pad or Plate Material 0460 2 2 Steel Gr| ...

Bearing Material 0400147_Neoprene | ...
Bearing Seat Material 0400 4 5 Conc Cl

Build Order L]
Pad or Plate Build Order 1
Bearing Build Order 1
Beam Seat Build Order 1

Feature L]
Feature Definition Neoprene Composite
Mame Prefix BEARING 1

To place the bearings, select the desired Substructure SupportLines and right click to end the selection.
Data point in space to place the bearings.
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APPROACH SLABS

As described in the Add Bridge section above, there are two ways that approach slabs can be modeled. Most
approach slabs can be modeled with the first method which includes using the Approach Slab tools found in
the Home > Approach Slab group. Similar to the how the deck is modeled between two SupportLines, an
approach slab can only be modeled between an Approach Reference Line and the first or last SupportLine.

gﬁ: Place Pier @ Place Custom Abutment réi'ﬂ Place Excavation gic- Place Point sl

{:j Place Abutment Q Place Wingwall “\_ Place Path @

']:] Place Custom Pier €9 Place Bearing ,[';" Place Barrier &
Substructure Accessory Approach Slab

The user can place these lines with any Skew and Offset from the nearest SupportLine. Additionally, the
approach slab’s Location must be chosen—whether it is at the Start or End of the bridge. Note that only
one reference line can be placed at either end of the bridge.

With an approach reference line in place, the approach slab can be modeled using the Place Approach
Slab tool also found in the Home > Approach Slab group.

gﬁ Place Pier (I Place Custom Abutment réi'ﬂ Place Excavation gi-:- Place Point 1

{:j Place Abutment Q Place Wingwall “\_ Place Path

ﬁ Place Custom Pier &9 Place Bearing Jj Place Barrier e
Substructure Accessory Approach Slab

This brings up the Place Approach Slab window which allows for the selection of the approach slab template,
offset values, material, Feature Definition, and other parameters. This window is nearly identical the Place
Deck window. As such, the description of many of these fields can be found in the Place Deck section above
or the OBM Help Contents material can be consulted for additional information.
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Approach Slab )
Location |Start e |
Sync With Dack L]

Template Mame
Start Station Offset 00 |
End Station Offset 00 |
Herizontal Offset |1]':1]' |
Start Viertical Offset 00 |
End Vertical Offset 00 |
Add Constraints ]

Chord Tolerance |1]'_'I1]'I]'IZI'I]'I]'IZI'I]'I]'IZI'I]'I]'I]'I]'I]I |
Max Dist Between Sections 3.3 3/8 |
Slesper Slab ]

Approach Slab Breakbacks S

Left Start Breakback Distance |1]':1]'

Right Start Breskback Distance |ﬂl;ﬂl |
Left End Breakback Distance  [0:0 |
Right End Breakback Distance [0:0 |

Material A~
Approach Slab Material Name  |0400 2 10 Conc E

Build Order N
Build Order 1 |

Feature Ea
Feature Definition |Fq:pmad1 Slab o |
Name Prefix |APP SLAB 1 |

The two fields that are unique to the Place Approach Slab window are the Location and the Sync With Deck
toggle. The Location defines if the approach slab being modeled is meant to be placed at the Start or End of
the bridge. Sync With Deck option toggled on, the approach slab will be modeled using the same template
that is used for the bridge deck and use all the same offsets. This is not an option that is commonly used as
the approach slab and deck for a bridge nearly never use the same template.

The alternative method to creating an approach slab is to use the Home > Superstructure > Place Deck
tool. In this option the user will just create a new section of deck that has no beams. This method is very
similar to adding a deck slab discussed in previous sections. Placing barriers and adding superelevation
also follows the same workflow.
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When the top of slab elevation varies across the length of the approach slab, such as those with an
asphalt overlay, a vertical offset from the alignment can be used in conjunction with multiple deck segments/
station offsets to accommodate the stepped approach slab elevations. In cases where the bottom of slab
varies, such as those with an increased depth at the backwall, variable constraints can be applied for deck

thickness, see below.

SingleDeckTemplateWindow

0.9+

-0.95 4

SupportLinel

Value

-1.15-

FFBW End Bent 1

T T T
341+73.5300 341+78.5300 341+83.5300

T
341+88.5300
Station Distance

T
341+03.5300

T
341+08.5300

1
342+03.5300

Variable Constraints

Variables 341+73.5300 - 342+03.5300 Slab w/ constraints Thickness Default = -0:9 13/16

Variabl ~ Active  Default Errors

LT Slope | |+ 0.020000000000000

Expanded View @ Grid View

LT Width_ | -200 Add Section  Mode: | Supportline O 0:0

From | Supportlinel vl 4

K Delete Selected

Rotation E 00°00'00" -
Rotation 0.000000000000000 0 Copy To Variable
RT_Slope_ ~0.020000000000000 Location Type (= From Start Distance  End Distance ] Starl (e Transition
RT_Width_ v/ 200 Location Length Value Value
LT ' S GO S 1. 3500 sor-resw0 v S S N m—
Supportline 1:0 Supportlinel | 341+745300 341+75.5300 10 -1:1172 -1:0 Linear
Supportline 20 SupportLinel | 341+75.5300 342+03.5300 28.0 -1:0 -1:0 Linear
0K Cancel
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[Bearaie@ 8.7 Create Deck and Approach Slab Templates

CREATE A DECK TEMPLATE

1. Open the data set file: BOIMODLBRTRO01_5.1_5.2_5.3 5.4 Begin.dgn
2. Open the deck template library by navigating to Utilities > Libraries > Decks.

OpenBridge Modeler B o HE % I EEE: 5
Home Civil Reports and Drawings View Collaborate FDOT Help
. —N N » &“ 1 Columns crj Abutments _ Material

(CLimw XX sti

B 4L Footi Wi I Stiff
LEAP LEAP RM ProStructures  Templates gxport O amers s [J it freners
Bridge Concrete ¥  Bridge Steel *  Bridge ~ M - Terrain I Beams ;géi Piers & SleeperSlab [X] Cross Frames

Interoperability Import/Export Libraries

3. Expand the Standard Templates and FDOT Deck Slab folders, right click on Deck Slab w/V-Groove-
NoChamfers and select Copy. Right click the copied template and select Rename. Rename the
template to _TR-Deck.

ﬂ Template Creation - templates.xml [ Decks\Standard

O Approach Slab-w-MSE-Coping
) Deck Slab w/ V-Groove
-4 Deck Slab wf V-Groove - Slope Break LT
) Deck Slab wf V-Groove - Slope Break LT/RT
43 Deck Slab wf V-Groove - Slope Break RT
-3 Deck Slab w/ V-Groove-NoChamfers 4—' Template to Copy
) Deck Slab wjo V-Groove-NoChamfers
-4} Deck Slab wjo V-Groove-NoChamfers_TOHL_L
43 Deck Slab wjo V-Groave-NaChamfers_TOHL_R
43 Deck Slab wjo V-Groove-NoChamfers_TOHLR
£ Deck Slab wjo V-Groove-NoChamfers_TOHR_L
-4 Deck Slab wfo V-Groove-NoChamfers_TOHR_R
) FSB CIP Topping
.43 FSB End Closure
20 MultiCellBox
21 Parametric Segmental Boxes
[#-21 Seg Box - Balanced Cantilever
421 Seg Box - Span by Span
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4. Within the newly created deck template _TR-Deck, highlight P_1 in the Points section, change the
Horizontal constraint Value to 4:0 for the PGL_to_RT_Coping Variable and the Slope constraint to
0.02 for the RT_Slope Variable. Click Save to update the graphical view.

E Template Creation - templatesxml [ Decks\Standard Templates\FDOT Deck Slabs\_TR-Deck ] - [m] X
= BSH Xt 1 % [E I 1
8-V REE =8
=L Standard Templates ~ E halt e =
=21 FDOT Deck Slabs
O NI

© Approach Slab

© Approach Slab-w-MSE-Copi
© Deck Slab w/ V-Groove

© Deck Slab w/ V-Groove - Slc
© Deck Slab w/ V-Groove - Slc
©) Deck Slab w/ V-Groove - Slc
© Deck Slab ) V-Groove-Nol
) Deck Slab w/o V-Groove-Ne
© Deck Slab w/o V-Groove-Ne v

< >

Point Details Key Points

Paints Edit Details
Name  Typel  Type2  Variablel Variable2 O E— e ] Eivaton Repor
X Horizontal |Vertical i
P1 |Horizontal |Slope |PGL_to_RT_Coping|RT_Slope Point Constraints Cormer Attributes
P2 Horizontal |Vertical Thickness
P3 Horizontal |Vertical Thickness Mode Bl Gl Mode None i
P4 Horizontal |Vertical Thickness Constraint Constraint
PS5 Horizontal |Slope PGL_to_LT_Coping |LT_Slope Tyoe [ Siope
P_6 Horizontal |Slope RT_Slope
P_7 Horizontal |Vertical V_Groove_Depth Parent PO ! Working Point ~
X Horizontal |Slope RT_Slope value 20 [0.020000000000000 1
X Horizontal |Slope LT_Slope
P_10 Horizontal |Vertical V_Groove_Depth Varaple  |[PGL_to_RT_Coping v [RT_stope “|
P_11 Horizontal |Slope LT_Slope Rotation

[[] Do Not Rotate

Cance

Close

C:\Worksets\FDOT\12345678901 \Stm(tures\Bndge Temelaies\temelaies‘xml

NOTE Since Point P_2 is horizontally constrained to P_1 with a value of 0:0, after the previous
step, Point P_2 as well as the points that make up the V-groove (P_6, P_7, and P_8) all
adjust automatically to follow P_1.

5. Highlight P_5 and update the Horizontal constraint Value to -40:5 for the PGL_to_LT_Coping Variable.
Click Save to update the graphical view. Notice that the horizontal offset of P_4, P_9, P_10, and P_11
were updated automatically with the change to P_5.

6. Select Close to close the Template Creation window. The new deck template is now complete and is
ready to be used with the Place Deck tool. See the Deck Template section of the guide for additional
options within the Template Creation window.
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=-C1 FDOT Deck Slabs A
" _TRDeck
© Approach Slab
© Approach Slabw-MSE
) Deck Slab w/ V-Groove
© Deck Slab w/ V-Groove
) Deck Slab w/ V-Groove
© Deck Slab w/ V-Groove
) Deck Slab w/ V-Groove
© Deck Slab w/o V-Grooy
© Deck Slab w/o V-Grao
© Deck Slab w/o V-Grooy v
< >

Point Details Key Points

G Template Creation - templates.xml [ Decks\Standard Templates\FDOT Deck Slabs\_TR-Deck ]
=l B X T

Points Edit Details
Name Typel Type2 Variable1 Variable2 ]
P o Horzonial | Verscal Name ! Flag [] Elevation Report
P_1 Horizontal |Slope PGL_to_RT_Coping |RT_Slope Point Constraints Comer Attributes
P_2 Horizontal |Vertical Thickness
P3 Horizontal |Vertical Thickness Mode Horizontal + Slape Mode  [None "
P_4 Horizontal |Vertical Thickness Constraint Constraint
P& Herizontal |Slope RT_Slope
P_7 Horizontal | Vertical V_Groove_Depth Parent PO 2 PO e
P8 Horizontal |Slope RT_Slope Value [-40:8 | [0.020000000000000 ]
P9 Herizontal |Slope LT_Slope [FoLiorc | Ta
P10 Horizontal |Verical V_Groove_Depth Variable o--1-bopng [L7_slope “]
P11 Horizontal |Slope LT _Slope Rotation
[[] Do Not Rotate
Save Cancel
Close
C:\Worksets\FDOT\12345678901\Structures\Bridge Templates\templates.xm|
SRS EEC ek SRR oo SR SRR
See below for summary of input used in the exercise.
Exercise 5.1 - Create Deck and Approach Slab Templates
Create a Deck Template
Step Dialog Box Field Name (Section) Field Input
Point P_1
Mode Horizontal
Parent P 0O
Value 4:0
4 Template Creation Variable PGL_to_RT_Coping
Mode Slope
Parent Working Point
Value 0.02
Variable RT_Slope
Point P_5
Mode Horizontal
5 Template Creation Parent P_0
Value -40:5
Variable PGL_to_LT_Coping
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CREATE AN APPROACH SLAB TEMPLATE

1. Continue with the data set file: BOTMODLBRTR01_5.1_5.2 5.3 5.4 Begin.dgn

2. Open the deck template library by navigating to Utilities > Libraries > Decks.

OpenBridge Modeler - 8 H E & IR R EE: 5
Home Ciwil Reports and Drawings View Collaborate FDOT Help
:ZI":\ m » f& _ Columns Jv] Abutments Material
.- - | - -

[ Barriers <J: Footings [ Wingwall ,X‘ Stiffeners

LEAP LEAP RM ProStructures  Templates pyport ) )
Bridge Concrete ~  Bridge Steel *  Bridge ~ v "  Terrain L Beams & Piers  « SleeperSlab [X] Cross Frames
Interoperability Import/Export Libraries

3. Expand the Standard Templates and FDOT Deck Slab folders, right click on Approach Slab and select
Copy. Right click the copied template and select Rename. Rename the template to _TR-AppSlab.

ﬁ Template Creation - templatesxml [ Decks\Standard 1I

=] Standard Templates

=1 FDOT Deck Slab
I8} TR-Appsiab]
X R-D

- . ecl
0 Rppmach Slab Template to Copy

) Approach Slab-w-MSE-Coping
O Deck Slabwj V-Groove
-3 Deck Slab w/ V-Groove - Slope Break LT
- Deck Slab w/ \V-Groove - Slope Break LT/RT
© Deck Slabwj V-Groove - Slope Break RT
43 Deck Slab w/ V-Groove-NoChamfers
.. Deck Slab wjo V-Groove-NoChamfers
.. Deck Slab wjo V-Groove-MoChamfers_TOHL_L
O Deck Slab wjo V-Groove-NoChamfers_TOHL_R
.. Deck Slab wjo V-Groove-MoChamfers_TOHLR
-3 Deck Slab wjo V-Groove-NoChamfers_ TOHR_L
O Deck Slab wjo V-Groove-NoChamfers_TOHR_R
--£) FSB CIP Topping
-3} FSB End Closure
-1 MultiCellBox
HHZD Parametric Segmental Boxes
-] Seg Box - Balanced Cantilever
-2 Seg Box- Span by Span

NOTE For approach MSE walls along both edges, the Approach Slab-w-MSE-Coping template
can be used. In this example, an MSE wall is only along one edge, so we will use the
approach slab template without the built-in MSE coping. Future releases of FDOTConnect
will have templates to accommodate an MSE coping on only the left or only the right side.
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4. Within the newly created deck template _TR-AppSlab, highlight P_1 in the Points section, change the
Horizontal constraint Value to 4:0 for the PGL_to_RT_Coping Variable and the Slope constraint to
0.02 for the RT_Slope Variable. Click Save to update the graphical view.

I8 Template Creation - templatesxmi [ Decks\Standard Templates\FDOT Deck Slabs\ TR-AppSlab ] - o X
u| (o B k%3 1 ke S [H]v b 7
x]l® - RiME =18

/3 Standard Templates
=1 FDOT Deck Slabs
~ _TR-AppSiab
© _TRDeck
© Approach Slab
© Approach Slab-w-MSE-Coping
© Deck Slabw/V-Groove
© Deck Slabw/ V-Groove - Slope Break LT
© Deck Slabw/ V-Groove - Slope Break LT/RT
© Deck Slabw/ V-Groove - Slope Break RT
© Deck Slab w/ V-Groove-NoChamfers
) Deck Slab /o V-Groove-NoChamfers
© Deck Slabw/o V-Groove-NoCharnfers_TOHL_L
© Deck Slabw/o V-Groove-NoChamfers_TOHL_R
© Deck Slabw/o V-Groove-NoCharnfers_TOHLR
© Deck Slabw/o V-Groove-NoCharmfers_TOHR L
© Deck Slabw/o V-Groove-NoCharfers_TOHR_R
© FSBCIP Topping
© FSBEnd Closure
£ MuliiCeliBox
(1 Parametric Segmental Boxes
(1 Seg Box - Balanced Cantlever
(21 Seg Box - Span by Span

PointDetails Key Paints

Poinis Edit Details
Name  Typel  Type2  Variablel Variable2 . o —
ame [P
P g Horizontal |Vertcal Fea [ Elevation Repot
P Horizontal |Slope | PGL_to_RT_Coping|RT_Slope Point Constaints Corner Atributes
P2 Horizontal |Vertcal Thickness
P3 Horizontal |Verical Thickness Mode (Tl S50 Mode None v
P4 Horizontal |Vertcal Thickness Constraint Constaint
s Horizontal |Slope | PGL_to_LT_Coping |LT_Slope
Type Horizontal Siope
Parent PO 2 Working Point v
| Value [+0 | [0.020000000000000 ] |
Variable \Pcun,m,(:upmg \/l \m,smpe v‘
Rotation
[] DoNot Rotate

Close

NOTE Since Point P_2 is horizontally constrained to P_1 with a value of 0:0, after the previous
step, Point P_2 will adjust automatically to follow P_1.

5. Highlight P_5 and update the Horizontal constraint Value to -40:5 for the PGL_to_LT_Coping
Variable. Click Save to update the graphical view. Notice that the horizontal offset of P_4 was updated
automatically with the change to P_5.

6. Select Close to close the Template Creation window. The new deck template is now complete and is
ready to be used with the Place Deck tool. See the Deck Template section of the guide for additional
options within the Template Creation window.

Template Creation - templatesxm! [ Decks\Standard Templates\FDOT Deck Slabs\ TR-AppSiab | - o x
u | BT X0 T e Sa[H]v b 1
Moo - gRE B D

= Standard Templates ~
©(21 FDOT Deck Slabs

> _TR-AppSlab

O _TR-Deck

© Approach Slab

© Approach Slab-w-MSE-Coping

© Deck Slab w/ V-Groove

© Deck Slab w/ V-Groove - Slope Break LT

© Deck Slab w/ V-Groove - Slope Break LT/RT

Q) Deck Slab w/ V-Groove - Slope Break RT

O Deck Slab wf V-Groove-NoChamfers

© Deck Slab wfo V-Groove-NoChamfers

© Deck Slab w/o V-Groove-NoChamfers_TOHL_L

© Deck Slab wfo V-Groove-NoChamfers_TOHL_R

© Deck Slab w/o V-Groove-NoChamfers_TOHLR

© Deck Slab wfo V-Groove-NoChamfers_TOHR_L

© Deck Slab w/o V-Groove-NoChamfers_TOHR_R

© FSB CIP Topping

Q FSB End Closure

(1 MultiCellBox v

< b4

Point Details Key Points

Points Edit Details
Name  Typel  Type2  Variablel Variable2 .
) Horizontal |Vertical lame: ! [] Superelevation Flag [] Elevation Report
Pt Horizontal |Slope | PGL_to_RT_Coping |RT_Slope Point Constraints Comer Attibutes
P2 Horizontal | Vertical Thickness .
3 Horizontal | Vertcal Thickness Mode Horizontal + Slope Mode  [Rone i
P4 Horizontal | Vertical Thickness Constraint Constraint
Horizontal |Slope | PGL_to_LT_Coping |LT_Slope
[P5___|Horizontal |Siope _[PGLto_LT_Coping [LT_Siop S —— stpe
Parent Y = PO ~
Value [405 ] [0.020000000000000 ]
Variable  [PGLIo LT Coping  ~ | [L7_slope |

Rotation

[]Do Not Rotate:

Save Cancel

Close

C:\Worksets\FDOT\1 234567890W\Stru(tureS\BridEe TemEIa(eS\(emEla(es xml
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7. See below for summary of input used in the exercise.

IExercise 5.1 - Create Deck and Approach Slab Templates

Create an Approach Slab Template
Step Dialog Box Field Name (Section) Field Input
Point P_1
Mode Horizontal
Parent P_O
Value 4:0
4 Template Creation Variable PGL_to_RT_Coping
Mode Slope
Parent Working Point
Value 0.02
Variable RT_Slope
Point P_5
Mode Horizontal
5 Template Creation Parent PO
Value -40:5
Variable PGL_to_LT_Coping
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Breise 8.2 Create Substructure Template — End Bent

CREATE AN OBM ABUTMENT TEMPLATE

This exercise will demonstrate how to quickly create an end bent (Abutment) template using the out of the
box OBM templates. The OBM end bent templates will work fine for end bents with no skew, but they have
limitations if they are on a skew. Mainly, the cap and back wall cannot model the break backs (kinks) at the
ends to accommodate the skew. Even if the end bent is on a skew, the out of the box templates can still be
used for preliminary design to check horizontal clearances, etc. However, if you want to model the true end
bent geometry on a skew you will need to use the solids modifications tools in the Modeling workflow or use
the FDOT parametric cell end bent template (shown later in this guide).

1. Continue with the data set file: BOTMODLBRTRO01_5.1_5.2 5.3 5.4 Begin.dgn

2. Open the abutments template library by navigating to Utilities > Libraries > Abutments.

E OpenBridge Modeler i OB - - w=loke PP =

Home Civil Utilities Reports and Drawings View Collaborate FDOT Help

—— dh L > Decks J]_ Columng @Abutments ] Material &> Co
SHAN - Y =

—_ . - .
Lese . RM ProStructures | Templates fyport Q Barriers < Footings [ Wingwall x Stiffeners ﬁ She
Bridge Concrete v Bridge Steel ~  Bridge ~ v v Terrain I Beams @ Piers & SleeperSlab [X] Cross Frames :é’ Spif

Interoperability Import/Export Libraries
roperties v iXx

4 [E Models (1)
4 Ty Default

i View 1- Top, Default
mr& | L ,/9'_;9%53 0 R EE| &Y Y

PN Y. I

3. Expand the Pile Cap and Default folders, select 2 Lane — 27ft, and click Copy.

Abutment Ternplates

Selection

Pile Cap\Default\2 Lane - 27ft

Open Add Edit Delete | Import | Export Move
4 37 Pile Cap
4 i3 Default

#7 1 Lane - 14ft

¢ 2 lane - 271t

4. In the Create Template Copy dialog box, enter _TR-EndBent as the Name. A copy of the original end
bent template will now appear on the list under the new name.

5. Select the _TR-EndBent template and click on Edit from the top of the Selection section. For a pile
bent, the available categories are: Cap, Cheek Walls, & Piles.

6. Inthe Cap tab, select Front Face of Back Wall as the SupporiLine Alignment since that is what FDOT

uses to represent the begin of bridge in terms of stationing. Fill in the rest of the input shown based on
the image below. Note that the units vary depending on the input.

FDOT OBM 96



T

E Abutment Templates

Mame: _TR-EndBent
fCategony: | Default
Type: Pile Cap

(o0 Cheek Walls  Piles

bl Supportline Alignment | Front Face of Back Wall o |I

Cap Length (7 478
Pile Cap Depth (%) 30
File Cap Width (") 42
Back Wall Depth (") a9
Back Wall Width (%) 12
Back Wall Horizontal Offsst (") Q
Corbel

7. In the Cheek Walls tab, click Add Cheek Wall and enter the information shown below for both cheek

walls.
Abutment Templates
MName: | _TR-EndBent
Category:  Default
Type: Pile Cap
Cap Piles
Add Cheek Wall ==
< Cheek Wall 1 x
Crientation Left E
Height [7) 89
Width (") 30
Width Offset (") 0
Length Offset (") 0
bl Eottom Length () | 9716
Top Length (") a97/16

Crientation Right &
Height [7) 89

Width (") 63 9/16

Width Offset (") 0

Length Offset (") 0

Top Length (") 129/16
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8.

In the Piles tab, enter the information shown below.

Abutment Templates

Mame: _TR-EndBent
Category: | Default
Type: Pile Cap

Cap  Cheek Walls m

«  Default Pile Pattern

Pile Shape: Rectangle ™ || Pattern Lavout :::
Pile Length () 110:0
Embed Length (%) 12
Pile Width (") 24
Pile Depth (") 24

Click on the Pattern Layout button to edit the pile layout, a new window will open up. In the Pile Layout
Generation section, enter the input based on the image below. Once filled in, select Generate Piles to
update the Preview section that shows a graphical representation of the cap and pile locations. Note
that the margin distances are from the faces of the cap to CL pile.

Pile Pattern Layout — O X
Preview Pile Layout Generation
Associated Component D | Cap - Top Margin (") 30
lzl ® - TREHD - Bottom Margin () 30
Left Margin (") 36
Right Margin (") 60

Longitudinal Angle 00°00'00"
Transverse Angle 00°00'00"
Number of Rows 1

Number of Columns = 5

Generate Piles

Apply Selected Angles

10. Note that the Pile Positions section at the bottom is filled in automatically. If the pile spacing was not

11.

uniform, or you wish to delete a pile, the Manual checkbox could be checked, and the individual pile
parameters could be specified. For this example, the pile spacing is uniform, so click OK to save and
close the Pile Pattern Layout window.

Select OK to save the template and close the Abutment Templates window. The new abutment template
is now complete and is ready to be used with the Place Abutment tool.
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[Braraiee 8.8 Create Substructure Template — Pier

1. Continue with the data set file: BOITMODLBRTR01_5.1_5.2 5.3 5.4 Begin.dgn

2. Open the pier template library by navigating to Utilities > Libraries > Piers.

-

OpenBridge Modeler ~ M@ oW [« N EIEY EE: s
Home Civil Reports and Drawings View Collaborate FDOT Help

— s <> Decks || Columns Abutments || Material
SN - JES T

Interoperability Import/Export

— Barriers <. Footi —~ Wingwall
LEAP LEAP RM ProStructures  Templates pyport O s T (T
Bridge Concrete ¥ Bridge Steel ¥ Bridge v v

Terrain I Beams < SleeperSlab M Cross Frames

,x‘ Stiffeners

Libraries

3. Expand the Multi Column and Default folders, click on Hammer_Head2 and select Copy from the top
of the Selection section.

Pier Templates

Selection

Multi Column\Default\HammerHead2

Open Add Edit Copy Delete | Import Export Move

4 i Multi Column
4 4 Default
#4 1lane _14ft

Lane_30ft

#5 Hammer_Head1

ﬁ‘ Hammer_Head?2

#% Hollow_Pier

C\Worksets\FDOT\ 1234567890 1\Structures\Bridge Templates\PierLib.xml

s

G Sy S Y Sl e S Y S Y S S Y S S

original pier template will now appear on the list under the new name.

In the Create Template Copy dialog box that comes up, enter _TR-Pier as the Name. A copy of the

Select the _TR-Pier template and click Edit from the top of the Selection section. For a Multi Column

pier, the available categories are Cap, Cheek Walls, Columns, Struts, Footings, and Piles.
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6.

7.

In the Cap tab, change the Type to Variable and enter 51 as the Cap Width, which is in inches. Click
the ellipse (...) next to Sections to open the Edit Variable Cap window.

Pier Templates

Mame: _TR-Pier
Category:  Default
Type: Multi Column

Analytical Type: Multi Column v

(&'l Cheek Walls  Columns  Struts  Footings  Piles

Type: Variable v

a

. E _—

Cap Length ()

Cap Height (")
Cap Width ) B |

In the Edit Variable Cap window, enter the information shown in the clip below. Note that there are
seven sections, so the Add Section button will need to be used to add additional rows. The total cap
length should be 44:0, shown as a calculated value at the bottom of the window. All Variations are
linear in this example, but other options are available. Distance From Last is measured in feet and is
the length along the cap to the next height section while Height is measured in inches and is the depth
of the cap at each section. Click OK.

o' Edit Variable Cap - | x
Add Section Remove Up Down
Distance From Last (') Height (") Variation
0:0 36 Linear
812 5112 Linear
6:7 5112 Linear
7812 36 Linear
78152 5112 Linear
6:7 5112 Linear
* 7812 36 Linear
Caplength {): 440 -e———
Update Drawing Cancel

FDOT OBM 100



T

8.

9.

In the Pier Template window, select Front. The variable cap should appear as shown below.

7l BB

co

Display Mode Isometric

Front/Rear Left/Right  Top/Bottom

BRDDP

In the Columns tab, change the Type to Variable. Enter 17:6 as the Length (unadjusted), set Auto
Spacing to Off and set Overhang From Left Edge to 132, which is in inches. Click the ellipse (...) next
to Variation to open the Edit Variable Column window.

Pier Ternplates

Name: _TR-Pier

Category: Default

Length (unadjusted) ()
Auto Spacing

Type: Multi Column
Analytical Type: Multi Column

Cap Cheek Walls ESGIITHTE

Owverhang From Left Edge (7)

Struts  Footings  Piles




\

10. Inthe Edit Variable Column window, change the Shape to Rect-Bevel and change the Start Dimensions
and End Dimensions as shown in the clip below. Note that there are two sections, so the Add Section
button will need to be used to add an additional row. The Section Height is measured in feet and is the
length along the column to the next defined column section, with the top row representing the topmost
column section. One row must be selected as the Adjustable Height so that any changes to column
height based on Elevation Constraints can be accommodated within a section. For the Rect-Bevel
shape, W represents the transverse width of the column, L represents the longitudinal length of the
column, and X/Y represent the bevel dimensions in the transverse/longitudinal directions, respectively.
Set the Section Height of the first row to 10:4 and check the Adjustable Height checkbox for the second

row. Click OK.
Edit Variable Calumn - O X
Sections
I + Add Section I XK Delete Selected Up Down
q - . Start Di i (") End Dii i ) . . .
Section Height (') Shape W.LXY) W.LXY) Variation Adjustable Height

Rect-Bevel 42,51,3,3 42,51,3,3 Linear ~

Template Details

C P PP PP LLLLLLLLLPPLILLLLLLLLLPLPLPLILLLIPLLLLLILSLS

Update Drawing OK Cancel

11. In the Pier Template window, the variable column should appear as shown below.

"l IR EDRD

Display Mode Isometric Front/Rear Left/Right  Top/Bottom
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12. In the Columns tab, click Add Column to add a second column. A second column will be added with
the same column variation, length, and overhang.

Pier Templates - O X
WG LA T
Category: | Default Display Mode Isometric Front/Rear  Left/Right  Top/Bottom
Type: Multi Column +
Analytical Type: | Multi Column v —
L]
Cap  Cheek Walls Struts  Footings  Piles - o
P
I Add Column == O
=
=
+ Column1 X
Type: Variable o
.
Length (unadjusted) () 17:6 ‘ ‘
Auto Spacing Off v
Overhang From Left Edge (") 132

Variation

Length (unadjusted) () 17:6

Auto Spacing Off v

Overhang From Right Edge () 132 a o a o o o

oK Cancel

C\Worksets\FDOT\ 1234567890 1\Structures\Bridge Templates\PierLib.xml

NOTE  While the unadjusted column length is set as a predefined value in the template, users can
later use an Elevation Constraint to set the footing elevation based on the terrain model

and therefore override the column length.
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13. In the Footings tab, keep the Footing Type as Rectangular Isolated. Set the Footing Length to 16:0,
the Footing Height to 63 (inches), and the Footing Width to 10:0.

NOTE

Pier Templates

Name: _TR-Pier
Category: Default
Type: Multi Column

Analytical Type:  Multi Column ~

Cap CheekWalls Columns  Struts Piles

Add Pattern +

Rectangular Isolated v

Footing Length (')

Footing Height (")
Footing Width ()

Rotation Angle
Sloped

Transverse Offset ()
Longitudinal Offset ()

Concrete Pad

Column 1
Column 2

By default, the same footing will be used for both columns. This is the case for this
example, but for cases where there are different footings for each column, Add Pattern
could be used and separate columns could be assigned to each footing. There are also
options for rotated, sloped, or offset footings, as well as an added concrete pad (i.e. seal
slab).
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14. In the Piles tab, keep the Pile Shape as Rectangular. Set the Pile Length as 64:0, the Embed Length
as 12 (inches), and the Pile Width and Pile Depth both as 24 (inches).

Pier Templates

Name: _TR-Pier
Category: Default
Type: Multi Column

Analytical Type: Multi Column ~

Cap CheekWalls Columns Struts  Footings Iaﬂ

Add Pattern ==

Rectangle v B Pattern Layout m

Pile Length ()

Embed Length ()
Pile Width (")
Pile Depth (")

Footing 1
Footing 2

15. Totherightofthe Pile Shape input, click the Pattern Layout button to open the Pile Pattern Layoutwindow.

Cap CheekWalls Columns  Struts  Footings Iaﬂ

Add Pattern ==

Rectangle ~ W Pattern Layout :::
-

bl Pile Length () ‘ Bb4:0

Embed Length (") 12

Pile Width (") 24

Pile Depth (") 24




16. In the Pile Pattern Layout window, within the Pile Layout Generation section, enter the input based
on the image below. Once filled in, select Generate Piles to update the Preview section that shows a
graphical representation of the footing and pile locations. Click OK.

NOTE

Pile Pattern Layout

Associated Component Di

ROS-QREIE

Pile Positions

Manual

MName Left Distance (') Top Distance (')

=% Click here to add new item

- O X

Preview Pile Layout Generation

Footing 1 - Top Margin (") | 24

Bottom Margin (") 24

Left Margin (") | 24
Right Margin ("} 24
Longitudinal Angle = 00°00'00"
Transverse Angle = 00°00°00"
Number of Rows | 2

Number of Columns | 3

Generate Piles A

Apply Selected Angles

Angle Display

® Degrees Ratio

Longitudinal Angle Transverse Angle Pile Length ()

OK Cancel

The Pile Positions section at the bottom is filled in automatically. If the pile spacing was
not uniform, the Manual checkbox could be checked and the individual pile spacing could
be specified. For this example, the piles are spaced uniformly along the defined pile grid,
so the box should remain unchecked. Users can also delete piles from the pile grid by
right clicking on the pile in the Pile Position table and selecting Delete.
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17. In the Pier Template window, select Isometric. The pier template preview should appear as below.
Select OK to save the template and close the Pier Templates window. The new pier template is now

complete and is ready to be used with the Place Pier tool.

Pier Templates - O X
Name:| TR 1 IS RADS
Category: | Default Display Mode Isometric Front/Rear  Left/Right  Top/Bottom

Type: Multi Column +

Analytical Type: Multi Column ~ —

L]

Cap CheekWalls Columns  Struts Footings oo

P

Add Pattern == O

=

==

Rectangle ~ §| Pattern Layout [E]

Pile Length ()
Embed Length ()
Pile Width (")
Pile Depth (")

Footing 1
Footing 2

OK Cancel

C:\Worksets\FDOT\12345678901\Structures\Bridge Templates\PierLib.xml

NOTE Pier rustication can be accommodated using solids modifications if that level of detail is
required. Basic solids modification tools are covered in Chapter 8.
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[Braraiee 8.4 Create Parametric Cell End Bent Template

This exercise will demonstrate how to modify the FDOT Parametric Cell End Bent template. This template
will need to be used on any bridges which the end bents have a skew unless solids modifications on OBM
generated end bents are used. It is built to accommodate end bents with MSE walls and can handle wrap
around MSE wallls on either or both sides, as well as MSE walls going straight across in front of the end bent
on either or both sides. If a wing wall is required, the out of the box wing wall tool could be used or the wing

wall could be modeled manually with the regular MicroStation modeling tools within OBM.

1. Copy the FDOT _Substructure _Parametric_Templates.dgn file in the following location: C:\Worksets\
FDOT\12345678901\Structures\Bridge Templates\Parametric Cells, open that file, and make sure you

are in the End_Bent MSE_L R model.

2. Use the pop-up menu (Spacebar) to open the Variables dialog or search for Variables in the search

bar on the top right.

OpenBridge Modeler
Home  Civil

3 -
0
Qg «

fExplorer
m .,

Primary

roperties

Most Recently Used (2)

IR

e a

&) Place Abu 5 Configuration Variables | %
] Place Cust Ribbon (1)

x/ Variables

Backstage (1)

% Configuration Variables

BT Substructure, Parametic, Templates.dgn (End Bent MOE LT - Openbridge Modeler CE - 2022 Release 2 1 Vanaerer I
L3
@y “lace Cross Frames < Assign Superelevation 72
5. rstructure
-
. Hit Spacebar to
1‘ access pop-up menu
.
4
[ BT R eER L
< Oy ¢ AR @
. OB ORE-C-
BO= S 525 ]
4 o 96 of 1231 i A~ A AT A2 E
P ANMvelE@e ¢
Popups

3. Select the General folder and update the variables as shown below. Note that the grayed-out inputs are

calculated and thus do not need to be entered.

Show Details
—

X/

Tl

4

T —

b (3 Cap
B [ Cheekwall
[ Backwall

Variations

Variables - *
JFile  Tools
= _4. v |ltem Type: MNone ~
Variables Properties
4 Local Variables Variables -

Left Coping to PGL 4' 0"

Right Coping to PC 40" 5"

Skew Angle 13°52°33.9600"
Skew Angle = 90 103°52°33.9600"
Left Side Wrap Arc False

Right Side Wrap Ar True

Barrier Width_Left 1° 6"

Barrier Width_Righ 1" 1"

Coping to Wall Gap 0" 0 1/2"

MSE Lug Width 0*'51/2"

MSE Lug Length 0" 6"

MSE Lug Height 10" 6"

Pile Size 20"

Pile Length 105° 0"

Bearing Seat Width 3" 6"

Bearing Seat Offset 0° 0"

Bearing Seat Lengt 2° 6"
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4. Select the Cap folder and update the variables as shown below. Note that the grayed-out inputs are
calculated and thus do not need to be entered.

X/ Variables — %
File Tools
-{'\D i E-i- A W%  ltemType: MNone ~
4 \ariables Properties
4 Local Variables Variables Y
b9 General Cap Width_Left 4'115/16"
q# cap Cap Width_Right 40° 6 3/16"
b 3 Cheekwall Cap Extension Width_Left A 1" 0 3/8"
Cap Extension Width_Left_Bi 2" 5 1/16™
» [3 Backwall -
o Cap Extension Width_Right_ 1" 13/8"
e Cap Extension Width_Right_ 1" 2 7/16"
Cap Length 36"
Cap Height 2'6"
Cap Slope_Left (32) -1.5870

Cap Slope Angle_Left_Top  00°54'33.1477"
Cap Slope Angle_Left_Bottor -00°54'33.1477"
Cap Slope_Right (%) -1.5870

Cap Slope Angle_Right_Tep 00°34°33.1477"
Cap Slope Angle_Right_Bott: -00°54'33.1477"
Comer Angle_Right_Ahead 103°52'33.9600"
Corner Angle_Right_Back  90°00°00.0000"
Comer Angle_Left_Ahead  76°07'26.0400"
Corner Angle_Left_Back 90°00"00.0000"

5. Select the Cheekwall folder and update the variables as shown below. Note that the grayed-out inputs
are calculated and thus do not need to be entered.

(x) Variables — *

File  Tools

0y | R A W ltemType: MNone ~
4 Variables Properties
4 |ocal Vanables Variables 4
> B3 General Cheekwall Width_R 0" 9"
> B Cap Cheekwall Width_L 1' 0"

>0 Cheekwall Cheekowall Length_| 2" 3 11/16"

6" 23/8"
> [3 Backwal Cheekowall Ler?gth_l 2 f
Cheekwall Height_L 7' 0
Variations Cheskwall Height_ 7' 0
Cheekwall_Corner £ 76°07°26.0400"

Cheekwall_Corner £ 103752°33.9600"
—_— ]
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6. Select the Backwall folder and update the variables as shown below. Note that the grayed-out inputs
are calculated and thus do not need to be entered.

X/ Variables -
File  Tools
£ o 4 i ltem Type:  Mone -
4 Varables Properties
4 Local Variables Variables 4
b [ General Backwall_Width_L 2' 6 7/8
b [ Cap Backwa ::: 40" 6 3/16
b B Cheekwall Backwall Length 1'0°
5 Backwall Height ?1' g;?’u
Variations I DD.:54 33.1477
1 -00°54'33.1477
i -1.5870
1 00°54°33.1477
r -00°54'33.1477

7. When you are done entering the above inputs your end bent should look like what is shown below.
Note that some pieces of the end bent will need to be moved into place manually: MSE Wall lugs, beam
seats (pedestals), and pile. The DeckConc_pm lines are there to help verify that the end bent’s position
relative to the coping lines is correct.
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8. Rotate your view to a right isometric view and use the Copy command to copy the longitudinal MSE
Wall lugs to their position under the cap. Note that there is not a left lug in our example.

i L) View Rotation |7 Gy &
(left click & hald)

Top View
Front View
Right View

Isometric View

Bottom View
Back View
Left View

1) Right-lsometric View

=4 Open as ToelBox

Right Lug Longitudinal MSE %
Position Wall Lugs

Snap point
for right lug
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9. Adjust end of right lug:
a. Select the right lug
b. Click on the solid extrusion icon

Click the blue extrusion arrow

134

d. Snap to the corner of the end bent and left click to accept
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Vertical MSE
Wall Lugs

Lo

<

Right lug position

‘b_l Snap point
< for right lug
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10. Use the Copy command to copy the vertical MSE Wall lug to it's position on the back side of the cap.

11. Switch to the Modeling workflow, select the Solids tab, and click on the Unite command.

Medeling fa ™ .'I_" * - -DOT_Substructure_Parametric_Temp

Home View Curves Surfaces “lelp

e (=2 7™ (A — - -.J_' Unite
IR =k - £l L Oogf  Uni

f\____._] [ J I'\._./'I & A I\] [17 L(’; 4 7 L Subtract

Slab  Cylinder SPPlEFE CC'TV"E Torus Linear = Extrude Extruw Madify  Trim

i Je
Solid Alg Solid  Solid [ Intersect Pie
Primitives Cres Modify Features
Properties * 4 x

12. Set Originals to Hide and uncheck the Merge Parametric Solids box if checked. Select the first cap
piece, hold Control (Ctrl) on your keyboard, and select all the cap pieces to merge into a single solid:
left cap, right cap, left backwall, right backwall, left cheekwall, right cheekwall, all MSE Wall lugs. Then
left click to accept.

6(_?4

Originals: |Hide =
[ Merge Parametric Solids
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13. Switch to a top (plan) view [Shift + Right Click, T on the keyboard], select the beam seats and pile,
and rotate them (Q, R on the keyboard) with the settings shown below. Note that the angle input is the
negative of the skew angle we entered earlier.

4% Rotate

Method: | Active Angle  ~
-13°52'33.9600"| S
About Element Center
| Copies: | 1

Use Fence: |Inside
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14. Turn off the DeckConc_pm level. Move the center of the pile element 4’ away from the front left corner.

a.
b.

134

Select the pile

Move command (Q, W on keyboard)

Snap from CL pile

Snap to the inside face of cheek wall & front face of cap

Press R then E on your keyboard and select the front face of cap to rotate your AccuDraw compass
to the same orientation as the cap

Move your cursor over to the right, hit Enter on keyboard to lock in AccuDraw compass, type in 4,
and data point to place the pile
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15. Move the center of the pile element 1°-9” from the front face of cap using similar methods from step 14.
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16. Use Copy command to Copy the pile element over 9°-10” in the direction shown below, 4 ea copies,
using similar methods from step 14.

Qopies:

Use Fence: |Inside

rg..\lighting.cel]

o/ ] ExT— Y] oo [Z] 00 [l -4 /@ @ X
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17. Switch to a front view (Shift + Right Click, F on keyboard) and use Move command move each pile so
that the top of pile is 1’ above the high side of the bottom of the cap.

a.

b.

C.

Select the pile and Move command (Q, W on keyboard)

Snap to top left edge of pile

Move cursor down, hit Enter on the keyboard to lock in AccuDraw compass, and snap to the bottom

of cap

18. Adjust taper point of beam seat

a
b.

C.

Switch to an isometric view

Select beam seat element

Go to properties and right click on the Taper Face

Delete > Feature

roperties
4 ./)u Elements (1)

Ll f,l Parametric Solid
_} Taper Face #2

> (2 Slab #1

Parametric Setting

Angle
Enabled

@

Select
Rename
Disable C
Enable /
Delete r
Reorder Tree
Collapse History
Zoom

Isolate

Clear Isolate

' View 1, End_Bent MSE_L R

o~ &~

FDOT OBM
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U 98686 668868 £ 8

D

(L= I== T CN R [~ R [V R I S [VE R [ N P

GoREE &Y
Rotate View

Top View

Front View

Right View

Isometric View

Bottom View

Back View

Left View

Right-lsometric View

Open as ToolBox




19. Apply taper to bottom of beam seat

c o

o o

o

Switch to the Modeling Workflow

Go to the Solids tab

Select Taper Face

Choose Design X

Click on the variable icon: (X)

Choose “Cap Slope Angle_Left Bottom” and click OK

—
I I‘E Workset: 12345678901 - FDOT_Substructure_Parametric_Templatg

.C
Primitives Create Solids Features r Modify Features

X
' View 1, End_Bent_MSE_L_R

E-éx- 000040 HOREE YRS

&

11°00'00"
SkewAng\E+ 90 = 103°52'33..,
ap Slope Angle Left Top = ...

Cap SlupeAngIe nght Butt
Corner Angle_Right_Ahead =

Click inside the boundary of the bottom face

Right click to toggle through face selection to get to the bottom face

erties A
g. Select the beam seat
i.

j-

Select the back left corner of the beam seat
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20. Switch to a top view and use the Copy command copy the beam seat from the bottom left corner to the
left corner of the backwall kink
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21.

Switch to a front view and use the Move command to move the beam seat down to the top of the
cap, using the AccuDraw compass to lock the movement to the vertical direction (Enter on keyboard),
snapping from bottom of beam seat to top of cap

Final Beam
Seat Position
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22. Copy Beam seat

a
b.

134

Switch to a top view (Shift + Right click, T on keyboard)
Select the beam seat

Copy command (Q, E on keyboard) and enter 4 for copies
Snap from the CL pile

Press R then E on your keyboard and select the front face of cap to rotate your AccuDraw compass
to the same orientation as the cap

Hit Enter on your keyboard to lock in the AccuDraw compass in the direction of the cap and snap
to the CL of the next pile

Copies: |4

Use Fence: |Inside

Parametric
Solid of
Level: PileCone

Note, modifying the top of each beam seat to match the bottom of each bearing pad in the model is not part
of this exercise. However, to do so you can use the Modify Solid tool to modify (Push/Pull the top face of
the beam seat)

A= C 1T Workset: 12345678901 - FDOT Substructure P
3 Home View Curves Surface Utilities Drawing Aids Collaborate

b i () .",_\‘. (S [ = P A ST = (R Dl 'J:l
= [_J @ (3D [] 0 (% S |L ) (_ & l) D L% =
b Cylinder Sphere Cone Torus Linear | Extrude Extg Jtrude Shell Sweep Imprint Taper  Spin Trim I;'
N N Solid Al Edge Face Face Solid &
Primitives Cre} xatures Modify
Eriies > 1x

=

Mode: | Offset
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23. Now that we are done with the modifications to the parametric end bent model, we need to turn it into a
cell. Start by turning off the ClipDrawingBound_dp level and others shown below. Note you may have
to activate a level other than that to turn it off.

Level Display - View 1 > 1X :
® View 1 - Top, End_Bent_ MSE L R

2 C [View Display - mral- L ®O0ORD| 6y

K= Y AllLev~ [Levels ~| [+A ~

FDOT_Substructure_Parametric_Templates.dgn, End...

Name Used ~ ~

Defa
ipUrawingBound_dp
DD Construction
DDDimensions
eckConc_pm
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24. Go to the Content tab, click on Define Cell Origin, and type in 0, 0, 0 in the X, Y, & Z inputs, hit Enter,
and Right Click to finish.

Hila« -+ #2052 Workset: 12345673901 - FDOT_Substruc

odeling B
Home  View  Curves  Solids  Surfaces Meshl Content | Analyze  Constraints  Utilities  Drawing Aids  Collaborate  Help

= SV 0 o
. A = - o 3 I3
X L VS W . =1
ch Detach Picklist Import/Export  Place  Replach _Define Named  Perforators Placement
Item Active Cell - Cells| Cell Origin | Presentations Points
Item Types & Cells = Parametric Components

Display - View 1 vax
W View1- Top, End_Bent MSE_L_R

E; e - ]
Y aliter [Levels ~| [4 ~

DOT_Substructure_Parametric_Templates.dgn, End...

b3

e Used o

ault
ringSeatConc_pm

rawingBound_dp
onstruction
pimensions

Conc_pm

Footer_pm

sRamp_ep
sePointCell_dp Once you are

, done you should
see the cell origin

cross hair here

| evel Display - View 1

eferences (0 of O unique, O displayed] | | [2] Models

Eﬁifﬂi ~ 0 - - [D endBentmseL R~ |00 [l2]3]4]5]s

% Cell Library: [CAFDOTConnect10.10\0rg.. \lighting cel]

00 : [Z] o0 I
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25. Create the Cell

a. Open the cell library
b. File > New...

c. Browse to the directory: C:\Worksets\FDOT\12345678901\Structures\Bridge Templates\Parametric

Cells, name the cell library: _TR-PC, and click Save

d. Select all the end bent elements you want to turn into a cell

e. Click on the Create Cell button

f. Name the cell: _TR-EndBent3-PC, select Parametric, and click Create. This will likely freeze or
crash OBM. Close out OBM, re-open OBM, and open the cell file you just created. You will need to

make sure file type is set to all in order to see the .cel file.

Parametric Components

tes.dgn, End...

End_Bent_MSE_L_R
LPPOM¢D|G

Name: | _TR-EndBent3-PC
Description: | _TR-EndBent3-PC
Graphic  ~

A" Create Cell Library

FDOT 12345678901 Structures Bridge Templates

Name

butment.cel
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26. Go to the OpenBridge Modeler Workflow, Utilities tab, Assign Tag, under Tag Element select Cap,
select the cap element, and left click to apply the tag. There is no tag available for beam seat, so you
can use the Cap tag for those elements as well. Repeat the same steps for the pile elements, making
sure to use the Pile tag. The parametric cell is now ready to be used in a bridge model.

—
enBricge Modeler =R Hi o « - £ =ladya « FFH = Workset: 12345678001 - _TR-PC.cel (_TR-EndBent-PC) - O

Home Civil Reports and Drawings View Collaborate FDOT Help

a 4 | m =Y ‘&i‘ S pecks || Colomns & Abutaments [1] Materil @ Comnection (] Connector Angls st Q ~ g
[+ ] I 5 L 3 Wi ’ 5 5 s

LEAP LEAR M ProStructures | Templates Export ¢£ Barriers Footings [,7\ ingwall ,X‘Stlffaner. %j Shear Studs Variabid] Assign | import variabi

e Concrete ~  Bridge Steel ~  Bridge - & T Temain JC Beams & Piers 7 SleeperSlab [x] Cross Frames 0 Splices Mappind Tag || GCP File Mappin]
Interoperability Impart/Export Libraries Parametric Cell GC
rties v 1x
= View 1- Top, _TR-EndBent-PC

B Models (1) [~ SRR H1oREE|SIT %

T _TR-EndBent-PC

Tag element Cap

Action to perfo

Delete tag
Identify tag
General ~
Is Active True ;
Name _TR-EndBent-PC (%) More options
Description
Ref Logical

Type Design

s p False

Annctation Scale Full Size 1=1
Design Scale 1.0000

Paper Scale 1.0000

Propagate Annotz On

Line Style Scale  Annotation Scale
Update Fields Aut True

[Variables -~

Left Coping to PG 4" 0"

Right Coping to Pt 40° 5™

Skew Angl 13°52'33.9600"
Ske 103°52'33.9600™
Left Side + False

Right Side Wrap £ True

There are some limitations to using a parametric cell as shown in this exercise:
* Does not generate 2D decor levels as of now

*  Won't report quantities
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Braraiee 85 Model a Bridge Deck, Sidewalk, Barriers, and Add Superelevation

CREATE A BRIDGE AND ADD A BRIDGE DECK

1. Open the data set file: BOITMODLBRTRO01_5.5_Begin.dgn

Create Bridge by selecting Home > Bridge Setup > Add Bridge. Use the input parameters noted below for
the window. The “FDOT Training Bridge” will be created as a result. Note that the Beam Slab (P/S or RC
Concrete Girders) bridge type is selected here.

4B Add Bridge — it

Main ~
Description |FDOT Training Bridge |
Structure Number |123-455 |
Reguires Road Alignment ]

Use Road Alignment For Stationing [

Unit ~
Name |Un'rt1 |
Description |FDOT Training Bridge |
Bridge Type |Beam Slab (P/S or RC Concrete Girders) w |

Feature Ll
Feature Definition |Bridge Decorations ~ |
Mame Prefix |Bridge |
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u# View 1 - Top, 3D Bridge Model E=n = ==
l6d ~ &

Complex Element: CL_Y

Feature: Alignment\Baseline
Active Profile: PR_WB \ Arc

Level: BaselineSurvey

Ref: 1(..\Roadway\4L GNRDO1.dgn)

Select the “CL_WB” alignment. Data point to accept the selection.

NOTE Which alignment and corresponding profile are selected to use with the bridge model will
depend on how Roadway sets up the alignment/profile.

2. Create the SupportLines by going to Home > SupportLine > Place (Multi).

OpenBridge Modeler v HE B+« - = -
Home Civil Utilities Reports and Drawings View Collaborate FDOT Help

- 5 k & ) 0& T Add Bridge T Move \\/ /x,/ \:\_/;
Q E @1 — ﬁ;’ﬁ\dd Unit &7 Terrain 4 + 7
Explorer Element ..., - Import Bridge bl a g = I Place Move Modify
: ™ | Selection i..i ¥ " v Wizard o Alignment & Add Multi-Units -
Primary Selection Bridge Setup 7+ Middle Point |
Explorer X
¢ o View 1-Top, Default 7<% Parallel
File v . 1 e .
fag = &) 3t ~ E 2 Multi

FDOT OBM 130



——

-

Input the parameters shown below in the window.

NOTE

NOTE

4% Place MultiS.. — X
Main ~
£ Length |54:3 |
Offset 183172 |
[ Span Length [162:111/16 |
£ Start Station |2020+08.46 |
£ End Station 2023+34.30 |
SupportLines Number ~

Mumber of SupportLines |3 |

Direction Mode ~
Direction Mode | Direction v

Parameters ~
[ Direction |71°5401.8248" |

Feature o
Feature Definition [Supporthe v l
Name Prefix [Suppoftl.ine l

The length of the SupportLine is important because the width of the deck cannot go
outside the limits of the SupportLine. The SupportLine will by default always be centered
on the alignment. If used for plans production, the SupportLines can be modified in the
Properties after placement.

Direction Mode “Direction” sets the angle of the SupportLine based on bearing. Direction
Mode “Skew” sets the angle of the SupportLine relative to the selected alignment.
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After this information is entered the user can data point in open space to “Enter Start Location.”

[= e

= View 1 - Top, 3D Bridge Model
Eraw- L LBORD v A

Vis

E1'6r+0207

Data point again to Enter Skew. Data point again to Enter End Location.

The window in the following figure will open, where the user can modify each characteristic of these
SupportLines. For this exercise, update the station of SupportLine # 2 and make sure that all the values
match those shown in the figure below. Replace the default “SupportLine#” name to match the FDOT
nomenclature for substructure numbering. This will make it easier to identify the SupportLines and match

them with the substructure locations.

# Name Station Direction Span Length Length Horizontal Offset
"1 FFBW END BENT 1 2020+08.46 71°54'01.8248" 0:0 54:3 -18:3 1/2
2 CLPIER 2 2021+72.13 71°54'01.8248" 163:8 1/16 54:3 -18:31/2
3 FFBW END BENT 3 2023+34.30 71°54'01.8248" 162:2 1/16 54:3 =183 1/2
OK Cancel

The SupportLines should show as seen below. The Place Multi SupportLines tool will automatically allow
the user to start the placement of another set of SupportLines, but the user can end the placement by right

clicking in the view window or by selecting another tool.

8 View 1 - Top, 30 Bridge Model

SErox-i L eRORROEEEE ST -~ d LLROBE Y EEE 5T
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Rotate the orientation of View 1 to be parallel with the line connecting Begin Bridge and End Bridge.
First set the ACS: Utilities (tab) > ACS > Define ACS by Points <OR> [type] R + [type] A, then
place the ACS at the intersection of alignment and “FFBW END BENT 1”. Select the intersection of the
alignment and “FFBW END Bent 3”. Then select the top of the SupportLine to define the y-axis.

2 | Lin
Level: DecorSupporiLines(2D)

2020
Loosoe
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4. On the View toolbar, select View Rotation > Top View. <OR> [Hold Shift] + [Right Click] + [type] T.

. — [

Rotate View

Top View

Front View

Right View

[ [FE ([ %

lsometric View

3

Bottom View
Back View

Left View

[L¥= - - I R [

Right-Ilsometric View

Open as ToolBox

View 1 of the line connecting Begin Bridge and End Bridge should now be parallel with the screen.

5. Create the deck by selecting: Home > Superstructure > Place Deck. Select the _TR-Deck deck
template created in Exercise 5.1 and use the additional parameters shown below. Note that the Chord
Tolerance and Max Dist Between Sections were changed from the default value to 0.328 and 1:0
respectively. Set the Right Start Breakback Distance and Right End Breakback Distance to 1:6. Set the
Left Start Breakback Distance to 1:1 and set the Deck Material to 0400 4 4_Conc Class IV, Bridge
Super. Ensure Concrete Deck is selected as the Feature Definition.
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6(_2,.

Deck ~
Template Name _TR-Deck
Start Station Offset 00
End Station Offset 00
Honizontal Offset 00
Vertical Offset 00

Add Constraints L
Chard Talerance 0.328000000000000
Max Dist Between Sections 10

Analytical Deck

Deck Breakbachs ~
Left Start Breakback Distance 11
Right Start Breakback Distance |16
Left End Breakback Distance 00
Right End Breakback Distance |16

Material -~
Deck Matenal (400 4 4 Conc(

Build Order -~
Build Order 1

Feature ~
Feature Definition Concrete Deck
MName Prefo DECK 1

NOTE An alternative method to building a new deck template in the library would be to select a
default deck template and modify the constraints. See the Variable Constraints section for
how to add variable constraints to a default deck template.

Select “FFBW END BENT 1” as the slab beginning, and “FFBW END BENT 3” as the slab end. Data point
to accept. The deck will be created as seen below. The deck will be modified to fit the proper dimensions in
the following steps. Notice the breakback on the right side of the deck at Begin Bridge.
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6. Begin the Assign Superelevation process by turning on the Superelevation reference in References.
See below.

| References (5 of 5 unique, 2 displayed)

Tools  Properties

T ’ >y Y % =
B v |G 3 [ s‘( D ¢ 7 Il T I A = 2 Q) ¥ Hilite Mode: | Boundaries ~
Slot \‘: 1 File Name Model Description Logical Orientation Presentation | "j *

1 -\Roadway\ALGNRDO1.dgn Default Master Model Coincident Wireframe
2 ASurvey\SURVRDO1.dgn GTDMRD Terrain Coincident Wireframe
3 \Roadway\ALGNRDO1.dgn Default-3D Master Model Ref Coincident Wireframe " .
4 .\Roadway\ALGNRDO1.dgn Superelevation Superelevation Ref-1 Coincident Wireframe m ¥ v
5 ARoadway\ALGNRDO1.dgn Superelevation-3D Superelevation Ref-2 Coincident Wireframe

Scale | 1.000000000 ' 1.000000000 Rotation | 00°00°00" Offset X | 0:0 ¥ 00 £/ 00

m" EI o x‘ ' x |:5] l:l E‘ I} Nested Attachments: | No Nesting * | Nest ept a errides  Never ¥

New Level Display: Config Variable ~ efere

The Superelevation will be displayed in the model view, as shown below.

ge Model
LPPeROaN HemEE| STy 3-G- 2 PLROASHUREEEETX

7. Navigate to and select Home > Superstructure > Assign Superelevation.

8. Select WB-1 as the First Superelevation Section and right click to end the selection.

w View 2, 3D Bridge Model EI@
m-aw- 4 PLROND GoFDE ST

. i<
ation Section

B-1

Select First Superel

Superelevation Section:
Level: CorrSuper_dp
Ref: Ref (..\Roadway\ALGNRD(1.dgn)
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9. Select the Deck created in the previous step as the Candidate.

W View 2, 3D Bridge Model ‘i“ﬂ“ﬁ‘
Bl L PLROaD HoFEE HTR

10. The Superelevation Assignment window will open. The Template Point and Pivot Point need to be
changed to match the screenshot below. To do this:

a. Change the Template Point in the first row to P_1.
b. Change the Pivot Point to P_0.
c. Change the Template Point back to P_5.
For more information about this step, see the ASSIGN SUPERELEVATION section.

Superelevation Assignment

Lanes Lane Detail Offset Pivot Point Start Station End Station Start Slope End Slope gf:;in& Slope Template Point
Lane_L ~ | Station Slo... [-41:0 P_0 ~ | 2020+08.46 2023+34.30 0.020000000000000 | 0.020000000000000 | Station Slo.. |P_5
Lane_R ~ | Station Slo... |5:0 P_0 ~ | 2020+08.46 2023+34.30 0.020000000000000 | 0.020000000000000 | Station Slo... |P_1

OK Cancel

NOTE The Pivot Point can not be the same value as the Template Point. If the user wants to use
the default Template Point as the Pivot Point, then the Template Point will need to be given
a different value beforehand.

11. Select OK to assign the Superelevation. If a Warning box shows up with a warning about the
superelevation point x value simply click Yes to close it.

Template Point
Template Point O (Lane R)
(Lane_L) vF

A A— ——
a0
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12. The result of this exercise is the bridge deck shown below. The Superelevation Reference file is still
turned on in the following figure, but it can be turned off to simplify the viewing window.

=N o 5=

' View 2, 3D Bridge Model
=l ePROadHoRFEE ST R

1.

CREATE SIDEWALK
Create the bridge sidewalk by navigating to Home > Accessory > Place Barrier
& Place Pier Ml Place Custom Abutment J: Place Excavation :°_° Place Point 4
ATl i &) Place Abutment [ Place Wingwall "\ Place Path &

_|' Place Custom Pier @ Place Bearing I/ Place Barrier

Substructure Accessory Approach Slab

2. Next select the deck that was just created as the “Candidate” and fill out the Place Barrier window as

shown in the figure below. For Template Name select the Left Sidewalk template under the Sidewalks
folder. Set the Barrier Material to 0400 4 4_Conc Class IV, Super. Note that the Chord Tolerance and
the Max Distance Between Sections were changed to 0.328 and 1:0 respectively. Set the Feature

Definition to Sidewalk.

FDOT OBM 138



3. End the candidate selection by right-clicking and then data point in open space. This will open the Path
Selection window.

o o =N
Erduc L PEROAD GUREE| ST X
% Place Barrier - x
Barrier -~
Templste Name Left Sidewalk =Ip
Ert SonOFc
e——
——
Material -~
Barrier Material 0400 4 4_Conc Class v, |||
Select Candidate: Data Point on
Candidate to add / Data Point on Pay Unit Linear Unit
selected Candidate to sublract | Reset to
end selection Solid Placement -~
LS R
M it v St
Template Orientation Vertical
Start Cut Orientation Follow Skew
End Cut Orisntation Follow Skew
Build Order -
B B Ot
Feature -~ e
Festure Definition Sidewak
Name Prefix SIDEWALK 1 -

Path Selection - *

Candidate -

| Select Alignment |

| Select Guideline from List |

|0K||Came||

4. Click on Select Guideline from List to open the selection window.




5. Select P_5 from the list and hit OK.

85! Path Selection
Guideline Point Name BTH -1 1
PO A9 H- A RIEHE =
P_1 ]
P_10
P_1
P_2
P_3
P 4

6

P
P 7
F
P

7

8
3

oK Cancel

6. Verify that the blue check mark is showing and hit OK.

Path Selection — et

Candidate -

)

7. The sidewalk will be displayed on top of the deck.

8. Access the component’s properties using the Home > Primary > Properties tool. Then, click on the
“...” next to the Variable Constraints field.

9. In the variable constraints of the sidewalk, toggle Sidewalk Width variable to Active. Next, add a
section with the Mode as SupportLine and running From FFBW END BENT 1. Set both the Start Value
and End Value to be 11:1. Click OK to confirm the inputs and update this segment of sidewalk.
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SingleDeckTemplateWindow - m] *

. - =
=
& 2
2020+08.46 2020+58.46 202 202 2023+08.46
Variable Constraints
Variables 2020+08.46 - 2023+34.30 Left Sidewalk Sidewalk Width Default = 7:1
Variable Active Default Errors Expanded View @ Gric
ation By Ar
Rotation By Sk v -0 I FFBW END BENT 1 - I XK Delete Selected

Sidewalk_Min_
Copy To Variable

Si alk_Slopr
— 4 Location Type Re"“," From Start Distance End Distance Interval Start Value End Value Transition
Location Length
0:0 Gt 202040846 202343430 325:10

0K Cancel

10. The updated sidewalk will be displayed on top of the deck as shown below.

o View 1 - Top, Delna® R ]

-dlid- 4 AEPCED Y REE ST = - 3 B PETED HoREE S
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CREATE BARRIERS

1. Create the left bridge barrier by navigating to Home > Accessory > Place Barrier

2. Next select the sidewalk that was just created as the “Candidate” and fill out the Place Barrier window
as shown in the figure below. For Template Name select the 521-423: 32” Vertical Shape L under the
FDOT folder. Note that the WP for this barrier is at the gutterline which is why there is a horizontal offset
value. For Barrier Material select 0521 5 4_Barrier 32” Vertical Face and select Traffic Railing for the
Feature Definition.

w View 2, 3D Bridge Mode! i = 0
ol 4 POLCCENN HWORESE HVYX

&
Barrier -~

Template Name 521423, 32" V¢

Start Station Offset 00
End Station Offset 00
Horizontal Offset i
Vertical Offset 00

Material FS
Barrier Material 0521 5 4_Bar
Pay Unit Linear Urit

Solid Placement -~

nce 0.3280000
Bel ections | 1:0

Vertical
Follow Skew | >

|Folow Skew

PS

ES

[ J Traffic Railing |~
MName Prefoc (BARENERNL |

3. End the candidate selection by right-clicking and then data point in open space. This will open the Path
Selection window

4. Click on Select Guideline from List to open the selection window.

5. Select P_4 from the list and hit OK.

85! Path Selection — O X
Guideline Point Name = ? = X-3+ 1 Irdn :':H 1

P_O
P_1
P_2

P_2 comerend

LY - TRHEE

P_2 comer start

P 3

P_4 comerend

P_4 comer start

oK Cancel

6. Verify that the blue check mark is showing and hit OK.
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7.

8.
9.

The barrier will be displayed on top of the sidewalk.

Create the right bridge barrier by navigating to Home > Accessory > Place Barrier

Next select the deck as the “Candidate” and fill out the Place Barrier window as shown in the figure
below. For Template Name select the 521-428: 42” Single Slope R under the FDOT folder. For
Barrier Material select 0521 5 14_Barrier 42” Single Slope and select Traffic Railing for the Feature
Definition. Note that the Start Cut Orientation and End Cut Orientation were changed to Normal to
Path to account for the deck breakbacks.

= View 2, 3D Bridge Model el

A PRLOCEAN GHURES S

&

%

&
Barrier ~
Template Name 521-428 42" Sing.
00
00

0521 5 14_Barmie
Linear Uit
A
0 328000000000000 /
ns 1.0

Vertical

Normal to Path

End Cut Orientation Normal to Path
Build Order ~
Bamier Build Order 1
Feature -~

Feature Definition Traffic Railing

Name Prefix BARRIER 1

10.

11.

End the candidate selection by right-clicking and then data point in open space. This will open the Path
Selection window.

Click on Select Guideline from List to open the selection window.
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12. Select P_1 from the list and hit OK.

85 Path Selection - O
B X3 T X103 H
x

=

13. Verify that the blue check mark is showing and hit OK.
14. The barrier will be displayed on top of the deck.
o View 2, Default = = |

o i SO 0MERYy-REE &Y

4
<<
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[Braraiee 8.6 Create a Beam Layout and Model Beams

CREATE A BEAM LAYOUT

1.
2.

Open the data set file: BOTMODLBRTRO01_5.6_Begin.dgn

Create Beam Layout by navigating to and selecting Home > Superstructure > Beam Layout.

Select “FFBW END BENT 1” and “CL PIER 2” as the Start Limit Line and End Limit Line
respectively.

Data Point to Accept the Limit Lines and open the Beam Layout window.
In the Beam Layout window change the Number of Beams to 5.

Notice that there are errors shown in the table of beams. In the Spacing Reference section, update the
fields for all beams to Long Chord and update the beam spacing to the values shown below.

Spans Detaits | Step 5
t Span | FFE NT 1-CL 52

EB Beam Layout - o kS

set Defau Same Beam Star/End Values vanced Bearing Definition
Show Overhang Lengths BEAM START BEAM END REFERENCE
Span L -STED e Step 6
Detault
- - Spacing () Method SL Offset (7) Spacing () Method SL Offset (7)
* FFBW END BENT 1- CLPIER 2 Beam# Name o =i R & - Skew Ends o pcing Reference Beam | Aux Alignment “J" Chord| g cam Length

v

(3
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7. Uncheck the Same Beam Start/End Values box.

8. In the Beam Start section of the table, type 9 into the SL Offset and click an empty cell or press [Tab].
The SL Offset at the Beam Start should now be 9” for all 5 beams. Repeat the same process to change
the SL Offset at the Beam End to -3”. See the image below to verify the inputs.

BB Beam Layout

ement Method  Simple

Alignment  C{_WE Select

G Use
Detault
| Fowevoeenti-cmem2

Aux Alignments

Details

Beam ¢ Name 0:0

Add Delete

BEAM START

Spacing () Method

BEAM END

svew £ Spacing ()| Method
9 0:0 -

27:10

N
N
Norma
N
N

SLoffset (-
SKEWENS gpacing Reference Beam Aux Alignment U5¢ " geam Length

Long Chord
|

ng Chord
Chord
d

ong Chon

REFERENCE

validate

COMCONC SRl SRS

Cancel

9. Repeat Steps 3-8 using “CL PIER 2” and “FFBW END BENT 3” as the limits for the beam layout of Span

2. The Spacing and SL Offset will be different. The values used are shown in the figure below.

Ll Beam Layout ] X
] y
Alignment  CL_WB Select Aux Alignments Add Delete
Placement Method ' Simple
Spans Details
Default Span | CLPIER 2 - FFEW END BENT3 ~ Number Of Beams Edge Distance() 0:0 Apply ¥ Equal Edge Distance
Set All To Default Same Beam Start/End Values Advanced Bearing Definition
Show Overhang Lengths () BEAM START BEAM END REFERENCE
e ';::”“ Spacing () Method JSL Offset (7) Sy () Method JSL Offset (7)
as e aci e 3
| ceee-mewenoeents Beam# Name o I N I““' Ends| ST = IE.9 I"‘“" EndS Spacing Reference Beam Aux Alignment U5 "' peam Length
Beam-L §-37:7 Normal 3 377 Normal -9 DN ord v
Beam-2 J-28:1 Normal 3 28:1 Normal -9 ~
Beam Normal 3 87 Normal -9 v
Beam-4J-9:1 Normal 3 91 Normal -9 =
Beam-R J0:5 Normal 3 05 Normal -9 v
Validate Save Cancel
NOTE For this example, the Long Chord Spacing Reference is used because the alignment is

curved. For bridges with straight alignments, the user can use the Edge Distance and
Spacing fields to layout the beams. Also note that users can rename the beams if desired.
Future versions of OBM no longer use the Beam-L and Beam-R naming convention.

10. Click Save at the bottom of the window to place the Beam Layout in the model. Notice that the Layout
is placed at a 0 elevation. Placing the beam layout is required before the 3D beam elements can be

placed.

o View 1, et
e T s [

== 59

FDOT OBM

146



11. Next, add the actual beams to the bridge. Navigate to and select Home > Superstructure > Place Beam.

Home Ciwvi Utilities Reports and Drawings View Collaborate FDOT Help
ki@ X &f Import ~ ¢ Add Unit &/ Terrain /< Place ~ Place Deck
= Bridge Wizard %y Alionment % Add Multi-Units =~ ~f Move & Jiaphragms [X] Place Cross Frames
Explorer @ I ~ %7 AddBridge % Move #¥ Modify Z Beam Layout
Primary Selection Bridge Setup Supportline Superstructure

12. Verify that the Feature Definition shows Girder and use a Name Prefix of GIRDER 1.

d’_?.a\.

Default Type .3
Custom ]
Orientation LS

Use Beam Rotation [ ]

Build Order -~
Build Order 1

Feature -~
Feature Definition  Girder o
Mame Prefix GIRDER 1

13. Select the beam layout created for Span 1 as the beam layout.

Select Beam Layout

Beam Layoul. BeamLayout
Levels
DECORBEAMLAYOUT(2D)
DECORBEAMENDOFFSET{2D)
DECORBEAMENDCLEXT(2D)
DECORBEAMLAYOUTTEXT(2D)

| Line String
Level: Default
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14.

15.
16.

17.
18.
19.

Data point to Accept the Beam Layout. The Beam Definition window will open to allow the user to
modify the beam properties.

Change the Beam Type to Custom.

Make sure the Compute box is checked. Change the Min. Clearance to 0.5” and the Camber to 2”.
Notice that the haunch at the start and end of beam is automatically calculated.

Change the Start Template to FIB 84.
Verify that all inputs match with the image below.

At the bottom left of the window, verify that the Apply To All Beams box is not checked.

Haunch Rotation Angle

End Template Material

Sort Be
Section Different
Length  Start Template End
) Template
Beams\St: Sections\FDOT

e I Y TY T —

20.
21.

NOTE

Repeat Steps 15-17 for the other four beams and select OK.

Repeat Steps 11-20 to create the beam group for Span 2. Use a Name Prefix of GIRDER 2 for the new
beam group. See the results for this exercise below.

If changes need to be made to the beam group, the user can follow the procedure
below to reopen the Beam Group window (a similar procedure can be used to reopen
the Beam Layout window):

Navigate back to the Beam Definition window by selecting the beam group and opening
the Properties window.

Select the “...” in the Beam Definition field.
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Baardiee 5.7 Model Abutments

PLACE AN OBM ABUTMENT

1. Open the data set file: BOTMODLBRTRO01_5.7 Begin

2. To begin the abutment placement, navigate to the OpenBridge Modeler (Workflow) > Home >
Substructure > Place Abutment.

‘Bridge Modeler CE - 2022 Release 2

alE 57 Place Pier [, Place Custom Abutment

ort -{D Place Abutment [;?PlaceWingwaII

straints | 1 Place Custom Pier €9 Place Bearing

Substructure

3.

|J|%§3.=:=.—.'.'."=.". — e | El

Solid Placement

Template Name |PileCap_TR-EndBent

Integral ]

Ll . ] STEL b

Select Abutment

[an

4 75 Pile Cap
4 3 Defz

I TR-EndBent

7 1 Lane - 14t
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4. Verify that rest of the window inputs match the image below. Note that the Feature Definition should
be Endbent with Concrete Pile. Note that Cap, Column, Footing, and Pile Material options are all
available even if not all elements exist in the chosen abutment template. For components not in the
selected template, they can be left blank or filled in as placeholders by the user.

&

Solid Placement ~
Template Name |PiIeCapLTR—EndBent |
Integral D
Horizontal Offset |—'I 8.6 5/8 |
Longitudinal Offset |D:D |
Apply Skew To Solids
Conform BackWall With Deck Top
Edit Elevation Constraints D
Orientation |Star1 ™ |
Cap Length Adjustment |None > |

Material A
Cap Material 0400 4 5_Conc Class M |
Colurnn Material |D~4ErD 4 5_Conc Class I‘|
Footing Material |D~400 4 5_Conc Class I‘|
Concrete Pad Material |D~4ErD 4 5 Conc Class I‘|
Pile Material |0455 34 5_PSC Piling. £

Build Order v

Feature ~
Feature Definition |Endbentwith Concrete Pi ™~ |
Name Prefix [END BENT 1 |

5. Select FFBW END BENT 1 as the abutment location (Select SupportLine) and then data point again in
open space to accept. The abutment should now be visible in the model view window.

I

‘ e+

p—_——

Select = ——————
SupportLine +
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6. Select the abutment and go into the Properties window for the abutment and change the Backwall
Vertical Offset From Top of Deck to -1:1.75 to accommodate the thickened portion of the approach slab
resting on the backwall.

Abutment ~

Bridge Structure # 123456
State Element Nu 219
NEI Element Nurr 219

Syncld beb4efal-ec6b4el12-b914-¢
Name END BENT 1
Description

Template Name _TR-EndBent

Feature ~
Feature Definition Endbent with Concrete Pile
Substructure Placement Rule A

Elevation Constra SELECT to Edit
Substructure Terr SELECT to Edit
Apply Skew To St True

Coce

o T

BackWall Vertical -1' 3 1/4" I
rrteyiar rm

Horizontal Offset -18' 6 5/8"

Longitudinal Offse 0" 0"

Cap Length Adjus None

Orientation Start
Build Order v
Material v

PLACE A PARAMETRIC CELL ABUTMENT

1. To begin the abutment placement switch to a top view and navigate to and select Home > Substructure
> Place Custom Abutment.

b ‘Bridge Modeler CE - 2022 Release 2
Ra
X @ Place Pier L Place Custom Abutmentl
1 u{’j Place Abutment [_:,:’ Place Wingwall
Explorer . . )
= & - " H ﬁ' Place Custom Pier &9 Place Bearing

Prirary Selection Substructure

2. In the Place Custom Abutment window change the Cell Name to TR-EndBent3-PC.

Solid Placement -~
B - - o
Select Cell
Cell Name Type File Name -

Angle_ Corner R 30 12 | Parametric| Sheet_Pile.ce
Angle_Corner_R_45_10 | Parametric  Sheet_Pile.cel
Angle_Corner_R_45_12 | Parametric Sheet_Pile.ce
Angle_Corner R_60_10 | Parametric  Sheet_Pile.cel

Angle_Corner R_60_12 | Parametric  Sheet_Pile.cel

Corner_L_10 Parametric Sheet_Pile.ce
Corner_L_12 Parametric Sheet_Pile.ce
Corner_R_10 Parametric | Sheet_Pile.cel
Corner_R_12 Parametric Sheet_Pile.ce
Starter_10 Parametric Sheet_Pile.ce
Starter_12 Parametric Sheet_Pile.ce
Typical_10 Parametric  Sheet_Pile.cel

Typical_12 Parametric | Sheet_Pile.cel
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Verify that rest of the dialog box inputs match the image below. Note that the Feature Definition should
be Endbent with Concrete Pile. Note that Cap, Footing, and Pile Material options are all available
even if not all elements exist in the chosen abutment template. For components not in the
selected template, they can be left blank or filled in as placeholders by the user

4@ Place Custom Abutm - x
Solid Placement -

Cell |_TR-EndBent-PC

IType Parametric

Pctive Angle |192'5233.4678"

K-Scale (1.00000000D0DO000D

Jr-scale [1.000000000000000

-Scale |1.000000000000000

Horizontal Offset |ﬂ:ﬂ

ertical Offset |{|':2 7/8
SupportLine Offset |ﬂ:ﬂ
[Cap Length Adjustment |None el

gnore Support Line Skew [

Pinalytical Properties |
Material -
Cap Material 0400 4 5_Conc Class IV ...

Footing Material | |

File Material (0455 34 5_PSC Piling, 2 ...
Build Order v
Feature ~

Feature Definition |Endbert with Concrete Pilé v

Name Prefix |END BENT 3
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4. Select FFBW End Bent 3 as the abutment location (Select SupportLine) and then right click again in
open space to accept. The abutment should now be visible in the model view window.
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Beareise 8.8 Model Pier and Bearings

CREATE A PIER

1. Open the data set file: BOITMODLBRTRO01_5.8 Begin

2. To begin the pier placement for the previously created pier template, navigate to and select Home >
Substructure > Place Pier.

OpenBridge Modeler v Mg~ H l[' Eh/ OpenBridge Modeler CE - 2022 Release 2 S
Home Civil Utilities Reports and L
a NRE * [ T4 ﬁ & Place Pier (A, Place Custom Abutment () Place Excavation
[ 5| i _;J Place Abutment [,J Place Wingwall
Explorer Element ..., - "y : .
z 5 - Selection i ¥ L B ﬁ’ Place Custom Pier @ Place Bearing
Drimary Selection y Substructure

3. Inthe Place Pier window, select “...” next to the Template Name field and select the _TR-Pier template
within the MultiColumn > Default folder of the templates library.

4. Fillin the rest of the input shown in the image below. Make sure that the Feature Definition is changed to
Pier with Concrete Pile, the Cap Length Adjustment is set to Aligned, and the materials are selected
as shown below. Note that Cap, Column, Footing, Concrete Pad, and Pile Material options are all
available even if not all elements exist in the chosen pier template. In this example, Concrete Pad
Material can be left blank.

48 Place Pie - x
Solid Placement A

Template Name MultiColumn\_TR-F|

Integral D

Horizontal Offset |D:D |

Cap Length Adjustment |Aligned ™ |

Edit Elevation Constraints |:|

Material A
Cap Material 0400 4 5_Conc Clz I:ll
Column Material 0400 4 25_Conc Cl| ..
Footing Material 0400 425 Conc Cl| .
Concrete Pad Material I:I
Pile Material 0455 34 5 PSCPili| _..

Build Order ~
Pier Cap Build Order [1 |
Column Build Order [1 |
Footing Build Order [1 |
Concrete Pad Build Order |‘I |
Pile Build Order [1 |

Feature ~
Feature Definition [Pier with Concrete Pil |
Name Prefix [PIER 2 |

5. Select the CL PIER 2 SupportLine as the pier location, and then right click to end the location selection.
Note that more than one SupportLine can be selected to create multiple identical piers, although not
needed in this example.
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6. Data point to create the pier.

- = 53 | ™ View2, Default [E=RECE ">
- ol |4 PRPCADNHSREERE &%

NOTE The view on the right can be obtained by opening View 2 and tiling the views by going to
View > Window > Tile.

7. Setthe terrain as active by navigating to Home > Bridge Setup > Terrain. In the dialog box that opens,
select SURVRDO1 from the dropdown list. Once the terrain is active, footing elevations (and therefore
column length) will be controlled by the terrain file rather than the pier template.

8. Next, we will set footing elevation constraints based on the terrain file. This will override the column
length set in the template and elongate it based on the keyed in cover to the footing. Select the pier
in View 1 (which will highlight pink) and open the Properties window (Home > Primary > Properties).

OpenBridge Modeler * WE T H I[' _}
Home Ciwvil Utilities Reports and [J

R - k & EY

D 1 |
Explorer Element ... -~ m
Selection .. ~ ‘@ W ~

Primary Selection

w View 1 - Top, Default

- o] 4 £ LREANI

Jao(dey o I | maip - Ae|dsi] (ana)
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9. Within the Properties window under Substructure Placement Rule, click SELECT to Edit next to
Elevation Constraints and then click the ellipse (...) to open the Elevation Constraints window.

@] Properties - x

4 5 Elements (1)
4 & Pier Element: Unit 1= PIER 2
> (7 Caps
> J]_ Columns
> & Footings
> Piles -

Pier v
Feature

Substructure Placement Rule ~

=S eRNEET A SELECT to Edit
Substructure Template SELECT to Edit \

Integral False
Horizontal Offset -18' 10 15/16"
Cap Length Adjustment Aligned

Build Order v

Material

10. Click the Footing tab, make sure From DTM is selected from the dropdown, enter -3:0, and click Apply
to All. This will set the value for both footings to -3:0 (i.e. 3 feet below the minimum terrain point within
that particular footing). Click OK to close the window.

Elevation Constraints - O -

From DTM > [ -30 II Apply To All

ID Constrained Mode Value

From DTM -3:0

Mote: Reference is top of footing elevation.

OK Cancel
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CREATE BEARING ELEMENTS

reinforcement) can be selected. Currently, the cells are not compatible with the FDOT
automated bridge quantities. Users can either use the cells and manually add the quantity
or use a Bearing Type of Cube or Cylinder, which will also need to be used in the case of

non-standard bearing pads.

FDOT OBM

1. Add bearings to End Bent 1 by navigating to Home > Substructure > Place Bearing.
OpenBridge Modeler v T H Ir' Bh/ OpenBridge Modeler CE - 2022 Release 2
Home Civil Utilities Reports and L
. P, r -
q CIRA * [ ) ﬁ f‘? Place Pier Place Custom Abutment (2] Place Excavation
E L-=| X J_] Place Abutment [’47 Place Wingwall
Explorer Element ... - I"y : .
= G - Selection i ¥ - 5 ﬂ’ Place Custom Pler
Domary Selection 2 Substruciyre
2. Fillin the Place Bearing window as shown below.
f‘ Place Bea - >
Bearing ~
Bearing Type
Cell Type H
Active Angle 00°00'00"
*-Scale 1.000000000000000
Y-Scale 1.000000000000000
Z-Scale 1.000000000000000
Orientation
Grout Pad/Bevel Plate ~
Has Pad or Plate ]
Bearing Seat ~
Has Bearing Seats I:‘
Path ~
Material ~
Pad or Plate Material 0460 2 2_Steel G|
Bearing Material 0400147_Neopre | .
Bearing Seat Material 0400 4 5_ConcC| .
Build Order ~
Pad or Plate Build Order
Bearing Build Order
Beam Seat Build Order
Feature ~
Feature Definition Neoprene Compos ™
Name Prefix BEARING 1
NOTE Inthis example, the Bearing Type of Cell is used. The standard FDOT bearing pads (without

15

oe]




3. Check the box next to Has Pad or Plate and fill in the following input.

48 Place Bea - X
Bearing ~

Bearing Type Cell ~
LIl S S S S LT SR S W

=TT TN ATT

Grout Pad/Bevel Plate ~
Has Pad or Plate S
Pad Thickness Definition Min. Thickness ™
Pad Min Thickness 00142
Pad D1 0:6
Pad D2 0:6
Pad W1 16
Pad W2 16
Pad Crientation Girder ™

b Jraghgal M A S S P

Al 2. dn sl

Feature ~
Feature Definition Neoprene Compos ™
Name Prefix BEARING 1

4. Check the box next to Has Bearing Seats and fill in the following input.

48 Place Bearing Un a .
Bearing *

PaghTigh. S S H S o P

vadLoente.on SirG

Bearing Seat ~
Has Bearing Seats S
Model Stepped Cap ]
Model As Sloped Bearing Seats |
Seat Min. Thickness
Seat D1
Seat D2
Seat W1 19
Seat W2 19
Seat Orientation Pier ™

o Bty 2 2 2 0 0 0 2 2

N N al B
Feature ~
Feature Definition MNeoprene Compos ™
MName Prefix BEARING 1

5. Select the FFBW END BENT 1 SupportLine as the bearing location.

6. Right click to end SupportLine selection. Data point to place the bearings: bearing pads, beveled
bearing plates, and beam seats (pedestals).

FDOT OBM 159



7. Now add the bearing pads and beveled bearing plates to End Bent 3. The pedestals will not be placed
with the Place Bearing tool since they were incorporated into the parametric cell. Navigate again to
Home > Substructure > Place Bearing. Fill in the window as shown below. Has Bearing Seats is
unchecked and the Back Offset and Ahead Offset are different than End Bent 1.

&8 Place Bearing Un — >
Bearing ~
Bearing Type Cell ™
Cell Type H
Active Angle 00°00'00"
X-Scale 1.000000000000000
Y-Scale 1.000000000000000
Z-Scale 1.000000000000000
Orientation
Grout Pad/Bevel Plate ~
Has Pad or Plate
Pad Thickness Definition Min. Thickness ™
Pad Min Thickness 0:01/2
Pad D
Pad D2
Pad W1
Pad W2
Pad Orientation
Bearing Seat ~
Has Bearing Seats I:‘
Path ~
Back Offset
Material ~
Pad or Plate Material 0460 2 2_Steel G| ..
Bearing Material 0400147_Neopre| .
Bearing Seat Material 0400 4 5 Conc C| ...
Build Order ~
Pad or Plate Build Order
Bearing Build Order
Beam Seat Build Order
Feature ~
Feature Definition Neoprene Compos ™
Name Prefix BEARING 1

8. Select the FFBW END BENT 3 SupportLine as the bearing location.

9. Right click to end SupportLine selection. Data point to place the bearings: bearing pads, and beveled
bearing plates.
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10.

1.

Now add the bearings to Pier 2 by again navigating to Home > Substructure > Place Bearing. Fill in
the window as shown below.

@ Place Bearing Un... - X
Bearing ~
Bearing Type ]Cnl El]
Cell [ Type H | ...
Active Angle |00'0000”
X-Scale |1.000000000000000
Y-Scale |1,000000000000000
Z-Scale |1.000000000000000
Orientation | Girder ~
Grout Pad/Bevel Plate e
Has Pad or Plate
Pad Thickness Definition [Min. Thickness |~ |
Pad Min Thickness 00172 Path ~
Pad D1 06 Back Offset [0 |
Pad D2 06 Ahead Offset lo11 |
Pad W1 e
. s Material A
Pad Orientation Girder Vﬂ Pad or Plate Materal wl e |
e —— " Bearing Material M: -
Bearing Seat Matenial 0400 4 5 ConcC|
Has Bearing Seats —
Model Stepped Cap O Build Order A
Model As Sioped Bearing Seats [] Ped or Plate Build Order [
Seat i Thickinss [os Bearing Build Order 1
Seat D1 011172 Beam Seat Build Order 1 |
Seat D2 lo-11
Seat W1 [19 Feature ~
Seat W2 e Feature Definition |Ni~uprana Cnmpuirﬂ]
Sest Orentation [Pier I~ ] Name Prefix [BEARING 1 |

Select the CL PIER 2 SupportLine as the bearing location. Right click to end SupportLine selection.
Data point to place the bearings: bearing pads, beveled bearing plates, and beam seats (pedestals).




Bwreise 8.9 Create Approach Slabs

CREATE APPROACH SLABS

1.
2.

Open the data set file: BOTMODLBRTRO01_5.9 Begin.dgn

Before placing the approach slab in the model at beginning of bridge, SupportLines must be placed
to denote the limits of the approach slab. The approach slab requires two sections of deck: one
section with a vertical offset required for the asphalt cover and one section for a no offset on top of
the backwall. Therefore, two new SupportLines will need to be created by navigating to and selecting
Home > SupportLine > Place > Multi. Note that if a rigid approach slab is used there is no need for
two approach slab sections as no asphalt overlay needs to be accommodated.

Use the Place Multi SupportLine window with the Direction Mode set to Direction and verify the
SupportLine information below. Input parameters are shown in the window below.

4'%33?:&..:3 —

Main A
Length |54:3- |
Offset 183122 |
[] Span Length |25':4 374 |
Start Station 2013+76.96 |
End Station |2020+06.36 |
SupportLines Number L

Mumber of SupportLines |2 |

Direction Mode -~
Direction Mode |Directin:|n v |
Parameters e
Direction 71°54101.8248" |
Feature S
Feature Definition |Suppnrtljne w |
Mame Prefix |Suppu:urt Line |
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4. Once this information has been entered, the user can data point in open space to Enter Start Location.

# View - Top, Defaut (==

E-oiR-d PPOOND HUFRERNT

Enter Start Location

Main:Offset | EEREEF

Data point again to Enter Skew. Then data point one last time to Enter End Location.

5.  When the Modify Multi SupportLines window comes up, rename the new SupportLines to match what is
shown in the image below. Then select OK to confirm the SupportLine data and close out of the Modify
Multi SupportLines window.

z Mame Station Directicn Span Length Length | Horizontal Offset
+ 1 APP SLAB 1 BEGIN 201947696 71°54'01.8248" 0:0 54:3 -18:21/2
2 APP SLAB 1 TRANSITION 202040636 71°54'01.8248" 20:413/16 34:3 -18:21/2
OK Cancel

6. Repeat steps 2 through 5 to create the SupportLines for the approach slab at the end of the bridge. The
Start Station and End Station should be 2023+36.36 and 2023+65.18, respectively. Once the names
are updated to match below, click OK to confirm the SupportLine data.

Place Multi Supportlines X
z Name Station Direction Span Length Length | Horizontal Offset
$ 1 APP SLAB 2 TRANSITION | 2023+36.36  71°54'01.8248" 0:0 54:3 -18:3 172
2 APP SLAB 2 END 2023+63.18  71°54'01.8248" 28:913/16 54:3 -18:31/2
OK Cancel
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With the SupportLines all in place, the approach slabs are ready to be modeled. Using the second
method discussed earlier in the APPROACH SLABS section of this manual, the approach slab will be
created using the Place Deck tool. Navigate to and select Home > Superstructure > Place Deck. This
approach slab will use a negative vertical offset to account for the 1.75” asphalt layer. Use the _TR-
AppSlab template that was created in Exercise 5.1 and the Approach Slab features definition. Match
the information window shown in the image below.

Deck »
Template Name _TR-App5lab
Start Station Offset 0:0
End Station Offset 0:0
Horizontal Offset 0:0
Vertical Offset 0:1 374
Add Constraints ]
Chord Tolerance 0.100000000000000
Max Dist Between Sections 1.0
Analytical Deck ]
Deck Breakbacks »

Left Start Breakback Distance  0:0
Right Start Breakback Distance 16
Left End Breakback Distance  0:0
Right End Breakback Distance 0:0

Material ~
Deck Material 0400 210_Conc

Build Order )
Build Order 1

Feature ~
Feature Definition Approach Slab W
MName Prefix APP SLAB 1
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8. Begin placing the approach slab by selecting the limits of the approach slab. Select the first deck
boundary by left clicking on the APP SLAB 1 BEGIN SupportLine and select the APP SLAB 1
TRANSITION SupportLine as the second deck boundary. Data point to accept the orientation, and the

approach slab will appear in the model.

8 View 2, Default o |5 ]

E-ol%-|4 PPROYD | HRED ITHS
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9.

Repeat the process for the 2ft approach slab transition segment, selecting the APP SLAB 1 TRANSITION
and FFBW END BENT 1 SupportLines as the limits and using the information below.

@ Place Dec —

Deck Ea
Template Name
Start Station Offzet 0:0
End Station Offset 0:0
Horizontal Offset 0:0
Vertical Offset 00 |
Add Constraints ]
Chord Tolerance |D_‘I 0000000000000 |
Max Dist Between Sections 1.0
Analytical Deck ]

Deck Breakbacks ~

Left Start Breakback Distance  0:0
Right Start Breakback Distance 0:0
Left End Ereakback Distance  |1:1
Right End Breakback Distance 16

Material Ll
Deck Material 0400 2 10_Conc

Build Order S
Build Order 1

Feature -~
Feature Definition Approach Slab W
MName Prefix APP 5LAB 1

10. The thickness of the 2ft approach slab transition segment needs to be changed 1°-1%4” so that the

1.

bottom of slab matches the 28ft segment that was vertically offset for the asphalt. However, the Assign
Superelevation tool must be used before changing any other variable constraints. Repeat Step 6
through Step 11 in the “Create a Bridge and Add a Bridge Deck” portion of Exercise 5.5 for both
segments of the begin approach slab.

Once superelevation has been applied to both segments, turn off the Superelevation reference file and
click on the 2ft transition segment of the approach slab so that it is highlighted, as shown in the following
image.
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s View 1 - Top, Default
=-8%- [P LROAD HLEEE &YX

12. Access the component’s properties using the Home > Primary > Properties tool. Then, click on

“...” next to the Variable Constraints field.

& Properties

4 P Elements (1)

I @ @Label_

4 2 Deck Element: Unit 1:: APP SLAE 2

Items_Related@

Point Cantrol

Top Surface fArea

Max Dist Between Se 1" 0"

VEE ARG ST SELECT to Edit

SELECT te Edit
93578 5q.°

& SE=WE-1

General A
Bridge Structure ¥ 123456

State Element Mumbe 12

MBI Element Number 12

Syncld d0113¥6a-6b67-4d3a-8090-ddd
Deck -~
MName APP SLAB 2

Description

Template Name _TR-AppSlab

Analytical Deck False

Start Station Offset 0" 0™

End Station Offset 0" 0"

Horizontal Offset oo

Vertical Offset oo

Template SELECT to Edit

Chord Tolerance 0 3 15716
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13. Once in the variable constraints of the approach slab, toggle the Thickness variable to Active. Next,
add a section with the Mode as SupportLine and running From APP SLAB 1 TRANSITION. Set both
the Start Value and End Value to be -1:1 3/4. Click OK to confirm the inputs and update this segment
of approach slab.

SingleDeckTemplateWindow - O ®

06

8 C
= =z
083 ]
3 g
1=
=
24003 &
¢
&
144<
1.6
-1.8-
r T T T T
2020+06.36 2020+06.86 2020+07.36 2020+07.86 2020+08.36
Station Distance
Variable Constraints

Variables 2020+06.36 - 2020+08.46 _TR-AppSlab Thickness Default = -1:0

Variable Active Default Errors

Expanded View @ Grid View
1T Slope v
PGL_to_LT Copi
PGL_to_RT Cop

Rotation By An;

0.020000000000000
-40:5

40

00700'00"
0.000000000000000

Add Section  Mode: | Supportline ' From | APP SLAB 1 TRANSITION

Copy To Variable
¥ Delete Selected
Interval

Rotation By Slo =l Start Distance End Distance
Location Length
RT Slope

0.020000000000000
L

Location Type Start Value End Value Transition

OK Cancel

NOTE 1) Check mark Active indicates that the variable is changed. Highlighted in blue means

that the variable is in editing mode.
2) Use the green plus button to add additional constraints.
3) Top graphical view verifies accuracy.

14. See below for summary of approach slab data used in the exercise.

Approach Slab Data (ft)
Span ngrft;(;?I Thickness Slrgg}(ggirli BRrigglt(tl)Eancdk
Distance Distance
28t A;‘;gﬂteﬁt"e”ay 0:1 3/4 1:0 1:6 0:0
i i 0 111 3/4 0:0 16

15. The slab segments should appear as shown below.
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16. Repeat Steps 2 through 13 for the end bridge approach slab. Use inputs from the table below.

Exercise 5.9 - Create Approach Slabs

16

Segment)

Create Approach Slabs
Step Window Field Name (Section) Field Input
Template Name (Deck) _TR-AppSlab
Vertical Offset (Deck) 0:0
Left Start Breakback Distance (Deck Breakbacks)  |0:0
Place Deck (End Approach Right Start Breakback_[]lstance (Deck Breakbacks) |1:6
- Left End Breakback Distance (Deck Breakbacks) 0:0
Slab - 2ft Transition
Right End Breakback Distance (Deck Breakbacks) |0:0

Deck Material (Material)

0400 210 Conc Class Il, Approach Slabs

Feature Definition (Feature)

Approach Slab

Mame Prefix (Features) APP SLAB 3
SupportLines FFEW END BENT 3 to APP SLAB 2 TRANSITION
Template Name (Deck) _TR-AppSlab
Vertical Offset (Deck) -0:13/4
Left Start Breakback Distance (Deck Breakbacks)  |0:0
Right Start Breakback Distance (Deck Breakbacks) |0:0
Place Deck (End Approach -
Left End Breakback Distance (Deck Breakbacks) 0:0
Slab - 28ft Asphalt Overlay [— -
Right End Breakback Distance (Deck Breakbacks) |16

Segment)

Deck Material (Material)

400 210 Conc Class Il, Approach Slabs

Feature Definition (Feature)

Approach Slab

Name Prefix (Features)

APPSLAB 4

SupportLines

APP SLAB 2 TRANSITION to APP SLAB 2END
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1.

CREATE SIDEWALK

The last step is to place the sidewalks and barriers on the approach slabs. To start, Create the bridge
sidewalk by navigating to Home > Accessory > Place Barrier

Next, select the 28ft asphalt overlay segment of the begin approach slab (APP SLAB 1) that was
created as the “Candidate”.

To accommodate for the vertical offset of the 28ft segment of the approach slabs, there are special
barrier and sidewalk templates created for each side that are slightly thicker at the base. Access the
template selection through the Template Name field and select the Left Sidewalk_Flex AP template
under the Sidewalks folder.

Ensure that the Horizontal Offset to 0:0. Update the Barrier Material to 0400 4 4_Conc Class IV Super
and Feature Definition to Sidewalk. Lastly, ensure that the respective Start Cut Orientation and End
Cut Orientation are both set to Follow Skew.

u View 1 - Top, Defult =i e

Salsd Placenent

1 11 711 YO 1 o 1
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5. Reset (right click) to end selection and then data point to continue.

6. In the Path Selection window select Select Guideline from List, then select P_5 from the list of
Guideline Point Names and click OK.

Candidate -

= 7

o5 Path Selection - O x
Guideline Point Name EIR T S i Gl H 1
PO ERRCE R = Lle
P
P_2
P3
P_4

Select Guideline from List
:

oK

Select Alignment

oK Cancel

7. Verify that the blue check mark is showing in the Path Selection window and then click OK to place the
barrier.

Candidate —

M= 00 %

8. The sidewalk will be displayed on top of the approach slab.

= & =
- D A S
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9. Select the previously created sidewalk and access the component’s properties using the Home >
Primary > Properties tool. Then, click on the “...” next to the Variable Constraints field.

10. In the variable constraints of the sidewalk, toggle Sidewalk Width variable to Active. Next, add a
section with the Mode as SupportLine and running From APP SLAB 1 BEGIN. Set both the Start
Value and End Value to be 11:1. Click OK to confirm the inputs and update this segment of sidewalk.

Méq=z =
@ Q
142 %
3 5
n2{® E
a
. B 2
3 111 a
= &
=4
108 4
106 1
104~
T T T T T T
2019+76.96 2019+81.96 2019+86.96 2019+91.96 2019+96.96 2020+01.96
Station Distance
Yariables 2019+76.96 - 2020+06.36 Left Sidewalk_Flex AP Sidewalk_ Width Default = 7:1
Variable Active Default Errors Expanded View @ Grid View
Rotation By Ar 00°00°00"
Rotation By Sl 0.000000000000000 Add Section  Mode:  Suppartline v 0:0 ' From | APPSLAB 1 BEGIN B o XK Delete Selected
Sidewalk_Min_ 0:6
[
Sidewalk_Slop ~0.020000000000000 | STy 1 e 2
__- Location Type Relall_ve From Start Distance End Distance Lz Start Value End Value Transition
Location Length
oK Cancel

Repeat Steps 1 through 10 for the sidewalk on other segments of the bridge approach slabs. Use inputs
from the table below.

Exercise 5.9 - Create Approach Slabs

Create Sidewalk

Step Window Field Name [Section) Field Input

Template Name (Barrier) Left Sidewalk

Horizontal Offset (Barrier) 0:0

Place Barrier (Begin - - -
Barrier Material (Material) |0400 4 4 Conc Class IV, Super

Approach Slab - 2ft —— -
Feature Definition (Feature) |Sidewalk

Transition Segment)

Mame Prefix (Features) SIDEWALK 3
Candidate APP SLAB 2 (Begin Approach Slab - 2ft Segment)
Template Name (Barrier) Left Sidewalk

Horizontal Offset (Barrier) 0:0

Place Barrier (End - - -
Barrier Material (Material) 0400 4 4 Conc Class IV, Super

11 Approach Slab - 2ft
PP Feature Definition (Feature) |Sidewalk

Transition Segment) -
Mame Prefix (Features) SIDEWALK 4

Candidate APP SLAB 3 (End Approach Slab - 2ft Segment)

Template Name (Barrier) Left Sidewalk_Flex AP

Horizontal Offset (Barrier) 0:0

Place Barrier (End - - -
Barrier Material (Material) |0400 4 4_Conc Class IV, Super

Approach Slab - 28ft
PP Feature Definition (Feature) |Sidewalk

Asphalt Overlay Segment
P L }NamePrefixl{Features} SIDEWALK 5

Candidate APP SLAB 4 (End Approach Slab - 28ft Segment)
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CREATE BARRIERS

1. Create the left bridge barrier by navigating to Home > Accessory > Place Barrier

2. Next select the sidewalk on the 28ft asphalt overlay segment of the begin approach slab (SIDEWALK
2) as the “Candidate” and fill out the Place Barrier window as shown in the figure below. For Template
Name select the 521-423: 32” Vertical Shape L under the FDOT folder. Note that the working point
(WP) for this barrier is at the gutterline which is why the Horizontal Offset needs to be set to 1:1. For
Barrier Material, select 0521 5 4_Barrier 32” Vertical Face and select Traffic Railing for the Feature
Definition.

G-l |4 PPOOND G EED &R TYH

B Place Barrier —

Barrier

e

521-423: 32" Vert

!)

Template Name
Start Station Offset
End Station Offset
Horizontal Offset

Vertical Offset

Material

!3

Barrier Material 0521 5 4_Bame]

Pay Unit Linear Unit
Solid Placement ~
Select Candidate: Data Point on
Candidate to add / Data Point on Cherd Tolerance
selected Candidate lo sublract / Reset to
end selection Max Dist Between Sections |16:4 7/8
Unit 1 SIDEWALK 2\ Template Orientati
Template : Left Sidewalk_Flex AP emplate Crientation Verical
Projected Length - 294 578 Start Cut Orientation Folow Skew
Level: SidewalkBrdg_pm End Cut Orientation Follow Skew
Build Order ~
Barrier Build Order
Feature ~
Feature Definition Traffic Raiing
Name Frefix BARRIER 1

3. End the candidate selection by right-clicking and then data point in open space. This will open the Path
Selection window.

4. Click on Select Guideline from List to open the selection window.




5. Select P_5 from the list and click OK.

o5 Path Selection - O x
Guideline Paint Name B<SH -1 s H 1
PO R]OS- QBN
P_1
P2
P_3

P_3.comer.end
P_3.comer.start
P_4

, CE— |
P_5comer.end

P_5.comer start

oK Cancel

6. Verify that the blue check mark is showing next to the WP in the Path Selection window and click OK.

7. The barrier will be displayed on top of the sidewalk.

8. Repeat Steps 2 through 6 for the left barrier on other segments of the bridge approach slabs. Use
inputs from the table below.
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Exercise 5.9 - Create Approach Slabs

Create Barriers

Place Barrier (Begin
Approach Slab - 2ft
Transition Segment)

Step Window Field Name {Section) Field Input
Template Mame (Barrier) 521-423: 32" Vertical Shape L
Horizontal Offset (Barrier) 1:1

Barrier Material (Material)

0521 5 4_Barrier 32" Vertical Face

Feature Definition (Feature)

Traffic Railing

Mame Prefix (Features)

BARRIER 4

Candidate

SIDEWALK 3 (Begin Approach Slab - 2ft Segment)

Path Selection Guideline

P4

Place Barrier (End
a Approach Slab - 2ft
Transition Segment)

Template Name (Barrier)

521-423: 32" Vertical Shape L

Horizontal Offset (Barrier)

1:1

Barrier Material (Material)

0521 5 4 Barrier 32" Vertical Face

Feature Definition (Feature)

Traffic Railing

Mame Prefix (Features)

BARRIER 5

Candidate

SIDEWALK 4 (End Approach Slab - 2ft Segment)

Path Selection Guideline

P4

Place Barrier (End
Approach Slab - 28ft
Asphalt Overlay Segment)

Template Name (Barrier)

521-423: 32" Vertical Shape L

Horizontal Offset (Barrier)

1:1

Barrier Material (Material)

0521 5 4_Barrier 32" Vertical Face

Feature Definition (Feature)

Traffic Railing

Mame Prefix (Features)

BARRIER 6

Candidate

SIDEWALK 5 (End Approach Slab - 28ft Segment)

Path Selection Guideline

P 5

Accessory > Place Barrier if it is not already open.

10.

The last component to add to the approach slabs is the right bridge barrier. Again, navigate to Home >

Next, select the 28ft asphalt overlay segment of the begin approach slab (APP SLAB 1) as the

“Candidate” and fill out the Place Barrier window as shown in the following image. For Template Name
select the 521-428: 42” Single Slope R - Flex AP under the FDOT folder. For Barrier Material select
0521 5 14_Barrier 42” Single Slope and select Traffic Railing for the Feature Definition. Note that the
Start Cut Orientation was changed to Normal to Path to account for the deck breakbacks.

w0 View 2, Default
E- -4 LLOTAD

/ Data Point o
Candidate to subiract / Reset to
ction

Unit 1 = APE SLAB 11 APP SLAB 1
Level: AppSlabConc_pm

(=0 e 58

&
Barrier
Template Name 521428: 42" Sin|
Start Station Offset
End Station Offset
Horizontal Offset

Vertical Offset

i I

Material

Barrier Material

|

0521 514_Bame
== Pay Unit

Solid Placement
| Chord Tolerance 100000000000000
" | Max Dist Between Sections
Template Orientation fertical
== Start Cut Orientation jomal to Path |~

End Cut Origntation

Build Order

Barrier Build Order

Feature
Festure Definition raffic Railng__|»

Name Prefix BARRIER 1

= E FIE =lle g
E A c
H e g
0 s g
H 1
H
> > < < > <
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11. End the candidate selection by right-clicking and then data point in open space. This will open the Path

Selection window.

12. Click on Select Guideline from List to open the selection window.

13. Select P_1 from the list and hit OK.

o5 Path Selection

Guideling Point Name:
P_D
»
P2
P_3
P4
P 5

B kX3 L xe e
ko8- QREHE

E=a™!

=8

OK

Cancel

14. Verify that the blue check mark is showing next to the WP in the Path Selection window and click OK.

15. The barrier will be displayed on top of the sidewalk.
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16. Repeat Steps 9 through 14 for the right barrier on other segments of the bridge approach slabs. Use

inputs from the table below.

Exercise 5.9 - Create Approach Slabs

16

Place Barrier (Begin
Approach Slab - 2ft
Transition Segment)

Create Barriers

Step Window Field Name {Section) Field Input
Template Name (Barrier) 521-428: 42" Single Slope R
Horizontal Offset (Barrier) -1:6

Barrier Material (Material)

0521 514 Barrier 42" Single Slope

Start Cut Orientation (Solid Placement)

Follow Skew

End Cut Orientation (Solid Placement)

Normal to Path

Feature Definition (Feature)

Traffic Railing

MName Prefix (Features)

BARRIER 8

Candidate

APP SLAB 2 (Begin Approach Slab - 2ft Segment}

Place Barrier (End
Approach Slab - 2ft
Transition Segment)

Template Mame (Barrier)

521-428: 42" Single Slope R

Horizontal Offset (Barrier)

-1:6

Barrier Material {Material)

0521 514 Barrier 42" Single Slope

Start Cut Orientation (Solid Placement)

Mormal to Path

End Cut Orientation (Solid Placement)

Follow Skew

Feature Definition (Feature)

Traffic Railing

MName Prefix (Features)

BARRIER 9

Candidate

APP SLAB 3 (End Approach Slab - 2ft Segment)

Place Barrier (End
Approach Slab - 28ft
Asphalt Overlay Segment)

Template Name (Barrier)

521-428: 42" Single Slope R - Flex AP

Horizontal Offset (Barrier)

-1:6

Barrier Material (Material)

0521 514 Barrier 42" Single Slope

Start Cut Orientation (Solid Placement)

Follow Skew

End Cut Orientation (Solid Placement)

Mormal to Path

Feature Definition (Feature)

Traffic Railing

Mame Prefix (Features)

BARRIER 10

Candidate

APP SLAB 4 (End Approach Slab - 28ft Segment)
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17. Use the following image to place when confirming barriers on the begin and end approach slab. Note
that the begin approach slab is shown and the end approach slab will be the same templates but

mirrored longitudinally.

® View 2, Default =B ]
Erox-d OOz Ea=m TR
2 7
521-423: 32" Vertical Shape L D __
521-423: 32" Vertical Shape L / /_,/"
/ 521-428: 42" Single Slope R
; P4 Left Sidewalk
P_5 Left Sidewalk_Flex AP
521-428: 42" Single Slope R - Flex AP P_1

18. The final product of Exercises 5.9 is shown below, with the Superelevation reference turned off. Note
that, if required, the asphalt pavement can be modeled as another deck on top of the 28ft segments.
Approach Slab Asphalt Pavement has its own Feature Definition.

ol
-t PERLOND HwEEERTX

w2 PPROQD HwEEE ST
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6 PLANS DEVELOPMENT

OVERVIEW

As modeling bridges in 3D becomes more and more industry standard, many clients and project stakeholders
are pushing for the 3D bridge model to be contract deliverable. However, the need for 2D bridge plans will
not be going away anytime soon. Traditionally, bridge plans production has been done by drawing in 2D.
While this is still a viable and sometimes necessary workflow, having a 3D bridge model gives us the
opportunity to use an alternative or supplemental workflow of producing the 2D plans from the 3D model.
This 3D to 2D workflow has numerous advantages and is very efficient in that when the 3D model get
updated, the 2D plans will update automatically. The majority of the bridge plans can be created from the
3D model, but there will still be instances where drawing in 2D is necessary and more efficient for certain
details. However, in the Bentley Connect Edition products, even the normal 2D drawing workflow has
changed since the Microstation v8i (SS10 etc) days. This chapter will provide an overview of both the 3D to
2D plans workflow as well as explain how the traditional 2D method has changed.

OBJECTIVES
The objectives of this chapter are to cover the following plans production topics:

*  Model Types

*  Dynamic View Workflow

« Starting a New File

*  Create Drawing Dialog

*  Dynamic View Workflow Tools
« 2D Plans Production Workflow
« Display Styles & Display Rules
* Annotations

* Tables

*  Sheet Border Information

MODEL TYPES & KEY TERMS

In the old Microstation v8i 2D plans production workflow, is was most common to start drawing in a 2D
design model, reference a sheet border cell into that design model, scale it up, and print. The design model
was the only model used for that workflow. However, even then there were two additional model types that
were rarely used: drawing models and sheet models. The new dynamic view workflow utilizes all three
model types, and even the new 2D workflow uses two out of the three model types. Therefore, it is important
to understand the differences between these model types, how they should be used, and some key terms
associated with the different model types.
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DGN

A DGN is not a model type, but rather it is a box or container of models. A DGN can contain one or many
models inside of it. Oftentimes, you will have many models within a DGN of different types. In the dynamic
view workflow it is very common to utilize all three model types in a single DGN.

% D P
. \ o el
N
\.'\ I pa TR0

Design Model

A 2D design model is traditionally what was used in the past for the 2D drawing v8i workflow. Design models
can be 2D models or 3D models. It typically has a black background color and is where native geometry &
elements are stored. This is where we will use some of the dynamic view workflow tools such as a Section
Callout tool or Named Boundary tool.

Clip Volumes

A clip volume is used to define a specific volume within a 3D model that you wish to create a saved view of
for placement in a drawing model. Clip volumes are automatically created when you use certain Dynamic
View Workflow tools such as a Section Callout tool. Bentley has a good video explaining Clip Volumes
which can be found HERE.

Saved View

A saved view is a view definition, which includes the level display for both the active model and
references, the clip volume, and other view attributes. The view definition is given a name and saved

in the DGN file. A saved view is a way to get a 2D view of a 3D model into a drawing model. Saved
views get created automatically when using a dynamic view workflow tool, but you can also create them
manually by navigating to View > Saved Views > Create Saved View.

OpenBridge Modeler v 8 & H“p‘ ?C: L R 2 * é =
Home Civil Utilities Reports and Drawings View Collaborate FDOT Help

& & LPOZeas=<Eg. # N7 Y» @ I

View Appl Window Zoom  Fit @ﬁ@ - Lens  place . Place Clip s Create  Update Saved  Appl
Attributes Displaygtyle Area Out  View & g E@E &) Type™ Camera & MNarned Boundary Volume B | Saved View \u‘lpewSettings Savecr\ﬁew

Presentation ] Tools Camera MNamed Boundaries = Cw Saved Views I}
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https://learn.bentley.com/app/VideoPlayer/LinkToIndividualCourse?LearningPathID=111447&CourseId=121170&MediaID=5013756

)

R ———

«

The Create Saved View window allows for several inputs including the Method (from the current view or
2-Point Box, adding a View Type (including Section, Elevation, Plan, Detail, etc.), naming the view and

creating a Drawing Model as the view is created.

ﬁ Create Saved

Method:
View Type:

Name:

=k s

Clip Violume:

View — b 4
From 2-Points b
Detail o

ediate Bent 1_Bm Seat Elev

. Create Drawing

(From View) -
|:| Associative

The saved views can be accessed through Home > Primary > (More) Saved Views.

B -
e

Explorer .
gl 1§ 0

anar).r @

{2 File ﬂ

) a 2@
Search 4
4 A BoMe @

|
o8 De 8=

d’" GpenBrldgeModeler A= Hl@

I i3 Toggle AccuDraw -

a Dil | Winfiow List

Civil Analysis an

ERCTIA
o
AR
Key-in

llary Coordinates

Saved Views

Markups

Details

Existing saved views can be used to generate drawings by opening the Saved View dialog box, selecting
the desired view, right clicking and selecting Create Drawing. This will open the Create Drawing dialog box

for drawing and sheet model creation.

MName

(4] Saved Views - View 1

cbrt-\ ﬂj '1 D {., ?

Desc ription

[ Typical Section

Apply

Create Drawing...
Generate Callout
Associate Callout
Add Link to Element

A more detailed explanation of Saved Views can be found HERE.
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Drawing Model

A drawing model is used to get a 2D view of a 3D model by referencing in a Saved View. All dimensioning
and annotations associated with the Saved View are typically stored in the drawing model. Some important
properties of a drawing model are:

* Adrawing model is always 2D

* |t does not have a sheet boundary

*  The default color is usually gray

» Areference attached to a drawing model is 1:1 and coincident

« Each drawing model should contain only one attached saved view

* Annotations can be placed in a drawing model. The drawing model acts as a container for
annotations specific to that saved view. If you want to place more than one saved view on a sheet,
you shoudl create separate drawing models for each saved view.

* Annotation (detail) scale should match the reference scale on the sheet model. If you reference
a drawing model into a sheet model at 4” = 1°, then the annotation scale of that drawing model
should also be ¥4 = 1'.

*  When using the Create Drawing dialog, you can pre-specify the detail scale of a drawing model.
When a drawing model is attached to a sheet model, the drawing model’s annotation scale is used
as the attachment’s default scale.

Sheet Model

A sheet model is the electronic (virtual) plan sheet. It is a true (virtual) size: 11”x17”. Drawing models are
referenced into a sheet model for display on the final sheet. When you annotate in the drawing model, those
annotations come with the drawing model into the sheet model. When a drawing model is referenced into
a sheet model, it utilizes a Drawing Boundary for placement on the sheet model. Generic annotations that
are not view specific should be placed directly on the sheet model. An example of a generic annotation
would be a sheet note such as: cross reference notes, notes related to multiple views/drawing models, etc.

Drawing Boundary

A drawing boundary is a defined area on a sheet model which may contain a referenced drawing model.
You can think of it as an initial target on the sheet model for a drawing model reference. A drawing boundary
can be pre-defined and targeted when using the Create Drawing dialog, or it can be created as part of the
Create Drawing dialog process. A drawing boundary controls the scale of the drawing model reference.
A quick way to change the scale of a drawing model reference on a sheet model is to select the drawing
boundary, go to properties, and change the detail scale.

Detailing Symbol Styles

Detailing symbol styles define standards for detailing symbols and placeholder fields. For example, when
you use the section callout tool, you get two arrowhead cells with text such as A-A or B-B. The section arrow
cells and placeholder text that go with them are part of a detailing symbol style. In the FDOT workspace, the
detailing symbol styles have been setup in the drawings seeds so users do not have to choose the correct
one manually. For a more detailed explanation of detailing symbol styles, see Bentley documentation HERE.
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DYNAMIC VIEW WORKFLOW

The dynamic view workflow is a method to produce 2D drawings from a 3D model. It can also be used in
the regular 2D drawing workflow, which will be discussed in a later section. The dynamic view workflow
utilizes all the items discussed in the previous section: design models, clip volumes or named boundaries,
saved views, drawing models, sheet models, and drawing boundaries. The general steps of the dynamic
view workflow are outlined below:

1. Create elements in a 2D or 3D design model
2. Utilize a dynamic view workflow tool such as a Section Callout tool to:
a. Define clip volume or named boundary
b. Create a saved view
c. Reference the saved view into a drawing model
d. Reference the drawing model into a sheet model (optional, could be done manually later)
3. Adjust scale & placement of drawing model reference on the sheet model
4. Add dimensions and annotations to the drawing model

5. Add generic notes & annotations to the sheet model

Dynamic Views Workilow:

Create Drawing dialog

{Optional)

= :
< 1) Reference B 1] Reference

@—I » Saved view Drawing Model —— » Sheet Model

Design Model

Cip Voume or Drawi del Sheet model
named bounda; rawing mode
N
o= Scale1:1 * FPrint Scale
Annotatiop Scale = 0 Reference of * FReference of
whatever is needed . needed = 4
saved view drawing model
¢ Flace annotations /F1ace annotations
¢ Flace callouts * Flace callouts
\Annotation /
scale of sheet|
model = 1:1

Note that FDOT borders should never be added as a reference or placed as a cell in the design model. The
border is setup to be automatically placed within a sheet model.
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CREATE DRAWING DIALOG

There are various dynamic view workflow tools within OBM that will be discussed in the next section that
utilize the Create Drawing dialog. With these tools, there is either a check box to Create Drawing or the
dialog box will open automatically within the course of using the tool. The create drawing dialog is quite
powerful as it can do all of the following at the same time:

1. Create a saved view

2. Create a drawing model and set the annotation scale in the drawing model
3. Reference the saved view into the drawing model

4. Create a sheet model
5

Reference the drawing model onto the sheet model at a specific scale you define

4% Place Section Callout - *

Detailing Symb

Style: | FDOTSection vd
Height: | From View o %‘

I [A] Create Drawing I

Drawing seeds control several important properties in the drawing model:

» Display Style (of the saved view reference) — Solid, Hidden, Wireframe, etc. These display styles
control whether the 2D saved view shows hidden lines, solid lines, or wireframe. Display style of the
saved view reference can be found in the Reference Presentation of the Reference dialog.

* Reference Presentation Settings — clip volume settings (including display style), synchronize view
settings, etc

*  Detailing Symbol Style — Section callout arrows, drawing boundary view titles, etc

A variety of drawing seeds have been setup in the FDOT workspace. They are grouped together with
numbers by tool type for the different dynamic view workflow tools as shown in the screenshot and table
below. The direction of tool and sheet # in cell are specific to the section callout tool. If a section callout is
drawn in a vertical direction on the sheet, then one of the “Vert” seeds should be used to get the orientation
of the section callout text correct. If the sheet number does not need to be included with the section callout
arrow cell, then a “NoSheet#” seed should be used.

6'}?',? Place Secti -
Tool Displayj | No Sheet
Drawif Qrouping # f§ Style 7 #in cell
Detailing Symbol Style: Discipline
(no

00_FDOT_Selid eric
01_FDOT Solid_MNoShest® ad Direction
ariad Indicator

02_FDOT_Solid_Vert
03_FDOT_Solid_VertMoSheet®  Bridge
0d_FDOT_Hidden Bridge
05_FDOT_Hidden_MoSheet® Bridge

Height:
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Direction | Sheet #
Drawing Seed Name Tool Display Style | of Tool in cell?
00_FDOT_Solid Section Callout FDOT Solid Horizontal | Yes
01_FDOT _Solid_NoSheet# Section Callout FDOT Solid Horizontal | No
02_FDOT_Solid_Vert Section Callout FDOT Solid Vertical Yes
03_FDOT_Solid_VertNoSheet# Section Callout FDOT Solid Vertical No
04 FDOT_Hidden Section Callout FDOT Hidden | Horizontal | Yes
05 FDOT_Hidden_NoSheet# Section Callout FDOT Hidden | Horizontal | No
06_FDOT_Hidden_Vert Section Callout FDOT Hidden | Vertical Yes
07_FDOT_Hidden_VertNoSheet# | Section Callout FDOT Hidden | Vertical No
08 FDOT_Wireframe Section Callout Wireframe Horizontal | Yes
11_FDOT_Solid 3D Named Boundary | FDOT Solid NA NA
12_FDOT_Hidden 3D Named Boundary | FDOT Hidden | NA NA
13_FDOT_Wireframe 3D Named Boundary | Wireframe NA NA
14_FDOT_ByView 3D Named Boundary | By View NA NA
15 FDOT_ByView 2D Named Boundary | By View NA NA
20_FDOT_Solid Detail Callout FDOT Solid NA NA
21_FDOT_Hidden Detail Callout FDOT Hidden | NA NA
22 _FDOT_Wireframe Detail Callout Wireframe NA NA

create a drawing

[f you only want to
maodel un-check this

O
Sheet
Model

Section

Drawing Boundary:

Mame of Saved View
& Drawing Model

-

Drawing Seed
chosen with Dynamic
View Workflow tool

Annotation scale of
drawing model

Create Drawing
Name: | Section *__-

Saved Drawing Seed: |D0_FDOT_Solid

Vi E_W View Type:  Section
Section Discipline:  Bridge

Purpose:
Create Drawing Model

Drawing Seed Model: | FDOT_DRAWINGSEED_OB
Model O Filename: | (Active Filg)
Section A [18m=1-0"

=]

Visible Edges: | Dynamic

pr— 7] Create Sheet Model

N

Seed Model: | FDOT_DRAWINGS

Filename: | (Active Filg)

Send drawing model to new
or existing sheet maodel

Sheets: |(Mew) o
A [Full Size 1= 1 <m—
(Mew)

Annotation scale of sheet
model. Always 1 =1

s Seiel [ar=1-0
[[] Add To Sheet Index

Scale of drawing
model reference on
sheet maodel

Make Sheet Coincident

Open Model

Replicate Drawing in Sheet File

v | f—
=

Cancel

Should always
be equal to
each ather

If you already have a sheet model or wish to create a sheet model at a later time, then you only need to
do use the create drawing dialog to do steps. In that case, you may need to create models manually. In
this situation, the Models dialog box can be used to create Drawing Models and Sheet Models. Open the
Models dialog box by navigating to Home > Primary > Models. Once open, select Create new model and

a Create Model window will open. Fill in the information as needed for the new sheet and select OK.
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OpenBridge Modeler b ' H t_l::‘
Home Civil Utilities Reports
— E - s:-;ﬁ * 1;.5: . A
@i .
Explorer Element ...
s = %‘ T | Selection i ~ ﬁ? .
Primary Selection
[E Models - x
F
) D E 7%
Type 20/3D Mame Description 4+ Design File
[T 1] Default Master Model v oo BOTMODLERTRDN

NOTE

The Type selected should match the required model and should always be XXXXX From

Seed, with the XXXXXX being either Design, Drawing, or Sheet. This ensures proper FDOT
seed files are used in the creation of the models. Using the Sheet From Seed option will
display additional Sheet Properties, which will be filled by the FDOT seed. The Drawing
Boundary for sheets can be (New) or can be placed within an existing sheet model.

This process should be completed one at a time for each drawing model and sheet model. In the
FDOTConnect workspace, the background for drawing models is set to a gray color and for sheet models is
set to a navy/blueprint color. These colors are part of the user preference file and can be changed if desired
as shown HERE. The different models can also be distinguished within the Models dialog box by the symbol
under the Type column. See below for symbols and the corresponding models.

L3

Type
i
Y
(3

| Design Model |

I[Drawing Model

Sheet Model

D 7| X
20730 Mame
P Default

1 PileDataTable
] PileDataTable Sheet

When the models are created using the Models dialog box, they will not be automatically linked together.
Once content/linework has been placed in the drawing model, the link to the sheet model can be made from
the Models dialog box by dragging and dropping the drawing model into the sheet model.

[E Models

Y X

Y a
+ ©F| ~ L
Type 2D/3D Name
[ A Datanls

]  PileDataTable
PileData lable

Description
Maciecticodol

Pile Data Table

Pile Data 1able Sheet

An Attach Source Files window will open with various Attachment Method options. Recommended can be
used. Once accepted, the drawing model outline can be used to place the drawing model into the sheet
model. With a left click to confirm the location, a reference of the drawing model will be made in the sheet
model. The newly created reference can be viewed and manipulated in the References dialog box.
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There are display symbols for section and model cut lines produced when creating views in the Design
Model, Drawing Model or Sheet Model. The View Attributes tool (at the top left of the view window) is
a critical tool to control how certain elements are displayed. These attributes include clip volume lines,
markers, and dimensions. If the model is brought in as a reference these changes can be made by right
clicking on the file in the References window and selecting Presentation from the drop-down list.

ur
ER = - |2[@PlLeLROaD fya =
View Number: 1 - |2y 5
) Presentation HHEIES
Display Style: | (Wireframe Display) ~] -
U | ACS Triad T Fast Cells
[2d Background = Fin
"1 Boundary Display [ crid
&l Camera §Ei Level Overrides
7 Clip Back LmeSt-,‘Ie.;
3, Clip Frent Elune \weights
ip Volume Markers -
onstructions F'attems
14 Default Lighting [P0
[F] pimensions [ et
Data Fields 14 Text Hodes
[8 Displayset Transpar&nc‘;
Named Presentation He\ght Field
Global Brightness: @ b,
4] view Setup -
[l Backaround Map -

It is very common to need to adjust the scale of the drawing model reference on the sheet model. To do so,
select the drawing boundary detailing symbol (View Title), go to properties, and change the detail scale.
This is quicker than opening the reference dialog, opening reference properties, and changing it.

roperties rix

L View 1, Section [Sheet]

P p ;
4 ‘7L Elements (1) =Re 1L e epOadE= Cl?‘-a'f. G
4 O— Drawing Boundary, ELEVATION, 1

b o Drawing Link

General A~

scriptiol Drawing Boundary. ELEVATI
Lev
Class Primary

Template (None) ¢ _I Detail Scale
Detail Scale 1"=40"

Drawing Type Gif Construction Profile
Drawing ldentifier 1
Name ELEVATION

Extended A~

Model Section [Sheet]

12/18/2023 8:41:26 AM

Not Snappable
odified Modified

Ne: New

Locked Unlocked Drawing Boundary

Display Style (From View Display) Detailing Symbol
Geometry -~

Angle 00°00°00.000™
Annotation ~

Detailing Symbel 5t FDOTSection
Origin 0 11/16.0 3/16'

A detailed explanation of the Create Drawing dialog can be found in the Bentley documentation HERE.
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DYNAMIC VIEW WORKFLOW TOOLS

There are various dynamic view workflow tools available in OBM, but the most versatile one is the Section
Callout tool. This tool can be used to replicate the function of various other dynamic view workflow tools,
such as Plan Callout and Elevation Callout. The tools can be found in Drawing (Workflow) > Annotate
> Detailing. The detailing tools discussed below have FDOT seeds set up to control the detailing symbol
style, display style, and reference presentation. See previous section for a list of FDOT drawing seeds and
the tools they are used with.

Detailing tools can be used directly in a Design File dgn, but the recommended workflow is to create a sheet
file dgn, reference in the bridge model into a design model, and then to use the detail tools to generate the
drawing model and sheet model within the sheet file. This process will be demonstrated in the exercises
accompanying this chapter.

SECTION CALLOUT

Once the bridge model is referenced into the design model of sheet file dgn (in the Default model, which
can be renamed as desired), the Section Callout tool can be used to create a section or view with a user-
defined depth. This will in turn create a Saved View within the file and provide the option to open a Create
Drawing dialog box for plans production as mentioned in the previous section.

To use the Section Callout tool, navigate to Drawing (Workflow) > Annotate > Detailing > Section
Callout. Place Section Callout dialog box will appear for the user to select the Drawing Seed, which will be
one of the several seeds FDOT has developed. The Height settings will allow the user to define a specific
height or allow the program to automatically select a height. This can always be adjusted after placement.
As discussed previously, the Create Drawing box can be checked to create drawing and/or sheet models.

Drawing Brodkdle 26 @ FE] =
Home View Annotate Attach Analyze Curves Constraints Utilities
B A% ¥ A — M = 1™ o o
A B = Bl
As AP 4 |C L x-0 Or =)
Place Edit Change Text Place Place Dimension T_I Place [ Section @
Text Text Attributes 2, * Note Label Element o s ~ il Table | Callout|™™ o3
Text P MNotes Dimensioning & Tables Detailing =
[E Models x
I 1 ?
Type 2D/3D Name Description Design File

[ FG 0

Default

«_BO1MODLBRTRO]]
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The section cut will show everything that is currently displayed in the view, so the user can control the
elements shown by toggling on and off levels. This can also be adjusted afterward within the level display
of the drawing and sheet models, if needed. After the settings are selected, the section itself can be placed.
Within a top view, the first click will define the start point for the section and the second click will determine
the end point. The third point will define the depth, which can also be keyed in. Follow the prompts in
the message section at the bottom left of the screen. Following the third click that completes the volume
definition, a Create Drawing window will appear for the user to select the drawing and sheet model settings

if the Create Drawing box is checked, discussed in a previous section.

! Drawing Identifier

‘ Dramf/ing Identifier

The Section Callout symbol will be placed in the model. In top view, the plan view limits of the clip volume
can be adjusted. In an isometric view, the height of the clip volume can be adjusted. Select the callout
symbol to reveal the dashed lines that represent the clip volume, see below.

4 View 1 - Top, Defaut o= | - o [®B]=
Emr-Ox~- 4 2200040 =l ol PRGN HUREE STXS

% 4
L . chi 4
il i Move Side 3 Clipping
i
it i 7

/
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Selecting the callout and opening the Properties will also allow the user to edit various Clip Volume settings
such as the heights, depths, and direction of the cut. Keep in mind that any linked drawing models will
display exactly as the clip captures the elements, which will need to be taken into account for skewed or
curved bridges.

(@1 Properties — X
Pl Elements (1) B
Al

General ~
Element Description  Section Callout, Typical Sectio
Level Symbols

Class Primary

Template (None)

Extended v
Geometry b4
Clip Volume ~

» Clip Paints

‘nfidth 71" 8 13/16"

Flip Directicn On

Preserve Up Off

Height 2301" 6 15/16™

Bottom Height 1133" 6 5/16"

Top Height 1168' 0 5/8™

Back Depth 10 0

Front Depth 10" 0"

Bottom Crop On

Top Crop On

Right Crop On

Left Crop On

Back Crop On

Front Crop On

> Point Cloud

Annotation -
Raw Data b

Section callouts can be placed directly in a drawing or sheet model to create additional views. For example,
a section callout could be placed above an elevation view (itself created with a section callout) to create a
top view, as will be done in a later exercise. One could also be cut through an element, such as through
a column and through a footing to create a footing plan. The section callout can be placed in the drawing
model or sheet model. If the section callout symbol is to be visible when plotted and the section callout was
placed in the drawing model, simply hover over the marker, click, and select Show Callout.

Below is an example of placing a section callout within a sheet model to create a footing plan. Note that
the ..._NoSheet# version of the Drawing Seed was chosen, which controls what information is shown on
the section callout symbol.

4& Place Section Callout -
{Drawing Seed:| 05 FDOT Hidden NoSheets -~
Detailing Symbol Style: | FDOTSectionNoSheet#
Height: | From View: -3
[ Create Drawing

Drawing Identifier Drawing Identifier
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After placement, a Create Drawing dialog will come up. Once all the information is filled in and accepted,
the new sheet model with the footing plan will be created.

Back in the original sheet model of the pier, by right clicking on the section callout and selecting Create
Gap, the continuous line can be adjusted to display with the desired gap. Snap to the points at the end of
the arrow symbols to control where to start and stop gaps.

Edit Text
Create Step
Flip Direction
Create Gap
Saved View Properties
Open Drawing
1 Select Al
Select None
" Sebect Previous
[ Displayset Set
¥ Cutto Clipboard
" Copyte Clipboard
i" Paste from Clipboard
Turn Level Off by Elerment
K Delete Element

] Properties
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After the gap is created, the drawing identifier text can updated by going into the sheet model created by
the section callout, clicking the label to reveal the drawing boundary, opening the properties, and changing
the Drawing Identifier as needed.

] Properties

4tk Elaments (1) =
4 o= Drawing Boundary, Fosting Detai

-
B A Pemente e 17ale

4 | 3

General A A

Element Descriplic Drawing ih.n.']a?l

Level

Class Primary

Temglste {Morne)

Dete| Sepla 1/2"=140"
Drawing Type oif 1on Py
[Dezwing ldeiiie L8

HNeme Fooling Ded ails
Extended -

W
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DYNAMIC VIEW BY STATION

The Dynamic View by Station tool is one of the most flexible OBM drawing tools available. Users can take a
section view normal to any station point or at any skew angle. The views can even be rotated after creation
to create horizontal sections. The tool is accessed from the Reports and Drawings > Bridge Reporting
> Dynamic View By Station.

Brodidlhe«-r-» &=

Home Civil Utilities Reports and Drawings View Collaborate FDOT Help

E O eI e @ A E@ o G

L i Pier T

|OpenBridge Modeler =

Quantities |nput XYZ i Dynamic Settings Create Create Place MNamed Adjust
Report Report [:E Bearing Seat View By Station Drawings MNamed Boundary Boundaries Profile Named Bo..
Bridge Reporting Drawings

Once an alignment on the bridge is selected, any station can then be entered to cut a section at that
location. A skew must then be specified for the section. For a section to be cut longitudinal along the
alignment, a skew of 90°-00’-00” would be entered, whereas a transverse section—like a superstructure
typical section—would use a 0°-00’-00” skew. With the location and skew set, a direction of the cut (i.e.,
upstation or downstation) can be set by clicking a data point in the direction the user would like the cut to
face.

Depending on what needs to be included in the drawing, the user can either choose for the Profile Type
to be set as Cut (just the section with the elements that are at that cut line) or Cut With Depth (includes
additional members contained beyond the cut line up to the specified Depth.) The Cut With Depth selection
is useful, for instance, if a longitudinal cut with a beam in view is need, but the selected alignment is not
atop a beam.

f Dyna — *
Main ~

[] Station  |662-20.3358

Skew Angle (000000

[] Depth 1167/16
Profile Type [Cut v
Half Callout []

PLACE NAMED BOUNDARY

The Place Named Boundary is a flexible plans development tool that is highly used in both 3D and 2D plans
production. The tool is accessed from the Reports and Drawings > Drawings > Place Named Boundary.
It is also available in View Tab of any of the workflows.

OpenBridge Modeler v @ S H I'._::! G::: *- ; |.g| s
Home Civil Ltilities Reports and Drawings View Collaborate FDOT Help

== cl = S y (= [m

K j Pier |

Quantities Input XYZ ) Dynamic Settings Create Create Place
Report  Report '::E Bearing Seat View By Station Drawings Marmed Boundary

Bridge Reporting

This tool is designed to place one or more named boundaries and automate the dynamic view, drawing
model, and sheet model creation process. Boundaries can be placed utilizing the alignment/civil data or
they can be placed manually. The process for creating these boundaries and the subsequent drawings
using the alignment can be seen in the following exercise.
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DETAIL CALLOUT

Another helpful detailing tool is the Detail Callout tool. This tool can be used to create an enlarged detalil
if a certain area needs to be isolated for clarification. The tool can be accessed by navigating to Drawing
(workflow) > Annotate > Detailing > Detail Callout.

Drawing iR - | RIS AR =

Home View Annotate Attach Analyze Curves Constraints Utilities
B A ¥ A wIE Ly o

A A A’ AL [t 1 1

% -0 D &0
Place Edit Change Text Place Place Dimension H Place @ Section o
Text Text Attributes .~ ™ MNote Label Elerment Cf/ i ﬁ Table Callout ' pi

=
:‘ ._'_],

Text s Motes Dimensioning % Tables = Detailing 1

The Place Detail Callout window will appear for selection of the Drawing Seed, Height, shape, and the
option to Create Drawing like the Section Callout tool. The available shape options are circle, ellipse,
rectangle, or to use a previously drawn boundary.

i Place Detail Callout — X

d: [21_FDOT_Hidden -

Detailing Symbol Style: | FDOTSection G

Height: | From View =
Boom

Create Drawing

The next click will start to define the detail boundary. For the circle and ellipse options, the first click will be
the center of the detail. For the rectangle, the first click will be a corner. The next click will fully define the
size and extents of the shape. The final click will be to place the detail callout text with the drawing identifier
and any desired leaders. Right clicking will end the placement and bring up the Create Drawing window

if the corresponding box was checked. The remaining steps are similar to the Section Callout tool. See
exercise for use of the detail callout.

DETAIL 1
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ADJUSTING SCALES

After a drawing or sheet model has been created, the scale can be adjusted, if needed. This can be
accomplished by first adjusting the reference detail scale for the drawing model in the sheet model. This will
make the drawing model appear smaller or larger in the sheet model border. Once the desired reference
scale is updated, the detail scale in the drawing model should be adjusted to match the selected reference
detail scale. This will adjust the text and symbols so that they match FDOT requirements for size. The
dimension offsets from elements may need to be adjusted when changing scales. See below images for
this process.

i mstherer Prepertion: b0l ectngla ted] dga

g Meme | §27Frotngl TRE 1O 450
Full Pithe_itrustused S e 411t dgn
Modet Footing Dutade
Legitel Hame.  Footing Detst

Dusoriptigre  Fagting Dty
Detai Seale] M2=10
Sealn (MaterRef et

i Grours

Toch Peopertien

BB g g9 AN P R D180 20 smwn bwmdin -
St PO FleMame el Derarigtion Legal Qary
1 4 BalFsotingDes TESTILdgn  Focking Detalls  Foosng Detaik Fusting Desat-]

¢

S4ak: | 109000500 1| 28000000 Entatian | 9°0000"

O | 19085106 ¥ -6T

OERCER e . JE 0 tecimme: ety =

5 | Diieliy Ovamisss [FIPRR e | birw el Displiye | Coamlog Marintle =

Grortorsced [ =

If the reference from the drawing model into the sheet model has Use Active Annotation Scale enabled
(in the red box above), the text and symbol size in the sheet model will be adjusted with the change to the
reference detail scale. However, updating the annotation in the drawing model will allow users to better set
the dimension line offsets.
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General e
Is Active True

Name Footing Details [Sh
Description

Ref Logical Footing Details [Sh

Paper Scale 1.0000

Propagate Annotz On

Line Style Scale Annotation Scale
Update Fields Aut True

Sheet
Show Sheet Bou True

Sheet Number  Footing Details
Sequence Numt 0
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Note that the sheet model annotation scale should always be set as Full Size 1=1.

2D PLANS PRODUCTION

As mentioned in the overview of this chapter, there will still be instances where drawing in 2D will be
necessary. However, in the Bentley Connect Edition products, even the normal 2D drawing workflow has
changed since the Microstation v8i (SS10 etc) days. The biggest difference is that the new Connect Edition
workflow and FDOT plans production workflow require the use sheet models. There are a few different
routes you can go leading up to the sheet model which will be discussed in this section.

Dynamic View Workflow

The dynamic view workflow mentioned in previous sections can still be used for the 2D drawing workflow.
A design model, drawing model, & sheet model would be utilized the same way. All the steps previously
mentioned would be the same. The only difference is that you would use a normal (non-civil) Named
Boundary tool to designate the area you wish to capture in a saved view. You could skip the Named
Boundary tool itself and just create a saved view to create a drawing from, but the benefit of using a Named
Boundary is that you have a graphical representation of the saved view that you can manipulate after the
fact. While this same dynamic view workflow can be used in the 2D drawing workflow, the drawing model
is technically an extra/unnecessary step since you already have a 2D representation of what you want to
show on the plans.

Hybrid Dynamic View Workflow

Another option for traditional 2D plans production is a “hybrid” method. With this, you still start drawing in
a 2D design model, same as the method mentioned above. The difference with this workflow is that you
add dimensions and annotate directly in the 2D design model, which is what we are used to doing in the
past. You can create a saved view manually or use the normal (non-civil) named boundary tool to send
(reference) the saved view directly onto the sheet model.

Regular Reference Workflow

The last option for the 2D plans production workflow starts the same way, draw elements in a 2D design
model as you have in the past. You can place all annotations and dimensions in the 2D design model,
create a sheet model manually, and reference the 2D design model into the sheet model with the reference
manager.

Of the different methods mentioned above, the Hybrid Dynamic View Workflow offers the best of old and
new methods and provides the most flexibility. However, workflows preferences are user based, so it is
recommended that you try each one and see which workflow suits you best.
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DISPLAY STYLES & DISPLAY RULES

Display Styles are predefined render overrides and optional settings that can be applied to views, sections,
or reference attachments. OBM has default display styles and FDOT has developed display styles for use

on FDOT projects.

& Display Styles

+ @
Fpe  Name © ~ | Render Mode
6'1 cut Display: | Wireframe ~
&) FDOTHidden [] Use File Order
&I FDOT Solid Display Rules
1
Ql Fpo‘r_pmcum_reta s v &
&0 Filled Hidden Line
&0 Filled Hidden.\Modeling || Ovemides
&0 Filled Hidden ...\Realistic Element: I — ™
Qn Filled Hidde...\Sky Sphere No Material ~
&1 Forward :
&) Gray Eisting Background: |Color -
&0 Hidden Line Reflection: |Colar |

&0 Hidden LineMadeling

&0 Hidden LineRealistic

A0 Hidden Line:Sky Sphere
lllustration
Ilustra..\lgnore Lighting
Illustration:Modeling
lllustration:Shadows
Illustration:Sky Sphere

[ Thematic Display:
Edge Settings

Hidden Edges:

[ Invisible to Camera

Treat Open Elements as Edges

Monochrome Options
MonochromeModeling [] Hidden
Monachrome:Shadows Usable for
Monachrome:Sky Sphere [ views
&1 Outside X
Smooth Clip Velumes

Smooth:Modeling

Smooth:Shadows

Smooth:Sky Sphere

Thematic:Aspect Angle

Thematic:Height v
< >

The display style for a design model can be selected directly from the top of the view window by clicking
and holding the button indicated below. Clicking the button once will open the Display Styles dialog box.

u View 1- Top, End_Bent_MSE_L_R
=faki- L eo0Tan t

B EE| H T &

For drawing models, the display style will be set based on the drawing seed selected. If the display style
needs to be changed for one or more directions of the clip volume (forward, backward, cut, or outside), it
can be adjusted in the model properties. The display style selected for the drawing model will be reflected
in the corresponding sheet model.

@] Properties - X

4 [& Models (1)
4 [ Pier2
b [E| BO1FootingDet TESTO1.dgn Default, Pier2

Clip Volume Settings a

Forward Display
Forvard Snap
Forvard Locate

On
On
On

Forvard Display Style (5] FDOT Hidden
Backvard Display  Off
On

On
Display Styt ] (From View Display)

Qutside Display
Ou

Cut Display On

Cut Snap on

CutLocate On

CutDisplay Style  [&0] FDOT Hidden
off
off
Off

il

yle B (From View Display)

v

[T — -

For a given display style, one or more display rule can be created. Display rules allow the user to specifically
control the symbology, appearance, and display of design elements based on the property of an element,
named group, view, model reference, or file. They are found within the Display Styles window. Display rules
are very powerful and can be used to control symbology to get the 2D drawings produced from the 3D
model looking how we are used to them looking. Display rules are an advanced topic and outside the scope
of this guide, but there is documentation about them in the Bentley Help Content available online HERE.
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& Display Styles - >

+ 1 ad| XK
Type Mame " ~ | Render Mode
S Display:  Visible Edges o
il Back Liisplay: g
oL Cut [ Use Color From Material
51 FDOT Hidden Display
& Filled Hidden Line & Geomet
. ry Maps
o, Filled Hidden...\Modeling
&7 Filled Hidden ..\Realistic & Transparency Threshold: Gy 30 '
50 Filled Hidde...\Sky Sphere Display Rules
':_r..-'l Forward (none) |
'-TS‘I: Gray Existing Chcacsiclac
Display Rules
» (none)
Overrides
Element: Create new Display Rule Set...
@ Display Rubes = =
& Mew 8 X o LkNew & Generate
_ g ¥ Conadition Actions Stop if true
o Untitled
ANNOTATIONS

Traditionally, annotations have been thought of as: notes, dimensions, callouts, etc. Those traditional
annotations have always been static/unintelligent in the sense that users had to manually input information,
i.e. station & offset on a wall control drawing. The Connect Edition products have introduced some new
technology related to annotations that make them automated and intelligent so that they populate field data
based on element properties. These new types of annotations are dynamic in that they will update if the
model or element updates. This is much more efficient and leads to less rework when designs change.

TEXT FAVORITES

Text Favorites can be utilized to take advantage of annotation automation available when using accurate 3D
models for plans production. Common annotations can be saved as “Favorites” and accessed for repetitive
annotations using model properties such as elevation values. Text favorites can be static text that gets used
frequently such as notes on a key sheet, or they can be dynamic fields that populate a label by pulling data
from a model element.
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The Text favorites are accessed through the Text Editor dialog box when the Place Note or Place Label
tool is selected under Reports and Drawings > Placement > Place Note <OR> Place Label. For Place

Label, either a Cell or Text Favorite can be used for the Type and an Element or DataPoint must be
selected prior to placement.

Drawing | 8~ =k e & - = =
I File Home View Annotate Attach Analyze Curves C
A.B » ¥V [ M= R
e £
At A’ AA ’ L x-0 [0Op
Place Edit Change Text , Place Place | Dimension o e
Text Text Attnbutes .~ ™ | Mote Label Element < I =
Text G Motes Dimensicning fu
A, Text Editor - O *
' FDOT Structures T @ ‘O fix} | | T FDOT | AT | 0.0063 - B I Q =
E---l---: T T T T T T [T |

There are several Text Favorites provided in the current workspace for use as shown in the following image.

A Text Editor

S FDOT Structures

Z---|---|---|---|---|---|

-

~ || AT |0.0063
pl---|---|---|---|--|

_BR_Begin Approach
_BR_Begin Profile

_BR_Element Elevation

_BR_End Approach

_BR_End Approach/Begin Bridge
_BR_End Bridge/Begin Approach
_BR_End Profile

_BR_Pier Station

_BR_Section Identifier

7 Manage...

The notes save the text for common labels but also access model properties that can be used to automate
actual dimensions or value placement in the note. The example below shows a Begin Bridge station Text
Favorite that will automatically input the station based on the point selected in the plan view.

£E Place Label Settings 4

ols

Type:

Favorile Madme:
Dimension Stybe:
Label Rotation

Start At

Horizontal Attachment:

Text Favamte

%3 _BR_End Approach/Begi

o FDOT Structures Line Le. ... 2y
Honzontal w
Teminator
Auto
Al

—_— —s

-

Y

Properties
B
i e
lot 1= O FileName

isplay Overrides Y| New Level

Model Description

Rotatio
z

-

Display

3 Nested Attachments:

¥ Georeferenced:

Logical

n

Orientation Presentation [=] ./ K &

¥ Nesting Depth:
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The use of Text Favorites is more common in the ORD workflows. Many Text Favorites are setup and can

be taken advantage of, including for stationing of specific points such as start and end of bridge on our

General Plan view. Custom Text Favorites can be created for personal use to automate certain note and

text placement and will be used more heavily in the future as the tool develops and more model properties
are exposed in OBM for plans production use.

Text Editor

‘v FDOT Structures

Elev, 35.217

— Elev. 39.672

4

- Elev. 35.366

— ElEVIB5 555
/ —— ElESSEI 4% Place Note

Note
Pl .- Divcosicn

Groups= GG{16) E ®

[Dimension Style] [~ FDOT Structures ~ | 7 2y

Text Rotation: | Horizontal i
Location: | Automatic =
Start At | Terminator =

) )

Horizontal Attachment:

CIVIL LABELS

The place Label tool has been somewhat replaced with a better tool for the civil transportation industry
called the Civil Label tool. The Civil Labeler tool is extremely powerful and will be demonstrated later on in
this chapter in an exercise. For more details on this tool see Bentley documentation HERE.

ANNOTATION GROUPS

Annotation Groups can be thought of as “automated rule based annotation”. An example of an annotation
group in practice is the horizontal alignment. In the past, users had to draw multiple alignment with tick marks
and station callouts at different sizes to satisfy different scales. Now when an alignment is created using
ORD, users can automatically annotate that alignment with an annotation group to produce all the stations,
tick marks, curve data, etc. For more information on annotation groups, see the Bentley documentation
HERE.
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TABLES

As a basic MicroStation tool, the Table tool is very useful for any tables that are commonly found in the
plans. It is a MicroStation element that functions like an excel table in terms of formatting, columns, rows,
cells, etc. You can place blank tables in a file and fill them out manually or link them to an excel file. These
tables keep an active link that can be updated dynamically when changes are made to the spreadsheet.

Prior to placing a table from an excel file, an Excel file with the data must preexist. FDOT has created a
standard structures data tables excel for the purpose of linking tables in the plans to that excel file. This
excel file can be found in the eng data folder within the Structures folder of a newly created workset:
C:\Worksets\FDOT\12345678901\Structures\eng_data\STR_StandardDataTables.xlsx.
Detailed instructions for how to use this excel file can be found in the first tab of the excel file.

The Place Table tool can be accessed from Drawing (workflow) > Annotate > Place Table in the Tables
group.

Drawing < -J HE L = 5 C\Worksets\FDO
Home  View Attach  Analyze  Curves  Constraints

- -
-

A AP Afﬁ A B mmrmj
e =

i+ @
Place  Place Dimension - Place
Note Civil Label Element O r ~ B Table

Place Edit Change Text
Text Text Attributes

-

Text Fa Notes Dimensioning Tables
L ]

The Place Table dialog box is then opened. Select the Excel file tool and navigate to the file with the data
that is planned as the table content.

[

Seed: From Excel s @
Active Angle: | 00°00'00.0000" -

Range: | Automatic

D Contains Title Row
D Contains Header Row
Retain Association

Once the file is selected, the Select Cells dialog box is opened. Select the cells for the table by selecting
the worksheet and the range of cells to include.

FDOT OBM 202



Select Cells *

Worksheet: Sheetl '
Ramge: Automatic ¥
From:

To:

OK Cancel

After the user clicks ok, the status window shown below generates the table. Depending on the size of the
Excel file, the program may take a minute or more to create the table.

Generating table...

AL L ELLLRLLLLV

Cancel

The table can be placed in any model; however, it is recommended that these tables be placed directly onto
Sheet Models to ensure formatting and sizing of the table fits. Once the table is placed, conduct additional
formatting, e.g. change the text style etc.

Ta

The table can be refreshed at any time with updated data by selecting the table and accessing the Table
Tools options in the Layout > Refresh Table from Data Source tool under the Rows / Columns group.
However, note that any formatting that was executed after the table was placed in the DGN file will need to
be repeated as the settings for the table will also be reset.
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View Annotate Attach Analyze Curves Constraints Utilities Drawing Aids Content
Titie Row First Column 0.1849 s - - Bl 'y
Header Row Last Column B Width: 11809 4 ” )
; R - Insert Insert Insert Insertf Refresh Table | Merge Split
ooter Row Lock Aspect Ratio Below Left Rightll from Data Cells Cells
Table Options Table Size Rows / Columns Merge Cell Size

PLAN SET MANAGER (SHEET BORDER INFO)

The Plan Set Manager is a tool developed by FDOT in order to help populate, manage, and update all of
informationfoundinthe sheetborders. Anindepth video explaining allthe details of this tool can be found HERE.

STARTING A NEW FILE/DRAWING

Plans production will utilize drawing models and sheet models, which will be contained within a sheet file
(dgn). A new Drawing or Sheet Model can either be created directly within a Design file or in a separate
sheet file. For the models in a separate file, the OBM model is referenced from the Design file (with the
bridge model). This workflow utilizing references allows for several advantages in plans development and
is the recommended workflow by FDOT. First, a team of users can work separately on multiple workstations
on the model file and the drawing files simultaneously. This can help increase efficiency as one user can
be developing plans drawings while another can be developing the model or adding additional detail at the
same time. Note that only one user can be editing a single DGN file at a time, but the separate files created
in this approach provides a workflow in which multiple users can be developing various content for the
same bridge. Second, this separates the sheets and the model files so that if one file becomes unstable or
corrupt, loss of data and efforts is likely to be minimized. Alternatively, having all the models and sheets in
one file may result in loss of most if not all of the data when corruption occurs.

The FDOT > Create File tool should be used to create all sheet files. When STRUCTURES is selected as
the Discipline and Sheet Files is selected as the File Group, there are many sheet Base Filenames
which may be selected for the File Type. The user should select the applicable sheet file for the current
plans production activity to stay in compliance with FDOT CADD standard per FDOT CADD Manual.

CreateFile (v2020.10.15.1) x

Workset:  C\Worksets\FDOT\240835715201
Discipline:  STRUCTURES =
File Group: Structure Sheet Files »

File Type:

Base Filename Description
B#BridgeHydro Bridge Hydraulic Recommendations
» Section Through Bridge
BHConduit Det Conduit Details
B#ConstAcc Construction Access
BHConstDet Construction Details
B#ConstMotes Construction Notes
B#ConstSeq Construction Sequence
B#DataTable Data Table
B#DataTableloa... | Load Rating Summary Table
B#Drain Det Drain Details
B#ErectProced Erection Procedure for Launching Girder
B#ErectSeq Erection Sequence
B#FenderDet Fender System Details W

Output File:

Bridge File

Seq #: Base Filename: Modifier (Optional) Sequence #: Extension:
B l:l Bridge Section | | |D1 | .dgn
C:\worksets\FDOT' 240835715201 \structures\EBridgeSection(1.dgn

Output Folder: |5t"""m‘"'es | Eares

Seed File: |o:fdotconnect 10.10Norganization-civilfdot \seed \FDOT-OBM-StucturesSheetSeeddddgn | | Browse

County: Clay ™| Coordinate System: FLB3-EF ™

Action: | |

Create - Open File Close
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In general, sheet files that would reference the 3D bridge model will use a 3D sheet seed file so that any
Saved Views will be able to reside in the sheet file itself. For other sheet files that will not utilize 3D Saved
Views, those can use a 2D sheet seed file. Users can change which seed file is used by selecting Browse
next to the Seed File.

Once a sheet file is created, the user can create sections and views from the model directly into these new
files. This creates an active reference to the model in which additional detailing and annotation can be
generated to prepare for plans development.

Note that there is some uniqueness in model-centric plans development compared to traditional plan
production. First, the linework is essentially a “view” of the model, so it will reflect exactly what is in model
as lines are references directly from the design model. Although this is advantageous over traditional
methods in many situations for both efficiency and quality, the user must be aware of this, as the tools used
and processes followed are likely altered. For example, lines cannot just be simply deleted as they are
references from the model; instead, display rules and masking tools must be used if certain linework is to
be shown differently or not shown in a particular detail.
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Braralee 6,9 Use Section Callout Tool to Make Pier Sheets

CREATE A PIER SHEET

1. Open the data set file: BOTMODLBRTRO01_6.1_Begin.dgn

2. Access the FDOT > Actions > Create File tool and create a sheet file with the inputs indicated below.

CreateFile (v2023.5.12.1) >

workset:  C:\Worksets\FDOT\12345678901

Discipline: STRUCTURES e
File Group: Substructure Sheet Files w
File Type:
Base Filename Description [
BHDill Shaft Drilled Shaft Data Table
BHDvill Shaft Diet Drilled Shaft Details
BHEndBent End Bent
BH#EndBent Det End Bent Details
BHFooting Footing
BHFooting Det Footing Details
BHEFoundLay Foundation Layout
BHint Bent Intermediate Bert
B#IntBert Det Intermediate Bent Details
»
BHPierDet Fier Details ™
Output File:
Eridge File
Seq#: Ease Filename: Modifier (Optional) Seguence #: Extension:
B Pier | | [o1] | | dan

Chworksets\FDOT12345678501 s tructures\BO1 Pier(1.dgn

Output Folder: |sh'1..|ch..res | ElTE

GeedFile: | ganization-civil\idot'seed\FOOT-OBM-StructuresShestSeed3d dgn|  Browse

County: Pasco ~ | Coordinate System: FLEI/Z011-WF

Action: | |

Create - Open File Close
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3. Ensure that the seed file being used is the FDOT-OBM-StructuresSheetSeed3d.dgn file. If it is not, click
the Browse button next to the Seed File field to navigate to the Seed folder. Select the correct file and
click Open.

Open X
« v « FDOTConnect10.12 » Organization-Civil » FDOT » Seed v | D O Search Seed
Organize ¥ New folder = O @
Name Date modified Type Size
Sheets 23 2:42 PM File folder
FDOT-OBM-KeySheetSeed 23 2:49 PM Bentley MicraStati.. 292 KB
FDOT-0BM-5StructuresSeed2d 23 9:45 AM Bentley Micro5tati... 88 KB
FDOT-OBM-5StructuresSead3d 23 211 PM Bentley MicraStati.. 256 KB
FDOT-0BM-StructuresSheetSeed3d 023 2:11 PM Bentley Micro5tati... 120 KB I
FDOT-ORD-KeyMapSeed 6/22/2023 2:49 PM Bentley Micro5tati... 76 KB
FDOT-ORD-RWseed 6/22/2023 2:49 PM Bentley MicraStati... T0KB
FDOT-0ORD-5eed2D 023 Bentley Micro5tati... 92 KB
FDOT-ORD-5eed3D Bentley MicraStati.. 392 KB
FDOT-0ORD-5tructSeed2D Bentley Micro5tati... 43 KB
FDOT-ORD-5tructSeed3D Bentley MicreStati.. 24 KB
FDOT-0ORD-TypicalPackageSeed Bentley Microbtati... 260 KB
File name: | FDOT-OBM-StructuresSheetSeed3d ~ | Seed files (*.dgn) -

4. Once all inputs are set and the correct seed file is selected, click Create — Open File to create the
sheet file.

5. The new sheet file will automatically be opened, click Close in the CreateFile window. In the Default
model, open the References tool by navigating to and selecting Home > Primary > References.

6. Attach the BOTMODLBRTRO01_6.1_Begin.dgn file as a reference in the Default model by using the
Attach Reference tool at the top of the References window and then selecting the file. Set Nested
Attachments to Live Nesting with Nesting Depth = 1 and Display Overrides to Allow.

|E| References (0 of 0 unique, 0 displayed) - X
Tools _Properties
Fe B N >N A AN " - :
R EPEEEEEEREE Y X
Slot = 3 FileName Model Description Logical Orientation Presentation [+] C,.f | =
Scale | 1.000000000 : | 1.000000000 Rotation
Offset X Y Z
[} =] 0 @ & Nested Attachments: ¥ Nesting Depth:
Display Overrides: ¥ | New Level Display: ¥ | Georeferenced: v
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7. Once all inputs for the incoming reference are set, click OK to attach the reference.

Reference Attachment Properties for BOTMODLBRTROT_6.1_Begin.dgn X

File Name: BOTMODLBRTRO1_6.1_Begin.dgn
Full Path: ..\12345678%01\structures\BO1MODLBRTRO1_6.1_Begin.dgn
Model: | Default M |

EL-:: ical Na

Description: | Master Model

Orientaticn:
View Description
Coincident Aligned with Master File
Coincident - World Global Origin aligned with Master File
Geographic - AEC Transform Calculated Transform, max error 7.589e-07 "
Geographic - Reprojected Reproject reference data to Master GCS

Standard Views
Saved Views (none)
MNamed Boundaries (none)

Detail Scale: |1"=30' -

Scale (Master:Ref): | 1.000000000 : | 1.000000000
MNamed Group: -
Revision: -
Level: hd

Mested Attachments: §| Live Mesting ¥ N Mesting Dep_th:

Display Overrides: i Allow ~
Mew Level Display: | Use M5_REF_MEWLEVELDISPLAY Cor
Global LineStyle Scale: | Master ~
Synchronize View: [Volume Only ~

Toggles

o B Y e [

8. Once attached, click the Fit View tool at the top of the view window, then click within the view window
to fit the reference within the view. Locate the bridge and zoom in.

9. Note that the annotations are difficult to see. To change the annotation scale of the model, access the
Properties tool at Home > Primary > Properties.

10. Next, open the Models window in the same group by selecting Home > Primary > Models.

11. Once the Models window has opened to show all the models present in the file, highlight the model
titted Default. The model’s properties will all be accessible in the Properties window. Here, change the
Annotation Scale field to 17=30’.
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12. To turn off any bridge superstructure levels, access Home > Primary > Level Display. After selecting
BO1MODLBRTRO01_6.1_Begin.dgn and clicking the (+) next to the file name. Turn off all barrier, deck,
haunch, beam, bearing pad, sidewalk, and all Decor levels (as shown below) to allow for easier

placement of the section callouts on Pier 2. Make sure to save settings by clicking the icon at the
top left or (Ctrl + F) to keep all level display changes.

= Level Display - View 1 _ x

|:|I.J_1 E; |\l’iew Display © |

e [E] Tarter- [Lees ~| (A -

=+ BO1Pied1.dgn
Ié!- BOTMODLBRTRO1_6.1_Begin.dgn, Default
\Roadway\ALGNRDO1.dgn, Default
\Survey\SURVRDO1.dgn, GTOMRD
LGNRDO1.dgn, Default-3D
LGNRDO1.dgn, Superelevation
VALGMRDO1.dgn, Superelevation-3D

Narne Used o]

AppSlabConc_pm
BarrierWallConc_pm
BeamConc_pm
BearingBevelPlate_pm
BearingPadMisc_pm

BearingSeatConc_pm

CompGrpBeams

CompGrpSubstructure
ContoursMajor_ep
ContoursMinor_ep

DeckConc_pm
DecorBarriers(2D)
DecorBeamEndCLExt(2 D)
DecorBeamEndOffset(2D)
DecorBeamLayout(2D)
DecorBeamLayoutText({2D)
DecorBearingGroupText(2D)
DecorBearingPlateorPad(2D)
DecorBearings(2D)
DecorBearingSeats(2D)
DecorCLBearing(2D)
DecorConcPierCap(2D)
DecorConcPierColumn(2D)
DecorConcPierFooting(2D)
DecorDeckOutline(2D)
DecorPile(2D)
DecorSupportlinesText(2D)
DecorUnitLabel(2 D)
DTM_ep

DTM_ex

DTMSource_ep
DTMTriangles_ep
DTMVertices_ep
EndBentCapConc_pm
EndBentCheekWallConc_pm
FlowArrow_ep
HaunchConc_pm
PierCapConc_pm
PierColumnConc_pm
PierFootConc_pm
PileConc_pm

SidewalkBrd qiprn
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13. Rotate the orientation of View 1 so that the x-axis and y-axis run along the width and length of the
footing. First set the ACS: Utilities > ACS > Define ACS by Points <OR> [type] R+ [type] A, then
place the ACS at the southwest corner of the footing. Select the southeast corner of the footing to define
the x-axis. Then select the northwest corner of the footing to define the y-axis.

T
£ i Al T thy
E!'H‘; o & '1'3::;5 _,l:'.k L%

Define | Move Rotate Select .;'D Attach
an ACS« | ACSs  ACS ACS = | ltem

@ Define ACS (Aligned with Elernent) |

Define by Points

o= Define by View

B Define by Reference

Define by Top Plane
2 Define by Front Plane

i,  Define by Side Plane

14. On the View toolbar, select View Rotation > Top View <OR> [Hold Shift] + [Right Click] + [type] T.
Save Settings (Ctrl + F) once the view is rotated.

o View 1 - Top, Default
o i ®0

3.

- -"" v f‘j = EE 5 r\i,:_(';;i' i

Rotate View

Top View

Front View
Right View

Isometric View

Bottom View

Back View

Left View
Right-lsometric View

e e |~ |ov || & Jwiiire |f 1=

U 9886 86

Open as ToolBox
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15. The x-axis and y-axis should now run along the width and length of the footing.

[ |
]
g
[ —
1 |
ﬁ

16. To begin creating the Pier Sheet, access the Section Callout tool found at Drawing (Workflow) >
Annotate > Detailing > Section Callout.

Drawing - v HE = ga & 1 =
Home Wiew Annotate Attach Analyze Curves Constraints LUtilities
A B S A B |'—'| M= ITTH LA o o
AT At B | %o Oy N
Place Edit Change Text |, Place Place Dimension . H oo e Place @ Section o
Text Text Attributes .~ ¥ MNote Label Element o I =] Table = Callout ©* pi
Text F Motes Dirmensioning | Tables  Detailing
Properties v 1 X _
| View 1 - Top, Default

17. Select the 04_FDOT_Hidden drawing seed. This will allow the pile embedment and any other hidden
lines to be shown as dashed in the newly created view.

4% Place Section Callout — e

! \04_FDOT Hidden -

Style: | FDOTSection o

Height: | From View S

Create Drawing

Detailing Symbol

18. Snap to the SupportLine on each end of Pier 2. Make sure the section cut extends past the ends of the
pier cap.
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19. Define the direction and depth of the section callout by moving the cursor to the upstation side of the
pier and data point to ensure the section boundary fully encapsulates the pier footing.
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20. Setthe name of the view to be Pier 2 Elevation. The drawing seed is already set as 04_FDOT_Hidden.
Set the annotation scale for the drawing model and the detail scale of the Sheet Model to 3/16” = 1°-
0”. Note that the annotation scale of the sheet model should be Full Size 1 = 1. Verify the rest of the
settings match the image below and click OK.

Create Dra
Mame: | Pier 2 Elevation
Drawing Seed: |04_FDOT_Hidden -
View Type:  Section
Discipline:  Bridge
Purpose:
Create Drawing Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 04_FDCO1
Il Filename: | (Active File)
A 3ne=1-0 -
Visible Edges: | Dynamic ~
Create Sheet Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 04_FDCO1
Il Filename: | (Active File)
Sheets: |(New) -
é Full Size 1= 1 -
Drawing Boundary: |(Mew) -
Detail Scale: |3/16"=1'-0" -
[] Add To Sheet Index (!

Make Sheet Coincident
Replicate Drawing in Sheet File
Open Model

0K Cancel
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21. The sheet model with the elevation view will automatically open in the active file.

2 View 1, Pier 2 Elevation [Sheet] EI@

22. To reduce the length of the piles shown, return to the Default model by opening the Models window
and double-clicking Default. Rotate the view to clearly see the section cut location relative to the piles
using View Rotation > Rotate View with the Method set to Dynamic.

W View 1, Default

HARES WYX

Rotate View

Top View

- % Rotate View —
Front View )
Right View

Isometric View
Bottom View

Back View
Left View

1
2
3
4
3
6
z
8
9

Right-lsometric View

b=y
B
i
©
@
B
15
&
=

Open as ToolBox
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23. Select the Section Callout previously created to see the clip volume for the Pier 2 Elevation view. It will

be located at the zero elevation (same elevation as the décor levels).

215
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24. Access the Move tool at Drawing (Workflow) > Home> Manipulate and move the Section Callout
above the piles by setting movement in the Z-direction to 100:0 and setting the X-direction and
Y-direction movement to 0:0. Data point in the view window to accept the move, then right click to exit
the move command.

[ a3 ]4]s]s]7]s
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25. Rotate the view again by using View Rotation > Right View and select the Section Callout. Adjust the
clip volume by selecting the blue handles and moving the top handle closer to the top of the pier cap
and the bottom handle just under the footing.

wf View 1, Default

ol 4 0 00CAD

: Top Handle
w View 1, Default I :
-0~ 4 PPOCED HRBESGYXD : ——— j

&) 1 Rotate View i Section
@ 2 Top View Ly Callout

Front View

Right View

3
4
5 Isometric View
6 Bottom View

@

[ 7 Backview
@ 8 Left View
® e
=

Right-lsometric View : e
Bottom Handle
Open as ToolBox

26. After adjusting the clip volume, return to the Pier 2 Elevation [Sheet] sheet model by opening the
Models window and double-clicking the model name. The sheet model should look like the image
below.
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27. Open the References window the (Home > Primary > References) and select the Move Reference
tool to move the section within the borders of the sheet. Then, use the Drawing (Workflow) > Home >
Manipulate > Move tool to place the Drawing Boundary title directly below the section.

E| References (8 of 8 unique, 4 displayed) - X
Tools Properties
'E:- - | i ¥ D ¥ D ¢ =) E 33 33 A '1 & = U 3 Hi Hilite Mode Boundaries ¥

Slot P 2 File Name Move Reference Description Logical Orientation Presentation  Visible Edges L] J .- :3

1 <~ BO1PierD1.dgn Pier 2 Elevation Pier 2 Elevation Pier 2 Elevation-1 Wireframe Wireframe .
Scale | 1.000000000 : 64.000000000 Rotation 00°00°00" Offset X | 23947 7/8 Y -05/8
ﬂ .. @E @_ 1, Nested Attachments: | Live Nesting ~ | Nesting Depth: 99 Display Overrides: Never ~ New Level Display: Config Variable ~
eferenced: |No

== FOR "X

— View 1, Pier 2 Elevation [Sheet]

=- 4 8 PPCHNES 5% ¢

Drawing Boundary Title
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28. To create other views using the Section Callout tool without showing the arrow annotations, the
additional section cuts should be done in the drawing model. Navigate to the Pier 2 Elevation drawing
model in the Active View Groups drop-down list.

—_ View 1, Pier 2 Elevation [Sheet] \EI@
-4 P PPCHIES S 7

Name Model

{T3 Default I§p Default

{TIPier 2 Elevation [Sheet] Views [ 1 Pier 2 Elevation [Sheet]
1L_IPier 2 Elevation Views Miﬂ 2 Elevation

v

@ﬁ;&@- - & ~ [D Pier2 Elevation ishee ~ [T [ 2[3]4]s 6 [7]e] * X 134 ‘Y -01/16
] i

Element Selection > Identify element to a
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20.
30.

31.

Open the Section Callout tool again using the 04_FDOT Hidden drawing seed to create a plan view.

Next, click above and to the right side of the pier cap to define a start point for the callout. Then, define
an end point for the callout by clicking at a point at the same elevation and beyond the left side of the
cap.

Define a direction and depth to the callout by clicking at a point below the cap, within the column.
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32. Once the Create Drawing window opens, set the name of the view to be Pier 2 Plan.

33. Set the Annotation Scale for the drawing model and the Detail Scale for the sheet model to be 3/16” =

1°-0”. Additionally, change the Sheets drop-down to the existing Pier 2 Elevation [Sheet] sheet model.
Verify the rest of the settings match the image below and click OK.

Create Drawing x

Name: | Pier 2 Plan

Drawing Seed: (04_FDOT_Hidden =

View Type: Section

Discipline: Bridge

Purpose:
Create Drawing Model
Seed Model: | FDOT_DRAWINGSEED_OEM.dgnlib, 04_FDOT I
l:l Filename: | (Active File)
Al3ne=1-0" ~ |

Visible Edges: Dynamic -

Create Sheet Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 04_FDOT_

l:l Filename: | (Active File)

Sheets]l Pier 2 Elevation [Sheet] -1
.:"5:. Full Size 1 =1 -
Drawing Boundary: (New) -
Detail Scale :§ 3/16°=1-0" ~ |
Add To Sheet Index Lol

Make Sheet Coincident
Replicate Drawing in Sheet File

Open Model
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34. Notice that upon returning to the Pier 2 Elevation [Sheet] sheet model, a plan view is now found within
the limits of the border. However, the plan view is overlapping the elevation view.

— View 1,Per 2 Elevation (Sheer] —
-4 8 LPCHNES &Y

35. Open the References window by navigating to and selecting Home > Primary > References.

[E| References (16 of 16 unique, & displayed) - X

Tools  Properties

e g™ ¥ & AP e 3 08 (@ % Hilite Mode: |Boundaries +

Slot ‘P A File Name Model Description Logical Orientation Presentation Visible Edges m T,f h 3
1 BO1Pier01.dgn Pier 2 Elevation Pier 2 Elevation Pier 2 Elevation-1 ‘Wireframe Wireframe
2 . BO1Pier01.dgn Pier 2 Plan Pier 2 Plan Pier 2 Plan-1 Wireframe Wireframe

Scale 1.000000000 : 64.000000000 Rotation | 00°00'00" Offset X | 23947 7/8 Y -12281/4

@\; @ 71 M Nested Antachments: Live Nesting ¥ | Nesting Depth: | 99 Display Overrides: Never ~ New Level Display: Config Variable ~

Georeferenced: | Na L g

36. In the References window, notice that each view has its own reference (Elevation View = Pier 2
Elevation, Plan View = Pier 2 Plan).

37. To move each view so they are not overlapping, they will need to be moved using Move Reference at
the top of the References window.

38. Highlight the view that will be moved. Then, click Move Reference and move the highlighted view.
Move the Plan model reference to be directly above the Elevation model reference so both views are
horizontally aligned. This can be done by snapping the corner of the plan view to the corner of the plan
view then moving the plan view directly up.
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39. Use the Move tool to place the Drawing Boundary titles (i.e., PIER 2 PLAN and PIER 2 ELEVATION)
directly below their respective views. Navigate to Home > Manipulate > Move and then select the
text to be moved. The sheet should look like the image below.

— View 1, Pir 2 Elevation [Sheet (=B e
w4 2 RPROCEHNES 5% 2

40. Return to the Pier 2 Elevation drawing model in the Active View Groups drop-down list to create an
end view.

Marme Model

[0 Default Tiw Default
[T Pier 2 Elevation [Sheet] Views

(55 ~ T Pier 2 Elevation [She v || £ i
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41. Open the Section Callout tool using the 00_FDOT_Solid drawing seed and click above and to the
right side of the pier cap to define a start point for the callout. Then, define an end point for the callout
at a point below the tip of the piles.

42. Define a direction and depth to the callout by clicking at a point beyond the other end of the cap.

43. Once the Create Drawing window opens, set the name of the view to be Pier 2 End View. Match the
annotation and detail scales used for the previous view, and change the Sheets drop-down to the
existing Pier 2 Elevation [Sheet] sheet model.

NOTE In this case the depth of the callout extends past the entire length of the pier. There may
be cases where the depth of the callout needs to be adjusted to obtain the desired view
(i.e. footings at different elevations may result in additional lines in end view).
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44. Verify that the rest of the window matches the following image and click OK.

Create Drawing

Mame:
Drawing Seed:
View Type:
Discipline:

Purpose:

Pier 2 End View
00_FDOT_Solid -
Section

Bridge

Create Drawing Model

Seed Model: | FDOT_DRAWIMNGSEED_OBM.dgnlib, 00_FDO1
O Filename: | (Active File)
A 3ne=1-0t -
Visible Edges: | Dynamic =
Create Sheet Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 00_FDO1
O Filename: | [Active File)
Sheets: WPier 2 Elevation [Sheet] M |
2 |Full Size 1=1 -
Drawing Boundary: |(New) -
Detail Scale: |3/16"=1"-0" hd
Add To Sheet Index =
Make Sheet Coincident
Replicate Drawing in Sheet File
Open Model

45. When the Pier 2 Elevation [Sheet] sheet model is opened, ensure the new end view model reference
is now located in the sheet model.

46.

Use the Move Reference and Move tools described in Steps 38 through 40 to place the Pier 2 End View

model reference and Drawing Boundary title to the right of the Elevation view. The same methodology
used for aligning the plan and elevation views can be used. Use a common point in the end view and
align it with its corresponding point on the elevation view.

47.

Double click on each view title annotations (Pier 2 Plan, Pier 2 Elevation, and Pier 2 End View) and

remove the “Pier 2” portion. The view title annotations should now read “PLAN”, “ELEVATION”, and
“END VIEW”.

NOTE

There are some elements in the plan view that can either be drawn in live within the Pier
2 Plan View drawing model or brought in with additional references to the model. For
example, the centerline of pier, bearing lines, and centerline of beams will need to be

added.
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48. The final view should look like the image below.

_ View 1, Pier 2 Elevation [Sheet] f=]E e
-4 0 BPCHDER G5
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CREATE A PIER DETAILS SHEET

1. Access the Open Bridge Modeler (Workflow) > FDOT > Actions > Create File tool to create another

sheet file.

2. Ensure that the seed file being used is the FDOT-OBM-StructuresSheetSeed3d.dgn file. If it is not, click
the Browse button next to the Seed File field to navigate to the Seed folder. Select the correct file and

click Open.

3. Once all inputs are set as shown below and the correct seed file is selected, delete any text in the

Action field. Click Create — Open File to create the sheet file.

CreateFile (v2023.5.12.1)

Workset | C:\Worksets\FDOT\12345678901

Discipline: STRUCTURES

File Group: Substructure Sheet Files

File Type:
Base Filename Description ~
BHEndBent End Bent
BHEndBentDet End Bent Detailz
B#HFooting Footing
B#tFootingDet Footing Details
B#tFoundLay Foundation Layout
B#irtBent Intermediate Bent
B#intBent Det Intermediate Bent Details
B#Pier Pier
(O ::FicrDet
B#PileData Pile Data Table
B#PileDet Pile Details W
Output File:
Bridge File
Seq #: Base Filename: Modifier (Cptional) Seguence #: Extension:
B PierDet | | |m | | dan
C Wworksets\FDOT1 2345678301 \structures\B01 PierDetl1 dgn
Output Folder: |5tn..|c:tures | B
Seed File - |c:\fdotconned1D.1Z\nrganiza’[ion-dvil\fdot\seed\FDDT—OEM-Strucl Browse
County: Pasco ~ | Coordinate System: FLE3/2011-WF  ~
Action: | |
Create - Open File Close

4. The new sheet file will automatically be opened. Click Close and then re-open the pier sheet file
created at the beginning of Exercise 6.1 by selecting File > Open and select BO1Pier01.dgn.
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5. To create section views for the newly created details sheet, the Section Callout tool will again be
utilized. However, in this case, we want to show the arrow annotations to denote where and what
direction each section is cut. The subsequent section cuts will be done in the sheet model.

Navigate to the Pier 2 Elevation [Sheet] sheet model in the Active View Groups drop-down list.

6. Access the Section Callout tool found at Drawing (Workflow) > Annotate > Detailing > Section
Callout and select the 05_FDOT_Hidden_NoSheet# drawing seed. This seed will create a callout that
is displayed more as a traditional FDOT section cut annotation.

7. Locate a point in the elevation view within the non-tapered region of the column. At this location, click at
a point to the left of the column to define a start point for the callout. Then to create a horizontal section,
define an end point for the callout at a point to the right of the column, as shown below.

8. Define a direction and depth such that the section arrows point towards the footing and the depth limit
is above the footing, as shown below.

Dawing !dentifr'erfr

ELEVATION

9. Once the Create Drawing windows opens, set the name of the view to be Section A-A. Then, set the
Annotation Scale for the drawing model and the Detail Scale of the sheet model to 3/16” = 1’-0”.

10. Check the boxes next to the Filename fields and click the folder button to select the file created in Steps
1 through 3 (B0O1PierDet01.dgn) to send the new drawing and sheet models to the specified file.
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11. Verify that the rest of the window matches the following image and click OK.

Create Drawing x

Mame: | Section A-A
Drawing 5eed: |[05_FDOT_Hidden_MoSheet# -
View Type: Section

Discipline:  Bridge

Purpose:

[+] Create Drawing Maodel
Seed Model: | FOOT_DRAWINGSEED _OBM.dgnlib, 05_FDOT |

= Filename: | BO1PierDet01.dgn E=NF
3/16"=1'-0" -
Visible Edges: | Dynamic - |

[+] Create Sheet Madel
Seed Model: | FOOT_DRAWINGSEED _OBM.dgnlib, 05_FDOT |

] Filename: | BO1PierDet01.dgn =N
Sheets: | (New) -]
Full Size 1= 1 v
Drawing Boundary: |{New} v|
Detail Scale: 3/16"=1'-0" -
[] Add To Sheet Index =

Make Sheet Coincident
Replicate Drawing in Sheet File
[+] Open Madel

ok | | Cancal




12. Notice that, once the new sheet model has opened, that Section A-A is small in relation to the sheet
border. The scale of the section can be changed to increase the section size within the border. However,
both the annotation scale for drawing model and the detail scale of the sheet model must be changed

for consistency.

13. To change the detail scale of the sheet model, open the References tool by navigating to and selecting

Home > Primary > References.

14. In the References window, highlight the drawing model reference. Then right click and select Settings.

15. This will open the Attachment Properties window to open where the Detail Scale should be changed to

1/2”=1’-0". The Scale of the reference is now set to be 1:24.

Attachment Properties: b0 pierdet01.dgn

File Name: | BO1PierDet01.dgn

Full Path:
Model: Section A-A
Section A-A-1

Section A-A

Logical Name:

Description:

Afdoty 12345678901\ structures\b01pierdetD1.dgn

Browse...

Del A2 =1-0°

vl

Scale (Master:Ref): | 1.000000000 24.000000000

MNamed Group
Level:

Mested Attachments: | Live Nesting >

Display Overrides: | Never
New Level Display:
Global LineStyle Scale: | Master

Synchronize View: | (Mo View)

Toggles
CIEN ©

Nesting Depth:

Use M5_REF_NEWLEVELDISPLAY Configuration Vari¥

(none)

oK

-
-

b

99

-

b

4]

Cancel
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16. Now, to change the annotation scale of the drawing model, access the Properties tool at Home >
Primary > Properties.

17. Next, open the Models window in the same group by selecting Home > Primary > Models.

18. Once the window has opened to show all the models present in the file, highlight the drawing model
titted Section A-A.

Models - X
&

PRI PR b

Type 20/3D Name Description 4+ Design File Sheet Mumber

[T 0 Default Iaster Model v \BO1PierDetD] ..
T Section AA v .\BOIPierDetD] .. I
ection A- &l ...\BU]I—'lerm.ﬂ beacn A-A

19. With the Section A-A drawing model highlighted, the model’'s properties will all be accessible in the
Properties window. Here, change the Annotation Scale field to 1/2”=1’-0"” as shown below.

@1 Properties - *

4 [E] Models (1)

BY Section A-A
General ~ D
s Active False
Name Section A-A
Description
Ref Logical Section A-A
Type Drawing
Design Dimensio 2C

Fs=

Annctation Scale
Ign Scake

Paper Scale 1.0000
Propagate Annotation Scale On
Line Style Scale Annotation Scale

Update Fields Automatically True

20. Now that both scales have been set, Section A-A needs to be moved to make room for additional
sections. Returning to the References window, use the Move Reference tool to move the Section A-A
view to the top left side of the sheet.
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21. Use the Drawing (workflow) > Home > Manipulate > Move tool to place the Drawing Boundary title
(SECTION A-A) directly below the section view. The sheet should look like the image below.

22. Re-open the Pier file by selecting File > Open and select BO1Pier01.dgn. Here we will create an
additional section at the top of the column.

23. In the Pier 2 Elevation [Sheet] sheet model, access the Section Callout tool at Drawing (Workflow) >
Annotate > Detailing > Section Callout and select the 05_FDOT_Hidden_NoSheet# Drawing Seed.

24. This time, locate a point in the elevation view slightly below the pier cap. At this location, click at a point
to the left of the column to define a start point for the callout. To ensure the section cut will be perfectly
horizontal, click in the Y-Axis data field in the AccuDraw toolbar, input 0 and hit Enter. Then define an
end point for the callout at a point to the right of the column.
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IDrawing Identifier

16 of 16 unique, 5 displayed)

26. Once the Create Drawing window opens, set the name of the view to be Section B-B. Then, set the
annotation scale for the drawing model to 1/2” = 1’-0” to match the re-scaled Section A-A.

27. Next, toggle off the Create Sheet Model box so a sheet model is not automatically created for this
section. Instead, the created section will be manually placed into an existing sheet model without the
use of the Create Drawing window.

28. Check the box next to the Filename field in the Create Drawing Model section and click the folder button
to select the file created in Steps 1 through 3 (B0O1PierDet01.dgn) to send the new drawing model to
the specified file.

29. Verify that the rest of the window matches the following image and click OK.
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Create Drawing

MNarne:
Drawing Seed:
View Type:
Discipline:

Purpose:

Section B-B

05_FDOT_Hidden_MoSheet® -
Section

Bridge

Seed Model:
Filenarne:
A

=
Visible Edges:

Create Drawing Model
FDOT_DRAWINGSEED_OBM.dgnlib, 05_FDOT
BO1PierDet01.dgn = 3
1/2"=1-0" -

Dynamic =

Seed Model:
Filenarme:

Sheets:
A

=
Drawing Boundary:

Detail Scale :

[] Create Sheet Model
FDOT_DRAWINGSEED_OBM.dgnlib, 05_FDO1
BO1PierDet01.dgn

(New) <
Full Size 1 =1 -
(New) <
1/2"=1"-0" -

Add To Sheet Index =

Make Sheet Coincident
Replicate Drawing in Sheet File
Open Model

Cancel

30. The BO1Pier01Det01.dgn will open where a Section B-B drawing model has been created. However,
the Section B-B model reference has not been included in the Section A-A [Sheet] model.

31. To add Section B-B to the Section A-A [Sheet] sheet model, open the Section A-A [Sheet] sheet model
by selecting it from the Active View Group drop-down list and then open the Models window. Here click
and drag the Section B-B drawing model from the window and into the sheet model border limits.

[® 5 I T
+DEES 0 TX
Type  2D/30 MName Description ¢ Sheet Nurmber

i P Default Baster Model
Section A-A

Section A-f [Shest] Secticn A4

il
Tecon B-E E: LT
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32. Next the Aftach Source Files window will automatically open. The Attachment Method should be set to
“Recommended”. Then, click at the point within the border that the section will be placed.

33. Once Section B-B has been placed in this sheet model, use the Move Reference and Move tools to
position the new section similar to the following image.

34. Re-open the Pier file by selecting File > Open and select BO1Pier01.dgn. Here we will create a section
of the pier cap at the centerline of column.
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35. In the Pier 2 Elevation [Sheet] sheet model, set the active level to NonPlottingEle_dp (Drawing
(Workflow) > Home > Attributes) and draw a working line for the centerline of column. Access the line
tool at Drawing (workflow) > Home > Placement > Place Line. Start the working line from the midpoint
at the top of footing and end it above the pier cap and pedestals.

Drawing AT - | LN 2R L =
Home View Annotate Attach Analyze Utilities Drawing Aids AutoTable Mesh
# |None ‘I NonPlottingEle_dp 7 I 6‘ \L] " T @ k & J X / / J O T
Y= v = v v | [ A - Attach L vCd PopSet "~ Fence p|,sfe Place _ Arc l:l v
E 4 £ 0 = 0 g 0 o 0 Explmrer Tools ~ §éJ M @ M SEEIFETSS}] ". Tools .ﬂ‘ M Smartline Line Tools ™ N‘ M
Attributes Primary Selection Placement

—— View 1, Pier Elevation [Sheet]

- b-d PPN 5% Y

EEEEN

Working Line

| malp - fejdsig aaa

36. Access the Section Callout tool at Drawing (Workflow) > Annotate > Detailing > Section Callout
and select the 07_FDOT_Hidden_VertNoSheet# Drawing Seed.

37. This time, locate a point in the elevation view directly above the pier cap. At this location, snap to the
working line previously created to define the start point for the callout. Then, define an end point for the
callout at a point directly below the pier cap. Make sure to snap to the working line previously created
to ensure the section cut will be centered on the column.
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38. Define a direction and depth by clicking at a point to the left of the cut within the width of the column.

Working Line

Drawing Identiffier

Drawing Identifier

39. Once the Create Drawing window opens, set the name of the view to be Section C-C. Then, set the
Annotation Scale for the drawing model to 1/2” = 1’-0” to match the re-scaled Section A-A.

40. Toggle on the Create Sheet Model box so that the section will appear with Section A-A and Section
B-B created in previous steps.

41. Check the boxes next to the Filename fields and click the folder button to select the file created in Steps
1 through 3 (BO1PierDet01.dgn). In the Sheets drop down menu, select Section A-A [Sheet].
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42. Verify that the rest of the window matches the following image and click OK.

Create Drawing X

' | Section C-(|
rawing seed. O7_FDOT_Hidden_VertNoSheet# >

View Type: Section
Discipline: Bridge
Purpose:
E Create Drawing Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 07_FDOT_t

IE Filename: | BO1PierDet01.dgn s S
A h=ron v
Visible Edges: = Dynamic >

Ei Create Sheet Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 07_FDOT_t

E Filename: | BO1PierDet01.dgn +
Sheets: Section A-A [Sheet] v
A Full Size 1=1 v
Drawing Boundary: (New) ef
Detail Scale: 1/2"=1-0" ba
Make Sheet Coincident
Replicate Drawing in Sheet File
E} Open Model
oK Cancel

43. The B0O1PierDet.dgn will open where a Section C-C drawing model has been created. Section C-C will
also be in the Section A-A [Sheet] sheet model.

44. Use the Move Reference and Move tools to position the new section similar to the following image.
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45. Re-open the Pier file by selecting File > Open and select BO1Pier01.dgn. Here we will create a section
of the pier cap at the tapered cantilever.

46. In the Pier 2 Elevation [Sheet] sheet model, delete the working line that was used to create Section
C-C and access the Section Callout tool at Drawing (Workflow) > Annotate > Detailing Section
Callout and select 07_FDOT_Hidden_VertNoSheet# drawing seed.

47. This time, locate a point in the elevation view directly above the pier cap within the limits of the tapered
cantilever. At this location, click at a point above the pier cap to define a start point for the callout. Then,
define an end point for the callout at a point below the pier cap.

48. Define the direction and depth by clicking at a point to the left of the cut within the limits of the tapered
cantilever.

ing Idenﬁﬁier

ing Identifier

49. Once the Create Drawing window opens, set the name of the view to be Section D-D. Then, set the
annotation scale for the drawing model to 1/2” = 1’-0” to match the re-scaled Section A-A.

50. Ensure the Create Sheet Model box is toggled on so that the section will appear with the sections
created in previous steps.

51. Ensure the boxes next to the Filename fields are toggled on and B0O1PierDet01.dgn is selected. In the
Sheets drop down menu, select “Section A-A [Sheet]”.
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52. Verify that the rest of the window matches the following image and click OK.

Create Drawing X
Mame: | Section D-D
Drawing Seed:  07_FDOT_Hidden_VertMoSheet® -
View Type: Section
Discipline:  Bridge
Purpose:
Create Drawing Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 07_FDOT
Filename: | BO1PierDetD1.dgn = (3
A =10 -
Visible Edges: | Dynamic A
Create Sheet Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 07_FDOT
Filename: | BO1PierDetD1.dgn = (3
Section A-A [Sheet] -
2 Full Size 1= 1 -
Drawing Boundary: |(Mew) hd
Detail Scale: |1/2"=1'-0" -
Add To Sheet Index =
Make Sheet Coincident
Replicate Drawing in Sheet File
Open Model
oK Cancel

53. The B0O1Pier01Det01.dgn will open where a Section D-D drawing model has been created. Section
D-D will also be in the Section A-A [Sheet] sheet model.

54. Use the Move Reference and Move tools to position the new section similar to the following image.
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55. While these Sections look like a traditional section included in FDOT plans, they are currently shown
with depth. For this exercise, the sections are only meant to be cuts without any depth. Fortunately,
these model references are dynamic, and the views can be modified after creation.

56. To modify the section cuts, return to the Pier01.dgn file. Once the file has opened in the Pier 2 Elevation
[Sheet] sheet model, move the cursor to the Section D-D section callout (currently labeled 4-4) and
click on it to select it.
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57. The dashed white line denotes the limits of the clip volume. The depth can be manipulated in two ways.
The first method is to access the Properties tool by navigating to and selecting Home > Primary >
Properties. If the section callout is selected, its properties will show up in the window. Scroll down to
the Clip Volume section of the window and change the Front Depth and the Back Depth fields to 0’ 0”.

Properties *1x

4 b Elements (1)
4 o Section Callout, Section D-D

I ©— Drawing Link

General ~

Element Description Section Callout, Section D-D

Level Symbols

Class Primary

Template (None)

Geometry w
Clip Volume LS
Clip Points

\wfidth 9 7 3/8"

Flip Direction OFf

Prezerve Up OFf

Height 12" 8 11/16™

Bottom Height 6" 4 5/16™

Back Depth
Front Depth 00" I
0 LTOp on
Top Crop On
Right Crop On
On
On
On

Left Crop

Back Crop
Front Crop
Point Cloud

Annotation w
Extended L4

Raw Data b
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NOTE  Alternatively, the clip volume can be manually manipulated by clicking the horizontal
handles on thelimits of the clip volume. Once selected, the handle will turn purple.

NOTE Move the handle to the center of the clip volume. Click once more on the section callout
line to releasethe handle. Then repeat for the opposite handle to remove all depth.

58. Repeat this process for the Section A-A, B-B, and C-C section callouts.
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59. These changes will now be reflected in the BO1PierDet01.dgn sheet file and should look like the
following image. Note that reinforcing bars and annotations could be added to the drawing models.

60. Now that Pier Details sheet (BO1PierDet01.dgn) has been completed, the section callout annotations
in the Pier sheet (BO1Pier01.dgn) need to be updated to match the titles of the sections in the details
sheet. This is accomplished by changing the properties of the drawing boundary for each section within
the sheet model.

61. In the Section A-A [Sheet] model, click on the SECTION A-A view title to select the drawing boundary.

Then, access the Home > Primary > Properties tool and change the Drawing Identifier field in the
General section to A.
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Properties v X
4 7h Elements (1)
4 O Drawing Boundary, Section A-A A

B ©— Drawing Link

General ~

Element Description  Drawing Boundary. Section
Lewvel

Class Primary

Template {None)

Detail Scale 12 =10"

swing Tvpe

rawing ldentifier A
Mame Cection AA

Extended
Geometry

Annotation

<€ ¢|| ¢

Raw Data

. Repeat this with the Section B-B, C-C, and D-D section callouts.

. Re-open the BO1Pier01.dgn and notice that the section callout annotations found in the Pier 2 Elevation
[Sheet] model now show the correct section callouts.

. Lastly to get the section callouts to look like they would in a traditional FDOT plan sheet, there should
be a gap between the arrows. To achieve this, first right-click and hold on the Section A-A section
callout to get a list of options to pop up, as shown in the following image. Select Create Gap.

Options

&= Properties

Select All On Level By Element

View Control

Copy
Move
Scale
Rotate
Mirror

Open Link
Edit Link

Remove Link

Saved View Properties
Open Drawing

Level Off

Edit Text

Create Step

Flip Direction

Create Gap

Select Same Type and Size
o Select Same Type
. Select All
Select None
Select Previous
Displayset Set

Cut to Clipboard
Copy to Clipboard
Paste from Clipboard

Delete Element
Turn Level Off by Element

@E Properties

of 16 unigue 5 displayed
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65. Next, click at the tail of the left arrow. Then click again at the tail of the right arrow, as shown in the
following image.

Section Callout, Section A-A
Level: Symbaols

Links to:
BO1PierDet01.dgn; Section A-A [Sheet]; Section A-A

66. Repeat this with the remaining section callouts.

67. The final sheet should look like the image below.
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CREATE FOOTING PLAN VIEW

1.
2.

In the BO1Pier01.dgn, open the Pier 2 Elevation drawing model.
Open the Section Callout tool using the 04_FDOT_Hidden drawing seed to create a footing plan view.

Next, click to the left at an elevation around the center of the footing. Then, define an end point for the
callout by clicking at the point at the same elevation and beyond the right side of the footing.

Define a direction and depth to the callout by clicking at a point below the piles.

|m View, Pier 2 Elevation
G- éi - 4 P PBOOD T ARE

Once the Create Drawing window opens, set the name of the view to be Footing Plan. Then, set the
annotation scale for the drawing to 3/8” = 1’-0”.

Next, toggle off the Create Sheet Model box so a sheet model is not automatically created for this
section.

Check the box next to the Filename field and click the folder button to select BO1PierDet01.dgn to
send the new drawing model to the specified file.
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8. \Verify that the rest of the window matches the following image and click OK.

Create Drawing >
Mame: | Footing Plan
Drawing Seed: 04 _FDOT_Hidden -
View Type:  Section
Discipline:  Bridge
Purpose:
Create Drawing Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 04_FDNN
Filename: | BO1PierDetD1.dgn = 3
A 3rg=1-0" -
Visible Edges: | Dynamic ~

Seed Model;
Filename:

Sheets:
A

e}

Drawing Boundary:

Dretail Scale :

[ ] Create Sheet Model
FDOT_DRAWINGSEED_OBM.dgnlib, 04_FDCA

(Active Filg)

(Mew) o
Full 5ize 1 =1 -
(New) -
Full 5ize 1 =1 -

Add To Sheet Index

Make Sheet Coincident

Replicate Drawing in Sheet File
Open Model

Cancel

9. The B0O1PierDet01.dgn will open where a footing plan drawing model has been created. Notice that the
column does not appear on the footing plan view.

™ View 1, Footing Plan
-@- i PRROOD EE SRR
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10. Open the References window by navigating to and selecting Home > Primary > References.

11. In the References window, right click BO1PierDet01.dgn and select Presentation from the drop-down

menu.

[
I—ﬂ References (7 of 7 unique, 3 displayed) — X
Tools  Properties
— ;- . >y ey
ek £ AP D A g D 29 @ X0 HiteMode Boundais -

Slot P A File Name Model Description Logical Orientation Presentation  Visible Edges (3] D_f k @
1 BO1Pier01.dgn Default Attach... g Plan Footing Plan (From Clip... Dynamic v .
Detach
Reload
Scale | 1.000000000 + | 1.000000000 Exchange Offset X | 0.00 ¥ | 0.00
EEN2EE. wEe ¢ @ w | OpeninNewsession esting | Mesting Depth: 98 | Display Overrides: |Never =
Activat
New Level Display: | Config Variable ¥ | Georeferenced; vate
Deactivate

Move

Copy

Scale

Rotate

Merge Into Master

Make Direct Attachment
Add Link to Element

Create Drawing Boundary
Clip Boundary

Clip Mask

Delete Clip

Presentation I

Update From Saved View
Push to Saved View
Update From iModelHub

Settings

12. Click the Synchronize View drop-down menu and select “Presentation Only”.

[ Reference Presentation — X
@ Presentation == =~
Display Style: | (From Parent] v
Use View Flags
Clip Volume Line Styles
Constructions lE‘ Line \wWeights
Deefault Lighting E‘ Patterns

Dimensions §|Tags

[] Fast Cells EText

= Fil 14 Text Nodes

{E‘j Level Overrides E‘Transparency
Mamed Presentation E‘ Height Field

2% Placement Point E‘Text Field background

ﬁ Clip Volume Settings ~

Forward: [Co]|[F]|[ ] 7 FDOT Hidden
Back: 1Y) [ FDOT Hidden
e [N [EF|IRIf SPFooT idden

Outside: [=] __ k [ From View

Synchronize V'lewl Presentation Only R I@ éi

0K Cancel

FDOT OBM 249



\

13. In the Clip Volume Settings, make sure that the Back display is toggled on and that the Forward, Back,
and Cut display styles are set to FDOT Hidden.

14. After the presentation settings have been adjusted, the footing plan should look like the clip below.

8 View1, Footing Plan Lo [

G -8~ 4 PLPEOOD EID IR
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15. To make the column appear as a hidden line, navigate to Open Bridge Modeler (Workflow) > View >

Presentation and select the arrow on the bottom right corner.

OpenBridge Modeler

Horme Ciwil

Ap

o

View

Presentation

pl Appl
Attributes Display f‘:tyle Display ﬁule

Area

@ CHEG -
Ltilities Reports and Drawings

Window foom
Cut

RN =

View Collaborate FDOT Help
LB = oEm A
& o ]
] 0 | = L
Fit © . View View  View Place
View 53 Q Orientation ~  Previous Mext Mamed Boundary
Tools Mamed Boundaries =

16. From the Display Styles window, select

Column” from the drop-down menu.

FDOT Hidden and for the Display Rules select “Hidden_

) Display Styles
3 Bes|X
Type  Name - &
('Sg o
y FDOT Solid
&0 FDOT_ProConcrete
&0 Filled Hidden Line
&7 Filled Hidden ..\Modeling
(55 Filled Hidden Line:Realistic
&0 Filled Hidden..\Sky Sphere
&) Forward
&) GrayExisting
&0 Hidden Line
&0 Hidden Line:Modeling
&0 Hidden Line:Realistic
57 Hidden Line:Sky Sphere
50 llustration
%) llustra..\Ignore Lighting
51 lllustration:Modeling
50 lllustration:Shadows
%0 Nlustration:Sky Sphere
%) Monochrome
") MonochromeModeling
%) MonochromeShadows
%) Monochrome:Sky Sphere
&0 Outside
5) Smooth
%7 Smooth:Modeling
% Smooth:Shadows
%) Smooth:Sky Sphere
%) Thematic:Aspect Angle
%0 Thematic:Height
Y0 Thematic:HillShade
%) Thematic:Slope
%7 Transparent
") TransparentModeling
%) Transparent:Shadows
5 TransparentSky Sphere  w
< >

Render Mode
Display: | Visible Edges =
[] Use Color From Material
Display
% Geometry Maps
Transparency Threshold: |G 30 -
Display Rules
>
Overrides
Element: | —
No Material e e
O Background: | Color > W~
O Reflection: Color | W~
Thematic Display: ~ '
[ Invisible to Camera
Edge Settings
Visible Edges: | —— ™
Hidden Edges: | ——
Treat Open Elements as Edges
Options
[] Hidden
Usable for
Views

Clip Volumes
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17. After closing the Display Styles window, the footing plan should look like the following image.

w1, Faatng Pian R
Re@iv|d PARESD BE[HGD

18. Open the Section A-A [Sheet] sheet model and then open the Models window. Click and drag the
Footing Plan drawing model from the window and into the sheet model border limits.

19. Next, the Attach Source Files window will automatically open. The Attachment Method should be set
to “Recommended”. Then, click at the point within the border that the section will be placed.

20. Once the Footing Plan has been placed in the sheet model, use the Move Reference and Move tools
to position the new section similar to the following image.
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EXERCISE] Create a Typical Section from the Dynamic View by Station Tool

GENERATE A TYPICAL SECTION VIEW

1. Open the data set file: BOIMODLBRTRO01_6.2_Begin.dgn

2. Ensure the 2D Alignment reference is toggled on. The Alignment file for the bridge must be attached
and toggled on in order to use the Dynamic View By Station tool. This can be turned on inside the
References dialog box.

1 References (5 of 5 unigue, 1 displayed) e X

Tools Properties

E-BXD £ P B6:d P Rl

Boundaries ¥

Slot ¥ 3 FileName Model Description Logical Orientation Presentation [ J 1Y Cj
1 .\Roadway\ALGNRDO1.dgn Default Master Model Coincident Wireframe L
2 .\Roadway\ALGNRDO1.dgn Superelevation Superelevation Ref Coincident Wireframe ¥ v
3 .A\Survey\SURVRDO1.dgn GTDMRD Terrain Coincident Wireframe v v
4 .\Roadway\ALGNRDO1.dgn Default-3D Master Model Ref-1 Coincident Wireframe ~ ~
5 .\Roadway\ALGNRDO1.dgn Superelevation-3D Superelevation Ref-2 Coincident Wireframe v ¥

Scale | 1000000000 :[1.000000000 Rotation | 00°00'00"
Offset X [ 0:0 ¥[00 z[00

ﬂmnﬁax ;?C,)‘E Eﬂ 8 El,_‘ - Nested Attachments:  No Nesting

New Level Diselﬂ. CnnﬁEVnriable ~ | Georeferenced: | No =

¥ | Nesting Depth: | 1 Display Overrides: |Never =

3. Access the FDOT > Actions > Create File tool and create a sheet file with the inputs indicated below
and delete any text in the Action field.

CreateFile (v2023.5.12.1) X
Workset: C:\Worksets\FDOT\12345678301
Discipline:  STRUCTURES st
File Group: Superstructure Sheet Files ~
File Type:
Base Filename Description A
B#SlidingPlate | Traffic / Pedestrian Railing Sliding Plate Assembly
BHSteelDet | Steel Girder Details
 BHSteelGirder | Steel Girder
B&Stiffener Stiffener Details
B#Superst | Superstructure
B#Superst Det | Superstructure: Details
B#TrafficRailing Traffic Railing
» B#TypicalSection | Typical Section Through Bridge Deck
B#TypSegDet | Typical Segment Details
B#TypSegDim | Typical Segment Dimensions
B#Typ SegReinf Typical Segment Reinforcing v
Output File:
Bridge File
Seqg#. Base Filename: Modifier (Optional) Sequence #: Extension:
B TypicalSection ] |D1| | dan
Clwiorksets\FDOT\12345678901 \structures\B01 Typical Section01.dgn
Output Folder: | Stuctures | .
SeedFile. |C:\dotconnect10.12\organization <ivil¥dot \seed\FDOT-OBM-Struc| ~ Browse
County: Leon ~ | Coordinate System; | FL83/2011-NF  ~
Action: I |
Create - Open File Close
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4. Ensure that the seed file being used is the FDOT-OBM-StructuresSheetSeed3d.dgn file. If it is not,
click the Browse button next to the Seed File field to navigate to the Seed folder. Select the correct file

and click Open.

I Open X
« v 4 || > ThisPC » OSDisk(C:) > FDOTConnect10.12 > Organizstion-Civil > FDOT > Seed v o Search Seed
Organize »  New folder ~
Wall Sheets A Name ) Date modified Type Size
Westshore Interchange el Fie follies

Whiteboards

B WsP
@ | WP Only - Structures

fg WSP 0365

B3 ThisPC

- 3D Objects

.. CADD (entpacifs01)
[ Desktop

|= Documents

¥ Downloads

. Jobs_Agreements (entpacifs01)
. Marketing (entpacifs01)

. Marketing (USORL600cifs01)
D Music

. Office (entpacifs01)

=] Pictures

B videos

%2 0SDisk (C:)

1160 AICK A

File name: | FDOT-OBM-StructuresSheetSeed3d

FDOT-OBM-KeySheetSeed
FDOT-0BM-StructuresSeed2d
FDOT-0BM-StructuresSeed3d
FDOT-OBM-StructuresSheetSeed3d
FDOT-ORD-KeyMapSeed
FDOT-ORD-RWseed

& FDOT-ORD-Seed2D
FDOT-ORD-Seed3D
FDOT-ORD-StructSeed2D
FDOT-ORD-StructSeed3D

8 FDOT-ORD-TypicalPackageSeed

Bentley M

Bentley
Bentley M

Bentley M

| [seedfiles (".dgn)

Cancel

Once all inputs are set and the correct seed file is selected, click Create — Open File to create the

sheet file.

The new sheet file will automatically be opened. In the Default model, open the References tool by

navigating to and selecting Home > Primary > References.

Attach the BOTMODLBRTRO01_6.2 Begin.dgn file as a reference in the Default model by using the

Attach Reference tool at the top of the References window and then selecting the file.

B References (0 of 0 unigue, D displayed) = -
Toals Froperties
BB s XD [Filte Mode] Boundaries +
Slet F‘ A File Marme Model Descrption Logical Onentation Presentatson  [&] 0 h E,

¥ B atal

t1.4 ¥

k i { BitBehee | Mesting Depat
I Ovemides * | Blew Level Disg =  (Georeferenced -
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8.

10.

11.
12.

Once all inputs for the incoming reference are set, click OK to attach the reference.

Reference Attachment Properties for BOIMODLBRTRO1_6.2_Begin.dgn X

File Mame: BOTMODLERTRI1_6.2_Begin.dgn
Full Path:  ..412343678901\5tructures\BOTMODLBRTRO1_6.2_Begin.dgn

Legical Mame:

Description: | Master Model

Orientation:
Wiew Description
Coincident Aligned with Master File
Coincident - World Global Origin aligned with Master File

Geographic - AEC Transform Calculated Transform, max error 0.0001066 '

Geographic - Reprojected Reproject reference data to Master GC5
Standard Views

Saved Views (nong)

Mamed Boundaries (none)

Detail Scale:  Full Size 1=1 -

Scale (Master:Ref): | 1.000000000 + | 1.000000000
Mamed Group: hd
Revision: -
Level: hd

Mested Attachments: | Live Mesting * | Mesting Depth: | 3

Display Overrides: | Mever A
Mew Level Display: | Use M5_REF_MEWLEVELDISPLAY Cor
Global Line5Style Scale: | Master e
Synchronize Yiew: |VWolume Only -

Toggles

EIEAN @ = 2 <[ e 2

Once attached, click the Fit View tool at the top of the view window, then click within the view window
to fit the reference within the view. Locate the bridge and zoom in.

Note that the annotations are difficult to see. To change the annotation scale of the model, access the
Properties tool at Home > Primary > Properties.

Next, open the Models tool in the same group by selecting Home > Primary > Models.

Once the Models window has opened to show all the models present in the file, highlight the model
titted Default. The model’s properties will all be accessible in the Properties window. Here, change the
Annotation Scale field to 17=30’.
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13. Select the Dynamic View By Station tool by navigating to and selecting Reports and Drawings >
Drawings > Dynamic View By Station

Home Civil Utilities Reports and Drawings View Collaborate FDOT Help
CfDeck 2} Camber = — = A nBC
% >_ | - . il T T i EBE
" JffBeam i Pier -ABC X —
Quantities Input T Dynamic  JSettings Substructure Typical Place Mamed Adjust Element Drawing
Report  Report ':E Bearing View By Station Section Mamed Boundary Boundaries Profile Named Bo... Annotation ~  Model Annotation
Bridge Reporting Drawings

14. In the Dynamic View Report window, the Profile Type should be set to Cut to only show any elements
that directly intersect with the cut line. Additionally, only the Skew Angle checkbox should be selected
with an angle of 00°00°00”, as shown in the following image.

6(.?,1.

Main -~

[ Station  |2080'7 3/16"

Skew Angle |D0°00D0"

[] Depth 19:85/16
Profile Type |Cut v
Half Callout [ ]

NOTE If the Profile Type is changed to Cut with Depth, the section will also be able to show
elements not directly intersecting the cut line. Any elements encapsulated by the defined
depth will be shown in the created view, as the section will show up more as a volume
instead of a plane with no depth.

15. To create a view with the Dynamic View By Station tool, the alignment where the drawing will be cut
must be selected. Select “CL_WB”.

16. Next, the location of the section cut must be determined. Move cursor to a point in Span 1 between
the “FFBW END BENT 1” SupportLine and the “CL PIER 2” SupportLine, and data point to select this
location along the alignment “CL_WB”.

w View 1 - Top, Default
-l 4 8LPTHN/ = 50 %
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17. Determine Orientation and Length of Section Cut. Position the orange crosshairs outside the limits of
the bridge to define the length of the section cut, as shown in the following image. Notice that the Skew
Angle field is locked because it was already set to 00°00°00” in the Dynamic View Report window.

NOTE Note that sections can be cut with different skews. For instance, to create a longitudinal
cross section of a bent, a skew of 90°-00’-00” can instead be used.

e

s View 1 - Top, Default
MGl L POOTNN GZWRAEE 5T

-«

18. Data point at a location upstation from the defined cut line to specify what direction the cut should show.

S

w View 1 - Top, Default

tion and Depth

Main:Depth  [EERIE

19. After selecting the direction, the Create Drawing window will appear. Set the name of the view to be
Typical Section and the Drawing Seed to be 04_FDOT_Hidden. Set the annotation scale for the

drawing model and the detail scale of the sheet model to 1/4” = 1°-0”.
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20. Verify that the rest of the window matches the following image and click OK.

Creat b
Typical Section
Drawing Seed: 04 FDOT_Hidden -
View Type:  Section
Discipline:  Bridge
Purpose:
Create Drawing Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 04 FDOT
[ Filename: | (Active File)
A an=1-0 v
Visible Edges: | Dynamic ~
Create Sheet Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 04_FDOT
O Filename: | (Active File)
Sheets:  (Mew) -
A Full Size 1=1 -
Drawing Boundary: |(Mew) -
Detail Scale: |1/4"=1'-0" -
[] Add To Sheet Index =

Make Sheet Coincident

Replicate Drawing in Sheet File

Open Model

21. The following window should open, showing the section created. The section may appear outside of
the border.

— iew 1, Typical Section [shest] [E=8E5R %~
G- i B ROCHNES S5k ¢
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22. In the newly created sheet model, open the References tool by navigating to and selecting Home >
Primary > References.

23. To center the section in the sheet border, the model reference will need to be moved using Move
Reference at the top of the References window.

24. Highlight the view that will be moved, as shown below. Then, click Move Reference and move the
highlighted Typical Section model reference to be centered in the border.

k| References (8 of 8 unique, 4 displayed) = X
Tools Properties
EE ki hi X & X D ¢ <] »J ’3’1 :ﬁ ‘(f.:f; ’5 ;‘:' (@) X} Hilite Mode: | Boundaries ~
St ¥ 3 FileName Model Description Logical Orientation Presentation VisibleEdges [ ./ N &
1 v BO1TypicalSection01.dgn Typical Section Typical Section Typical Section-1 Wireframe Wireframe
Scale | 1.000000000 : | 48.000000000 Rotation | 00°00'00" Offset X | 19956 Y|-03/16
ElIIIC_‘] Iil .E f @I‘ Nested Attachments: Live Nesting ¥ | Nesting Depth: | 99 Display Overrides: Allow ~
New Level Display: | Config Variable ¥ | Georeferenced: No M
o

25. Use the Move tool to place the view titles (i.e., TYPICAL SECTION) directly below their respective
views. Navigate to Drawing (workflow) > Home > Manipulate > Move and then select the text to be
moved. The sheet should look like the image below.

— View 1, Typical Section [Sheet =l E

G- 4.8 SN DES 5%

26. For this section, the 2D Decoration levels do not need to be visible. Therefore, these unneeded levels
can be toggled off. While in the Default model, navigate to Home > Primary > Level Display. The
dots in the image below show the components that are active in the model. Order the components by
clicking on Used until all active components are at the top of the list. Undesired items can be hidden by
clicking on the list item to remove the blue highlight. Note that this process could also be done prior to
using the Dynamic View by Station tool.
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w» View 1 - Top, Default

Level Display - View 1

n Ly [ View Display

% B T auter [Leveis =

BO1TypicalSection01.dgn, Default

VB BOTMODBRTR01_6.2_Begindgn, Default

DecorBearingPlateor Pad (2D)
DecorBearingGroupText(20)
DecorBeamLayoutText(2D)
DecorBeamLayout(2D)
ndOtfset(2D)
2D,

27. To ensure that the levels remain toggled off the next time the file is opened, save the settings by
accessing File > Save Settings or (Ctrl + F).

GENERATE AN OVERHANG DETAIL

1. Within the Typical Section [Sheet] model, access the Detail Callout tool by navigating to Drawing
(workflow) > Annotate > Detailing > Detail Callout.
Home View Annotate Attach Analyze Utilities Drawing Aids Mesh
A,B A7 ¥V A — M= R
A =< - ' L=
AT A+ % 7 1t x.e O :
Place Edit Change Text , Place Place = Dimensicn v H oo e Place = Section o
Text Text Attributes ~— 7 MNote Label Element o W v il Table = Callout ©* of
Text P Motes Dimensioning G Tables  Detailing &

2. Select the 22_FDOT_Wireframe Drawing Seed and use the circle boundary to create the detail.

6(}.

Drawing Seed: |22_FDOT_Wireframe

Detailing Symbol Style: | FDOTSection

Height: |From Yiew b
Qo1

Create Drawing
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3. Click on the left corner of the top flange to place the center of the circular callout. Then click a point
directly above to define the edge of the detail circle so that it fully encompasses the overhang and
barrier.

4. Click once more to define the end point for the callout above the circle and to the right. Click one
final time to provide a leader for the callout and then, right-click to reset and finish the detail callout
placement.

5. Set the name of the view to be Detail A. The Drawing Seed is already set as 22_FDOT_Wireframe.
Set the annotation scale for the drawing model and the detail scale of the sheet model to 3/8” = 1’-0”.
Additionally, change the Sheets drop-down to the existing Typical Section [Sheet] sheet model.

6. Verify that the rest of the window matches the following image and click OK.

Create Drawing >

Mame: | Detail A
Drawing Seed: |22_FDOT_Wireframe -
View Type: Detail
Discipline: Bridge

Purpose:

Create Drawing Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 22_FDO1

| Filename: | (Active File)
A aer=1-0 M
Visible Edges: | Dynamic ~

Create Sheet Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 22_FDON

1 Filename: | (Active File)
Sheets: |Typica| Section [Sheet] -
A Full Size 1= 1 -
Drawing Boundary: |(New) -
Detail Scale: |3/8"=1'-0" -
Add To Sheet Index =

Make Sheet Coincident
Replicate Drawing in Sheet File
Open Madel

0K Cancel
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7. The Typical Section [Sheet] sheet model now has the Detail A view within the border. Note that the
detail shown is a mirror of the area with the detail callout. This issue has been filed with Bentley and will
be updated in an upcoming release.

8. Use Home > Primary > References > Mirror Reference to mirror the detail so that it is correctly
displayed.

9. Use the Home > Primary > References > Move Reference tool to move the different views a bit to
avoid any overlapping.
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10. Then, use the Drawing (workflow) > Home > Manipulate > Move tool to place the view titles (i.e.,

TYPICAL SECTION and DETAIL A) directly below their respective views. The sheet should look like
the following image.

— View 1, Typical Section [Sheet] =l
3 Tolag Nle)
o~ = ML == s f

TYPICAL SECTION

12. Click once more on the text handle, then move the text up into open space and click one last time to
release the text. Do the same with the additional node for the leader line.

13. Lastly, using the Drawing (workflow) > Annotate > Text > Edit Text tool, change the text in the detail
callout to read “DETAIL A”
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The final sheet should look like the image below.

__ View 1, Typical Section (Sheet] =N Bl X
- 48 LEaE i
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EXEREISE Create a Plan and Elevation View with the Place Named Boundary Tool

GENERATE A PLAN VIEW

1. Open the data set file: BOITMODLBRTRO01_6.3_Begin.dgn

2. Access the OpenBridge Modeler (Workflow) FDOT > Actions > Create File tool and create
a sheet file with the inputs indicated below. Make sure to change the seed file to FDOT-OBM-
StructuresSheetSeed3d.dgn, located in the same folder as the 2D seed file.

CreateFile (v2023.5.12.1) x

Workset | C:\Workseis\FDOT\12345678301

Discipline: STRUCTURES ™
File Group: Structure Sheet Files ~
File Type:
Base Filename Description [l
B#index Index of Sheets
B#JunctBoxDet Junction Box Details
B#ladderDet Ladder Details
B#MaintLight Maintenance Lighting Plan

B#MaintLightDet | Maintenance Lighting Details
B#PedBridgeDat... | Pedestian Bridge Data
»
B#RebarList Reirforcing Bar List
B#RemoveExist Removal of Existing Structures
B#SumOfPaytems | Summary of Pay tems Sheet (For Structures as Lead Companen...

B#SumOfQuantiti... | Summary of Structures Quantities W
Output File:
Bridge File
Seq#: Base Filename: Modifier (Optional)  Sequence #: Extension:
B PlanBlev | | |D‘I | dan

CWorksets\FDOT'1 2345678501 structures\BO1PlanElevl1.dgn

=
Output Folder: |stn.|ctures | rovse

Geed File : | 12\organization-civilfdot ‘seed \FDO T-OBM-Structures Seed 3D .dgn Browse
County: Pasco | Coordinate System: FLB3/2011-WF  ~

Action: “ |

Create - Open File Close

3. Click Create — Open File. Once the new file opens, go to OpenBridge Modeler (Workflow) > Reports
and Drawings > Drawing Scale and set the Annotation Scale to 1”=30’. Go into the Model properties
and change the Name and Description to PLAN.

AA) A 1"=30 N oo— - O~+ ~3%-~
— US Survey Foot x I I O/"\ A tamna / Q/D J o
[ P— [ F—— —— ) ] — o
&7 | Custom ACS it L= . v S

Civil US Survey Inch il | p— Measure Measure Measure Place Place _ Arc
Labeler 1"=30 T | Distance Radius Angle == Smartline Line Tools* A+ A =
Labels Drawing Scale Measure Placement

— — e ==

[E Meodels — X
gl K -
+ e E 7 X
Type 2D/3D Name Description -¢‘— Design File Sheet Number

@i Default Master Model "  C\Worksets\F..\BO1PlanElev01.dgn
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|Properties * 0>

4[] Madels (1)
Tew PLAN

General », N
|z Active True
Mame PLAN
Description PLAN
]
Type Design

Design Dimension D

|z Markup Falze
- 0000

FPaper Scale 1.0000

Propagate Annotation £ On

Line Style Scale Annotation Scale

lpdate Fields Automat True
Angle Readout -
Direction Base East

Direction Mode Azimuth

Format DD MM ~55

Accuracy 0.1234

Direction AntiClockwise

Isometric LS
|zometric Plane Top

|lzometric Lock False

4. Go into the References window and attach the main bridge model file BIMODLBRTRO01_6.3_Begin.
dgn with the settings shown below. Set Nested Attachments to Live Nesting and set Nesting Depth to
1.
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Reference Attachment Properties for BOTMODLERTRI1_6.3_Begin.dgn *

File Name: BOTMODLBRTR01_6.3_Begin.dgn A—
Full Path:  .\FDOT\12345678901\structures\BO1MODLBRTR01_6.3_Begin.dgn
Model: Default b
Logical Name:
Description: | Master Model

Orientation:
View Description
Coincident Aligned with Master File
Geographic - AEC Transform Calculated Transform, max error 0.0001085 *
Geographic - Reprojected Reproject reference data to Master GCS

[ Standard Views
Saved Views (none)
Named Boundaries (none)

Detail Scale: |1"=30' v df—

Scale (Master:Ref): | 1.000000000 ¢ | 1.000000000
Named Group: -
Revision: -
Level: -

Nested Attachments: | Live Nesting ¥ | Nesting Depth: | 1

Display Overrides: | Never »
New Level Display: | Use MS_REF_NEWLEVELDISPLAY Confir
Global LineStyle Scale: | Master -
Synchronize View: | Volume Only b

Toggles

EIEEN = 2 Els 0
o

5. Change your active level to ClipDrawingBound_dp by navigating to Drawing (Workflow) > Attributes
> Level. This will put the named boundary on a non-plotting level. Use the Fit View tool to locate the

bridge.
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6. Open the Level Display window, expand the dropdowns, select the BTIMODLBRO0O1_6.3_Begin.
dgn reference file, and turn off all levels except: Default, DecorBarriers(2D), DecorDeckOutline(2D),
DecorSupportLines(2D), EndBentCapConc_pm, EndBentCheekWallConc_pm, PierCapConc_pm, and
PierColumnConc_pm. Select the drop down list associated with the BIMODLBRO01_6.3 Begin.dgn and
ensure that all levels are on for ALGNRDO1.dgn, Save Settings (Ctrl+F) once levels are modified. The
reason for doing this is because complex 3D elements such as the deck will display internal “lofting”
lines in the wireframe display style which we do not want to show up in the plan view. Turning off the
superstructure 3D elements and only keeping on the 2D projection elements will yield the desired result
for the plan view as seen below. Note that the Default and 3D substructure levels are kept on because
parametric cells don’t create the 2D projection elements consistently.

Oy Eﬂ e -
=| YalLey~ [Levels ~ [ ~

=L BO1PlanElevd1.dgn, PLAN
£ BOIMODLBRTRO1 6.3 Begin.dgn, Default
[ .\Roadway\ALGNRDO1.dgn, Default
{8 \Survey\SURVRDO1.dgn, GTDMRD

B

Name Used

|

AppSlabConc_pm
BarrierWallConc_pm
BeamConc_pm
BearingBevelPlate_pm
BearingPadMisc_pm
BearingSeatConc_pm
CompGrpBeams
CompGrpSubstructure
DeckConc_pm
DecorBeamEndCLExt(2D)
DecorBeamEndOffset(2D)
DecorBeamlayout(2D)
DecorBeamlayoutText(2D)
DecorBearingGroupText{2D)
DecorBearingPlateorPad(2D)
DecorBearings(2D)
DecorBearingSeats(2D)
DecorCLBearing(2D)
DecorConcPierCap(2D)
DecorConcPierColumn(2D)
DecorConcPierFooting(2D)
DecorPile(2D)
DecorSupportlinesText(2D)
DecorUnitLabel(2D)

EndBentCapConc_pm
EndBentCheekWallConc_pm
HaunchConc_pm
PierCapConc_pm

Prcmncﬂnq;m . ::|:5? Y | 1432206:0 3/16 Z 133174 D A_/@-E@-(’)XH_J

7. Access the Place Named Boundary tool through Reports and Drawings > Drawings > Place Named
Boundary or through the View > Named Boundaries > Place Named Boundary.
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8.

10.

Select the Civil Plan option in the top left of the window and select the CL_WB alignment by clicking
on the alignment. Notice that this automatically fills the Name field, however the name will change in a
subsequent step. Note that this is the 2D alignment, not the 3D alignment.

V1S

1 I\J
S
N

' [
+
Py
o
—
L

Set the Drawing Seed to the 11X17_PE_Plan 14in and the Detail Scale to 1” = 30’. The five seed
files for P&E sheets range from 11X17_PE_PLAN 11in to 11X17_PE_Plan 15in. These different sizes
correlate to the width of the drawing boundary on the sheet model. The Length, Left Offset, and Right
Offset values are automatically calculated based on the lengths of the drawing boundaries in the seed
file and the Detail Scale selected. Changing the Detail Scale will automatically change those values to
maintain the aspect ratio of the drawing boundary in the seed file. However, users can change those
values manually if desired.

Once the alignment is selected, change the Name and Group Name as shown below, and uncheck the
Create Drawing box. For drawings requiring more than one plan sheet, the number at the end of the
view name will automatically update on subsequent sheets.

£% Place Mamed Boundary Civil Plan - d
i) &K \
Drawing Seed:] 11x17_PE_PLAN_14in -
Detail Scale:§ 1°=30' -

Name:§ Plan 1

Description:

Group: (New) -

Description: |
[ btart Location: | 2022+49.50 |«
[ Btop Location: | 1991+60.00 s >
Length: | 420.000000
Left Offset: | -75.000000
Right Offset: | 75.000000

Owverlap: | 0.000000

(%]

Boundary Chords:

M Create Drawing
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11. The user’s next data point will select the Start Location of the boundary. Select a point just before the
Start Approach Slab. The Place Named Boundary tool is actually set up to create multiple boundaries
at the length automated in the Length field by the drawing seed. Move the cursor into the Model view
to see the preview of the boundaries that can be created depending on where the Stop Location is
selected. Move the cursor to a location that only creates one boundary and data point.

Start Location
‘ Stop Location

12. Data point one last time in space to confirm your selection. The boundary should appear slightly
transparent once placed. Note that if your bridge requires multiple plan sheets an Overlap value of O’
as shown in this example would result in no overlap of the plan views and would require match lines. If a
value is entered for Overlap then the named boundaries will have an overlap equal to the value entered.
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GENERATE TERRAIN ELEVATION VIEW AND CREATE DRAWING &
SHEET MODELS

The Named Boundary — Civil Profile tool will be used to create the terrain (existing and/or proposed
groundline) and elevation scales shown in the elevation view. The Section Callout tool will be used later in
this exercise to create a side elevation view of the bridge.

1. Open View 2 and use the Fit View tool to locate the bridge. Switch to a Top View and set the Display
Style to Wireframe.

w View 2 - Top, PLAN

Trsiw 4 @O ED Y
FDOT Hidden

FDOT Solid

FDOT_ProConcrete

Filled Hidden Line »

4

Gray Existing
Hidden Line

~ jon s e ha (=

Illustration
Monochrome
Smooth

Thematic

v v v v v v

Transparent

Open Display Styles Dialog

=lo 1= e 1=

|rm

2. Access Civil > Vertical > Open Profile Model to start opening the profile model.

OpenBridge Modeler - | Mg~ HE S - o = % FE] = Workset: 12345678901 - BO1P

Home Civi Utilities Reports and Drawings View Collaborate FDOT Help

&¢ Import/Export ~ ¢ Civil Accudraw / Lines » _L Offsets and Tapers * +~ Modify ~ Lines ~ Element Profiles =
Design Elements ~ Geometry Report * O Arcs * X Reverse Curves ~ ~ Complex Geometry ~ = Cu
# Standards - > Civil Analysis + Point * = Spirals * Profile Creation = Complex Geometry =
Gsw‘d- Tools Horizontal Vertical

3. Once the tool is active, select the CL_WB alignment within the limits of the bridge to Locate Plan
Element. Data point in an open area of View 2 to confirm and open the profile model.

s View 1-Top, PLAN =)0
=6 i PPRCUf B oREE RTES

s

4. In this example the alignment file will have a terrain file referenced in and set active to the alignment.
When an alignment has an active terrain associated with it, the terrain will automatically show up in the
profile view as it does in this example. However, if the alignment file does not have an active terrain
set, you will need to create a 3D slice to generate the terrain profile in the profile view. That scenario
is shown below, but can be skipped for this training as our alignment has a terrain associated with it.
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To create that 3D cut start by setting the active level to ClipDrawingBound_dp. Start the Create 3D Cut
tool in the top of the profile view and select the Corners Placement Method. Place the start at a station
before the start of the first approach slab (STA. 2019+76.96) and above the profile. Then place the end at
a station beyond the second approach slab (STA 2023+65.18) and near elevation 120. Leaving the View 1
plan view open will help show where the 3D cuts are being made relative to the bridge. The position of the
cursor in profile view will be shown as a position line in plan view. Once the 3D cut has been made turn off
all levels in the profile view except DTM_ex and save settings. The resulting view should look similar to the
image below.

® View 2, AttachedLongSection - CL_WB =
- 2 PR HEB OYNEES  wB ks A

-l

Sealect Placement Mathod
Parameters Placement Method | LS |~

5. Use the Place Named Boundary tool through the Drawing (Workflow) > View > Named Boundaries
> Place Named Boundary. Notice that the Place Named Boundary tool can be found in either the
Drawing or the OpenBridge Modeler workflow. This time click on the third tool at the top called Civil
Profile until it is highlighted and click on the PR_WB profile in the profile view.

6. Set the Drawing Seed to the 11X17_ELEVATION 14in and the Detail Scale to 1” = 30°. Since this
profile tool is mainly being used to create the elevation view of the terrain, change the view Name to
TERRAIN_1 and the group Name to TERRAIN_1. Make sure the Method is set to From Plan Group
so that the elevation will line up with the plan view. The rest of the settings should be automatically
populated from the seed file, but can be adjusted by the user as desired. Note that if Overlap on the
Plan boundaries is used, the “Profile” boundaries will not take that into account automatically and will
require manual adjustment in the profile view. Make sure to match the remaining settings as shown
below:
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Jf—é Place Named Boundary Civil Profile

Drawing Seed:
Detail Scale:

Name:

ady L Pardsiujerss

11x17_ELEVATION_14in
1"=30
TERRAIN_T

-

-

Description:

Method
Plan Group
Group:

Namej

[From Plan Group
PLAN

(New)
TERRAIN-1

Description:

Vertical Exaggeration:
Available Profile Height:
I:I Top Clearance:
I:l Bottom Clearance:
Elevation Datum Spacing:
Station Datum Spacing:

From Plan Group: PLAN
1.000000

80.000000

0.500000

0.500000

10.000000

10.000000

Profile Shifts§ Do Not Shift
Use Terrains

Use Active Vertical

[ ] whole Conduits Only
Create Drawing

Show Dialog




\

7. Data point within View 2 to accept the boundary. Once the Create Drawing window pops up, be sure
that all scales and annotation groups are correctly set and the Open Model toggle is on. By default, the
tool combines the named boundary group name and the view names in this dialogue. You will need to
rename them as shown below. Select OK and the drawing will be created.

Create Drawing x

Mode: | Plan and Profile >

l:l One Sheet Per Dgn:

View Name: PLAN_1 View Name: | TERRAIN_1
Drawing Seed: 11x17_PE_PLAN_14in > Drawing Seed: 11x17_ELEVATION_14in -
View Type: Civil Plan View Type:  Civil Profile
Discipline: Bridge Discipline: Bridge
Purpose: Plan View Purpose:  Elevation View

Drawing Model

Drawing Model

Model Name: | PLAN_1 Model Name: | TERRAIN_1
Seed Model:  PlanOverElevationNamedBoundary.dgnlib, Seed Model: | ElevationNamedBoundary.dgnlib, 11x17_EL
I:I Filename: | (Active File E‘ Filename Active File
A =30 - A =30 -
Annotation Group: |Plan_Annotation_OBM - Annotation Group: |Elevation_Grid_0BM ~
Sheet Model Sheet Model
Model Name: PLAN AND ELEVATION_1 ! PLAN AND ELEVATION_1
Seed Model: | PlanOverElevationNamedBoundary.dgnlib, Seed Model: | ElevationNamedBoundary.dgnlib, 11x17_EL
l:l Filename: | (Active File) Filename ctive File
Sheets: (New) - Sheets: |(New) v
A Full Size 1 =1 - A Fullsize1=1 -
Drawing Bound: 11x17_PE_PLAN_14in - Drawing Boundary: |11x17_ELEVATION_14in -
Detail Scale: 1°=30° - Detail Scale: |1"=30 -
[ ] Add To Sheet Index
Make Sheet Coincident
Open Model
oK Cancel
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The OBM specific Annotation Groups will always have “ OBM” at the end of the name. Some of the
automatically placed annotations may need to be removed if not needed.

The following sheet model will be displayed in the view window as shown below. Note that the sheet
model background of the image shown below is black because Preferences > View Options > Sheet
Background was changed to black.

The next step in the typical plans production process, which is not shown in this exercise, is to go into the
PLAN drawing models and add annotations and dimensions as you normally would. You may also need to
go into the TERRAIN drawing model and move the elevation scales horizontally as needed so that they are
positioned where you want them in the sheet model. You may also need to turn of levels you don’t want to
see in the TERRAIN drawing model. Before you turn levels off in the TERRAIN drawing model make sure
the reference settings for Display Overrides is set to Allow. Once you verify that and turn off the unwanted
levels, be sure to Save Settings (Ctri+F).

E| References (9 of 9 unique, & displayed) = X
Tools Properties Attachment Properties: b01planelev0l.dgn X
EE v n_‘;‘ K ] L > 3 File Name: | BO1PlanElev01.dgn Browse...
Sot Y2 3 FileName Full Path: ..\fdot\12345678901\structures\bO1planelev01.dgn Yresentation
[ 1 ; 7 BO1PlanElev0ldgn | Model: - Nireframe

Logical Name: | TERRAIN_1

Description: | =3

Detail Scale: |1"=30 e
Scale (Master:Ref): | 1.000000000 : | 1.000000000
Named Group: -
Revision -
Level: =
Nested Attachments: | Live Nesting ¥ | Nesting Depth: | 99

-

New Level Display: | Use M5_REF_NEWLEVELDISPLAY Configuration Variz

Global LineStyle Scale: | Master o
Synchronize View: A TERRAIN_1 Volume Only a
< Toggles 2
Scale | 1.000000000 :114 - a =
Offset X | 0.00 Y EIEN = = (4]
ﬂmr:‘l s : : Iai oK Cancel
Display Overrides: Never ¥ New Lebw sy premmmmg s e
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NOTE The substructure elements are currently shown as solid lines. A display style that shows
the substructure elements has hidden lines will be provided in future FDOT workspace
releases.
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CREATE THE BRIDGE ELEVATION VIEW AND COMBINE VIEWS

1. Once the Plan and Terrain Elevation: saved views, drawing models, and sheet models are created, the
last step is to create the bridge elevation view using the Section Callout tool. Since 3D elements were
turned off in the PLAN design model to create the plan view, a new design model will need to be created
for the Elevation view with the 3D elements turned on. Open up the Models window, Create Model, and
follow the settings below:

I3
? _I_\,pr: Design From Seed - hd
e 2D/3D Name Description Seed Model: | FDOT-OBM-StructuresSeed3D.dgn, Default

s [ PLAN PLAN Name: | ELEVATION

B PLAN_1 " P e

D‘ TERRAIN 1 Description: LEVATION

[ PLAN AND E Ref Logical:

Line Style Scale:  Annotation Scale i

|i' Auto-Update Fields
Annotation Scale
A 1"=30" -
|7_ Propagate
Cell Properties
Ability to Place: |_ As Cell

E Create a View Group

0K Cancel

2. Once the ELEVATION design model opens, close View 2 and maximize View 1. Open your References
window and attach:

a. The main bridge model: BIMODLBRO01.dgn_6.3_Begin with Nested Attachments set to No
Nesting (this will be used for the elevation)

b. The PLAN model: BO1PlanElev01.dgn with Nested Attachments set to No Nesting

Once the files are referenced, make sure top view is set. Then, use the Fit View tool.
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3. Atypical bridge elevation view shows the bridge from the side with “solid” elements (elements are not
transparent). “Solid” elements can be incorporated into a view by using a section callout seed file that
has a “solid” display style. Access the Section Callout tool through Drawing (workflow) > Annotate
> Detailing > Section Callout. Select the Drawing Seed of 01_FDOT_Solid_NoSheet# and check
the Create Drawing box.

Drawing v NE T Hl}" N 'i — ¥ : '_’_ ¥
Home View Annotate Attach Analyze Utilities Drawing Aids

A8 AT 7 | Ax| [} 0 Z N

Place Edit Change Text , Place Place Dimension H Place

Text Text Attributes -~ ™ Note Label Element o L =] Table

Text . MNotes Dimensioning « Tables

% Place Section Callout — X
Drawing Seed:| |01_FDOT_Solid_NoSheet# -
Height: | From View v A
|7\ Create Drawing

4. Snap to the beginning of the drawing boundary and data point to start the section callout placement,
snap to the end of the drawing boundary and data point to end the section callout placement, move
your cursor to set the depth of the clip volume past the extents of the bridge, and data point to accept.

Beginning of
Boundary
Shap Point
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5. Change the view name to ELEVATION_1 to match the plan view naming convention, change the
Annotation Scale to 1”=30’, and uncheck Create Sheet Model.

Create Drawing

Name: | ELEVATION_1
Drawing Seed: 01_FDOT_Solid_MNoSheet# -
View Type: Section
Discipline: Bridge
Purpose:
E Create Drawing Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 01_FDOT_S

A r-g -
Visible Edges: = Dynamic i

E Create Sheet Model
Seed Model: | FDOT_DRAWINGSEED_OBM.dgnlib, 01_FDOT_S
ame: | (Active File
heets:  (New) >
A FullSize =1 -
Drawing Boundary: (New) -

yetail Scale: Full Size 1 =1 -

Cancel

6. Once the drawing model opens, open the ELEVATION design model. Open the Level Display tool and
turn off all the 2D Decor levels as well ClipDrawingBound_dp level so that you only see the 3D bridge
elements you want to see in the elevation view, and save settings. These level settings in the design
model will propagate to the drawing and sheet models. The next step in the typical plans production

process,which is not shown in this exercise, is to place the typical annotations and dimensions in this
elevation view drawing model as you normally would.
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= Level Display - View 1 - x
'_‘._'_'!-l m View Display -
ko E Y Allev~ [Levels ~| [ ~
=& BO1PlanElev(1.dgn, ELEVATION

V8| BOIMODLBRTRO1_6.3_Begin.dgn, Default

@ BO1PlanElev01.dgn, PLAN
MName Used ™ =~
DecorBarriers(2D) . L :
DecorBeamEndCLExt(2D) . = :‘ View Display T
DecorBeamEndOffset(2D) . K= T aitev [teves | [od ~
DecorBeamLayout(2D) . |
DecorBeamLayoutText(2D) i —-vB BO1PlanElev01.dgn, ELEVATION
DecorBearingGroupText(2D) . E‘ BOTMODLBRTRO1_6.3_Begin.dgn, Default
DecorBearingPlateorPad(2D) . @ BO1PlanElev01.dgn, PLAN
DecorBearings(2D) .
DecorBearingSeats(2D) .
DecorCLBearing(2D) . i -
DecorConcPierCap(2D) . Name Used -
DecorConcPierColumn(2D) . ’
DecorConcPierFooting(2D) .
DecorDeckOQutline(2D) . ClipDrawingBound_dp
DecorPile(2D) . Border
DecorSupportlines(2D) . Dimension
DecorSupportLinesText(2D) . Symbols
DecorUnitLabel(2D) . TextMisc
EndBentCapConc_pm TextProfGrades
EndBentCheekWallConc pm TextProfGridMajors

7. Open the PLAN AND ELEVATION 1 sheet model, open the Models window, and click & drag
ELEVATION_1 drawing model onto the sheet model. Select Recommended for the Attachment
Method, and click below the sheet to initially place it below the sheet.

NOTE It is common, when first placing a drawing model onto a sheet model, for level displays
to look incorrect. Switch to a different model within the dgn and come back to the sheet
model to correct this initial graphical bug.
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Right click and hold on the ELEVATION_ 1 reference and use the Move Reference command, snap to
an element on the ELEVATION_1 reference that is in line with the plan view (begin of left/first approach
slab), lock in the AccuDraw compass (Enter) so that the reference can only be moved horizontally, and
shap to the same point on that element in the plan view to line up the elevation view horizontally.

Right click and hold on the ELEVATION_1 reference and use the Move Reference command, shap
to an element on the ELEVATION_1 reference you know the elevation of (Begin Approach Slab at
Right Coping = 118.080), lock in your AccuDraw compass (Enter) so that the reference can only be
moved vertically, and move the reference vertically to the known elevation using the elevation scale
from the TERRAIN_1 reference (this may be approximate as the elevation scale is in 5’ increments).
Adjust the location of the Plan and Elevation boundary view names. Move the 11X17_PE_ELEVATION
14in drawing boundary view name down below the sheet using the Move tool (Drawing (Workflow) >
Manipulate).
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Top of Approach
Slab Snap Point
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10. It may be desirable to adjust the clip volume of the bridge elevation view so that it clips off a portion of
the piles. To do this, go back into the ELEVATION_1 design model, click on the section callout that was
placed previously, and switch to a front view (Shift + Right Click, F). Use the Move tool to move the
section cut to the desired location. Navigate back to the sheet model to see the result.

Section Cut
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BRIDGE NO. XXXXXX
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NOTE

Proposed roadway sections in elevation view can be handled several ways. If an ORD model
is available, the Section Callout tool can be used. Alternatively, a Roadway Typical Section
that has been generated by Roadway could be used. Finally, 2D linework representing the
roadway section can always be added once drawing models are generated.
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EXEREISE Use Civil Labeler to Add Dynamic Labels

ADD STATION AND STATION/OFFSET CIVIL LABELS

1. Open the data set file: BO1PlanElev01_6.4_Begin

2. Access the PLAN_1 drawing model that shows the bridge plan view through the View Group dropdown

list.

MName Model

[ Default Ty PLAN
ELEVATION Views Ty ELEVATION

[ ELEVATION 1

==

Mew Mode > Settings Saved

i

ﬁﬁ@v & - [oranaviews - [[FD[]2]3]4]s]6[7]e]: X 55

3. Before placing any dynamic labels, all 3D levels displaying the end bents and pier should temporarily
be turned off in the drawing model, as shown below. This prevents the labels from being accidentally
attached to the 3D components and instead directly link to the SupportLines. The labels will then
update if the SupportLines shift within the model.

I:||‘J_1 En View Display =

k= Y AllLev~ [Levels v a4 ~

= Level Display - View 1 — x

=& BOTPlanElevD1_6.4_Begin.dgn, PLAN_1

é- PLAN_1, BO1PlanElev)1_6.4_Begin.dgn, PLAN

Iél- BOTMODLBERTRO1_6.4_Begin.dgn, Default

.\Roadway\ALGNRDO1.dgn, Default
MASurvey SURVRDO1.dgn, GTDMRD
Ref, .\Roadway \ALGNRDO1.dgn, Default-3D
ef-1, .\Roadway \ALGMRDO1.dgn, Superelevation
Ref-2, .\Roadway\ALGMNRDO1.dgn, Superelevation-3D

Mame Used ™

DecorPile(2D)
DecorSupportlinesText(2D)
DecorlUnitLabel(2D)
DTM_ep

DTM_ex

DTMSource_ep
DTMTriangles_ep
DTMVertices_ep
EndBentCapConc_pm

EndBentCheekWallConc_pm
FlowArrow _ep

HaunchConc_pm

PierCapConc_pm
PierColumnConc_pm

PierFootConc_pm

~
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4. Next, begin the dynamic label placement for the plan view, navigate to and select Reports and
Drawings > Labels > Civil Labeler.

W oo. @ @ & 5 om A

Dynamic Settings Substructure Typical Place MNamed Adjust Elernent Drawing
View By Station Section Named Boundary Boundaries Profile Named Bo... Annotation = Model Annotation ~
Drawings Labels

5. Select the Station_End Bent label in the Labeler window. Ensure that the rest of the fields match what
is below and click Place.

,"-'-{ Labeler — )¢

[-® DU _BR_Station_End Bert
vl Right of Way
- Roadway Location Method: Data Point
E| : Structures
¢\ B Plan
R Dimension Style Override: | Overrige Dimesnsion Siie vl [JUseactive
-2 Station_Pier )
522 Station-Offset Text Style Override: | Override Taxt Side vl [ Use active .4

Element Template: |@ Structures_Note_Arrow v| [JUseactive &

mw---gw:oflle Leader Location: V| Extension:
Border Frame: | Nanz Vl Offset:
Text Divider: | Split v|
Rotation: | View Horizontal ~ | [] Lock Perpendicular

=
» = ATIRA IR

Note that prompts will be visible at the bottom left of the screen providing instructions on how to use the tool.

SHEHEHE D) - ) - &8 - [D AN Views  ~

Data Point > Select Alignment & |dentify Point Target

6. Click on the CL_WB alignment to select which stationing will be displayed in the labels.
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7. With the Intersect Snap snap mode toggle on, click on the intersection of the alignment and FFBW
END BENT 1 SupportLine.

B View, PLAN1

(= (=n =
E-6%-|LPPRO9D [EE &)

8. Data point at a location below the right barrier to place the label and the station data will populate, as
shown.

€1 6v+020Z V1S

FFBW END BENT 1
STA. 2020+08.46
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9. Next, repeat the labeling process at the FFBW END BENT 3 SupportLine.

10. Once the label for FFBW END BENT 3 has been placed, the text will need to be revised since the
default text for the label will read FFBW END BENT 1. Navigate to the Drawing (workflow) > Annotate
> Text > Edit Text tool, then click on the label.

Drawing B OHEEfe e 2058 2 =
i Home View Annotate Attach Analyze Utilities Drawing Aids Mesh
;4 ':E} A E |H| |'—| 5_'31 |H| F)‘ﬂ ‘_e O/e o=
+ . t - —
i — A-o O =W
hange Text A Place Place Dimensicn H Place = Section o
Attributes .~ ¥ MNote Label Element Ci/ e P Eﬂ Table Callout ©* g3

Text P Motes Dimensioning | Tables Detailing =

11. When the Text Editor window opens, revise only the end bent number to match what is shown below
without changing any other text.

Direction of Stationing

A Text Editor

%t FDOT Structures Annotation | ... 2 @ = S
I

le

FFBW END BENT 3
S5TA 2023+34.30

NOTE When making edits to dynamic labels, users must ensure to only edit the text that is not
dynamically linked to the model (stations, offsets, etc.) The dynamic information is a field,
which should always have a shaded background, as shown in the previous image. If that
text is deleted, the label will lose its link to the model and make the label no different than
an annotation note.
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12.
13.

Data point outside of the Text Editor window to confirm the edit and update the label.

Next, reopen the Reports and Drawings > Labels > Civil Labeler tool and select the Station_Pier
label in the Labeler window. Ensure that the rest of the fields match what is below and click Place.

A Labeler - *
u DU _BR_Station_Pier
[-f Right of Way
#-{i Roadway Location Method: Data Point
?---_émStn.l;tl::.-s Element Template: |@ Structures_Note_Arrow v| [ Use active |1=
i L taton_d Bert Dimension Style Override: | Overrids Dimansion Stis V| []Use active |+
Ef \ Text Style Override: | Override Taxt Stle ~ | []Useactive .4
m:u---gw:ofile Leader Location: | Aute Left Right Center ~ | Extension:
Border Frame: | MNome v| Offset:
Text Divider: | Split i |
Rotation: | View Horizontal ~ | [] Lock Perpendicular

W r‘o f I‘Hl i o_é/‘ -

)

14.

15.

16.

17.

18.

Click on the CL_WB alignment. Then, with the Intersect Snap snap mode still selected, click on the
intersection of the alignment and CL Pier 2 SupportLine. Data point at a location below the right barrier
to place the label, as previously done with the end bent labels.

Because there is no approach slab label, the Station_Pier label can continue to be used to place the
approach slab dynamic labels. Click at the intersection of the alignment and APP SLAB 1 BEGIN
SupportLine. Data point at a location below the right barrier to place the label.

Navigate to the Drawing (workflow) > Annotate > Text > Edit Text tool, then click on the label. In the
Text Editor window, change the CL Pier 2 text to BEGIN APPROACH SLAB without making any other
changes.

Repeat steps 15 and 16 at the APP SLAB 2 END SupportLine, changing the CL Pier 2 text to END
APPROACH SLAB.

Turn on the 3D levels displaying the end bents and pier that were turned off in step 3 in order to show
all necessary components in the plan view.
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19. The final plan view should appear as shown below.

20. The last portion of this exercise is to demonstrate dynamic nature of these labels and use the Station-
Offset label.

NOTE The Station-Offset label has an additional data field within it that will display the labeled
object’s perpendicular distance from the associated alignment. This label is used more
frequently with wall plans to call out the station and offsets of wall limits and bend lines.

21. Access the PLAN design model that shows the bridge plan view through the View Group dropdown list.

Ty PLAN

(T ELEVATION Views F:.*, ELEVATION

(1 ELEVATION_1 Views [ ELEVATION_1

(51 PLAN AND ELEVATION_1 Views [ 5 PLAN AND ELEVATION_1

[C PLAN_1 Views 8 PLAN 1

(5 TERRAIN_1 Views [ TERRAIN_T
 SHEHE S O - O - & - D PLAN D Views - |t [2]3] 4 s]s]7[s]: X550
Mew Mode > Settings Saved | ‘I
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22. Use the Drawing (workflow) > Home > Placement > Place Circle tool to place a circle of with a radius
of 5’-0” below the right barrier around STA. 2021+00.00 as shown in the following image.

= View 1 - Top, PLAN

= | & |
E-6%-2 PRPROQAD HUZED NI

23. Return to the PLAN_1 drawing model. Access the Civil Labeler tool and select the Station-Offset
label in the Labeler window. Ensure that the rest of the fields match what is below and click Place.

A2 Labeler _ %
E ou _BR_Station-Offset
-l Right of Way
‘;'"'I Roadway Location Method: Data Point
T Struu;tI::as Element Template: |@ Structures_Note_Arrow v| [ Use active &
Station_End Bent Dimension Style Override: | Override Dimension Stile v| [ Use active ..
; Station_Pier )
L Y Station-Offset Text Style Override: | Override Taxt Side vl [ Use active | .=
Profile _ sion:
l Leader Location: | Auto Left Right Center ~ | Extension: 1.50
+--ll Survey
Border Frame: |.-‘1-'bne Vl Offset:

Text Divider: | Split vl

Rotation: | View Horizontal ~ | [ Lock Perpendicular

TN U I
v [dle S e A D
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24. Click on the CL_WB alignment. Then, with the Key Point snap mode selected, click on the right side
of the circle that was just placed. Data point at a location below and to the right of the circle. Note that
your station and offset will not match exactly which is fine as this is only a demonstration.

STA. 2021+02.46
17.77° RT.

25. Return to the PLAN design model and use the Drawing (workflow) > Home > Manipulate > Move tool
to move the circle near STA. 2022+00.00 as shown in the following image.

- L PRPRPOAD HoEZED ITXS
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26. Return to the PLAN_1 drawing model one last time. Notice that the station and offset within the dynamic
label has updated.

FDOT OBM 293



BERCISE @S Place Tables from Excel

IMPORT FDOT STANDARD TABLES FROM EXCEL

1. Navigate to the “eng_data” folder located in the Structures discipline folder and open the STR_
StandardDataTables excel file.

NOTE

» ThisPC » 0OSDisk (C:) » Worksets » FDOT » OBM Training Guide » Structures » eng_data

~

Yame Date modified Type Size
Mew folder 11/1/2023 5:48 AM File folder
E STR_StandardDataTables 10/31/2023 1:30 PM Microsoft Excel W... 3,021 KB

Instructions for using the STR_StandardDataTables spreadsheet and importing tables
into OBM can be found in the Instructions tab within the excel file.

2. Within the excel file, navigate to the tab named “458-110_Poured_EJ” and fill out the table as shown
in the figure below.

A B c D 3 F G H |
POURED EXPANSION JOINT DATA TABLE
o INDEX NO. 458-110
i ol t DM, "A'
P DM, "a' TOTAL DESIGN e
LOCATION @70 F HOVEMENT ADJUSTMENT
PER 10}
END BENT 1 IF N/A N/A
END BENT 2 IF 0.625" 0.063"
END BENT X
L1
POURED EXPANSION JOINT DATA TABLE T able Date 1-01-00
INDEX 458-110 T '
DIM. "A" |[TOTAL DESIGN|DIM. "A" ADJUSTMENT
LOCATION |~ & 70cF | MOVEMENT PER 10°F
B nore:
Dim. "A" ad justment per 10°F shown is measured perpendicular to ¢
Expansion Joint. Work this table with Standard Plans Index 458-110.

v ... IFTSTOYIMEEIE 515020 PermMsEWaliData Table1 | 548-020 PermMSEWallData Table2 | 548-020 PermMSEWallData Table3

3. Save the excel file and open FDOT Connect 10.12.

NOTE

The From File function linking the FDOT standard tables excel to the dgn file does
not currently work for FDOT Connect 10.12 but has been fixed in the 2023 release. A
workaround utilizing FDOT Connect 10.10 is presented showcasing the workflow used to
import FDOT standard tables.
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Recent W

OpenBridge Modeler CE

WorkSpace  WorkSet

FDOT - OBM Training Guide ~

3 FDOT
2 OBM Training Guide

Roadway
ROWMap

Seed

Signalization
SigningAndMarking
Specifications

Structures

Survey

Symbology

TrafficOperations

Utilities 9,

BlankFile 10/31/2023 127 PM Bentley MicroStati. s0xs]

File =

File name:

Directory v

Recent Files = 55 Properties *
Name OBM Trainin..
_BlankFile.dgn B
& . Description
CAWorksets\FDOT\OBM Training Guide\,
Modified: 10/31/2023 1:27:01 PM Size: 60 KB WorkSpace el
g Confighame Custom Con..
BO1MiscDet01.dgn
- C:\Worksets\FDOT\OBM Training Guide\structures\ ProjectWise Project Properti
Modified: 10/31/2023 6:41:46 PM Size: 136 KB No project attached.
Show All Properties
o L
Browse New File
4 1 > ThisPC > OSDisk(C) > Worksets > FDOT > OBM Training Guide v O
New folder - m @
Name ze
Leotecnnical
Gls
s
Landscape
Lighting
Maintenance
Materials
out
Permits
Planning
Pre-estimates [N

v‘ CAD Files (.dgn;".dwg;".dxf)

Cancel

Options

5. Open the Create File dialog by selecting the FDOT tab option: FDOT > Actions > Create File. The

Create File dialog displays.

OpenBridge Modeler * N HE F =L
Home Ciwil Utilities Reports and Drawings View Collaborate FDOT Help
@ @ : ikl {3
. |
Element ... Create [ Filters Linked Misc. Plan Set ~ Cell Cell FDOT Attach
Selection - ¥ File T  DataManager Tools™ Manager~  Llibraries~ Webpages~ (Cells  Survey Reference
Selection Actions Cell Applications Roadway

(Proposed)” as the File Type and set the Bridge Seq # (I) to “01”.
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From the Create File dialog, click on the Discipline dropdown arrow to select “STRUCTURES”.

Click on the File Group dropdown arrow to select “Structure Design Files” and select “2D Bridge Plan



8. Click Browse next to the Output Folder field and select the “eng_data” folder located within the
“Structures” discipline folder and click OK.

CreateFile (v2022.5.19.1) X
Worksel: C\Worksets\FDOT\OBM Training Guide v
Discipline: I SEHERIREES - I Browse For Folder X
File Group: | Structure Design Files ~ Select Output Folder
File Type: > EnvironmentalManagement ~
Ei?::ame 4 Descripion ’ Estimates
Trma Geotechnical
GIS
Maodel > ITS
GDTMER Converted Terrain for Bridae Desian 3y Landscape
> Lighting
> Maintenance
> Materials
> Out
> Permits
> Planning
> Pre-estimates
> Roadway
Qutput File: 3y ROWMap
Bridge File Seed
Seq#: Base Filename: Modifier (Optional) Sequence & Extension: > Signalization
B DSGMBR l | |U‘I | dgn > SigningAndMarking
C\Worksets\FDOT\OBM Training Guideistructures\BDSGNBRO1.dgn > Specifications
v Structures
OutputFolder | Stuchires | I i I > 1 Bridge Templates
SecdFile.  C\dotconnecti0 T0\organization-civilidoiseed\FDOT-OBM-Stuctu|  Browse
> Survey
County: Hillsborough ¥ | Coordinate System:  FLB3-WF - > | Symbology
> TrafficOperations
Action | | o v
< >
Create - Open File Close Make New Folder [II Gt

9. Click Create-Open File to open the newly created design file in OBM. The new design file is automatically
created and opened as specified and saved under the corresponding discipline folder.

10. Open the Place Table tool by navigating to Drawing (workspace) > Annotate > Place Table.

| Drawing @ Tl e =R s

Home View Annotate Attach Analyze Utilities Drawing Aids AutoTable Mesh
AP A Y A= D DEEH e X E
Al Uoxeo ar o@ " =
Place Edit Change Text Place Place Dimension - Place} Section o Place %
Text Text Attributes A\ * Note Label Element r ~ il Table} Callout " ° of | Active Cell %2 ™

Text £ Notes Dimensioning B Tables Detailing ™= Cells =

11. Within the Place Table window, select the icon containing the excel logo and set the Seed to “458-
110_PouredExpansionJoint”.

12. Select the “...” button to the right of the File Name field and navigate to the previously opened excel file.

Place Table - X
&
Hef]

Active Angle: | 00°00'00"

-
File Name: | |
[ ] Contains Title Row
D Contains Header Row

Retain Association
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13. Once the Select Cells window opens, set Worksheet to “458-110_Poured_EJ” and Range to “Manual”.

Set From to “A5” and To as “D6".

Select Cells d

Worksheet: 458-110_Poured_EJ ~
Range: Manual

From: AS

To: | D&

OK Cancel

14. Click OK and data point to place the imported table.

= View 1, Default E 38X

POURED EXPANSION
JOINT DATA TABLE
INDEX NO. 458-110

TABLE DATE
01-01-09

DIM. “Av = TOTAL DIM. "A"
LOCATION - 7'0 F DESIGN ADJUSTMENT

@

= MOVEMENT PER 10° F

END BENT I
END BENT 2 0.625"

15. Save this file by navigating to the save icon or using (CTRL +S) and close FDOT Connect 10.12.

ml . ’

Annotate Attach Analyze Utilities Drawing Aids AutoTable

Drawing
Home View

Mesh

16. Navigate to the recently created file and rename the file to “BO1MasterDataTable”.

17. Open FDOT Connect 10.12 and click Browse. Select the data set file “B01ExpJointDet_6.5.dgn” and

click OK.

18. Open the References window by navigating to OpenBridge Modeler (workspace) > Primary > Attach

Tools.
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19. Use Attach Reference to select the file previously created.
World” and click Open.

Set the attachment method to “Coincident

E| Attach Reference - C:\Worksets\FDOT\OBM Trainin g Guide\Structures\eng_data',
Look in eng_data Q3 A
Name Date modified
ﬂ BO1MasterDataTable 11/1/2023 7:11 AM
Quick access
Desktop
"
Libraries
This PC
Network
<
File name: E01MasterDataTable -
Files oftype CAD Files " dgn.” dwg;" dx) v
- Save Relative Path

B&

Type
Bentley Mic

2D -VBDGN

Attachment Method
Coincident World

>

Cancel

20. Click OK on the Reference Attachment Properties window.

K| References (1 of Tunique, 1 displayed) — *
Tools  Properties
EE - | ¥ L % D ¢ A A 'SJ :j i B jj [J) > Hilite Mode: Boundaries ~
Slot P A File Name Model Description Logical Orientation Presentation [l (_f * :‘J
1 eng_data\B01MasterDataTable.dgn Default Master Model Coincident Wireframe P e v
Scale | 1.000000000 ;' 1.000000000 Rotation  00°00°00" Offset X | 0:0 Y 00
EIE ’L__"‘J i B |:| @ Nested Attachments: No Nesting ¥ | Nesting Depth: | 1 errides: | Never =
New Level Display: Config Variable ¥ Georeferenced: No =
—

21. Use the Fit View tool to locate the previously created table.

22.

Highlight the view that will be moved, as shown below. Then, click Move Reference and move the

highlighted table reference to be within the borders of the sheet.

B| References (1 of 1 unique, 1 displayed) - *
Tools Properties
B yxe g '33 A3 7o D E8 (@ %) Hilite Moce: [Boundaries +
Slot P 3 File Name Model Description Logical Orientation Presentation  Visible Edges
1 eng_data\B01MasterDataTable.dgn Default Master Model Coincident - World Wireframe Wireframe
< >
Scale | 1.000000000 1 1.000000000 Rotation | 00°0000" OffsetX 0 Yo
Q‘m’:] = B l:‘ @ Nested Attachments: | No Nesting * | Nesting Depth: | 1 errides: Neves .
New Level Display. Config Vaniable ¥ Georeferenced: No il
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23. The final sheet should look like the image below.

NOTE The method shown in this exercise utilized a single master design model dgn file for all
data tables in the plans. However, tables can be placed directly on a sheet model and do
not require using a design model.

FDOT OBM 299



7 QUANTITIES AND REPORTS

OVERVIEW

Model-centric bridge workflows produce additional deliverables beyond plans production. Quantities and
elevations are a by-product of working in 3D. OBM and FDOTConnect have built-in tools to help create
some of these deliverables. There are also reports generated to aid in QA/QC. Value can be added to
workflows in terms of both efficiency and quality when using this model-centric process. FDOT continues to
develop the FDOT-specific quantity tools to help users generate and format required quantity information.

OBJECTIVES

The objectives of this chapter are to introduce the available tools to generate additional deliverables
including:

*  Quantities

» Elevation Reports
* Input Report

* Geometry Reports

QUANTITIES

FDOTConnect for OBM has several options for obtaining bridge quantity information. This section will
go over the FDOT Structures Quantity Reports that was developed by FDOT as well as the Non-FDOT
formatted quantities report that was developed by Bentley. The FDOT Structures Quantity Reports will format
the quantities as is required by the FDOT CADD Manual for the project Estimated Quantities Report. The
built-in (non-FDOT formatted) quantities report includes superstructure, substructure, and miscellaneous
categories. Independently of the quantity report, the volume can be extracted from any solid created in
OBM.

FDOT STRUCTURES QUANTITY REPORTS

The FDOT Structures Quantity Report tools can be accessed through OpenBridge Modeler (Workflow) >
FDOT > Quantities > Structures Report Raw and OpenBridge Modeler (Workflow) > FDOT > Quantities
> Structures Report Final. As the bridge components are being created, it is important to assign the
material according to the FDOT pay item numbers. This the basis for the FDOT Structures Quantity Reports
workflow and without properly assigned materials, the reports will not be generated as needed.

OpenBridge Modeler v M- HE S e-»£2[65 03t s & 7345678901 - BOIMODLBRTRO1_QtyTestdq
Home Civil Utilities Reports and Drawings View Collaborate FDOT H;]'
k (5] ’ g ﬁ il _\(#/ d T Structures Report Raw g
- P, aHn T~ A X :
+ ) / = < y Structures Report Final 4
Element ... Create Filters Linked Misc. Plan Set Cell Cell FDOT p = Quantity
Selection i ™ File " Data Manager Tools® Manager~  Libraries~ Webpages~ (ells W s | K Takeoff Manager Tools ~
Selection Actions Cell Applications y Quantities

The process for generating the FDOT-formatted bridge quantities involves two steps. First, the Structures
Report Raw tool must be run to extract the quantities from the bridge model into an unformatted spreadsheet.
This spreadsheet should be saved in the C:\Worksets\FDOT\....\Calculations\Structures folder, where the
“....” represents the project-specific WorkSet folder name.
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Save As x
T+ « OSDisk (C) > Worksets > FDOT * 12345678901 > Calculations *> Structures v [@] 2 Search Structures
Organize ~ New folder = ~ 0
Name Date modified Type Size

Mo items match your search.

File name: | Summary of Structures Quantities RAW.xlsx “

Save as fype: | Excel Workbook(* xIsx) ~

~ Hide Folders Cancel

Once the raw quantity spreadsheet is saved, the Structures Report Final tool must be run to process
the raw quantity spreadsheet into its formatted form. The OBM Quantity Reports Converter will look in the
C:\Worksets\FDOT\....\Calculations\Structures folder for the raw quantity spreadsheet and will save the
Summary of Structure Quantities spreadsheet in the C:\Worksets\FDOT\....\Calculations\ folder.

OBM Quantity Reports Converter (v1.1.9.15) - O X

Default Properties

Raw Reports Input Location: | C:\Worksets\FDOT\1234567890 1\calculations\structures

Quanitity Report Ouiput Location: | C:\Worksets\FDOT\1234567890 1\calculations

RAW OBM Reports

Name Date Directory

Summary of Structures Quantities R._. | 12/15/2023 4-___ | C:\Worksets\FDOT\12345678901\calculations\structures

Once the Summary of Structure Quantities is generated, users are responsible for checking that all quantity
items expected have been reported. It is very important that the proper OBM material is applied to each
bridge element, or it will not be pulled into the FDOT quantity report.

AutoSave (@ off) - £ search Piorun, Heather C. ‘?‘ =B o a X

File Home Insert Pagelayout Formulas Data Review View Automate Developer Help BLUEBEAM  ProjectWise = PDF-XChange | 4 Comments ‘ | & "‘
fIW] A FDOT ~8 - General +| | [l conditional Formatting ¥ B Create PDF 111
[m[m]
- B I U~ AT v v O Format as Table ¥ & Change Settings
Paste EB - A A . $ A’ 9 @ Cells Editing | Analyze Add-ins g 2 Get Jira
. g Feld A < -9 [ cell styles - ~ Data Batch PDF Data
Clipboard Font [ Alignment ml Number Styles Analysis | Sensitivity | Add-ins Bluebeam Jira Cloud ~
Y29 - b3 v
A B D H w X Y z AA AB AC Al AN []
1 Summary of Structure Quantities - 123456
2 Section Pay Item Pay Item Descrintion Unit of Quantity Total Quantity Se(unu‘ary Quantity iu(a?on Desion Notes
3 Number v o Measure P F 4 F unit P F ocation g
Description
4 Foundation 0455 34 5|Prestressed Concrete Piling, 24" Sq LF 550.0 1318 END BENT 1
5 768.0 PIER 2
6 [Railing/Barriers|0521 5 4|Concrete Traffic Railing - Bridge, 32" Vertical Face LF 325.6 388 BARRIER 2
! 29.4 BARRIER 3
8 2.1 BARRIER 4
9 2.1 BARRIER 5 L
10 28.3 BARRIER 6
11 0521 5 14]|Concrete Traffic Railing - Bridge, 42" Single-Slope, LF 325.8 388 BARRIER 1
12 28.8 BARRIER 10
13 r 294 BARRIER 7
14 2.1 BARRIER &
15 2.1 BARRIER 9
16 Substruciure |0400 4 5|Concrete Ciass IV, Bridge Substructure cr 29.58 56.2 END BENT 1
17 26.59 PIER 2
18 0400 4 25|Concrete Class IV, Mass, Subsiructure cr 83.54 83.5 PIER 2
19 ["superstructure 6400 4 4|Concrete Ciass IV, Superstructure cy 379.55 767.5 DECK 1
20 32563 SIDEWALK 1
21 2938 SIDEWALK 2
22 2.10 SIDEWALK 3
23 2.06 SIDEWALK 4
24 28.30 SIDEWALK 5 ~
s =
Sheet1 [ & ] D
Ready [@® % Accessibility: Investigate B B - ——F———+ 106%
— —

The FDOT Structures Report tools within OBM are continually being improved. Currently, there are several
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known limitations based on access to back-end data and the overall development of the FDOTConnect for
OBM workspace. As of FDOTConnect 10.12, the following limitations are known:

» Bearing pads placed as Cell rather than Cube or Cylinder will not be included

» Pedestal, wingwall, and diaphragm concrete is currently not included

*  Grout pads/Bevel plates are not currently included

*  Custom Abutments and Custom Piers (i.e. parametric cells) are not included

» Steel tubs, cross-frames, stiffeners, field splices, and shear studs are not included

*  Segmental superstructure concrete is not included
The previously listed items will need to be manually added to the quantity report, along with any elements
that are not modeled (expansion joints, thickened end slabs, test piles, etc.). This can be accomplished

by accessing the raw quantity spreadsheet, inserting a row for each additional item, and entering the
corresponding Bridge Number, Section, Pay Item Number, Description, Units, and Quantity.

AutoSave (@ off) Ly % Summary of Structures Quantities RAW.xdsx L Piorun, Heather C. ‘s‘ &3l

bctWise PDF-XChange | B ||#& ~|

File Home Insert Page Layout Formulas Data Review View Automate Developer Hel Add to RAW
El”] g@ E % [l conditional Formatting v spreadsheet [create PDF 111
m~

@ Format as Table ¥ & Change Settings

Paste Font Alignment | Number Cells Editing | Analyze Add-ins Get Jira
v g v - - [iZZ Cell Styles ~ v - Data [B Batch PDF Data
Clippaasd L =1 Analysis Sensitivity Add-ins Bluebeam Jira Cloud ~
o Insert row and fill in Br_idge Num_ber, Section, _Pay .
Iltem Number, Description, Units, and Quantity
a3 =3 = — D E F -
1 |BridgeNumber Section PayltemNumber Description Units Quantity S
Z 123456 Superstructure 0458 111 BRIDGE DECK EXPANSION JOINT, NEW CONSTRUCTION, F&I POURED JOINT WITH BACKERROD  LF 92.333
3 123456 Superstructure 0400 4 4 Concrete Class IV, Superstructure cY 379.5457627

4 123456 Railing/Barriers 0521 514 Concrete Traffic Railing - Bridge, 42" Singe-slope LF 325.8463757
- FLN S N S S N N N NP N NP N N N N N N N N N PN N N NP N NP NP N N N NP N N NP NP N N N

110

v 22346 1 sunaation w455 34 L Prestre.seu Coicrece Puang, 24" Lq LF
28 123456 Foundation 045534 5 Prestressed Concrete Piling, 24" Sq LF 110 E‘
Sheet1 | @ ol ] b

Ready [@ % Accessibility: Good to go ::3) O - —F—+ %
— S

NOTE Pay Item Numbers and Descriptions of items added to RAW spreadsheet must be
formatted properly and exactly match the FDOT Basis of Estimates. It is recommended
that users copy and paste this information from the Master Pay Item website: https://dge.
fdot.gov/

Once the raw report is supplemented, the Structures Report Final tool will need to be used again to
process the raw quantities and format them as needed. Keep in mind that if the Structures Report Raw
tool is run again based on updates to the bridge model, it may overwrite the RAW report that includes the
supplemental items. It is good practice to maintain the supplemental items in a separate spreadsheet so
that they can be copied over to raw quantities spreadsheet if it is updated from the model. It is also good
practice to compare the quantities generated through the FDOT Structures Quantity Report tools with the
Quantities Report generated from the Bentley-developed tools, which are discussed in the next section.
The FDOT Structures Quantity Report tools are intended to give users a starting point, but users are always
responsible for the accuracy of the information, as well as performing a thorough QC of the information prior
to submitting.
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QUANTITIES REPORT (NON-FDOT FORMATTED)

The Quantities Report tool can be accessed through OpenBridge Modeler (Workflow) > Reports and
Drawings > Bridge Reporting > Quantities Report.

OpenBridge Modeler @ S o = [a 98 2 FF =

Home Civil Utilities Reports and Drawings View Collaborate FDOT

F Deck =i Camber =S
S ¥ o] [m
EE Beamn f_ij::.i'j Pier v
Cuantitiesf Input X7 ) Cynamic Settings Substructure Typical
Report fReport E:E Bearing View By Station Section Mal
Bridge Reporting

The resulting Print Preview window opens. The report can include only the active bridge or all the bridges in
the file, as well as the active or all of the units. The user can also choose to show or hide cost information.
The parameters can be selected in the red box below and then click Submit to retrieve the print preview of
the quantities report.

Preview

T ) o .
@ = Print E @ Margins +~ & A7 Thumbnails Previous Page |3 (=1, .3 . @ . 8
= Quick Print & Orientation v Bookmarks Next Page W Q v
12 save = Scale Find First Many Pages D o Cloze
7| Parameters ~ IOy Size v Editing Fields Fage Last Page <} =

Document Print Page Setup [P Mavigation Zoom Page ... Exp... Close
Parameters X -
Selected Bridge | Active -

[ Hide Unit/Cost Data

-

Page 1of 1 75% —-——F+— +

The Materials Quantities Report is generated for the active bridge or all bridges (listed separately) depending
on the parameters selected. The report is broken down by superstructure (approach slab, deck, and beams),
substructure (end bents, piers, and foundations), and miscellaneous items (barriers and bearings). The
Component Type, Material Name, and Material Type are all linked directly to the model and will reflect the
information input into the model through the templates and materials selected when creating the model.
Therefore, the user should consider these factors during creation of the model so that the quantities report
accurately reflects the desired parameters.
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. o ; )
Print v Thumbnails Previous Page =
o S I T Y E e
= Quick Print & v *] Bookmarks P Next Page W O Q ~
12 save . Scale Find First Many Pages D = Close
7| Parameters v IO Editing Fields = Page M| Last Page v =
Document Print Page Setup = Mavigation Zoom Page ... Exp... Close -~
Parameters o x X -
Selected Unit Bridge Name: FDOT Training Bridge
Bridge Unit: Unit 1 :: Beam Slab Concrete-Girders Bridge
[ Hide Unit/Cost Data g g
Materials Quantity Report
Superstructurs Quanifies
Name = Material Mame | Material Type Pay Unt Limit Price Cuanfty Cast
0400 2
AP | |t | s | Conorse | CubioYad 0.0 28347 0.0
Slsts
0400 2
APPSUB2 | | rncst | Whames | Conose | CubioVad 000 398 0.0
Slas
- L L 3@( 0200 4_% ~ | _ L
Y S S S S S SV A S R S ST S S S ST S il o S LW R LW A P A S
< = =y i,. N = ’ <
Siss
0400 4 4_Core )
Heumh | ClazziV, Super| Comoree Cubic Yad 0.00 33409 0.00)
450 234 A
seamsegrent| 20y | "EHE | conone 'F 000 1619035 0.0
Tats 0.00)
Document Map oz X
M ey mwmma"gﬁ"m Material Name | Material T PayUnt Unit i Q. Cost
» Bridge Name: FDOT Training Bridge Name Tyes s e e i a5
0400 4 5_Core
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Files U:ﬁ;‘;“zf.';?c Concret LF 000 550,000 000
0400 4 5_Core
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S
0400 4 5_Core
JIER2 Cap Classs\;frﬂge Comcrse Culic Yad 0.00 2652 0.00)
0400 4
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Sarrer Single Skpe R | -42" Singke Siops L 009 33000 009
) 0400 4 4_Core
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5214232 0521 5 4_Bamer _ B
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NOTE

Standard Index 450-199 for more information.
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The Materials Quantity Report currently assumes the haunch build-up is linear between
bearings and does not account for variations from parabolic prestressed beam camber.
This is conservative for quantities for every Build-up Case except Case 4. See FDOT



The FDOT OBM Material Library delivered with FDOTConnect does not include default unit prices, as all
unit costs are set to zero. To take advantage of the cost estimating portion of the Material Quantities Report,
unit costs can be added by accessing OpenBridge Modeler (Workflow) > Utilities > Libraries > Material.
Please note that when users create a new WorkSet, the delivered FDOT Material Library is automatically
copied as a starting point, in the form of the MaterialLibrary.xml. This file can be found within the Bridge
Templates folder of the project’s designated Workset. If users choose to maintain a material library with unit
costs, they will have to ensure that any updates to the FDOT-delivered Material Library in later versions of
FDOTConnect are used on new projects or there may be issues with the FDOT automated bridge quantities.

Material Library - O x
' CA\Worksets\FDOTY1234567890 1\Structures\Bridge Templates\MaterialLibrary.xml

~ Show Details

mﬂ Steel  Miscellan=ous

_ Description Unit Wt (PCFJl Unit Price §Poisson  f'c (ksi) f'ci (ksi) MR (ksi) E (ksi) CTE(1/F) =
=3 Click here to add new item
0400 125 Conc Class |, Mass Sub Cong Class |, Mass £ 150 [i] 0.2 3 24 04156927 3625 6E-08
0400 2 1_Conc Class ll, Culverts Concrete Class I, o 150 4] 0.2 34 272 0442538 3778 6E-06
0400 2 4_Conc Class Il, Bridge Super Conc Class I, Bridge 150 0 0.2 4.5 36 0.509116¢ 4145 6E-06
0400 2 5_Conc Class Il, Bridge Sub Congrete Clasz Il Br 150 1] 0.2 34 272 04425387 3778 6E-08
0400 2 10_Conc Class Il, Approach Slabs Concrete Class II, & 150 Q 0.2 34 272 04425387 3778 BE-08
0400 2 25_Conc Class Il, Mass Bridge Sub Concrete Class I, M| 150 4] 0.2 34 272 0442538 3778 6E-06
0400 3 45_Conc Class lll, Precast Bridge Sub  Concrete Class 1ll, P 150 1] 0.2 5 4 0.536656: 4201 GE-06
0400 4 1_Conc Class IV, Culverts Concrete Class IV, C 150 1] 0.2 0.562849¢ 4450 6E-06
| (02004 4cConcClmsvsuper  JconcreteComivs 10 -----
0400 4 5_Conc Class IV, Bridge Sub Concrete Class IV, B 150 0.562849¢ 4450 6E-06
0400 4 25 Conc Class IV, Mass, Sub Concrete Clasz IV, b 150 1] 0.2 5.5 44 0.562849 4459 GE-06
0400 4 39 _Conc Class IV (Precast Segmental ! Conc Class IV (Prec:| 150 1] 0.2 5.5 44 0562849 4459 GE-06
v

Save Cancel

It is important to note that these quantities are dependent on the accuracy of the model. There are certain
details, especially with end bents, that cannot be easily modeled using only OBM templates. An example
of this would be skewed end bents with “turned back” concrete cap, backwall, and cheekwall/wingwall to
eliminate the acute corners. These elements would then need to be supplemented with additional quantity
calculations to account for the discrepancies if these portions are not modeled to a high level of detail.
Additionally, if any OBM elements are modified with solids modeling tools (outside of the OBM specific
modeling tools), the quantities should be closely verified. If elements are placed as custom parametric cells
(abutments or piers), this will not be accurately reflected in the quantity report. Below is a list of known
situations in which it is recommended that the user verify and supplement the quantity reports as necessary:

+ Skewed end bents

»  Thickened deck slabs (if not modeled)

* Any element that has been modified outside of the OBM-specific tools (i.e. solids modifications)

*  Bearing pads placed as cells (will report as EA item rather than CF volume)

»  Substructure units placed as Custom Abutments or Custom Piers
In summary, users can take advantage of both the FDOT Structures Quantity Report and/or the default
Quantities Report within OBM but must carefully verify the report is generating the quantities expected and
supplement the reports as necessary. Note that all solid elements within a DGN file, generated by OBM

or not, can be analyzed and a volume reported. There is currently not a way to incorporate this into the
Materials Quantity Report, but the values can be utilized to enhance the quantity calculations.
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ELEVATION REPORTS

Another reporting functionality within OBM is automated elevation reports. There are tools available for
the following components: Deck, Beam, Bearing Seat, Camber, and Pier. The tools can be accessed by
navigating to OpenBridge Modeler (Workflow) > Reports and Drawings > Bridge Reporting.

OpenBridge Modeler Al | LS
Home Civil Utilities Reports and Drawings
ﬁ F <] Deck A camber %
= " | Tl Beam <] pier '
Quantities Input XYZQ - . Dynamic
Report Report Efﬂ Bearing View By Station

D% 0 s
View Collaborate FDOT]
:,‘1 r":
Settings Substructure Typical
Section N

Bridge Reporting

The Deck Elevation Report (commonly known as Finish Grade Elevation for FDOT) tool starts with
prompts to select the start and end SupportLine for consideration. Note that only the active bridge and unit
can be selected. The Deck Elevation Report window then is provided. The inputs are shown and described

in detail below.

Deck Elevation Report

Report Name | TR Bridge Deck Elevations

Start |FFBW END BENT 1 ¥ Offset() 00

End FFBW END BENT 3 v Offset() 00

Consolidated

Normal to alignment

J Select...

® Points Per Span 10 : Individual Paths
Spacing
==
Common References I.Accessones: =

Name

Include Type

L

Offset]| ~ : Include Type
0:0
0:0
0:0
0:0
0:0
0:0
0:0
0:0
0:0

_’ Generate

Save And Close

: Common References (WA

Solid Red Box — This section includes inputs for the Report Name, Start & End SupportLines and Offsets.
This can be used to modify the SupportLines selections and to choose a starting point different from the
SupportLines. SupportLines are typically at the front face of backwall and centerline of pier, while a starting
point may be at the centerline of bearings. Users may enter an offset from the start or end point.

FDOT OBM
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Dashed Red Box — These inputs provide additional reporting variables and formatting. The number of
elevations generated can be entered by a number of points in the span or an equal spacing between the
start and end points. Additionally, the Report Type offers several format and reporting options including
Station, Offset, and Elevations; X, Y, Z coordinates; and a Consolidated report option. The consolidated
option is the closest to the FDOT formatting for Finish Grade Elevations.

Report Type |Consolidated E

Station, Offset, Elevation
XY Z

hts Per Span | Consolidated

hsversal Lines

Solid Green Box — This selection input for Common References allows the user to select longitudinal
lines for which to report the deck elevations. The inputs include the alignments, deck edges, barriers (curb),
and beam centerlines. Note that offsets can be added to any of these points to capture additional points
such as beam flange edges. Select the checkboxes for the desired points to include them in the report. Note
that naming the elements during or after placement can aid in recognizing the reference elements.

Dashed Green Box — The Accessories tab allows the user to select additional elements in the model to
include in the deck elevation report. This input is not typically used for common bridges and reports.

Clicking Generate (indicated with the red arrow) will initiate two actions: showing a temporary view of
the transversal lines/points in the model and open the report preview in another window. Note that it is
important to set the Working Units within the Design File Settings to survey feet with the accuracy set to
three decimal places, as this will be used in the report. See below for the temporary view and see the next
page for the report preview. Clicking Save And Close will save the report selections and close the window.

Transversal Line
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The resulting report is generated in the Print Preview window. The elevations are grouped by point and
sorted by span. The report can be exported as a PDF or Excel spreadsheet, among other options.

Preview 53] = (] X

E’ Print @ Margins v & ED m Previous Page 3 DD Q Zoom Out a " @ . Q

= Quick Print % Orientation + P Next Page W u] Q Zoom ¥
B save Scale Find  Thumbnails Bookmarks  Editing First Manyfages E ~ Close

%| Parameters v ]E Size v Fields Page | Last Page

Open

@ Zoom In

Document Print Page Setup [ Navigation Zoom Page ... Export Close -~

Paramets o X a
arameters v Bridge Name: FDOT Training Bridge

Sorted By: | Station -
Bridge Unit: Unit 1 - Beam Slab Concrete-Girders Bridge

Reset Submit
Deck Elevation Report

(Normal to alignment)

Span 3 ('
Start Start End End
Location | Support | Bearing 1 2 3 4 5 [} 7 8 9 10 | Bearing | Support
Line Line Line Line

Left Deck
Edge
with
offset= | 118.762 | 118.810 - 118.940 | 119.517 | 120.0685 | 120.585 | 121.077 | 121.541 | 121.976 | 122.384 | 122763 | 122.967 | 122.984
0.000
(DECK
1)P_5
DocumentMap O % X Beam
Path with
v Deck Elevation Report offset =
Span 3 (") 0.000 - 118.843 - 119.000 | 119.58% | 120.140 | 120.662 | 121.154 | 121.616 | 122.049 | 122452 | 122.826 | 123.011 | 123.028
Span 4 (* (DECK
" 0 1)Beam-
1
SIDEWA
LK1-
Right
Edge
with | 118.868 | 118.918 - 119,162 | 110738 | 120.287 | 120.807 | 121.289 | 121.763 | 122108 | 122.605 | 122.084 | 123120 | 123.146
offset =
0.000
(DECK
1)P_1
Beam
Path with
offset =
0.000 - 118.934 - 110197 | 110778 | 120,320 | 120.850 | 121.342 | 121.804 | 122237 | 122641 | 123.014 | 123.149 | 123166
(DECK -

Page 1 of 4 100% —— +
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The Beam Report tool provides a set of parameters for each beam line including the length, grade,
direction (bearing), and rotation. It provides beam elevations, haunch thickness, and haunch elevations
based on selected number of points. Currently, the haunch thickness and elevations include cross slope/
superelevation; however, they do not include camber (even if it is entered in the Camber Report tool or
read from LEAP Bridge). This limitation is pending enhancements on prestressed beam camber/deflection
definitions and elevations at erection.

Preview i3] — O X
Open E‘j Print H @ Margins ¥ & Bl Thumbnails I‘ 4 Previous Page [ 3 DD =8 .3 . @ . @
E’ Quick Print & Orientation ¥ |I| Bookmarks P Next Page ‘W D Q v
4 save = Scale Find First Many Pages B [ e Close
| Parameters v ][y sizev Editing Fields =~ Page | Last Page v @ =
Document Print Page Setup [F} Mavigation Zoom Page ... Export Close -~
Parameters o x X Haunch Thickness -
Beam Elevation Report: |17
Points per Beam BeamLayout
Span FFBW END BENT 1- CLPIER 2
e Submit Locations/ Haunch Thickness Along Beam
Beam Name [Reference | 0/10L 110L 2100 3oL 4/10L 510L B/10L 7M10L 810L 9M10L 10/10L
Beam-1 0000 16.114] 32227 4834 64455 80568 ©06.682| 112796| 128900 145.023| 161137
Left 0.499 1.012 1.410 1.697 1.867 1.925 1.868 1.687 1.412 1.012 0.500
Beam CL| 0.968 1.484 1.885 2174 2.346 2.408 2.351 2.182 1.808 1.500 0.988
Right 1.437 1.956 2.360 2.691 2.826 2.888 284 2.666 2.384 1.987 1.476
Beam-2 0000 16.114] 32227 4834 84455 B056B| 96682 112796 128900 145.023| 161137
Left 0.499 1.016 1.418 1.707 1.879 1.937 1.880 1.707 1.420 1.017 0.500
Beam CL| 0.967 1.488 1.802 2184 2.358 2.418 2.363 2.192 1.906 1.504 0.988
Right 1436 1.859 2.366 2.661 2837 2898 2846 2676 2362 1.601 1.476
Document Map or X
Beam-3 0.000 16.114] 32.227| 48.3# 64455 80568 96.682| 112.796| 128.900 145.023| 161.137
Vv BeamReport Left| 0499 1.021| 1.426] 1717 1891 1.950] 1892 1.718| 1428 1.021| 0500
> Beam Report BeamCL|  0.967| 1492 1.900] 219%4| 2389 2430] 2374 2202| 1813 1.508] 0988
> Beam Elevations Right 1435 1.863 2373 2.670 2.848 2911 2.857 2.686 2.399 1.805 1.476
> Haunch Thickness Beam-4 0.000 16.114] 32227 48.34 64.455| 80568 96.682| 112.796| 128.900 145.023| 161.137
> Haunch Elevations Left 0.498 1.025 1434 1728 1.903 1.962 1.904 1728 1.436 1.026 0.489
Beam CL| 0.966 1.496 1.807 2.204 233 2442 2.3% 2212 1.821 1513 0.987
Right 1.434 1.966 2.380 2.680 2.859 2923 2.868 2.696 2.407 1.999 1.475
Beam-& 0.000( 16.114] 32287 48341 64456 80568 06.682| 12796 128.909 146.023| 161.137
Left 0.498 1.030 1442 1.738 1.915 1.975 1916 1.738 1444 1.030 0.489
Beam CL| 0.966 1.499 1914 2.214 2.382 2455 2.398 2222 1.829 1.517 0.987
Right 1.433 1.969 2.387 2.689 2.870 2935 2.880 2.706 2414 2.003 1.475
4 »
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NOTE The Beam Report tool currently assumes the haunch build-up is linear between bearings
and does not account for variations from parabolic prestressed beam camber.
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The Bearing Seat Elevations Report tool provides the bearing seat elevations and/or grout pad/bevel
plate elevations. The report has no settings and provides the elevations for each beam seat (assumes level
beam seats in all situations) and thicknesses at bearing center, minimum, and at each corner. Note that
both bearing lines will be reported at interior supports. This report can be beneficial but is only accurate for
situations in which the beam seat is to be constructed level as mentioned above. Enhancement has been
requested to model sloped bearing seats.

Preview 53] = O X
] v [ i Vi —
open = Print @ & B0 Thumbnails Previous Page | M oa Q ‘3 . @ v
N b} ]
=, Quick Print By~ Bookmarks P Next Page W ¥
1 save Scale Find First Many Pages 2) @ o Close
Parameters v O Editing Fields =~ Page | Last Page Q v . =
Document Print Page Setup = Mavigation Zoom Page ... Export Close -~
Bridge Name: FDOT Training Bridge -
Bridge Unit: Unit 1 :: Beam Slab Concrete-Girders Brdge
Bearing/Bearing Seat Elevation Report
FDOT Training Bridge
Bearings
Elevation
Support Line Name Bearing Line Girder1() Girder2() Girder3() Girderd() Girders()
END BENT 1 Ahead Beam-1 Beam-2 Beam-3 Beam-4 Beam-5
111.000 111.090 111179 111.268 111.355
FIER 2 Back Beam-1 Beam-2 Beam-3 Beam-4 Beam-5
115.162 115300 115438 115.574 115710
Ahead Beam-1 Beam-2 Beam-3 Beam-4 Beam-5
115.208 115.347 115485 115622 115798
END BENT 3 Back Beam-1 Beam-2 Beam-3 Beam-4 Beam-5
117.188 117.3% 175612 117.689 117.865
Bearing Seats
Elevation
Support Line Name Bearing Line Girder1(} Girder2(} Girder3() Girderd() Girder5(1
END BENT 1 Ahead Beam-1 Beam-2 Beam-3 Beam-4 Beam-5
110.7# 110824 110914 111.002 111.089
PIER 2 Back Beam-1 Beam-2 Beam-3 Beam-4 Beam-5 -
4 »
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The Beam Camber Report tool allows the user to enter the beam Camber (sum of the deflections due to
prestress force/strands and downward deflection due to self-weight of the beam), Self Deflection (due to
the dead load of the deck slab and haunch) and Additional Deflection (due to all other dead loads) for all
beams of the active bridge at midspan. Make sure all beam groups and spans have values entered, which
can be expedited for similar spans by using the Copy Beam button. Note that this information can be read
from a LEAP Bridge Concrete file if the analysis is performed using the Bentley workflow. For construction
information, these inputs are used to generate reports of deck elevations and screed elevations at user
defined intervals assuming a parabolic profile. Enhancements have been filed to include Net Beam Camber
@ 120 days and Dead Load Deflection During Deck Pour @ 120 days for prestressed beams as defined
per the FDOT Structures Manual.

Beam Camber And Deflections - | >
Beam Group |GIRDER1 v Span |FFBW END BENT 1-CLPIEF ~ Copy Beam | [ | Read from LBC
Camber Self Deflection Additional Deflection
Beam " " "
" ] "]
+ Beam-1 5.500 -3.000 0.000
Beam-2 5.500 -3.375 0.000
Beam-3 5.500 -3.375 0.000
Beam-4 5.500 -3.375 0.000
Beam-5 5.500 -3.250 0.000
Generate Save

NOTE Sign convention for all entries is upward for position and downward for negative. Camber
(i.e. net camber) should be positive and Self Deflection should be negative.
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Clicking Generate will populate the following report preview. Make sure to select the desired beam group,
span, beams, and points per span on the left and click Submit.

Preview c3] — O X
o E‘ Print @ Margins v & 8] Thumbnails Previous Page .3 DD =¥ .3 - = e
¥ Quick Print [ orientation v [*] Bookmarks P HNext Page W u] Q -
1] save = Scale Find First Many Pages ) @ v Close
7| Parameters ¥ JOsizev Editing Fields Fage | Last Page v - =
Document Print Page Setup n Navigation Zoom Page.. Export  Close |
Parameters or X *
Beam Group  |BeamGroupl -
= Supportlinel - Supportlin_~ Bridge: FDOT Training Bridge
Beam Beam-L, Beam-2, Beam-3, - Bridge Unit: Unit 1 :: Beam Slab Concrete-Girders Bridge
Points Per Span |11 - Group: BeamGroup1
Span: SupporiLine! - SupportLine2
Beam: Beamd
Reset Submit Ingut: Camber = 5,500", Self. Defl. = -3,000", Addl. Defl. = 0.000"
Dist. Along CL. Girder Top Elevation
R WET AT Final Der.BEbevatm Screed Sbvatm (Eresied) Screed Ht. Above Girder
0 0
Document Map R 1 0000 52500 00 FEE 0.987
~ Camber Deflections Repart 2 93778 0.912]
> Bridge: FDOT Training Bridge 3 88,906 0854
4 95008 0.812
5 99.053] 0.787]
6 99.071 0.779)
7 99.0 0.787)
8 111.650) 0.812]
9 127800 0.854
0 143.550) 98.778] 0.912]
1" 159.500) 98613 0.987|
Page 1 of 2 s0% — —f +

When the Pier Elevation Report tool is selected, all bridges/units in the file, whether active or not, may be
options to include in the report. Additionally, the user has the ability to select an individual support (end bent
or intermediate supports) or all the substructure units. The list of elevations includes top of cap elevations
at the left and right ends, as well as pile cutoff and bottom elevations. If applicable, column and footing
elevations at the top and bottom are also reported for piers.

Preview 53} = O X
open E’ Print @ Margins ¥ & DD m Previous Page [} DD €, Zoom Out @ - " e
E’ Quick Print % Orientation ¥ o P Next Page w D Q Zoom v
4 save = Scale Find  Thumbnails Bookmarks El.jitmg First Many Pages ) - Close
7| Parameters ~ |0 size v Fields Page Wl Last Page @ e @ Zoom In =
Document Print Page Setup 71 Navigation Zoom Fage.. Export  Close -
Parameters o x X -
Bridge Name: FDOT Training Bridge
Selected Bridge Active - Bridge Unit: Unit 1 :: Beam Slab Concrete-Girders Bridge
R Abutment: END BENT 1
Selected Pier  |FDOT Training Br -
Cap
Station 2020+08.46
Reset Submit Direction 71°54'01.8248"
Cap Elevation Left () 110.357
Cap Elevation Right () 110.788
Cap Length () 47 667
Piles
Pile # Top Elevation () Bottom Elevation () Length™ () Top X() TopY()
1 108.884 -1.116 110.000 550725.204 1432377 482
2 108.973 -1.027 110.000 550722.123 1432368.036
3 102.063 -0.837 110.000 550719.042 1432358 610
4 102.153 -0.847 110.000 550715961 1432349 184
5 103.243 -0.757 110.000 550712.880 1432339.758
Document Map o x X “Includes embedded length
~ Pier Elevations Report
> Bridge Name: FDOT Training Bridge Pier: PIER 2
Cap
Station 202147213
Direction 71°54'01.8248"
Cap Elevation Left ) 114.508
Cap Elevation Right (") 115.120
Cap Length () 44.000
Column #
Top Left Elevation () 110.323
Top Center Elevation () 110.367
Top Right Elevation () 110.412
Bottom Elevation (') 93.289
Length () 17.078
4 »
Page 1 of 2 100% ——} +
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All elevations and associated reports are generated with the OBM report tool and are opened in the Print
Preview window as shown. These reports can be exported to many common file formats including PDF,
XLS, XLSX, TXT, CSV, and more. The Export To drop down menu on the Print Preview menu group lists
all available choices. Note that the Working Units set within File > Settings > File > Design File Settings
controls what units are displayed in the reports.

HEQ

Export = E-Mail Close
To v S
PDF File
Adobe Portable Document Format

HTML File

|| web Page

pr—

MHT File
|| Single File web Page

it

I RTF File 1
Rich Text Format

- Iw.4 DOCX File E

| || Microsoft Word 2007 Document

1 LS File 1
- Microsoft Excel 2000-2003 Workbook

| 75 XLSX File
| | Microsoft Excel 2007 Workbook I

i CSV File

Comma-Separated Values Text
- Text File -
| Plain Text 1

1 Image File 1
- BMP, GIF, JPEG, PNG, TIFF, EMF, WMF

This allows for flexibility to incorporate these report values, especially considering spreadsheet exports, to
generate quantities and elevations as needed or for further calculations.

INPUT REPORT

Input Echo Report in OBM lists all input data the user provides. All input data is recorded in the report that
may be used for verification and as checkprints for the model creation. This tool may be accessed from the
Reports and Drawings > Input Report in the Bridge Reporting group.

OpenBridge Modeler - M = B[S £ 2[a9 01t 5

Home Civil Utilities Reports and Drawings View Collabaorate FDOT|

ﬁ L_, Clpeck  —d camber %\g 5 r T

Il Beam | pier '

Quantitiesy Input § XYZ ; Dynamic Settings Substructure Typical
Report JReport [-vE Bearing View By Station Section N

Bridge Reporting
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The resulting Print Preview window opens. The report may include only the active bridge or all the bridges
in the file, as well as the active or all the units. Also, the user can control which elements are included in the
report. These options are shown in the red box below, and the user may view the print preview of the Input
Report of the selected elements.

Preview i3] — O X
f Open = Print [ margins v & DD D Previous Page | kb oo Q KA /@~ g
E", Quick Print % Orientation ¥ o P Next Page u’ D Q-
B save = Scale Find  Thumbnails Bookmarks Editing First Many Pages 2 @ - Close
17| Parameters ¥ 1O Sizev Fields Page P Last Page Q v
Document Print Page Setup (] Navigation Zoom Page ... Export Close “
Parameters o R X E
Report Options |Bridge Type and Geometry| = Br dge Name: FDOT Tralnlng B”dge
Al =n tige Unit: Unit 1 :: Beam Slab Concrete-Girders Bridge
Bridge Type and Geometry
SupportLines Beam Slab (P/S or RC Concrete Girders|
Decks 123456
Approach Slabs No
Beam Layouts Not Set
Beam Groups EE WE
Tub Girder Groups BR WEB
Segments
Spans
Cross-Frame Placement
Stiffener Placement -
port Lines Input Report
oK Cancel | .
[ox [[comel] , i
DoTameT Ty = SLAB 1BEGIN
v Input Echo Report Station 12019+76.96
> Bridge Name: FDOT Training Bridge Lenath () 54.250
Direction 71°54'01.8248"
Skew 17°58'20.7108"
Horizontal Offset () -18.292
APP SLAB 1 TRANSITION
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Direction 71°54'01.6248"
Skew 17°38'07.0389"
Horizontal Offset ) -18.292
FFBW END BENT 1
Station 12020+08 46
Length ) 154 250
Direction 71°54'01.8248"
Skew 17°36'40.4365"
Horizontal Offset ) -18.292
CLPIER2
Station [a021-72.13 7|
[ | [
T T—
Page 1 of 35 90% + =

It is recommended that the 3D bridge model be reviewed along with this Input Report. Using this approach,
the input can be verified visually as well as numerically.
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[Bearalise 7.1 Generate Quantity, Elevations, and Input Reports

CREATE A BRIDGE QUANTITY REPORT

1. Open the data set file: BOTMODLBRTRO1_7.1_Begin.dgn

2. Change the working units to Survey Feet with accuracy to three decimal places via commands File >
Settings > File > Design File Settings.

Workset: 12345678901 - BOIMODLERTRO1_COMPLETED.dgn (Default) - OpenBridge Modeler CE - 2022 Release 2

Settings File Settings
’,‘"
:.‘_I;) User R
/A 3D and B-spline Change specific attributes of B-splines and 3D elements placed in the design
" L)
(5 System (PC)
EW Color Books Create and maintain color books

1 Configuration

Save Setlings

Send Mail

Color Table Browse and modify a copy of the active color table

Database Settings Change settings for linkages between elements and database rows
Close

Toals & Design File Settings Change design file-specific settings

Settings

Properties T Line Style Settings Browse and activate line styles and set line style modifiers
Print

— —/ Line Style Editor Define and madify line styles

Export

Publish iMadel
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Within the Design File Settings window, select the Working Units section and change the Format, Master
Unit, and Accuracy fields, as shown below.

Working Units

Design File Settings X
Category | Linear Units

Active Angle Format: | MU =

Active Scale Master Unit: |Survey Feet - Label: |'
i:igsle Readout Sub Unit: |Survey Inches | Label: | "
Civil Formatting [ Accuracy: 0123 M |

Color Custom
Fence =

Grid Advanced Settings

Isometric Resolution: 304800 per Distance Survey Foot
Locks Working Area:  5.59683E+06 Miles

Snaps

Stream Solids Area: 10 Miles

Views / Solids Accuracy:  5.27999E-07 Survey Feet

Focus ltem Description

Cancel

3. Open the Material Quantity Report Print Preview window by selecting Reports and Drawings >
Quantities Report under the Bridge Reporting group.
OpenBridge Modeler ~ B =S H l'._::! EE: *- - ’ Igl [::: f‘é ¢ :H: s
Home Civil Utilities Reports and Drawings View Collaborate FDOT Help
'::E Deck .--'-‘1{ Carnber

L_" IE Beam

e L:E Bearing

Bridge Reporting

¥

Dynamic
View By Station

s =] [m @&

Settings Substructure Typical Place
Section MNamed Boundany

D

5 Pier

Select All under the Selected Bridge input in the Print Preview window and click Submit to generate
the report. Note that Hide Unit/Cost Data is toggled off because unit costs are zeroed out in the FDOT
workspace. This can be turned on if custom costs are included.

= Print

@z @ Margins & ED Previous Page L3 S, Zoom Out “3 Page Color @ . @
E' Quick Print |E Orientation v Next Page Q, Zoom v
12 Save Seale Find Thumbnails Bookmarks Editing First Many Pages D Watermark [= 1" Close
7| Parameters v IO Sz Fields Page Last Page & Zoom In =
Document Print Page Setup [F} Navigation Zoom Page Background Exp... Close
Parameters X
Selected Bridge | All -
Hide Unit/Cost Data
[]
[« D
Page 10f 1 w0% -——F—+
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=T -
Open Il Print @ Margins v & ED E Previous Page L3 DD 2, Zoom Qut @ PageiCol @ =
E’ Quick Print % Orientation v b Mext Page D Q, Zoom v
3 o = Scale Find  Thumbnails | Bookmarks = Editing First Many Pages Water K
B save *| Parameters A (= Fields Page P Last Page a . &, Zoom In [ T 2~
Document Print Page Setup ] Navigation Zoom Page Background Exp.
Parameters o R X
Selected Bridge | All -
Selected Unit | All -
] Hide Unit/Cost Data Bridge Name: FDOT Training Bridge
Bridge Unit: Unit 1 :: Beam Slab Concrete-Girders Bridge
Reset Submit Materials Quantity Report
Superstructure Quantities
C: Name C Type Material Name Material Type Pay Unit CQuantity
Deck 0400 2 10_Conc
APP SLAE1 Class Il, Approach Concrete Cubic Yard 48347
(_TR-AppSiab) e
— 0400 210_Conc
APP SLAB 2 Class II, Approach Concrete Cubic Yard 3959
(_TR-AppSiaD) M
Deck 0400 4 4_Conc
Document Map os X DECK1 (_TR-Dedt Class IV, éuper Concrete Cubic Yard 379.548(
~ Quantities Report Deck 0400 210_Conc
ec ) ¢
~ Bridge Name: FDOT Training Bridge APP SLAB 3 TR-ADDSIaD) Class Il, Approach Concrete Cubic Yard 3.870]
(_TR-AppSib) s
~ Bridge Unit: Unit 1 :: Beam Slab Co
S fructu st Deck 0400 210_Conc
uperstructure Quantities APP SLAB 4 (_TR-AppSib) Class II, Approach Concrete Cubic Yard 47408
Substructure Quantities - PP Slabs
Miscellaneous Quantities Haunch %ﬂ;?ﬁﬁ%f Conerete Cubie Yard 38499
Be 1 Beam 0450 2 84 FIB 8& c LF 1613.005
amSegment (FlB24) 0450 | oncrete 619.095
Substructurs Quantities
C: Name C Type Material Name Material Type Pay Unit CQuantity
0400 4 5_Conc
END BENT 1 Cap Class IV Blage sub Concrete Cubic Yard 27522
TANR A F Fone
1
Page 10f 2 100% - ———1

NOTE

For this example, there is only one active bridge model and one unit present in the

dgn. However, if multiple bridge models or units existed within the file, the Selected

Bridge or Selected Unit fields can be changed to Active. This will isolate only the

active bridge or unit (verified in the Explorer > OpenBridge Model > Bridge Model >

Bridges) in the quantities report.

Select the Export To drop down menu and select PDF File as the file type.

B S -
Open Il Print @ Margins & HD D Previous Page (3 DD 2, Zoom Qut .3 rmEr g
E’ Quick Print % Orientation v P Next Page * D Q, Zoom v
2 save = Scale Find  Thumbnails Bookmarks Editng — First Many Pages [B) watermark & ~ Close
*| Parameters hd 1M Size Fields Fage Pl Last Page v @ Zoom In =

Document Print Page Setup (] Mavigation Zoom Page Background Exp. Close o
Parameters og X -
Selected Bridge | All -

Selected Unit | All -

] Hide Unitjcost Data Bridge Name: FDOT Training Bridge

Bridge Unit: Unit 1 :: Beam Slab Concrete-Girders Bridge



@u

p PDF File
Adobe Portable Document Format

—

HTML File
] Web Page

MHT File
] single File Web Page

FIaa RTF File
Rich Text Format

iTaTw 4 DOCK File
|| Microsoft Word 2007 Document

pakg LS File
Microsoft Excel 2000-2003 Workboaok

pakE 4 XLSX File
|| Microsoft Excel 2007 Warkboak

&0 csv File
Comma-Separated Values Text

Text File
Plain Text
7518 Image File
BMP, GIF, JPEG, PMG, TIFF, EMF, WMF

5. Select OK in the PDF Export Options dialog box and save the file as QuantitiesReport_TR_Bridge.
pdfin the ... Structures\eng_data folder. Open the file and view the results with a PDF viewer to verify.
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CREATE A DECK ELEVATION REPORT

Open the Deck Elevation Report window by selecting Reports and Drawings > Bridge Reporting >
Deck. Select FFBW END BENT 1 and FFBW END BENT 3 to capture the entire bridge deck then data
point to accept the selection.

OpenBridge Modeler @ oH-HE B« - o 2(ad8 & 5

Home Ciwil Utilities Reports and Drawings View Collaborate FDOT Help

E ._ _ ..--'-‘1{ Carnber % L‘zj |._|__‘|_|_|_.—| i_%

= IE Bearn E_:i[:.:.:j Pier - —
Cuantities Input  XVZ . Dynamic Settings Substructure Typical Place
Report Report CE Bearing View By Station Section Mamed Boundary
Bridge Reporting D

Make the selections in the Deck Elevation Report window shown in the image below. Set the Report
Type to Consolidated and the Transversal Lines to Normal to alignment. Then set the Points Per Span
to 10. Lastly, toggle on the CL_WB (Alignment), DECK 1 (Left Edge), DECK 1 (Right Edge), BARRIER
2 (Left Edge), SIDEWALK 1 (Right Edge), BeamLayout (Beam Path), BeamLayout1 (Beam Path).

Deck Elevation — m| s

Report Mame | TR Bridge Deck Elevations

Start FFBW END BENT 1 v | Oiffset) | 0.000

End FFEW END BENT 3 * | Offset() | 0.000
Report Type§ Consolidated v
Transversal Linesfl  Nermal to alignment =

® Paints Per Span 10 : Individual Paths

Spacing

Common References Y=t

Include Type Name Offset(’)

Generate Save And Close
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3. Click Generate to show the location of the transversal lines and elevation points and to access the Print
Preview of the report.

s icwe 1 - Top, Defoult
-2 eRPRAaD &

mEE

4. Select the Export To drop down menu and select XLSX File as the file type.

Preview B = X
=y Pri T Previo (=]
o 5 Print B Margins & ED m evious Pag 3 oo 1, Zoom Out &) Page Calor 9
E’ Quick Print |E Orientation v P Next Page .“’ D Q, Zoom ~
12 save Scale Find Thumbnails  Bookmarks | Editing _ ManyPages [Z) watermark oo Close
7| Parameters v Y Size v Fi Pl Last Page a v &, Zoom In =
Document Print Page Setup [F} Mavigation Zoom Page Background Exp... Close -
Parameters ox X *
Sorted By: | Station -
= Submit Bridge Name: FDOT Training Bridge

PDF File
Adobe Portable Document Format

HTML File

L1 web Page

MHT File
LI Single File Web Page

RTF File

Rich Text Format

DOCX File

Microsoft Word 2007 Document

¥LS File
Microsoft Excel 2000-2003 Workbook

bk 4 XLSX File
|| Microsoft Excel 2007 Workbook

CSV File
B Comma-Separated Values Text
Text File
Plain Text

B Image File
BMP, GIF, JFEG, PNG, TIFF, EMF, WMF
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5. Inthe XLSX Export Options window, change the Sheet name to Deck Elevations and select OK. Save
the file as Deck Elevation Report TR_Bridge.xIsx in the ... Structures > eng_data folder. Open the file
and view the results with Microsoft Excel.

¥L5X Export Options b 4
Export mode: Single file -
Page range:

Sheet name: Deck Elevations
Text export mode: | Value -

Show grid lines
| Export hyperlinks

Raw data mode

6. Because there are SupportLines used for the approach slabs, the program recognizes the deck as
Spans 3 and 4. Revise the title of the tables to read Span 1 (‘) and Span 2 (‘).

Deck Elevation Report_TR_Bridge ~
File Home Insert Page Layout Formulas Data Review View Automate Developer Help BLUEEH
flj & Cut Calibri S 1A A= EIEI P 35, Wrap Text General -
[® Copy ~
Pajte <F Format Painter I u-~ - O~ ﬁ = === = = Merge&Center w $ ~ % 9 <__0'8 ;)0_8
Clipboard [} Font [} Alignment [} MNumber [}
u22 =~ Fx
A B C D E F G H| I ] K L M N (0] P Qf
1
2 |Bridge Name: FDOT Training Bridge
5
4 |Bridge Unit: Unit 1 - Beam Slab Concrete-Girders Bridge
5
5 LTLh CITVALWVI MUCRJIL
(Normal to alignment)
7
8 { span10)f
Start Start End End
Locaion | Support | Bearing 1 2 3 4 5 6 T 8 9 10 Bearing | Support
9 Line Line Line Line
Left Deck
Edge with
.00 8.762 8.8 - Lx 9517 | 120065 | 120585 | 121077 | 12154 21976 | 122384 | 122763 | 12297 | 122.984
(DECK
10| )PS5
Beam
Path with
Ogb::.j: 118.843 - 119.008 | 119589 | 12004 | 120662 | 121154 | 121616 | 122049 | 122452 | 122826 | 123.011 | 123.028
(DECK
—a
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7. Delete the last row of the Span 2 deck elevations that shows the elevation on the alignment at the
beginning of the end approach slab (APP SLAB 3). This elevation is already accounted for in alignment
deck elevations at the end of the deck (DECK 1).

=
21 Span 2 ()
San | Sa@n End | End
Locaion Support | Bearing 1 2 3 4 5 6 7 8 9 10 Bearing | Support
22 Line Line Line Line
Lef Deck Edge win ofiat= | 93 00t A st | mant | T | m ’ aa | maee | aee | 1aeas | e
23|  QUDOECKIPS 234 | 1300 2. 2431 | 12372 | 123988 | 124205 | 120434 | 124516 | 12477 | 12489 | 120985 | 124.954
Beam Pt it oot =000 | 4o o | gj3s | - | 1;3m2 | 1mass | marer | 408 | 1z | s | nasm | am | maom
24 (DECK 1)Beam-
SIDEWALK 1-RightEdgewith | . ... | oo ur P P . B q B P . 194 0% anE 14 snp apn | a0k ape
25| o= 0000 pECK 1 1 | 1216 | B4 | - DA | 12365 | 135 | 12420 | 124447 | 12455 | 124838 | 14960 | 15418 | 12543 | 1506
Beam Path with ofest = 0,000
o | | 1mess | e | e | 12069 | 120872 | 125022 | 15143
- . B | 13184 BT | 125685 | 123982 24485 | 124593 | 124872 | 125022 | 125043
Beam Pt ofset =000 | oy | g3 | - | s | e | e | 24a% | imers | masm | msom | wson | msam
27 {DECK 1)Beam-3
Beam Path with ofiest = 0.000 -
»s DECK 1Bemed B4 | 12345 B | 1405 | 12435 68 | 124885 | 125073 | 1255 | 125402 | 125513
Ngrment il ofet= 000 | 10 | 1ameg | st | e | nauzs | asar | 7% | som | msam | s | osEe | 505 | 1256% | 125705
" p——— : 589 | 123, 919 | 124239 | 124, 7 : . : . 59 .
Baam Path with ofieat = (.000
13 1235% | 123579 | 1239 | 1242% | 12, 124818 | 12505 | 125263 | 125442 | 12559 - |
0 . BET | 1855 | 1359 | 1392 | s | s 2505 | 125263 | 125442 | 125592 25,704
BARRIER. 1 - Let Edge with P P et | 19000 | 4 g | 1 " q e | asmnea | o P anr R B B "
31| ohom- 000 DECK 7 | 1OV | 162 | 1862 | 120969 | 1AZ9 | 4SS | 4B | 125083 | 1252 | 547 | 125608 15742 | 12575
Right Deck Edge with ofset= | ., wnen | e | e | a2 | e 85 | 507 | 53 | 105 ¢ : et | g
22| 000 DECKIP 1 BED | 136 | 1260 | 12352 | 120312 | 120605 | 124859 | 125007 | 125316 | 125498 | 125652 BTG | 15772
[ | Aigoment wih ofset = 0000
Algnment with ¢= 0. o8 T
33 {APP SLAB J)CL_WB 5105

8. Right-click on the Column B heading and select Insert to add a column. Add the location names to the
newly created column for Span 1 as shown below.

A B C v} E F G H | J K L [ ] a P Q
5 Span1()
Sar | Sar End | End
Locason Support | Bearing | 1 2 3 4 5 6 7 8 9 10 | Bearing | Support
9 Line Line Line Line
Left Deck Edge with ofest = P P . 159 P B yna wmi Ear | ameo7e | 4mn m1er | 4o 1
. . 9 Y 20585 | 121 g : . 9 3
N Rrpeepuiigs Lek Coging || 118762 | 1188 894 517 | 120065 2077 | 12580 | 2197 | 122388 | 10783 | 12957 | 12884
BeamPanwiinoe=0000 | 0 o ol L | e | - | rioooe | trase | tanne | 10se | misst | e | o | mam | s | mon | o
11 {DECK 1)Beam-
SIDEWALK 1-RgnEagewn| M e | rar | R e | e | ene | JUS I,
12| okt 0000 DeCK 1 1 | Lot Gutmine | 118068 | 118918 o162 | 119738 | 120287 | 120, N2 | 1276 | 22198 | 122605 | 1298 | 13129 | 13106
BeamPanuitnoke =000 | 0 o o b L | e | - | veier | a7 | mae | 1205 | i | e | mow | et | mow | mes | e
13 {DECK 1)Beam-2
BeamPanuincke =000 | o o sl .| veem | - | e | e | mos | 208 | wm | e | s | ee | mon | mos | mam
14 (DECK T)Beam-}
Beam Path with offest = 0.000
s DECH hoeend CLBeamd 2 574 | 120154 | 120705 2719 | 12981 | 261 | 12307 | 239 | 134 | 1B
Abgrmertwh ofset= 0.000 PGL 119048 | 119195 | 119044 | 119749 | 120325 | 120873 | 121380 | 121885 | 1220 | 122785 | 123092 | 123571 | 123553 | 13T
16 (DECK f)CL W8
Beam Path with ofiest = 0.000
-l et | - | taTe2 | 120M3 | 0 | 121415 | s | 1239 | izew | 1mas | - | 1msm | 1
- DECK b’ CLBeam 5 762 | 1043 | 120.8% 21907 | 12389 | 280 | 13206 2559 | 1857
BARRIER 1 - Lek Edge with e N 110 10 1199 141 a79 | 1T e |19 91 g2 maeg | a2 R . ama
18| som=00m pECKp 7 oGt | 10167 | 11028 | 191 | vioTe0 | 0I5 | e | M | A5 | 23 | 28 | 1322 23588 | 123807
Right Deck Edge wih ofiet = . JO coa | 1 it | . . o
- =ogE i o Right Coping | - 95 | 119217 | 119822 | 120308 | 10847 | 121867 | 12195 | 1242 | 12285 | 123265 | - 260 | 12362
19| Q0W{DECK 1P

Copy and paste location names to Span 2.

Revise the column headings as shown below.

S w 1(")
FFBW oL oL
Locaion Locaion EI’H:IFEI’K Bearing 1 2 3 4 5 6 T 8 9 10 Bearing CL Pier 2
e et ot | ooy | 18702 | vt | - | view | nies7 | 1200es | 120585 | 12007 | st | iz | 23k | 27y | 2967 | 12204
[ Bean Pt i g~ 000

Copy and paste these cells to Span 2 and make the necessary changes for Column C and Q (change the
start and end location names per span).

This file now contains the base information needed for the deck elevation tables for plans sheet development.
The data can be further manipulated for format (changing the order of the rows if needed, removing merged
columns, etc.) and then imported to the proper DGN file using FDOT Linked Data Manager tool, the OBM
Place Table tool (see corresponding section of manual), or other third-party software.
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CREATE A GEOMETRY REPORT

1. Open the Horizontal Geometry Report window by selecting Civil > General Tools > Geometry Report
> Horizontal Geometry Report tool.

‘ OpenBridge Modeler v bl T Hl-._'LL - f =) f”‘ o 2|222|: 5

Home Civil Utilities Reports and Drawings View Collaborate FDOT Help
A% Import/Export *  #3F Civil Accudraw /" Lines * 3~ Offsets and Tapers * ~ Modify =
4% Design Elements * % Geometry Report ™ O Arcs = 4 Reverse Curves ~ # Complex Geometry =
® Standards ~ I ~  Horizontal Geometry Report I i
Generi Profile Report Horizontal

m View 1- Top, Def v Map Check Report

g ag v ©f kv | d 7  Station Offset Report

g #  Point Feature Station Offset Elevation Report
L-'?:l:_l Station Base Report

g fir Superelevation Report

2. In the Horizontal Geometry Report window, set the toggle on the Included Profiles and set the input to
All. The Start Station and End Station can remain toggled off as those will be selected in the model.

JP.'

Parameters L]
Lock Te Start []

] Start Station 1888 475
Lock Teo End ]

[] End Station 2437838

Interval L3
] Interval 0.000

Event Points 3
Include Bvent Paints |N|:|ne e |

Profile ~
Included Profiles |All v
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Complex Element: CL
Feature: Alignment!

Active Profile: PR_!
Level: BaselineSi

Parameters
Lock ToStert [

[ Start Station 1888.475'
Lock To End O

[ End Station 2437.838

Interval
[ Interval

Event Points ~

Include Event Points

Profile -~

Included Profiles

4. Next data point at a location before the begin approach slab to select a Start Station. Data point again

3. Select the CL_WB alignment then right-click to complete the selection.

at a location after the end approach slab to select an End Station.

5. Data point to confirm the Interval set to 0.000. Data point again to confirm the Include Event Points input

as None. Then, data point one last time to confirm the Included Profiles input as All.

6. The Bentley Civil Report Browser window will open displaying the horizontal alignment data.

File Tools
Aquaplaning.xsl
GeometryPointsxsl
GeometryPointsASCII_CommaDelimited.xsl
GeometryPoints_FeatureMoPath.xsl
Haorizontal AlignmentArea.xsl
HorizontalAlignmentCheckintegrity.xsl
HorizontalAlignmentCheckintegrityCalarCoding.x
HorizontalAlignmentControlLineDataTable.xs|

HorizontalAlignmentEventPointList.xs|

HeorizontalAlignmentReviewWithPlxs!
HorizontalAlignmentStationEquations.xs
Horizontal AlignmentToTIW.xs|
HarizontalAndVerticalAlignmentReview.xs|
HorizontalElementsTable.xsl
HaorizontalElementsTableSimplified.xs!
HarizontalElementsXYZxs
HorizontalRegression PointsNSlews sl
HorizontalRegressionPointsReview.xsl

Horizontal Alignment Review Report

HorizontalAlignmentCurveDataTablexs! Project: Default
Horizontal AlignmentCurveSetElementReview.xs| Descripﬁou:
HorizontalAlignmentCurveSetReview.xs| . -

2 File Name:

Last Revised:

Report Created: Thursday. December 14, 2023
Time: 10:23:17 AM

C:\Worksets' FDOT'12345678901"Structures BOIMODLBRTR(O1_COMPLETED .dgn
12/14/2023 10:03:43

Note: All units in this report are in feet ualess specified otherwise.

Alignment Name: CL_WB

Alignment Description:

Alignment Style: Alignment'Baseline

Element: Linear

Station Northing Easting

SettingQutTables| START (START) 200000.000 R1 1432306.179 548704.519
SettingQutTableDeflection.xs!
Traverse.xsl PC (PC) 200979.37¢8 R1 1432307 464 349683.896
TraverseCurve ASCllxsl Tangential Direction: N§9.925°E
TraverseCurveASClIZxs! -
TraverseCurveASCII3.l Tangential Length: 979.378
TraverseEditASCllxs|
TraversePointsasl Element: Circular
VerticalAlignmentCheckintegrity.xs| 2 4 - AF z 2
VerticalAlignmentCheckintegrityColorCoding.xsl PC (PC) 200979378 R1 1432307.464 549683.896
VerticalflignmentintervalStationElevationGrade.xs HPI (HPI) 201307788 R1 1432307895 350012.306
VerticalAlignmentntervalStationElevationGradeAS ce (€C) 1442456.455 349670.584
VerticalAlignmentPaintsXYxs| - T o
VerticalAlignmentReviewxs| PRC (PRC) 201635970 R1 1432329.556 350340.001
VerticalAlignmentReviewASCILxsl Radius: 10149 000
VerticalAlignmentReviewXY.xs! ) .
VerticalAlignmentSightDistanceReview.xs| Delta 3.707% Left
Vertical&lignmentToTIW.xs! Degree of Curvature (Arc): 03657
VerticalRegressionLiftsNLowers.xs! Length- 656.591

: ; Tangens 28410
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7. Staying within the Bentley Civil Report Browser window, click on the VerticalAlignmentReview.xsl at left

to see the vertical profile information.

File Tools

I Cant

I Civil Terrain

4 CivilGeometry

Aquaplaningas!

GeometryPoints.xs!

GeometryPointsASCI_CommaDelimited.xs|

GeometryPoints_FeatureMoPathxsl

HorizontalAlignmentArea sl

Haorizontal AlignmentCheckintegrity.xsl

HorizontalAlignmentCheckintegrityColorCoding.x

Horizontal AlignmentControllineDataTable.xs|

HorizontalAlignmentCurveDataTable xsl

HorizontalAlignmentCurveSetElementReview.xs|

Horizontal AlignmentCurveSetReview.xs|

Horizontal AlignmentEventPointListxs|

Horizontal AlignmentintervalXYZxsl

Horizontal AlignmentLength.xs]

HorizontalAlignmentReview.xsl

Horizontal AlignmentReviewASCllxs]

Horizontal AlignmentReviewWithPlxs!

HorizontalAlignmentStationEquations.xs!

Horizontal AlignmentToTIW.xs|

Horizontal AndVerticalAlignmentReview.xs|

HorizontalElementsTablexsl

HaorizontalElementsTableSimplified.xsl

HerizontalElementsXYZxs|

HorizontalRegressionPointsNSlews.xs|

HorizontalRegressionPointsReview.xs!

SettingOutTable.xs!

SettingOutTableDeflection.xsl

Traversexsl

TraverseCurveASCllxs|

TraverseCurveASClIZ.xs!

TraverseCurveASCII3.xsl

TraverseEditASClLxsl

TraversePoints.xs|

VerticalAlignmentCheckintegrity.xsl

VerticalAlignmentCheckintegrityColorCading.xs!

VerticalAlignmentintervalStationElevationGrade.xs

VerticalAlignmentintervalStationElevationGradeA$
S |

a = |.xsl
VerticalAlignmentReviewXY.xs|

Vertical Alignment Review Report

Report Created: Thursday, December 14, 2023
Time: 10:33:47 AM

Project: Default
Description:
File Name: C:\Worksets'FDOT\12345678901"Structures\BOIMODLBRTR01_COMPLETED.dgn
Last Revised: 12/14/2023 10:03:43

Note: All units in this report are in feet unless specified otherwise.

Horizontal Alignment: CL_WB
Horizontal Description:
Horizontal Style: Alignment'Baseline

Vertical Alignment: PR_WB
Vertical Description:
Vertical Style: Alignment'Baseline

Station Elevation
Element: Linear
START 200000.820 R1 98.308
VPI 200104.920 R1 100.390
Tangent Grade: 0.020
Tangent Length: 104.100
Element: Linear
VPI 200104.920 R1 100.390
VPC 200395.600 R1 108.222
Tangent Grade: 0.026
Tangent Length: 290.680
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CREATE AN INPUT REPORT

1. Open the Input Report Print Preview window by selecting Reports and Drawings > Bridge Reporting
> Input Report tool.

OpenBridge Modeler | B S H l:_t:g E:f: o v A " Igl D:: f't; ¢ :|333|: 5
Home Ciwil Utilities Reports and Drawings View Collaborate FDOT Help
E it C:E Deck .-—-‘:1{ Clamber % EI . :_ﬁ
EE Bearn 5;-_._;5.1 Pier & L__|

X¥Z . Dynamic  Settings Substructure Typical Place
L:E Bearing Wiew By Station Section Mamed Boundary]

Quantitiesyl Input
Report JReport

Bridge Reporting Dy

2. In the Print Preview Parameters, set the Selected Bridge and Selected Unit fields to All and toggle
on All in the Report Options field. This will show the data that has been input for all of the bridge
components. Then, click Submit to access the Print Preview of the report.

=B ae I &

Open  Save Print  Quick  Parameters Scale M

Print 4
Document Print
Parameters 1 X

Selected Unit
Report Options |Bridge Type and Geome | =
Al I
Bridge Type and Geometry
Supportlines
Decks

Approach Slabs
Beam Layouts
Beam Groups

Tub Girder Groups

Segments
Spans
Cross-Frame Placement
stiffener Placement
Shear Studs Placement
Field Splice Placement
Cross-Frame Definitions
stiffener Definitions
Connection Plate Definitions
Connector Angle Definitons
shear Stud Definitions
Field Splice Definitions
Barriers
Accessories
Supports
Bearing Groups
Wingwalls

Concrete Diaphragms

[ o e ]
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Preview 53] = o
B v i =
Open | ¥ Print n [ Margins & ED IH PreviousPage | k| [J[] S ZoomOut ) Pagecoory @ - g
I Quick Print. [P orientation ~ P Next Page W [u] Q, zoom v
B Save [ Scale Find  Thumbnails Bookmarks Editng  First Many Pages ) Watermark @@ v Cose
i Parameters v [ Size v Fields ~ Page Pl Last Page Q - @ ZoomIn =
Document print Page Setup = Navigation Zoom Page Background  Exp Close
Parameters o F x
Select=d Bridge | Al
Selected Urit | Al
Report Options | Bridge Type and Geome - Bridge Name: FDOT Training Bridge
Bridge Unit: Unit 1 :: Beam Slab Concrete-Girders Bridge
Reset Subrit [Bridge Type and Geometry
Beam Slab (P/S or RC Concrete Girders)
123458
No
Not Set
No
Bridge Algnment CL_WB
| Active Profile PR_WB
Document Map o %
v [ptEdnRer Support Lines Input Report
» Bridge Name: FDOT Training Bridge —
Support Lines
APP SLAB 1 BEGIN
Station 2019+76.96
Length () 543
Direction T1°54'01 3248"
Shew 17°5820.7108"
Horizontal Offset () -18:3 12
APP SLAB 1 TRANSITION
Station 2020+06.36
Length () 543
Direction T71°54101.8248"
Skew 17°38107.0399"
Horizontal Offset () -18:3 12
Page 10f 36 100% - —A

3. Select the Export To drop down menu and select PDF File as the file type.

IT g
T Orentaton ~
\ Sire ¥

= L

I Quick Frint
B sen "] Paraie -

Cpen

Ciscurmarit

& ol [

Fdl  Thumbeali Besmarks

-
—

oy
w
L]

=

HTML File

|| webPage

MHT File
|__| single File Web Page

=

sTiTw 4 DOCX File
|| Microsoft Word 2007 Document

PDF File
Adobe Portable Document Format

RTF File
Rich Text Format

¥LS File
Microsoft Excel 2000-2003 Workbook

XLs

pakF 4 XL5X File
|| Microsoft Excel 2007 Workbook

C5V File
Comma-Separated Values Text

Csv

=

Text File
Flain Text

Image File
BMP, GIF, JPEG, PMG, TIFF, EMF, WMF

4, Select OK in the PDF Export Options window and save the file as InputEchoReportPopulate TR _
Bridge.pdfin the ... Structures\eng_data folder. Open the file and view the results in a PDF viewer.
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Bearaise 7.2 FDOT Bridge Quantities Workflow

1. Open the data set file: BOIMODLBRTRO01_7.2_Begin

2. Open the Structures Report Raw tool by navigating to and selecting OpenBridge Modeler (Workflow)

> FDOT > Quantities > Structures Report Raw.

OpenBridge Modeler - Fﬁ 6 0 1t s Workset: 12345678901 - BOTMODLERTR01_7.2_Begin.d
Home Civil Utlllty Collaborate FDOT Help
() y - JiL - 99 - E . (&) structures Repor‘t Raw
_ Z S T~ =
) & = a Structures Report Final
Element ... Create Filters ~ell Cell FDOT Attach Geotech ~ Geotech | siandard Rebar  gteel Quantity
Selection i-i ¥ | File T Qg Tanesy Webpages ¥ Cells  Survey Reference = Data Manager 1001S™ ' packager 100157  Shapes ' Takeoff Manager Tools =
Selec_tlon y Cell AEEncatlons Raad_way Geaotechnical Structures Quantities

3. In the Save As window, update the File name to Summary of Structures Quantities RAW_TR.xIsx
and click Save. This will save the spreadsheet in the C:\Worksets\FDOT\12345678901\Calculations\

Structures.
Save As X
T « Worksets > FDOT > 12345678901 > Calculations > Structures v (@] 2 Search Structures
Organize ~ New folder = - 0
~
Name Date modified Type Size
No items match your search.

File name: | Summary of Structures Quantities RAW_TR.xlsx W
Save as type:  Excel Workbook(*.xIsx) ~

 Hide Folders Cancel

The file will not open automatically, so we must open a File Explorer window (outside of OBM)

and navigate to the C:\Worksets\FDOT\12345678901\Calculations\Structures folder to open the
spreadsheet in Excel. This spreadsheet contains the raw, unformatted quantity information that was

extracted from the bridge model.

1 item

Double-click to open

file in Excel

I M = | Structures - O x
Home Share View o
«— v T <« Worksets > FDOT » 12345678901 » Calculations > Structures 2% Q O Search Structures

M~
Name Date modified Type Size
Summary of Structures Quantities RAW_TR.xIsx 12/18/2023 2:10 PM Microsoft Excel W... 11 KB
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5.

In the raw quantity spreadsheet, we can enter some items that do not get generated with the FDOT
quantity tool. For example, since we placed the bearing pads using the cell bearing type, they do not
get reported in the FDOT quantity report. We know from the previous quantity report that we have 20
bearing pads of Type H, so we can manually calculate and enter the information shown below (the pay
item number must be manually formatted as text for the leading zero to display properly). We can also
manually enter the bridge fencing quantity, the thickened end slab quantity, and the quantity information
for the end bent that was placed with the parametric cell. Make sure to follow upper and lower case
formatting for consistency. Save and close the Excel file.

AutoSave (@ 0ff) 9~ Summary of Structures Quantiti.. » Saved to this PC v L Piorun, Heather C. ‘%\ =
File Home Insert Pagelayout Formulas Data Review View Automate Developer Help BLUEBEAM ProjectWise PDF-XChange | & | [& ~ \
J A E % [EH Conditional Formatting ~ EE B Create PDF 111
v F it as Table ¥ Ch: Setti
EB Font Alignment | Number @ ormat s fable Cells Editing | Analyze Add-ins o A SR Get Jira
= v - ~ [ cell Styles v v v Data |B Batch PDF Data
Clipboard ~ Styles Analysis Sensitivity Add-ins Bluebeam Jira Cloud ~
D23 - e Prestressed Concrete Piling, 24" Sq v
A B C D E F G H | -
1 |BridgeNumber Section PayltemNumber Description Units Quantity Secon Seco Location
2 123456 Superstructure 0400147 Composite Neoprene Pads CF 11.80555556 BEARINGS
3 123456 Superstructure 0550 10335 Fencing, Type R, 6.1-7.0', Vertical LF 387.9767705 VERTICAL BARRIERS
4 123456 Superstructure 0400 4 4 Concrete Class IV, Superstructure cY 3 THICKENED DECK END
5 123456 Substructure 0400 4 5 Concrete Class IV, Bridge Substructure cY 18.5 END BENT 3
6 123456 Foundation 045534 5 Prestressed Concrete Piling, 24" Sq LF 525 END BENT 3
7 123456 Superstructure 0400 4 4 Concrete Class IV, Superstructure cY 379.5505788 DECK1
8 123456 Railing/Barriers 0521 5 14 T Concrete Traffic Railing - Bridge, 42" Single-Slope  LF 325.8463757 BARRIER 1
9 123456 Superstructure Insert 5 rows at the top of the |53 IV, Superstructure cy 325.6254361 SIDEWALK 1
10 123456 Su spreadsheet for manual items |ss IV. Bridee Substructure CY 26.59186562 PIFR 2 E‘
Sheet1 @ [«] | ]
+)
Ready [® % Accessibility: Good to go H M -—F——+ 100%
— —

Open the Structures Report Final tool by navigating to and selecting OpenBridge Modeler (\Workflow)
> FDOT > Quantities > Structures Report Final.

OpenBridge Modeler v rﬁ‘ N 5

Workset: 12345678901 - BOIMODLBRTRO1_7.2_Begind

Home Civil Utilitj; Collaborate FDOT Help
(5] y < JiL z te - = R Structures Report Raw Q
N 4 & FF If = B :
) P B : Structures Report Final -
Element ... Create Filters ell Cell FDOT Attach Geotech ~ Geotech | Siandard Rebar  steel Quantity
Selection .0 7 File Qg anes~ Webpages ™ Cells = Survey Reference = Data Manager T0Ols™ Packager TO0IS™ Shapes % Takeoff Manager Tools ~

Selection y Cell Applications Roadway

Geotechnical

Structures

Quantities

The OBM Quantity Reports Converter window will open and will search for available raw reports. The
output location is set to C:\Worksets\FDOT\12345678901\Calculations. Click Run to run and open the

Summary of Structure Quantity Report. Click OK to close the file converted window that opens. The

reports converter window can also be closed.

OBM Quantity Reports Converter (v1.1.9.15)

Default Properties

Raw Reports Input Location:

Quantity Report Output Location:

RAW OBM Reports

C:\Worksets\FDOT\12345678901\calculations\structures

C:\Worksets\FDOT\12345678901\calculations

Name

Summary of Structures Quantities RAW_TR xIsx 12/18/2023 3:...

Date Directory

C:\Worksets\FDOT\123456789801\calculations). ..
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8. Within the new spreadsheet that opens, the column widths can be adjusted to display all the information
more clearly.

Summary of Structure Quantities - 123456.... D search poun Heather . ) @ - O X

File Home Insert Page Layout Formulas Data Review View Automate Developer Help BLUEBEAM  ProjectWise  PDF-XChange \ 3 Comments ‘ \ 12 Share
ﬁj X oot General  ~ | [EllConditional Formatting > | Eincert v | ¥ v Avv B Create PDF 11
— (]
v v v 9 Format as Table v % Delete v ~ P~ © Change Settings
paste. L2 B I U $ % 9 | SE o~ 2 Analyze Add-ins o % | Getira
- S = <8 %8 [iZZ el Styles ¥ [E] Format~ | @~ Data (B Batch PDF Data
Clipboard 1S Font 5] Alignment Sl Number & Styles Cells Editing Analysis | Sensitivty | Addins Bluebeam Jira Cloud ~
W41 - K ~
A B D H w X Y z AA AB AC A AN AO Z
1 Summary of Structure Quantities - 123456
g Section pay item Pay Item Description unit of OueptiLy.  Total Quantity, Secondary Ouantlty fZZi’,ZZ Design Notes | Construction
3 Number v s Measure | P F P F Unit P F ! g Remarks
Description
4 | Foundation | 0455 34_5 |Prestressed Concrete Piling, 24" Sq LF 550.0 1843 END BENT 1
) 525.0 END BENT 3
6 768.0 PIER 2
I [Railing/Barriers| 0521 5 4 |Concrete Traffic Railing - Bridge, 32" Vertical Face LF 3256 388 BARRIER 2
8 29.4 BARRIER 3
g 2.1 BARRIER 4
10 2.1 ARRIER 5
11 28.8 ARRIER 6
12 0521 5 14 |Concrete Trallic Railing - Bridge, 42" Single-Slope LF 325.8 388 ARRIER 1
13 28.8 BARRIER 10
L N N N PV N AW N N N NP Y N N S N N N N S N Y O TV IV S NV N N N N W » » & o F Ny N N N N ' ay wr o)
9 b _JE A5
21 3.00 THICKENED DECK END
28 0400147 |Composite Neoprene Pads CF 11.61 1.8 BEARINGS
29 0550 10335 |Fencing, Type R. 6.1-7.0", Vertical LF 388.0 388 VERTICAL BARRIERS
30 hd
Sheet1 ©) [ D
Ready F® % Accessibility: Investigate i3] M - —F——+ 106%
— —

NOTE In this example, the beams, approach slab, and pedestal concrete quantities are not being
pulled into the raw spreadsheet from the bridge model. For any issues with the FDOT
Structures Report Raw or FDOT Structures Report Final tools, please contact CADD.

Support@dot.state.fl.us.
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8 ADVANCED TOPICS

OVERVIEW

There are a number of topics commonly encountered in bridge model centric workflows which fall outside
of the limits of the main scope of this training guide due to their advanced nature. FDOT has already
developed supplemental guides for some of these topics and plans to release additional guides in the
future. The intent of this section is to provide links to those that are already developed and provide interim
guidance until the others are developed.

OBJECTIVES

The objectives of this chapter are to introduce some advanced topics that are commonly encountered
including:

* Rebar Modeling

*  Options for Modeling Fences

» Thickened Deck Overhang Modeling

* Retaining Wall Modeling Workflow

*  Florida Slab Beam Workflow

+ OBM Solids Modifications (exercise included at end of chapter)

REBAR MODELING

While rebar modeling is not required at this time, it is highly recommended for complex reinforced concrete
elements that have a high level of rebar congestion or interface with other reinforced concrete elements.
Examples of this are: pier caps, columns, and footings. Bentley’s reinforcement modeling & detailing software
is ProConcrete. OpenBridge Modeler (standalone OBM and OBM within OpenBridge Designer) comes with
about 50% of the ProConcrete tools. The ProConcrete tools that come with OBM are the tools needed to
model the rebar and apply bar marks. While a rebar modeling training guide has not been developed yet,
there are good resources on Bentley’s YouTube Channel. Link to their rebar modeling playlist HERE.

OPTIONS FOR MODELING FENCES AND RAILS

Depending on the level of detail desired for a bridge model, it may or may not be necessary to model
bridge fencing or rails. Often, the concrete parapet can be modeled without these elements and the length
of parapet can be used for the quantity. In general, there are three options when bridge fencing or rail is
present:

* Do not model the fence — add 2D linework into plans sheet
*  Model the fence using 3D linestyles
*  Model the fence using 3D cells

The first option is the simplest. Not every detail of a bridge needs to be modeled, and in the case of a fence,
there could potentially be more detail required in the bridge fencing than it is worth from a construction
perspective since bridge fencing follows the FDOT Standard Plans. With this option, users would simply
model the concrete parapet or barrier that the fence is to be mounted on. This way, the quantity for the fence
can be extracted from the parapet or barrier length. Once the model-centric plans are created, users can
simply add 2D linework on top of the model-centric elements once they are in the drawing model.

The second option involves using 3D linestyles to represent the fence or rail. While this gives a visual
representation of the element in 3D, depending how the linestyles are set up, they may not print as desired
within the typical section sheet. This method is fairly well documented in OpenRoads Designer workflows,
as it is more common for corridor modeling. FDOT is working on developing 3D linestyles for bridge railing.
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The last option is the most complex and furthest from inclusion in the FDOTConnect workspace and FDOT
bridge modeling workflow. It involves developing full 3D cells for the fence or rail components that can are
repeatable and can be placed using the Place Path tool within OpenBridge Modeler, which can be found in
OpenBridge Modeler (Workflow) > Home > Accessory > Place Path.

W

Vol

OpenBridge Modeler v
Home Civil Utilities

= @-¢ & @ X

L5

Reports and Drawings A

f=) A % on
/\W Y

7

o Place Point

“\_ Place Path

Explorer Element ..., Import  Bridge = -
T ¥ | Selection i.i Y 'S WY ¥ T Wizard 4 [/ Place Barrier
Primary Selection y. Accessory

% Place A By Path — X . .
& Place Accessory By Pa Once the cell is developed, this tool can be

Accessory Placement ~ used to place the cell along a path. Bridge
Call alignment with offset can be used as the path

_ — or a guideline could be used (i.e. barrier or
Active Angle 00 0000° Il parapet). This option is the most complete
Angle Calculation From Selected Path ~ | interms of a high degree of modeling detail,
X-Scale [1.000 but involves the most effort to develop.
Y-Scale [1.000 Some companies have developed project-
Z-Scale [1.000 specific cells for instances like this. FDOT
A Norical is evaluating the need for 3D cells such as

U [ - .

res these to be developed and provided as a

g L SV S N S SN part of the workspace.
v alBi.

Feature -~
Feature Definition |No Feature Definition b
Name Prefo Accessory

THICKENED DECK OVERHANG MODELING

Per FDOT Structures Design Guidelines, the standard deck thickness for new construction of “Long Bridges”
for CIP deck on beams or girders is 8.5”. Thickened deck overhangs are required in certain situations if
you are using table 4.2.5-1 in the FDOT Structured Design Guidelines for minimum transverse reinforcing.
If following that table, the following barrier types will require a 10” thick deck (not including extra thickness
required for deck planing): 42" F-Shape, 8’-0” Noise Wall, and 42” Single-Slope. Modeling this thicker deck
overhang while maintaining the 8” thick deck elsewhere is possible in OBM. Several deck templates have
been setup in the FDOT Connect workspace to accommodate this workflow as seen below.

Deck Slab w/o VGroove-NoChamfers_ TOHL_L
) Deck Slab w/o V-Groove-NoChamfers_TOHL_R
) Deck Slab w.o V-Groove-NoChamfers_TOHLR
) Deck Slab w/o V-Groove-NoChamfers_TOHR_L

Deck Slab w.o V-Groove-NoChamfers TOHR R

Additional versions of the thickened overhang templates may be added in the future, but the nomenclature

at the end will remain the same:

e TOHL_L (Thickened Overhang Left, Left) — Use when you only have a thickened overhang on the
left side of the bridge and the thickened overhang terminates to the left of the PGL.

« TOHL_R (Thickened Overhang Left, Right) — Use when you only have a thickened overhang on the
left side of the bridge and the thickened overhang terminates to the right of the PGL.

*+ TOHLR (Thickened Overhang Left & Right) — Use when you only have a thickened overhang on

both the left & right sides of the bridge.

TOHR_L (Thickened Overhang Right, Left) — Use when you only have a thickened overhang on the
right side of the bridge and the thickened overhang terminates to the left of the PGL.

*+ TOHR_R (Thickened Overhang Right, Right) — Use when you only have a thickened overhang on
the right side of the bridge and the thickened overhang terminates to the right of the PGL.
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Since the horizontal position of the thickened overhang is controlled by the flange of the girder, the overall
workflow for modeling thickened overhangs is as follows:

1. Model the deck with thickened overhang template that applies to your scenario
2. Model the girders

3. Trace the outside edges of girder flanges with Civil Lines (horizontal geometry)
4

Complex the civil lines together & offset them 1/8” away from edge of flange (for haunch modeling
tolerance)

5. Update the deck template to use horizontal point control on the thickened overhang stop point, using
the offset traced flange lines from step 4

RETAINING WALL MODELING WORKFLOW

The design and detailing of retaining walls has always been a collaborative effort between the Roadway
and Structures disciplines. Modeling retaining walls is no exception. The tools used in the retaining wall
modeling workflow are OpenRoads Designer tools, so roadway engineers and designers may be more
familiar with them. However, the workflow can be followed by either discipline, depending how each group
wants to handle it within a project. While there are many ways to model retaining walls, FDOT has developed
an example workflow to help users familiarize themselves with the tools HERE.

FLORIDA SLAB BEAM WORKFLOW

The Florida Slab Beam (FSB) workflow has several nuances that are not covered by this training guide. In
the more recent releases of FDOTConnect, the FSB beam and deck templates have been improved. To
supplement the OpenBridge Modeler training guide and discuss the workflow required to model FSB bridge
superstructures, FDOT has developed an example workflow HERE.

OBM SOLIDS MODIFICATIONS

Depending on a model’s level of detail, it may not always be possible to model a bridge exactly as desired
with the standard OBM tools. Because OBM is used globally, Bentley is not able to accommodate every
agency’s standard details and practice. While many FDOT practices have been incorporated into the
program, certain aspects of design such as the top flange clips specified in SP1 450-010 and the turnbacks
that are typically detailed at either end of end bent caps/backwalls are difficult to build into OBM and cannot
be modeled with the standard bridge modeling tools. Therefore, for models that require a higher level of
detail, the Modeling workflow, which contains all of MicroStation’s 3D drawing and manipulation tools, can
be used to modify the bridge model.

Modeling B oHEB -+ F2RE 2 HE -
Home View Curves Solids. Surfaces Mesch Content Analyze Constraints. Utilities Drawing Aids Collaborate Help
= S cRE=R SR TN @ Slab ~ A& O-+~| O O =88 (J (] EE
& None || Default M u ] - N et I B " - A P —
Q‘ AI: IR u ;’ Q Sphere 5675 O~ oot - Fr_thJ o ‘2
= = . - z Expl ach — El t ence olidBy * M G Rot Mod eatures Boolean
=L =0 =0 "|@o 0 PIOTE Tools 2~ BF ~ | gliorgon Tools+ [ + [J Cylinder Profiler _/ v %¢ ove Copy Ratate ) o, Modfy Te0i™ Mo+ X
Attributes Primary Selection Placement Manipulate Modify
p— — - —T
24 | Modeling @ SHBR « - > A 205 & -
m Home View Curves Selids Surfaces Mesh Content Analyze Constraints Utilities Drawing Aids Collaborate Help

g
Associative 3.
T | Extraction €2

— [ A =D Z7 -2 2 fa (W@ S =3 £ Cug ) Unite g < &
CHQAMNFAVDY HIGPBOHP@oI® PRI G2 =
Slab Cylinder Sphere Cone Tomus Linear Extrude Extrude Thicken Rewolve  Cut  Fillet Chamfer Hole Protrude Shell Sweep Imprint Taper Spin Edit Modify Trim Delete

T 7 i Edge Face Face Festure Solid Solic (8 Intersect Piece @

Primitives Create Solids Features Modify Features Solid Utilities
m— — m— —

olid Along g

There is no one way to complete these modifications. Because the MicroStation library of 3D tools is so vast
many different techniques can be used to accomplish the same outcome. The following solids modification
exercise provides just one way to incorporate beam clips and end bent turnbacks into a model.

A bridge model must, however, be completely modeled before incorporating and modifications to the bridge
components. Often times making changes to the model’s elements with the Microstation 3D modeling tools
can make those elements unable to be altered with the OBM bridge modeling tools after the fact. Therefore,
it is imperative that solids modification in the Modeling workflow be the very last step in one’s modeling
process.
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https://fdotwww.blob.core.windows.net/sitefinity/docs/default-source/cadd/downloads/documentation/fdotconnecttraining/obm/fdot-mse-rw-workflow.pdf?sfvrsn=ce8064d4_2
https://fdotwww.blob.core.windows.net/sitefinity/docs/default-source/cadd/downloads/documentation/fdotconnecttraining/obm/fdotconnectobm-fsb-workflow.pdf?sfvrsn=dad01807_1

EXERCISE OVERVIEW

BIERCISE &1 SOLIDS MODIFICATION: BEAM CLIPPING & MODIFYING OBM
END BENT

CLIP TOP FLANGES OF BEAMS

1. Open the data set file: BOITMODLBRTRO01_8.1_Begin.dgn

2. Navigate to the Modeling workflow to access the tools needed for solids modification.

File

Modeling [@- OElldB«-+ 225 & HE -
Home View Curves Solids Surfaces Mesh Content Analyze Constraints Ltilities

.= v |[= - . = Expl Attach El t Fence
=0 = @0 = P Tools + % 6 - SeFeTt?gn Tools~ [ ~

Attributes Primary Selection

3. To allow the beams to be easily viewed and modified, several other bridge components need to be
turned off. This can be done in by opening Home > Primary > Explorer and clicking on the OpenBridge
Model tab. There the deck, barriers and approach slabs can be turned off.

&, Explorer - x

& Resources B Links
Fle | OpenBridge Model || OpenBridge Standards & lems

Qap.
Search (O‘(O= ¥
4 % Bridge Madel

> < Civil Data

4 v & Bridges
4 v & Bridge( FDOT Training Bridge ) **
b 7 Complex Element: CL_WE
> &% SURVRDO1
4 v ? Units
a4~ r Unit 1:: Beam 5lab Concrete-Girders Bridge **
b E] Beam Layouts
b v I Beam Groups
5= Tub Girder Groups
<£J Concrete Diaphragms
1] Cross-Frame Groups
b Supportlines
B v @ Supports
Q Abutment Wingwalls
j Accessories
B @ Eearings
fTendons

‘:E Reports

4. Next, click on the FFBW END BENT 1 SupportLine and open its properties using the Properties tool
to find the skew that the clip needs to match. For End Bent 1 the skew is 17°36°40.4365” or about

17.6112°.

FDOT OBM 333



5. While there are several different methods that can be used in the solid modification process, the

Chamfer tool is one of the most efficient options when looking to clip a beam’s flange. Navigate to
Solids > Features > Chamfer to use the tool and open the Chamfer Edges window.

IS ) S P@eode

Cut  Filletj Chamfer fHele Protrude  Shell SWEEF:- Imprint Taper Spin
Edge Face Face

Features

6. Next, in the Chamfer Edges window, set the Method to Distance and Angle.

7. Input 0:5 in the Distance field and match the skew from Step 4 in the Angle field. Note that the angle
should be added in decimal format instead of DD°MM’SS” format. Otherwise the field may only allow a
whole degree to be entered (i.e. 17°00°00”) instead of allowing for the precise skew.

4% Chamfer Edges — >

Method: | Distance and Angle™ |
Distance: | 0:5 | x)
Angle: | 17°36'40.32" | ix/
[] Select Tangent Edges:
[] Rewverse Chamfer

NOTE Sometimes when trying to click on an element to modify with the Chamfer tool, an
undesired edge can accidentally be selected for chamfer. If this occurs, simply right click
and the element will remain selected, but the edge will be unselected or a different edge
will be proposed. The correct edge can then be selected and chamfered.

8. Open up the isometric view in View 2 and zoom in on the beginning of Beam-L in Span 1. Click on the
haunch to select it for modification.

S |d RO HoREEHTRE

ae

‘% Chamfer Edges =

Method: | Distance and Angle”
=
Angle: | 17°00°'00" x)

[A] Select Tangent Edges
[] Reverse Chamfer

Beam Segment : Haunch1

Template : BeamRectFivePntsBtmWP
% Bspline Curve

Level: HaunchConc_pm

NOTE In some cases, it may be easier to select the component to clip in a wireframe view (i.e.,
View 1). In that case, the user can select the component in View 1 and then return to View
2 to select which edge should be chamfered.



Click the vertical edge that is going to be chamfered (as shown in the red box below) and click one last
time to confirm (shown on the following page.)

[

E-o%-ARPPROAD HLREEITRR

@ Chamfer Edges =2

Method:  Distance and Angler
Ditance m
o

[] Select Tangent Edges
[] Reverse Chamfer

(E-6%-4 PPROAD HoREEE ITHE

‘E Chamfer Edges 2

Method:  Distance and Angler
b m
m

[] Select Tangent Edges
[] Reverse Chamfer




10. The clipped haunch will look like the image below.

™ View?,
B-Sl#-|d LLROED NINEERHTRS

é Chamfer Edges e

s, [EEREIAIE
e
woe (om0
[ Select Tangent Edges
[] Reverse Chamfer

11. Keeping the Chamfer Edges window open and with the same inputs, select the beam.

12. Next, select the same edge that was chamfered on the haunch.

F A PLPROAD O REDETXD

ﬁ Chamfer Edges —

-
Distance E
Angle: x
[] Select Tangent Edges
[] Reverse Chamfer




13. Data point once to confirm and complete the beam’s clipping. The model will appear as shown in the
following images.

o o || B &R

E-dx-|2 LP0OQYHUIEER HTXS

u o |2 =
EB-éx- 4 PLPROND HORERITRS
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14. Repeat Steps 6 to 13 with the remaining beams at End Bent 1.

15. Next, click on the FFBW END BENT 3 SupportLine and open its properties using the Properties tool
to find the skew that the clip needs to match. For End Bent 3, the skew is 13°52’33.4678” or about

13.8760°.

16. Zoomin onthe end of Beam-1in Span 2 in Views 1 and 2. Click on the haunch to select it for modification.
Then click the edge that is going to be chamfered.
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17. Before confirming the chamfer, notice in the first image below that the preview of the chamfer does not
run parallel to the front face of backwall of End Bent 3. In that case, the chamfer angle must be reversed
by toggling on the Reverse Chamfer option in the Chamfer Edges window, shown in the second image
below.

w View 1 - Top, Default = =R =

5 Chamfer Edges — >

Method: | Distance and Angle™
Distance: | 0:5 Xx
Angle: | 13°32'33.6" x
Select Tangent Edges

‘Reverse Chamfer
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18. This will flip the chamfer and make the angle parallel to the front face of backwall as shown in the image
of the chamfer preview below. Data point to accept the chamfer once the reverse of the clip has been
confirmed.

w View 1- Top, Default | = ” =l |@
mrdw- i 2RO HoEEE & TR

L]

19. Keeping the Chamfer Edges window open and with the same inputs, select the beam. Then, select the
same edge that was chamfered on the haunch.

i eppmadMusE= STk
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20. Using the same inputs, clip the remaining haunches and beams at End Bent 3.

21. The model should now look like the images below.

End Bent 1

End Bent 3




MODIFY AN END BENT

NOTE Once the beams have undergone solids modification, they are no longer able to be turned
off through the Explorer tool. So, while all other components may be turned off there, the
beams must be turned off from the display by turning off their levels in the Level Display
tool. So, to avoid going between the Explorer and the Level Display all components should
be turned on and off through the Level Display.

1. In the OpenBridge Model tab of the Home > Primary > Explorer tool turn all components back on.
Open the Home > Primary > Level Display tool and turn off all levels except for the BarrierWallConc_
pm, EndBentCapConc_pm, and EndBentCheekWallConc_pm. Do this for both View 1 and View 2, then
double-click on the NonPlottingEle_dp level in the Level Display tool to set it as active. The model

should look like the image below.

-S4 PPROQAD GomIAITRE

z0Z| V1S

['6t+0

W

2. Start laying out construction lines for the new backwall layout at the right end of the End Bent 1 by
navigating to the Modeling (workflow) > Home > Placement > Place SmartLine tool. Place the first
point where the right gutterline crosses the front face of backwall and then use the Perpendicular
Snap snap mode to draw a perpendicular line to the end of the end bent, as shown in the image on the

following page.

e View 1 - Top, Default
' L 2PRMadhumEE BT KRG
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3. Next, use the Home > Primary > Properties tool to change the z coordinates of the line’s start and end
to be 105’ as shown below. This will place the line at EL. 105’

& Properties - >
4 b Elements (1)
# Line
General N
Element Description Lire
Level NonPlettingBe_dp
Colar ByLevel (4)
Line Style =
Wigight
Class
Template
Transparency
Geometry ~
w  Start 550711° 5 1/4", 1432337 9 3/16™.105' 0"
x 550711° 5 1/4"
1432337 9 3/16"
| E 105" 0™
v End 550/11° 5. 1432335 2 13/16".105° 0™
x 550711° 5™
1432335° 2 13/16™
| E 105" 0"
Length 2 [¥]

4. Use the Home > Manipulate > Parallel tool to copy a line parallel to the one just created but place it
at the intersection of the gutterline and the back face of backwall. The BarrierWallConc_pm level can
now be turned off in View 1 and View 2 using the Level Display tool. The model should now look like
the following image.
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5. Zoom in on the end points of the lines that were just placed to ensure that they terminate on the
intersection with the end bent at both ends of the line by clicking on the line’s node and moving it to the

intersection. Once lengths have been manipulated, check the line’s Properties again to verify that both
ends are at EL. 105’

Mot good. Should
be no extension
beyond the end

bent at either end

of the line.

Good. Line
ends at end
bent limit.

6. Select both construction lines and access the Home > Manipulate > Copy tool to copy both lines
vertically 15’. The newly created construction lines should be at EL. 120'.

{25 ]4|5]s]7]s
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7. Then navigate to and access the Surfaces > Create Surfaces > Construct Surface > By Edges tool.
Begin forming the first surface by clicking on the EL. 105’ construction line furthest upstation and then
click on its EL. 120’ counterpart line. Data point to accept the limits and data point again to form the
surface.

Repeat the surface creation process with the second pair of construction lines to form another surface.

8. Next, access the Solids > Create Solids > Thicken tool to create the solids that will be used for
trimming. Once the Thicken Surface window has opened, set ensure the Direction is to Forward and
the Thickness is set to 1:0. Click on the surface furthest upstation to preview the direction and depth of
the thickening in View 1. Note that if the surface was created in a different order that described in the
steps prior, the Direction may need to be switched to Backward.

u View 1 - Top, Default | = H = ‘@
B rélx- 2 PPOOAY HUEZHIF AT RS

Direction: | Forward =

Thickness: | 1:0

[ Use Active Attributes
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9. Data point to accept and create the solid.

10. Repeat the solid creation process laid out in Step 6 with the second surface. The result should looks
like the image below.

@S # - |[ELEROad O am 2T %

11. These newly created solids can now be used to trim elements on the end bent. First, navigate to Solids
> Modify Features > Trim Solid to begin the trimming process.

Edit  Maodify . -
Feature Solid f| Solid i8] Intersect Piece - @— <

Medify Features

12. Once the Trim Solid tool has been accessed, begin trimming the cheekwall by selecting the portion of
the element to keep.

Nall % Line

Level: EndBentCheekWallConc_pm
---ltems---
FDO butment CheekWalls
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Click the trimming solid which is the forward most solid that intersects with the cheekwall. Then data point
to confirm the trim. This will trim the cheekwall and cause the trimming solid to be hidden.

T | Views Dotk
- 5w -[ELERDan OEE ==

13. After the cheekwall has been trimmed, repeat Step 12 with the end bent backwall and the second
trimming solid. The final result should look like the image below.

-5 - [ELLROAD N EDE| 8T &S
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14. The remaining modification that needs to be made on the right side of the end bent is to kink the front
face of backwall forward to align with the cheekwall. This will be accomplished by creating a solid to fill
the void between the front face of backwall and cheekwall and merging it with the end bent. To create
the solid a surface representing the top of this portion of backwall needs will be made and extruded

along a vertical path downward.

So, first place vertical construction lines to make it easier to create the surface. Using the Place
SmartLine tool, draw a vertical line from the earlier upstation EL. 120’ construction line directly 15’

down to the corresponding EL. 105’ construction.

LLPOG] HUEEEREHT X

Line
Level: NenPlottingEle_dp

After the first vertical line has been drawn, again use the Place SmartLine tool to draw another 15’ vertical
line down at the other end of the same EL. 120’ construction line.
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15. With the Place SmartLine tool still active, draw one more construction line. This one runs along the
rightmost edge of the top of backwall.

[=ERVACTRES
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16. Use the Drawing (Workflow) > Home > Modify > Extend Line tool to stretch the limit of the line out
past the end of the cheekwall as shown in the following image.

— LL :t;;i: f": > Bl T A

A o -
J i Insert Vert

Modfy Bresk Tim . = =0
Element Element Multiple "1 ™ 1%  Delete Vertex @

Modify




17. With all construction lines now in place, activate the Place SmartLine tool so the top of backwall
surface can be drawn. Rotate the isometric view as needed to allow for easy placement of linework at
each vertex of the surface shown below to create a closed shape/surface.

18. Use the Extend Line tool to move the bottom of the rightmost vertical construction line to the top of the
end bent cap as shown below.

CAPS\ Parametric Solid/Surface
Level: EndBentCapConc_pm




19. Navigate to and select the Modeling (Workflow) > Solids > Create Solids > Extrude Along tool.

‘ Modeling BrodEB«- > 20%

Home View Curves Solids Surfaces Mesh Con

3 QO hom 7|2 W

Slab  Cylinder Sphere Cone Torus Linear  ExtrudelfExtrudefThicken Revolve
T v Selid

Primitives Create Solids

20. When the Solid by Extrusion Along Path window opens, ensure that the custom profile is selected and
that the Alignment is set to Normal.

ﬁ Solid by Extrusion Along Path - X

4 &

i |Normal
[] Lock Profile Rotation:  Design X 7
] Start Distance: | 000 x
] End Distance: | 0:0 x
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21. With the Solid by Extrusion Along Path window still open, click on the vertical line that was shortened
in Step 18 to selected it as the path element. Click on the shape that was created in Step 17 to act as
the extruded element. Data point once to confirm and create the solid. The result of this action is yellow
solid shown in the following image.

u View 2, Default =]
Erow-LdPROOAN|oGEEE 0T X

o

22. Now the new solid needs to be joined to the end bent to fill the gap. Use the Solids > Modify Features
> Unite tool to accomplish this.

23. Once the Unite Solids window opens, click on the end bent to identify it as the first (primary) element.
Then click on the yellow solid to identify it as the next element. Lastly, data point in space to accept the
union. The right side of the end bent is now complete and will appear as shown in the image below.

TE] | o Viewd, btk ==
m-sid-d 0 PROD HoEER IWRE
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24. In the Home > Primary > Level Display tool, ensure that the following levels are turned on:
BarrierWallConc_pm, EndBentCapConc_pm, and EndBentCheekWallConc_pm. This only need be
done for View 1. Keep the NonPlottingEle_dp level as the active level. The model should look like the

image below.

|
i
1

-
=-Ew- 4 PPROAD HUEEEETK

25. In the Modeling workflow, start laying out construction lines for the new backwall layout at the left end
of the end bent. by navigating to the Home > Placement > Place SmartLine tool. Place the first point
where the inside of the left barrier crosses the front face of backwall and then use the Perpendicular

Snap snap mode to draw a perpendicular line to the end of the end bent.

u View1- Top, Default
- . - eLePOad|Ham
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26. Use the Properties tool to change the z coordinates of the line’s start and end to be 105’, as previously
done in Step 3, which places the line at EL. 105’.

27. Next, use the Move Parallel tool to copy a line parallel to the one just created, but place it at the
intersection of the back face of backwall and inside edge of the barrier, as shown highlighted purple in
the image below.

= View | - Top, Defeult oo || g eS|

Bl PeROND HUuRBER| TR

The BarrierWallConc_pm level can now be turned off in the Level Display.

28. Zoom in to the end points of the lines that were just placed to ensure that they terminate on the
intersection with the end bent at both ends of the line. Once lengths have been trimmed to the end bent
line, check the line’s Properties again to verify that both ends are at EL. 105’.

29. With both construction lines highlighted, access the Home > Manipulate > Copy tool to copy both
lines vertically upward 15’, as was demonstrated in Step 6. All four lines that have been placed are
highlighted purple in the image below.

40PROADNSEDEETR
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30. The first modification on the left end of the end bent will be to trim the front face of backwall to start
forming the breakback (shown in the red box below).

u View 1 - Top, Default B S

BE-d%- 4 PEPROafHerEa dTRE

However, this one will need to be performed with more precision since it requires trimming back just the
backwall without trimming the end bent cap. To complete this, construction lines will be laid out so that a
shape can be drawn directly on top of the end bent cap and then extruded vertically upward.
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31. Firstly, use the Place SmartLine tool to draw vertical construction lines at both ends of the upstation
horizontal construction lines as shown below.

Line
Level: MonPlottingEle_dp

=1l A HEE

32. Use the Level Display to turn off the EndBentCheekWallConc_pm level in View 2. Then, use the Place
SmartLine tool to draw a construction line from the front corner of the end bent cap along its top edge.
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33. Use the Extend Line tool to extend the line that was just placed beyond the back face of the backwall
as shown below.

34. Place one more construction line using the Place SmartLine tool along the base of the front face of
backwall that runs from the vertical construction line to the end of the end bent.
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35. Now, use the Level Display to turn off the EndBentCapConc_pm level in View 2. This leaves only the
construction lines on the NonPlottingEle_dp viewable. A shape to be used for extrusion can now easily
be placed. Use the Place SmartLine tool to draw the shape by connecting the intersections shown
below.

m-slu-d L PROAD G DE ST KD

Before Turning off EndBentCapConc_pm Level

E-ox-EeLrOqpt<rom 2T e

After Turning off EndBentCapConc pm Level




After Creating Shape

36. Once the shape has been created, navigate to and select the Extrude Along tool. Click on one of the
vertical construction lines to select it as the path element. Then, click on the shape to select the element
to be extruded.

Using the default inputs in the Solid Extrusion Along Path, data point once in space to confirm the extrusion

and create the solid.




37. Using the Level Display, turn back on the EndBentCapConc_pm and EndBentCheekWallConc_pm
levels in View 2. The newly created solid can now be used to trim the backwall. First, navigate to and
select the Solids > Modify Features > Trim Solid tool. Click on a portion of the end bent to keep.
Then, click on the trimming element and data point to confirm.

38. The resulting solid should like like the image below.

o |l o

39. Next modification is to extend the cheekwall so that it meets with the new location of the front face
of backwall. To start, more construction lines need to be placed. Using a combination of the Place
SmartLine tool and Extend Line tool, place a construction line at the top inside edge and top outside
edge of the cheekwall and extend them beyond the back of the end bent. Also replace the vertical
construction line that was used as a path element in Step 36. See the new lines in the image below
highlighted purple.

i View 2, Default = B )
Erilx-dPPRONOHoREEIUXS
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40. Before creating the shape for extrusion, one more line needs to be created. Use the Copy tool to copy
one of the existing vertical construction lines, grabbing it at its top node in View 2. Copy it into View 1 at
the intersection of the front face of backwall and the construction line at the cheekwall’s inner top edge.

Copy from
here
.|
The new construction is highlighted purple below.
w0 View 2, Default = e 5
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41. Use the Place SmartLine tool to create a shape using the points shown in the images below. Note
that these images are at the same location. They are just shots taken at different angles to more
clearly show each point that makes up the shape.

o
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42. If greater precision is needed when extruding a shape into a solid, the path element used in the Extrude
Along tool follows should be as close as possible to the solid’s intended length. Once the shape has
been placed, shorten the vertical construction line so that the bottom of the line is at the top of the end

bent cap, as shown in the following image.

E-du-id 20004l HommE TR

43. Using the Extrude Along tool, select the line that was just shortened as the path element and the
shape that was created as the extruded element.
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44. The new solid should look like the following image once created.

-4 B




45. Use the Unite tool to join the new solid with the cheekwall. Once the Unite Solids window opens, click
on the cheekwall to identify it as the first element, and then click on the yellow solid to identify it as the
next element. Lastly, data point in space to accept the union and complete the cheekwall.

u View 2, Default ‘E”Elg
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46. The next modification is the breakback on the back face of backwall. This will be accomplished by using
the Unite tool once again, but additional construction lines will be needed to complete this.

47. First, to clean up the area around the modification, delete the construction lines no longer in use, shown
below highlighted in purple.

8 View 1 - Top, Default
F-| 4 BEIRO 1D @

== e
ool |

Only delete lines that

are selected and
Do NOT delete highlighted purple
unselected lines

Do NOT Delete
unselected lines
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48. Now create a construction line along the side edge of the backwall using the Place SmartLine tool.

Construction Line

After the line has been placed, use the Extend Line tool to stretch the line several feet beyond the back
face of the backwall.

49. Verify that the back face of backwall construction line placed at EL. 120’ in Step 29 of this exercise
stretches beyond the newly created construction when looking at the top view in View 1. If it does not,
stretch it beyond the line as shown below.

w View 1 - Top, Default | = ” = |@
E-édx-d P00 0OaY HoEEE| 5T
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50. Use the Place SmartLine tool to draw a vertical construction line from EL. 105’ horizontal construction
line to the EL. 120’ one, as shown in the image below.

o
%
Ling
Level: NonPlottingEle_dp
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51. Then, use the Copy tool to copy the vertical construction line, grabbing it at its top node in View 2. Copy
it into View 1 at the intersection of the EL. 120’ horizontal construction line and the side of backwall
construction line.

Copy from
here
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52. Use the Place SmartLine tool to create a shape using the points shown in the image below.

Oad6HoREE GTR
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53. Once the shape has been placed, shorten the vertical construction line so that the top of the line is
at the top of the backwall and the bottom of the line is at the bottom of the end bent, as shown in the
following image.

B-ix~-d 200090 1uREER T

To make the line more visible, turn off all levels except for the NonPlottingEle dp level in the Level
Display.

54. Activate the Extrude Along tool and click on the shortened vertical construction line to select a path
element. Then click on the previously created shape as the extruded element, and data point in space
to confirm the selections and create the new solid.

55. With the new solid created, the end bent levels can be turned back on. In the Level Display, turn on
the EndBentCapConc_pm and EndBentCheekWallConc_pm.




56. Use the Unite tool to join the end bent to the new solid. Click on the end bent to select it as the first
element, then click on the new yellow solid to select it as the next element. Data point in space to accept
the selection and combine the solids.

57. The last modification to make to the end bent is to add the lugs used in MSE wall applications. Much
like what has been done throughout this exercise, the Extrude Along tool is the most effective tool to
complete this.

58. Use the Copy tool to copy the construction line along the side edge of the backwall down vertically 15’.

r
J‘ 2
[
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59. Once the construction line has been copied down, access the line’s Properties and set the

z-coordinates of the line’s start and end to be 105’. Use the Extend Line tool to extend the line 6”
beyond the back of the wall when looking at the plan view. Then, extend the line in the other direction
to the front of the end bent cap, as shown in the image below.

Move beginning of
line back to front
of end bent cap

60. Then, use the Move Parallel tool to copy a parallel line 5 %2” from the previously created line. Use the

61.

Extend Line tool again to move the limit of the new line to line up with the front of the end bent as
shown below.

Next, copy the vertical construction line located at the vertical edge of back wall back by grabbing it
from the bottom node and copying to the ends of both horizontal lines located at EL 105’. The copied
lines are highlighted in the image below.

/
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62. Copy the vertical construction line pictured below from the location shown in the View 2 isometric view
and place it in the noted location in the View 1 plan view.

w4 PPROMD 05 ER| 2T

63. Use the Level Display to turn off the EndBentCheekWallConc_pm level in View 2. Then draw a

construction line along the top of the backwall between the vertical construction line pictured in the
image below.

il View 2, Default
B4 QGOEI"'L§; yoRED A=

B

FDOT OBM 373



R EEEEEEE————

64. Again, use the Level Display to turn off the EndBentCapConc_pm level. Use the Extend Line tool to
extend the horizontal construction lines H1 and H2 to reach vertical construction lines V1 and V2.

Before Turning off EndBentCapConc_pm Level

Emrilx~|id 00
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Extend after Turning off EndBentCapConc_pm Level
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65. Next, use the Place SmartLine tool place shape with the vertices shown in the image below.
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66. Shorten the length of the selected vertical construction line so that the nodes are placed directly on the
corners of the end bent as shown in the following image.

L PO HuRER ITRD

Then use the Extend Line tool to extend the bottom of the selected line to go 6” beyond the bottom of
the end bent cap.

67. Next, activate the Extrude Along tool. Select the vertical construction line that was just modified in the
last step as the profile element. Click the shape at the top of the backwall as the extruded element, and
then data point in space to create the new solid representing the back MSE wall lug.
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68. Use the Unite tool to join the end bent to the new solid. Click on the end bent to select it as the first
element, then click on the new yellow solid to select it as the next element. Data point in space to accept
the selection and combine the solids. The combined solid is shown below.




69. Draw a construction line from the bottom corner of the end bent (P1) to the next vertical construction
line (P2).

G-l 2 PPROGD HLEED EERS

Use the Move tool to move the line that was just drawn directly downward in the global z coordinate
direction by 6”.
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70. Next, use the Place SmartLine tool place shape with the vertices shown in the image below.
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Once the shape has been created, place a construction line from the bottom corner of the end bent to the
interface with the MSE wall lug as shown in the image below.

E-a%- 4 LPPOOD HLEZEED STXS
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71. Activate the Extrude Along tool and select the construction line that was just created in the last step as
the profile element. Click the shape at the front of the end bent cap as the extruded element, and then
data point in space to create the new solid representing the bottom MSE wall lug.
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72. Use the Unite tool one last time to join the end bent to the new solid. Click on the end bent to select it as
the first element, then click on the new yellow solid to select it as the next element. Data point in space
to accept the selection and combine the solids. The combined solid is shown below.

S (3 [ | w View, Defoute Bl
2| W%

73. All construction lines can either be hidden or deleted. And any other levels may be turned on or off at
this point to see the final result.

= View 2, Default =N ===
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